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WORKING WITH XML 
 

1.1  Introduction 
Imagine CFO of a company who regularly looks at financial data. He wants to specify a range of dates and then 
get aggregate financial data relating to those periods. He wants to see Financial Figures, Revenue streams, 
Costs summarized by weeks within the specified range. He wants to see the raw data as well as charts showing 
these trends for the specified date range. 

To achieve this some staff, has to sift through lots of data and create separate spreadsheet reports for the 
different scenarios. The load on IT is huge in the sense that they have to cater to demands of not only CFO but 
whole lot of diverse departments like Sales, Procurement etc. 

A more viable alternative would be where we have an Excel spreadsheet that could adapt itself to deliver the 
various reports the CFO needs as well as one that other departments could reuse and adjust for their similar 
needs. 

The way out is XML, but let’s first understand what XML is. 

1.2 Understanding XML 
XML is a technology that is designed for managing and sharing structured data in a human-readable text file. 
XML follows industry-standard guidelines and can be processed by a variety of databases and applications. 
Using XML, application designers can create their own customized tags, data structures, and schemas. In 
short, XML greatly eases the definition, transmission, validation, and interpretation of data between databases, 
applications, and organizations. 

  

CHAPTER 

1 
LEARNING OBJECTIVES 

 To gain understanding of  XML 

 To understand XML in Excel 

 To understand Creating XML Maps from Excel file 

 To understand Exporting & Importing XML data 

 To understand working with XML tables 

 To understand refreshing data from XML
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XML was designed to transport and store data. 

 XML stands for EXtensible Markup Language 

 XML is a markup language much like HTML 

 XML was designed to carry data, not to display data 

 XML tags are not predefined, we must define our own tags 

 XML is designed to be self-descriptive 

 XML is a W3C Recommendation 

The simplest way to explain XML is as a structured way of storing information. 

The difference between an XML document and a database (which is also a way of storing structured 
information) is: 

1.  A database is a heavy system in that a lot of software goes into creating and maintaining a database; 
an XML document is based on tags, similar to a HTML document; the difference is that the tags can even be 
user defined, which means we can store data the way we want, as long as we create the software which can 
decipher what the data stands for. 

2.  Even a browser can interpret common XML documents which rely on standard tags. 

3.  Every database system is proprietary in the sense that even though each can interface with another 
through defined protocols, the internals are all hidden; an XML document is defined by tags which are within the 
document, so it is totally open. 

XML stands for 

 EXtensible 

 XML is extensible. It lets us define our own tags, the order in which they occur, and how they should be 
processed or displayed. 

 Markup 

 The most recognizable feature of XML is its tags, or elements 

 Language 

 XML is a language that’s very similar to HTML, but much more flexible. 

XML does not DO anything. XML was created to structure, store, and transport information. 

The following example is a note to Sachin, from Mahendra, stored as XML: 

<?xml version="1.0" encoding="ISO-8859-1"?> 

<note> 

<to>Sachin</to> 
<from>Mahendra</from> 
<heading>Reminder</heading> 
<body>Meet me at IPL!</body> 

</note> 
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The note above is self-descriptive. It has sender and receiver information, it also has a heading and a 
message body. 

Honestly, XML document does not DO anything. It is just information wrapped in tags. To send, receive or 
display it, software would be needed. 

XML allows the author to write their own Tags and their own data structure. 

XML documents form a tree structure that starts at "the root" and branches to "the leaves". 

 The first line is the XML declaration. It defines the XML version (1.0) and the encoding used (ISO-
8859-1 = Latin-1/West European character set). 

 The next line describes the root element of the document (like saying: "this document is a note"): 

<note> 

 The next 4 lines describe 4 child elements of the root (to, from, heading, and body): 

<to>Sachin</to> 
<from>Mahendra</from> 
<heading>Reminder</heading> 
<body>Meet me at IPL!</body> 

 And finally the last line defines the end of the root element: 

</note> 

 This XML document contains a note to Sachin from Mahendra 

 XML Documents Form a Tree Structure 

<root> 
     <child> 
           <subchild>.....</subchild> 
     </child> 
</root> 

The syntax rules of XML are very simple and logical 

 Every bit of data has to start and end with an identical tag: <TagName>Data</TagName> 

 Tag names are case sensitive. <Body> and </body> are NOT valid tags because the capitalization in 
the end tag is not the same as the capitalization in the begin tag. 

 The XML file must begin and end with a root tag. There can only be one root tag in a file. In the 
example above, the root tag is <Note>. 

 We can have an empty tag - put the slash at the end of the tag instead of the beginning: <TagName/> 

 If we nest tags, we must close the inner tag before closing the outer tag. <Item><a>data</a></Item> will 
work, but <Item><a>data</Item></a>will not. 

 XML Attribute Values must be put within quotes. 

Whether XML File is Valid or not can be checked at http://www.stg.brown.edu/service/xmlvalid/ 

XML Element 
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An XML element is everything from (including) the element's start tag to (including) the element's end tag. 

An element can contain: 

 other elements 

 text 

 attributes 

 or a mix of all of the above... 

XML allows us to separate information from presentation 

An element consists of an opening tag, its attributes, any content, and a closing tag. 

A tag – either opening or closing – is used to mark the start or end of an element. 

A node is a part of the hierarchical structure that makes up an XML document. "Node" is a generic term that 
applies to any type of XML document object, including elements, attributes, comments, processing instructions, 
and plain text. 

XML Attributes 

Attributes often provide information that is not part of the data 

XML Schema 

To ensure that everyone plays by the rules, we need a Document Type Definition (DTD), which is called XML 
Schema, whose purpose is to define the structure of an XML document.  It’s a lot like a rule book that states 
which tags are legal, and where. 

1.3 XML in Excel 
Microsoft Office Excel makes it easy to import Extensible Markup Language (XML) data that is created from 
other databases and applications, to map XML elements from an XML schema to worksheet cells, and to export 
revised XML data for interaction with other databases and applications. Think of these XML features as turning 
Office Excel into an XML data file generator with a familiar user interface. 

Excel works primarily with two types of XML files: 

 XML data files (.xml), which contain the custom tags and structured data. 

 Schema files (.xsd), which contain schema tags that enforce rules, such as data type and validation. 

The following are key scenarios that the XML features are designed to address: 

 Extend the functionality of existing Excel templates by mapping XML elements onto existing cells. This 
makes it easier to get XML data into and out of our templates without having to redesign them. 

 Use XML data as input to existing calculation models by mapping XML elements onto existing 
worksheets. 

 Import XML data files into a new workbook. 
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 Import XML data from a Web service into Excel worksheet. 

 Export data in mapped cells to XML data files independent from other data in the workbook. 

1.4 XML Maps 
XML schemas in Excel are called XML maps. XML maps link the cells in a worksheet to the elements (items) in 
an XML schema. We must build our maps from XML schemas. Because schemas don't contain data, our 
mapped cells remain blank until we import or otherwise load data into them. 

Inferred Schemas 

If there is no schema, Excel has a great facility where it infers one from the structure of the tags in an XML data 
file. 

Xml Data File Format vs. XML Spreadsheet Format 

The XML Data format allows us to save our data to standard XML data files. The XML Spreadsheet format is 
proprietary, and requires Excel 2002 or later. 

1.5 Create an XML Data File and XML Schema File from Worksheet 
Case Study 4.1: We have a salesman wise Invoice List in excel having the headers as which has Sales 
Id, Salesman, Invoice, Customer and Amount as shown in Fig. 1.5.1. We want to convert it into XML so 
that the data can be shared by other applications. 

 

Fig. 1.5.1: Sales list 

Strategy: 

One simple approach we could think of is to use “Save As” option in Excel and to save the file as XML. Seems 
like a simple approach, But it doesn’t work, as we try, we get a message that there were no XML mappings 
found in the workbook. In order to export an Excel worksheet to XML we have to add XML Mappings to the 
file 

 In order to create XML File from worksheet we have to use an add-in “OfficeExcel2003XMLToolsAddin. 
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exe” which is downloadable from Microsoft’s site http://www.microsoft.com/en-
us/download/details.aspx?id=3108. 

 When downloaded.  

 Run that exe file which will install at c:\Office Samples\OfficeExcel2003XMLToolsAddin. 

 Then to install add-in, we go to File> Option>Add-ins>Excel add-in and browse to locate the file which 
will be at c:\Office Samples\OfficeExcel2003XMLToolsAddin select the file XmlTools.xla. 

 Thereafter, the add-in would be available for installation as shown in Fig. 1.5.2. select XMLTools  

 XML Tools would be available in add-Ins Ribbon 

 

Fig. 1.5.2.: Add-in Dialog Box 

 Select the XML tools in the Add-Ins Tab and 'Convert range to an XML list'.  

 

Fig. 1.5.3:XML Tools 

 We get a Convert range to an XML List dialog box as shown in Fig. 1.5.4 
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Fig. 1.5.4:Convert Range to XML 

 Select range of cells to convert. 

 Select first row contains column names. 

 Optionally we can choose 'Advanced' to enter our own name for the root of the document and for each 
row. 

 At this stage it asks whether to use existing formatting select that option 

 

Fig. 1.5.5: Use Existing formatting 

 Click ok we see that our range has changed to Table 
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Fig. 1.5.6: XML Source 

 At this stage if we go to Developer>XML> Source we can see the XML map on right side panel. 

 We could then go to Export in XML Tab and export the file as XML 

 Alternatively, we can simply save the spreadsheet as XML data with an xml extension.  

 Our file is converted to XML as shown in Fig.1.5.7. 

 

Fig. 1.5.7: Excel converted to XML 

Gist: We have created XML from Sales List in Excel 

Commands Learnt:  Developer > XML 

Food for thought: If, the spreadsheet contains dates or times, we may have problems in conversion, 
because excel converts it into numbers. Best approach here would be perhaps, reentering the dates as text 
field. 
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1.6 Create an XSD Schema File 
To create a XSD Schema file, 

 Select the XML tools in the Add-Ins Tab. 

 Select “Create XSD files for the XML Schema at the active cell” 

 

Fig. 1.6.1: Create XSD Files 

 An XSD Schema file is created as shown in Fig. 1.6.2. 

 

Fig. 1.6.2: XSD File 

1.7 Delete an XML Map 
If we want to delete the XML Map created above we go to XML> Source Pane> XML Maps and a dialog box 
will appear as shown in Fig. 1.7.1. We have to simply select the map we want to delete and Click “Delete” 

 

Fig. 1.7.1: Delete XML Map  
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1.8 Working with XML Tables 
By using XML maps, we can easily add, identify, and extract specific pieces of business data from Excel 
documents. For example, an invoice that contains the name and address of a customer. We can easily import 
this information from databases and applications, revise it, and export it to the same or other databases and 
applications. 

Excel creates a map for us automatically when we open the XML data file as a Table. Excel uses every element 
in the schema, and we have no control over the map or the amount of data that Excel loads into the worksheet. 

The map becomes part of the workbook, and Excel saves any changes or new data to the workbook in the 
standard Excel file format (.xlsx). We can only save the workbook as an xlsx file. 

We can't export the data from the Table, but we can import new or changed data into the list. 

Case Study 4.2: We have an XML file Salesman Invoice.xml from which we want to create Table. 

Strategy: 

 We open Excel and on the File menu, click Open. 

 In the Files of type list, select XML files (*.xml). 

 In the Look in list, navigate to the file Salesman Invoice.xml.  

 Click Open. 

 Open XML dialog box appears. 

 Select “As an XML Table” as shown in Fig, 1.8.1. and click OK. 

 

Fig. 1.8.1: Open XML Dialog Box 

 An alert message is seen as shown in Fig click OK. 

 

Fig. 1.8.2: Alert Message 
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 Excel creates a new, blank workbook and loads the data into an XML list in that workbook. 

 We can now Click a column header and use the AutoFilter buttons to sort or filter the data. 

 We can also use the Table Tools tab to turn on the Total row under Table Style options. 

 We can use the table options with this Table as shown in Fig 1.8.3 

 

Fig. 1.8.3: Excel sheet created from XML 

Gist: We have created Excel Sales Table from XML File  

Commands Learnt:  XML to Table 

1.9 Creating a Map 
XML Maps are created from XML Schema. If there is no schema Excel infers one from the structure of the 
data in the XML file. Schemas don't contain data; the mapped worksheet cells remain empty until data is put 
into them. 

Case Study 4.3: We have an XML file Salesman Invoice.xml from which we want to create Map. 

Strategy: 

 Open a new Workbook 

 On the Developer Tab go to XML, and then click Source. 
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Fig. 1.9.1: XML Source in Developer 

 At the bottom of the XML Source task dialog box, click XML maps.  

 

Fig. 1.9.2.: XML Maps Dialog Box 

 In the XML maps dialog box, click Add. Find the Salesman Invoice.xml file  

 Click Open. 

 We get an alert that Excel will create a schema, click OK. 

 Excel infers a schema for the XML data file, and the XML Source task pane displays that schema for 
us to use in creating XML map. 

 

 
 

Fig. 1.9.3: Mapping Items 
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 On the worksheet we start by mapping items that occur only once in the data file. Under Sales ID we 
drag Sales ID from the task pane to cell E1. Excel surrounds the mapped cell with a Black border, and it 
displays the Header Options smart tag. Select “Place XML Heading to the left” 

 When we click another cell, the border becomes thinner and turns blue as shown in Fig. 1.9.3 

 Now drag Sales_man to cell B1.  

 We need to also map the data that will occur several times in the worksheet. Drag Row from the 
XML Source task pane to cell A3. Excel fills cells A3 through C3 with the schema elements located 
beneath Row. Excel also formats those elements as an XML Table, and an AutoFilter button appears in 
each cell in row 3 as shown in Fig.  1.9.4. 

 

Fig. 1.9.4: Mapping with XML 

 Save the workbook.  

Gist: We have learnt to create XML Map and create an Excel which can be populated. 

Commands Learnt:  Developer > XML Source 

1.10  Rename an XML Map 
If we ever want to rename an XML Map  

 Go to XML Source pane Click on XML Maps. 

 In XML Maps dialog box  
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 Right Click on the Map which we want to rename and click rename as shown in Fig. 1.10.1 

 

Fig. 1.10.1: Renaming XML Maps 

1.11  Import Data into MAP 
Case Study 4.4: We want to populate this worksheet from the contents of file Salesman Invoice.xml. 

Strategy: 

We now have a map, and want to import data from the contents of the XML file.  

 Select any mapped cell in the worksheet. 

 On the Developer Tab go to XML, and then click Import 

 
Fig. 1.11.1: Import XML 

 Import XML dialog box appears. 

 Browse to the Salesman Invoice.xml file, select it, and then click Import. 

 Excel loads the XML data into the mapped cells as shown in Fig. 1.11.2. 

 
Fig. 1.11.2.: Data imported into Mapped Cells 

 Save the workbook. Excel saves the data with the worksheet. 
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 Go to Developer> XML> Map Properties. 

 

Fig. 1.11.3: Map Properties in XML 

 Select Append new data to existing XML Table as shown in Fig. 1.11.4. 

 

Fig. 1.11.4: XML Map Properties Dialog Box 

 Now Excel Table is append able i.e. we can manually add entries. 

Gist: We have imported data into Excel from XML 

Commands Learnt:  Developer > XML Map properties 

1.12  Format the Data and Layout of an XML Table 
 Select a cell in the XML table. 

 Go to Developer > XML > Map Properties. 

 In the XML Map Properties dialog box, We have various options for formatting the data  
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Fig. 1.12.1: Options in XML Map Properties 

 Adjust column width 

 To automatically adjust column widths for best fit when XML data is refreshed, select this option. This is 
the default option. 

 Preserve column filter 

 To preserve sort order and applied filters when XML data is refreshed, select this option. This is the 
default option. 

 Preserve number formatting 

 To preserve number formatting when XML data is refreshed, select this option. This is the default option. 

1.13  Add-In SG Data 
 In the last row press Tab key. 

 A new row appears at the bottom of the Table. 

 In the last row we Add next Invoice details in A8 to C8 as shown in Fig. 1.13.1. 

 

Fig. 1.13.1: Add-In SG Data 

 Save the workbook. 
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1.14 Export Mapped Data 
After making the changes we can also export the Data. In the export process only the data in the mapped cells 
of the worksheet are exported.  

 Select any mapped cell in the practice worksheet.  

 Go to Developer>XML>Export.  

 
Fig. 1.14.1: Export data 

 Export XML dialog box appears. 

 Give the path, enter a name for the exported file, and then click Export. 

 An XML File is created as shown below and the data we appended manually is appended in XML also 
as shown in Fig. 1.14.2. 

 

Fig. 1.14.2.: XML File created after addition of data 

 The data file is generic XML, so other people or programs can reuse this data. 
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1.15  Moving Mapped Cells 
To move mapped cells, we cut and paste just the way we do when moving any other data. Rules to follow when 
moving mapped cells 

 To move an XML table e.g Invoices and keep it as a Table, entire set of cells has to be moved 
together.  

 If we move individual cells or columns from the list, moved cells will not function as Tables 

 Maps apply to one worksheet only.  

 If mapped cells are copied to another worksheet or workbook, recreate the map. 

 Excel does not export the data that has been moved out of mapped cells.  

 The export process works on mapped cells only. 

 In the Salesman Invoice workbook, select the Table that contains the Invoice: cells A3 through C8. 

 Press CTRL+C to copy the cells. 

 Select cell A10, press CTRL+V to paste the cells into the new location, and then press ESC. 

 The destination cells are in Table form. 

 Select and copy cells B3 through C8, the Customer and Amount columns.  

 Select cell A10, and then paste the copied data. 

 When we paste the data, Excel doesn't format it as a Table 

 
Fig. 1.15.1: Table formatting removed 

1.16  Remove Mapped Cells from a Worksheet 
Remove mapping leave data 

 Go to Developer>XML>Source. 

 In the XML Source task pane, right-click the element that we want to remove and click Remove element 
as shown in Fig. 1.16.1. 
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Fig. 1.16.1: Remove Element 

All the mapped schema elements appear in heavy dark letters. We can one by one remove element in all 
mapped cells. Alternatively we can remove element in parent element. 

1.17  XML Map Security-Remove Data Source Information  
An XML map and its data source information are saved with the Excel workbook, not a specific worksheet. This 
map Information can be seen by someone with a little bit of VBA knowledge. 

If we want to keep using the map information but remove the potentially sensitive data source information, we 
can delete the data source definition of the XML schema from the workbook, but still export the XML data,  

 Go to Developer> XML> Map properties and clearing the Save data source definition in workbook check 
box as shown in Fig. 1.17.1 

 

Fig. 1.17.1: Clear save data source 

1.18  Refresh Data in an Imported File 
 On the worksheet, click a mapped cell to select the XML map that we want to refresh. 

 On the Developer tab, in the XML group, click Refresh Data. 
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Fig. 1.18.1: Refresh data 

 If we want to refresh data automatically every time a workbook is opened. 

 Go To Data Tab >Connections, click the arrow next to Refresh, and then click Connection Properties as 
shown in Fig. 1.18.2. 

  

Fig. 1.18.2: Automatically refresh data 

 Under Usage > Refresh control set the preferences like “Refresh data when opening the file”. 

1.19  Validate Data against Schema for Import and Export  
If we want to ensure that the XML data that we are importing or exporting conforms to the XML schema. Excel 
provides us with a facility to validate data against the XML map when Importing/Exporting data.  

 Go to Developer> XML> Map properties and click the Validate Data Against Schema For Import And 
Export check box as shown in Fig. 1.19.1 

 

Fig. 1.19.1: Validating Data against schema 

 



Main source : ICAI

 downloaded from : taxupindia.com

WORKING WITH XML  

 ADVANCED INFORMATION TECHNOLOGY 23 

 

1.20 Summary 
XML is a great way of Exchanging information between Computer applications 

Excel is a great tool which allows us to import from or export to XML. 

In this chapter, we learned how to install XML Tool add-Ins from Microsoft, we learned basics of XML, 
converting XML to Excel and vice versa, creating an XML data File & Schema file. Create, rename, remove 
XML Map are important when we want to Add Data from XML and export it to XML. 

We have also learnt to refresh data from XML manually, or automatically 
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ADVANCES IN MACROS 

2.1  Introduction 
We all want shortcuts and to avoid the chore of doing monotonous work like data entry or some formatting 
which we want done every time. Excel offers us excellent options to automate in the form of Macros which are 
basically small programs which automatically perform repetitious steps. 

2.2  What is a Macro  
Programming of Macros is done in programming Language VBA (Visual Basic for Applications) but we can use 
Macros even if we do not know VBA since Excel gives us a wonderful tool in the form of Macro Recorder. A 
macro records our mouse clicks and keystrokes while we work and play them back later 

Macros can be written in two ways 

 Writing a Macro using VBA Code 

 Recording a macro using Excel Macro recorder 

2.3  Recording a Macro 
If we have to store Macros it is not possible in .xlsx files. Fortunately excel has a file extension .xlsm which are 
macro enabled workbooks. Excel gives macro-enabled workbooks a different icon, with a superimposed 
exclamation mark.  This icon enables us to recognize a macro-enabled workbook. 

Some tips to record a macro 

 Excel records every keystroke & every command we run, so something we don’t want should not be done 
while recording Macro. 

 We don’t need to work fast, i.e., Macro just records our actions, so if we are just browsing, that is not 
recorded it is only specific actions which get recorded. 

 Try to be generic, since we’d want that macro to run in various situations & scenarios. 

CHAPTER 

2 
LEARNING OBJECTIVES 

 To gain understanding of  Macros 

 To understand Recording of Macros 

 To understand Assigning a button to Macros 

 To understand Absolute & Relative references in Macros
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2.3.1 Enabling Macro Security  

 On the Developer tab, click Macro Security in the Code group.  

 The Security dialog appears. 

 In the Security dialog, change the Macro Settings to Disable All Macros with Notification. 

  With this setting, Excel alerts us whenever we open a workbook that has macros attached. 

 When we open a document and get the warning that the document has macros attached, if this is a 
document that we wrote and we expect macros to be there, click Enable Content to enable the macros 

2.3.2 Where Macros Are Stored  

Macros can be stored in either of two locations, as follows: 

 The workbook we are using, or 

 Our Personal Macro Workbook (which by default is hidden from view) 

 If our macro applies to all workbooks, then store it in the Personal Macro Workbook so it will always be 
available in all of our Excel workbooks; otherwise we store it in our current workbook 

Case Study 2.1: CA P C Gupta gives us a boring routine in Excel, he says when analyzing Debtors List 
in excel sheet wherever we find an aberration which needs to be investigated further, we are to highlight 
the cell. To highlight, Font in bold, the cell fill color has to be changed to pink, font color to blue and 
insert border for the cell. It is really a chore to do it every time. We want to automate this routine and 
assign a shortcut key for it. 

 

Fig. 2.3.1: Debtors Data 
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Strategy: 

We can automate this boring task using Macros in Excel 

We can record a Macro in 3 different ways 

 In Excel 2010 Macros are in Developer Tab, which is not there by default. 

 To activate it we have to go to File> Options as shown in Fig. 2.3.2 

 

Fig 2.3.2: Options in File Tab 

 Under Options > Customize the Ribbon > On the right of the window, a large box lists all the tabs that 
are currently shown in the ribbon. Near the bottom, we see an unchecked item named Developer as 
shown in Fig. 2.3.3. To show the Developer tab, check this box, and then click OK. 

 

Fig 2.3.3: Customize ribbon in options 
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 Macros are under Developer tab as shown in Fig. 2.3.4 

 

Fig. 2.3.4: Macros in Developer tab 

 Recording a Macros is also available in View> Macros as shown in Fig. 2.3.5 

 

Fig. 2.3.5: Macros under view 

 There is one more option to record macro in status bar as shown in Fig. 2.3.6 

 

Fig. 2.3.6: Record a macro in status Bar 

 Using any of the above methods we start recoding a Macro, a macro dialog box appears as shown in 
Fig. 2.3.7 
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Fig. 2.3.7: Record a macro in status Bar 

 We give  macro a name let’s say “PinkHighlight” , we can also attach a shortcut key to it, since most of 
Ctrl + short cut keys are already reserved it is better to go for Ctrl+Shift+. In this case we select 
“Ctrl+Shift+P” just a mnemonic since we want to go for pink highlight. Further Macro can be stored in: 

 This Workbook. 

If we choose this option, Excel stores our macro in the current workbook. Remember, we need to save 
this workbook as a macro-enabled .xlsm file or a binary .xlsb file, or we’ll lose our macros. 

 New Workbook.  

If we choose this option, Excel automatically creates a new workbook (which it opens in a separate 
window) and stores our macro there. 

 Personal Macro Workbook.  

If we choose this option, Excel stores our macro in a special hidden workbook named Personal.xlsb. The 
Personal.xlsb workbook opens automatically whenever we start Excel (although it remains hidden), so 
macros in this workbook are always available no matter what workbook we’re using. 

 

 We store the macro in personal workbook since we want it to be available for all workbooks. 
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 We also give the macro a description “Macro to highlight in pink”. 

 As we begin recording we see that record macro button has changed to “stop recording” in both header 
& status bar as shown in Fig. 2.3.8 

 

 

Fig. 2.3.8: Stop recording in developer tab & status Bar 

 Now we perform the recording of action 

 we select B10 which we need to highlight in pink and  

 go through the desired steps on Home Tab first we make the font Bold,  

 next we change the font colour to Blue, 

 Change the fill to Pink &  

 Insert a border for the cell.  

 We now click the stop recording Button  

 Our macro is now ready, to execute on any cell press Ctrl+Shift+P and we find that the cell gets the 
desired formatting 

 

Fig. 2.3.9: Macro is executed on pressing Ctrl+Shift+P 

Gist: We have recorded a macro to give the desired pink highlighting to a cell to Excel both in static format as 
well as dynamic format 

Commands Learnt:  Record a Macro 
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2.4 Assigning a Button to Macro 
We have seen that Macros make our repetitive job a lot easier to perform but it would be extremely useful if we 
can run macro with a simple click on button, rather than running it manually.  By creating macro-buttons we will 
be able to associate macros with buttons, and show them on the worksheet for performing different tasks we 
have recorded with macro. Excel enables us to create custom buttons to link macros with them, the following 
case study will elaborate how to create macros and associate buttons with them. 

Case Study 2.2: In case study 6.1 we wish to assign a button in Quick Access Toolbar & also make a 
button on the worksheet for one touch macro execution. 

Strategy: 

We can assign Buttons for macros in many ways we will discuss two of them. 

Button on Quick Access Toolbar (QAT) 

 Right click on Quick Access Toolbar (QAT) and select the option “Customize Quick Access Toolbar” 
as shown in Fig. 2.4.1 

 

Fig. 2.4.1: Customize Quick Access Toolbar 

 Select the “Macros” under “Choose commands from” 

 

Fig. 2.4.2: Select macros 

 Under Macros select the Macro we wish to add to QAT in this case “PERSONAL.XLSB!PinkHighlight” 
>add as shown in Fig. 2.4.3 
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Fig. 2.4.3: Select PERSONAL.XLSB!PinkHighlight 

 Select PERSONAL.XLSB!PinkHighlight  in the right pane & click  Modify we see lot of symbols which 
we can assign any pink symbol to make it easy for us to recall and also change the display name to Pink 
Highlight and click OK as shown in Fig. 2.4.4 

 

Fig. 2.4.4: Modify Button 

 We see that a new Button for pink highlighting is added to our toolbar. 

 

Fig. 2.4.5: Pink highlights Button on QAT 

 By clicking this button in QAT we can run this macro. 

 Another button we can have on the sheet itself. 

 We go to Insert>Shapes> select a shape, let’s say “5-Pointed Star” 
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Fig. 2.4.6: Select Shapes from Insert 

 Next we go to shape fill & select a color, we select pink since we want to use it for pink highlighting. 

 

Fig. 2.4.7: Pink highlight Button on QAT 

 We also go to txt box & give the star a caption “Pink” 

 We then right click on the star & select “Assign Macro” 
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Fig. 2.4.8: Right click & select ”Assign Macros” 

 In the Assign Macro dialog box we select macro “PERSONAL.XLSB!PinkHighlight” 

 

Fig. 2.4.9: Assign Macro Dialog Box 

 Macro is now assigned to the shape, clicking on the shape macro in executed. 
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Fig. 2.4.10: Pink highlight Button on QAT 

Gist: We have assigned a button in QAT to macro & also assigned a shape to it. 

Commands Learnt:  Assign a button 

2.5 Absolute and Relative Referencing 
Absolute reference mode. In absolute reference mode, Excel stores the absolute references for the cells that 
we’re modifying. 

Relative reference mode. In relative reference mode, Excel tracks how far we move from our starting position. 

2.5.1 Relative Referencing 

By default, Excel Macro Recorder records our absolute steps. Let’s suppose we want  to move from cell A1 to 
B1 after performing an action, we will press the Right Arrow key, but Excel will not record this key, instead it will 
only record the movement to cell B1. Now let’s suppose we have recorded the actions and are to perform it in 
cell C1, when we run the Macro, a line of Macro will be executed and then cell B1 will be selected instead of 
selecting cell D1 (which is to the right of C1). 

Excel records the movement to cell B1 instead of recording every action (keystroke). If we want Excel to record 
relatively, so that Excel moves to the right cell instead of selecting cell B1, we will have to enable Relative 
References. It can be switched on from the Macros menu just below the Start/Stop Recording option. 

Case Study 2.3: We have to include a debtor list with our balance sheet auditee has given us a list of 
debtors with Name & City underneath it & Balance in the next cell as shown in Fig. 3.3.1 , however we 
want a list with 3 columns Name, City & Balance. To convert it we have to follow the boring routine of 
cut, paste & delete row for each debtor. We however want to automate this task. 
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Fig. 2.5.1: Debtors Data 

Strategy: 

We can automate this boring task using Macros in Excel 

 We first insert a Column after A and name it city. 

 Go to Developer > Record Macro a Record Macro Dialog Box appears as shown in Fig. 2.5.2 

 

Fig. 2.5.2: Record Macro 

 Select a name for the Macro “Singlerow”,  

 Assign a shortcut key “Ctrl+Shift+R” and  

 Store the macro in” this workbook “since this macro would be used by us only once in this specific 
workbook. 

 Click Ok  

 Now the recording starts and all our steps would be recorded in the form of Macro. 



Main source : ICAI

 downloaded from : taxupindia.com

 ADVANCED MS-EXCEL 

36  ADVANCED INFORMATION TECHNOLOGY 

 We perform the steps as shown in Fig. 2.5.3 

 

 

 

 

 

Fig. 2.5.3: Steps to record a Macro 
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 We start  

 at Cell A2 

 Move to Cell A3. 

 Cut Cell A3 and paste to Cell B2. 

 Delete Rows 3 through 4. 

 Go to Cell A3 

 Stop Recording. 

 Our Macro is now recorded. 

 We can execute the macro by pressing Ctrl+Shift+R. 

 Let’s try executing the Macro!!!!!!!!! 

 Lo and Behold what has happened the company name from A3 has shifted to cell B2 and overwritten 
city. 

 

Fig. 2.5.4: Data destroyed 

 Executing Macro once more and we see Excel eating our cells & destroying Data. 

 What’s happened? 

 This has happened because by default macro records our actions literally and foolishly executes them ie 
it again goes to Cell A2, Move to Cell A3, Cut Cell A3 ie “XYZ LLP” and paste to Cell B2 overwriting city 
“New Delhi”, Delete Rows 3 through 4, Go to Cell A3. 

 And the result is absurdity we see above. 

 Solution to the problem is in a button on developer tab “Use Relative References” as shown in Fig. 
2.5.5. 

 

Fig. 2.5.5: Use Relative References 
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 Now before starting recording of the above macro we should have activated “Use Relative 
References” and proceeded to record the Macro. 

 To remove the above Macro we go Developer > Macros. 

 

Fig. 2.5.6: Macro under developer 

 We can see the Macro Dialog Box, Select macro Singlerow and click delete the Macro will be deleted. 

 

Fig. 2.5.7: Delete Macro 

 To again start recording a Macro we first Activate “Use Relative References” and we see that the 
option has changed in color. 

 Then we start recording Macros, to record Macro We repeat steps 9 enumerated above. 

 Our Macro is now recorded. 

 We try executing it & press Ctrl+Shift+R. 

 The result is perfect something we desired. 

 Basically by using “Use Relative References” we are telling Excel 

 Move down one cell,  

 Cut the Value  

 Move one cell up, one to the right and paste the value. 
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 Move two cells left. 

 Move Two cells Under select the two rows 

 Delete the rows 

 Move one cell below 

 We execute the macro a number of times and our sheet gets into the desired shape i.e. we have 
Name, City and Balance in a single Row as shown in Fig. 2.5.8. 

 

Fig. 2.5.8: Resultant Sheet 

Gist: We have arranged Name, City & Balance in single row using a Macro 

Commands Learnt:  Use Relative References in Macros 

3.6 Summary 
In this chapter we have learned it is easy to automate Excel to do repetitive things through Macros, we 
learned how to record a Macro. We have also learned to assign buttons to Macros 

Finally, we learned to use relative References so that Macros don’t do foolish things. 

References 
 [1]  Greg Harvey, ‘Excel 2010 For Dummies’, Wiley Publishing, Inc., Indianapolis, Indiana, 2010. 
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3.1 Introduction  
One of the most important features of excel is its number crunching ability. This is the reason it is used in 
almost every organization. Most Finance management or accounting packages allow us to export data into 
Excel format. Thus data analysis and reporting becomes an easier task. 

Excel allows us to use various functions and even simple mathematical calculations can be performed for 
financial analysis, equity analysis, leasing decisions and the list goes on. However before we proceed, we 
need to know certain basic things about excel formulae: 

3.1.1 Elements of a Formula 

A Formula can have the following elements: 

 Arithmetic Operators: These include symbols such as + (for addition) and / (for division) 

 Conditional Operators: These include symbols such as > (greater than) ; <= ( less than equalto); 
<> (not equal to)  

 Cell References: These include references such as C4, =Sheet2!C4 (reference to other sheets)or 
references to other workbooks.  

 Range References: These include references such as A1:A4, A1:D1, A1:D6 

 Named References: These are named ranges or references created by the user to refer to 
aparticular range of cells. Ex: Range name “Data” referring to a range “A1:D100”  

 Values or Strings: These are values such as 10 or10.5 (values) or “State wise Sales” (String). 

 Strings are to be always enclosed in double quotes when used in a formula.  

LEARNING OBJECTIVES 

 To understand Financial Analysis  

 To understand Du-Pont Analysis  

 To understand Leasing decisions  

 To understand Financial Shenanigans  

 To understand Equity Analysis  

 To learn Chart creation  

 Scenarios and Case Studies  

CHAPTER 

3 
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 Worksheet functions: A formula may consist of multiple functions and each function shall haveits 
own set of arguments and parameters.  

 Parentheses: Every formula has its own set of arguments which are written in 
parentheses.Parentheses are also used to change the order of calculation.  

Note: Excel colours the range addresses and the cells that you enter in a formula. This helps as a 
visual aid to spot the range used in the formula to either understand its working or to spot errors. 

3.1.2 What is a Function?  

A worksheet function is a built in tool that you use in a formula. Worksheet functions allow you to perform 
calculations or operations that would otherwise be too cumbersome or impossible altogether. 

3.1.3 Arguments of a Function  

A function may have:  

 No arguments Ex: =TODAY()  

TODAY function gives you system date which changes daily. This function doesn’t require an argument.  

 One argument Ex: =ABS(-4)  

ABS function gives you absolute value of a number, number without its sign. This function accepts only one 
argument.  

 A fixed number of arguments Ex: =MOD(100,3)  

MOD function returns the remainder after a number is divided by a divisor. It mandatorily requires two 
arguments: number and divisor.  

 Optional arguments  

Ex: =INDEX (Salesdata, 5)  

INDEX function returns value from a given data range based on row and column.  

However in this function, “column number” is optional thus the function will work even without column 
number provided appropriate data has been selected.  

3.1.4 Function Categories  

Following function categories are available in excel: 

Financial Date & Time 

Math & Trig Statistical 

Lookup & Reference Database 

Text Logical 

Information & Compatibility User defined 

Engineering Cube 
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3.1.5 Show Formula Mode  

You can often understand an unfamiliar workbook by displaying the formulas rather than the results of the 
formulas. To toggle the display of formulas, choose Formulas > Formula Auditing > Show Formulas. 

You can also use Ctrl+` ( ~ the accent grave key, usually located above the Tab key) to toggle between 
Formula view and Normal view. 

3.2 Financial Analysis  
Usually potential investors analyze financial statements of companies they want to invest in. This is 
because financial statements reveal about the current and future financial condition of the company. 
Financial analysis often involves comparison between companies in the same industry, companies against 
external benchmarks and analysis of internal performance trends. Analysis also includes forecast based on 
historical performance. Before we move into the analytics we need to understand the balance sheet.  

3.2.1 Understanding the balance sheet.  

A Balance Sheet is a summary of the financial position of a business at a specific point in time, showing all 
assets, liabilities, and equity. It represents the accounting equation: assets equals liabilities plus 
shareholders’ equity.  

Assets are the means utilized to operate the company and are balanced by a company’s financial 
obligations plus equity investment brought into the business and retained earnings. Here is a very simple 
example: For your new business, you want to buy a small office. You have `  5 lakhs which you pay as 
down payment for office. Additional ` 20 lakhs you borrowed is your liability. (Assume you have borrowed 
from friends and relatives as interest-free loan.) as shown in Fig 3.2.1. 

Financial Obligation Value 

Assets  

Office 25,00,000 

Total Assets 25,00,000 

Liabilities  

Loans Outstanding 20,00,000 

Owner’s Equity 5,00,000 

Total Liabilities and Equity 25,00,000 

Fig 3.2.1: Simple Balance sheet 
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A standard balance sheet comprises of following items as shown in Fig 3.2.2: 

Asset & Liability Categories Examples and Explanation 

Assets  

Current Assets Examples  include  cash,  marketable  securities, 
 accounts receivable and prepaid expenses. 

Long term investments and other assets Examples include investments in other companies.

Property, Plant and Equipment Examples include fixed asset and machinery 

Intangible assets Examples include goodwill and patents 

Total Assets Total of current long term and intangible assets 

  

Liabilities and Equity  

Current Liabilities Examples include accounts payable and short term
 debt 

Long term Liabilities Long term debts 

Total Liabilities Total of current and long term liabilities 

Equity  

Retained Earnings Companies cumulative net income or loss 

Owner Equity Examples   include   owner’s   contribution   and 
 investments. 

Total Equity Total of earnings and owner equity 

Total liabilities and equity Total of liabilities and equity 

Fig 3.2.2: Standard balance sheet items 

3.2.2 Financial Ratios – An introduction  

Financial analysts have a wide array of analysis tools at their disposal. Financial ratios are fundamental 
analytical tools for interpreting financial statements. Financial ratio analysis relates items in the financial 
statements in a manner that drives out performance information about the company. The following example 
shall better illustrate the significance of ratios.  

Ex: Revenue of Company A is ` 50,000/- and Company B is ` 40,000/-. Which company is better?The 
obvious answer based on earnings is that Company A is better because it earns more. Now, suppose the 
capital employed by Company A is Rs 4, 00,000/- and Company B is `  3, 00,000/-.  

Based on this new information we shall derive Profit as a % of Capital Employed Company A = (50,000 / 
4, 00,000)*100 = 12.50%  

Company B = (40,000 / 3, 00,000)*100 = 13.33%  

Company B is better than Company A based on the above ratio.  
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Thus ratios help us to convert figures into logical percentages which can then be compared with ratios from 
some other companies or a company’s own past performance and appropriate conclusions can be drawn.  

3.2.3 Various Ratios & Case Study  

There are various types of ratios available to an analyst. In this section we shall cover a few of them with 
the help of the following case study as shown in given Figures:  

 

Fig 3.2.3: Case Study – Balance Sheet 

 

Fig 3.2.4: Case Study – Income Statement 
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3.2.3.1 Liquidity Ratios  

These ratios shows the ability of a company to pay its current financial obligations. Company should not be 
selling its assets at a loss to meet its financial obligations. In a worst scenario company will be forced into 
liquidation.  

3.2.3.2 Current Ratio (CR)  

 It is a measure of company’s ability to meet its short term requirements.  

 It indicates whether current liabilities are adequately covered by current assets.  

 It measures safety margin available for short term creditors.  

 CR = Current Assets / Current Liabilities  

 If Net Working Capital is to be positive, CR > 1  

 Higher ratio ensures firm does not face problems in meeting increased working capital 
requirements.  

 Low ratio implies repeated withdrawals from bank to meet liquidity requirements.  

 High CR as compared to other firms implies advantage of lower interest rates on loans.  

 

Fig 3.2.5: Current Ratio 

3.2.3.3 Acid Test / Quick Ratio (QR)  

 Used to examine whether firm has adequate cash or cash equivalents to meet current obligations 
without resorting to liquidating non cash assets such as inventories  

 Measures position of liquidity at a point of time  

 QR = Quick Assets / Current Liabilities  

 Quick assets  = Current assets – (inventories + prepaid expenses) 

 = 681–(355+64) = 262  

 Current liabilities = 399  

 QR = 262/399 = 0.66  

 As a thumb rule ideal QR = 1; should not be less than 1  
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Fig 3.2.6: Quick Ratio 

3.2.3.4 Leverage / Solvency Ratios  

These ratios show dependency of a firm on outside long term finance. They show long term financial 
solvency & measures firm’s ability to pay interest & principle regularly when due. To assess extent to which 
the firm borrowed money vis-à-vis funds supplied by owners. Companies whose EBIT is less than Interest 
payments are risky  

3.2.3.5 Debt – Equity Ratio 

 It measures relative proportion of debt & equity in financing assets of a firm.  

 Company can have good current ratio and liquidity position, however liquidity may have come from 
long term borrowed funds, the repayment of which along with interest will put liquidity under 
pressure.  

 DER = Long term debt / Shareholders funds.  

 Creditors would like this ratio to be low.  

 Lower ratio implies larger credit cushion.  

 Debt (loans) =  Secure loans + Unsecure loans = 151+30=181  

 Shareholders’ funds =     (equity + preference capital + reserves & surplus – fictitious assets & 
accumulated losses not written off )  = 120+50+215 = 385 

 DER = 181/385 = 0.47 = (0.47:1)  

 Creditors are providing Rs 0.47 financing for each rupee provided by shareholders as shown in Fig 
3.2.7. 

 

Fig 3.2.7: Debt-Equity Ratio 
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3.2.3.6 Debt – Total Fund Ratio  

 DTF ratio= Long term debt / Total fund  

 Debt (long term)  = 181  

 Total funds (debt + shareholders’ funds)  = 181+(170+215-35) = 531  

 DTF ratio = 181/531 = 0.34  

 34% of the firms funds are debt (of various types) remaining 66% is financed by owners/ 
shareholders.  

 Higher the debt - total funds ratio, greater the financial risk as shown in Fig 3.2.8. 

 

Fig 3.2.8: Debt Total Fund Ratio 

3.2.3.7 Debt – Assets Ratio 

 Debt - Assets ratio = Debt / Net assets  

 Debt = 181  

 Net assets (less fictitious assets & losses) = 930  

 Ratio = 181/930 = 0.19  

 19% of the firm’s assets are financed with debt (of various types).  

 Shows coverage provided by the assets to total debt as shown In Fig 3.2.9. 

 

Fig 3.2.9: Debt Asset Ratio 

3.2.3.8 Interest Coverage Ratio 

 This ratio shows ability of company to pay back long term loans along with interest or other charges 
from generation of profit from its operations  

 Interest coverage ratio = EBIT / Debt interest  
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 EBIT  = 143  

 Interest = 29+4 = 33  

 Ratio = 143/33=4.33  

 EBIT should be 6 – 7 times of debt interest  

 

Fig 3.2.10: Interest Coverage Ratio 

3.2.3.9 Liability Coverage Ratio (LCR)  

 Calculated to determine time a company would take to pay off all its liabilities from internally 
generated funds.  

 Assumes that liabilities will not be liquidated from additional borrowings or from sale of assets.  

 LCR = internally generated funds / Total liabilities.  

 Internally gen funds = Equity + Preference + Reserves & Surplus  = 385  

 Total liabilities  =  965  

 LCR = 385/965 = 0.399  

 Firm will take 2.5 years (1/.399) to repay all its liabilities  

  

Fig 3.2.11: Liability Coverage Ratio 

3.2.3.10 Turnover / Activity Ratios  

Allows to examine whether total amount of each type of asset a company owns is reasonable, too high or 
too low in light of current and forecast operating needs. In order to purchase / acquire assets, companies 
need to borrow or obtain Capital from elsewhere:-  

 More assets acquired implies high interest and low profits.  

 Lesser assets implies operations not as efficient as possible.  

 Activity turn over ratios used to assess efficiency with which company is utilizing its assets.  

 Relates to level of activity represented by sales or cost of goods sold  
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3.2.3.11 Inventory turnover ratio 

 Measures No of times inventory turned over in a year OR No of days of inventory held by company 
to sales  

 Times Inventory turned over =  

Net sales OR  COGS .

Average inventory  Average stock 
 Inventory measured in days of sale =  365 x Average inventory 

Net Sales 

 Ratio = 904 / 355 = 2.54 times  

This ratio indicates that inventory has turned over 2.54 times in a year.  

 Inventory in days = (355 x 365) / 904 = 143.33 days  

This ratio indicates that company has enough inventory to support 143 days (almost 5 months) sales as 
show in given Figures.  

 

Fig 3.2.12(A): Inventory Turnover Ratio 

 

Fig 3.2.12(B): Inventory Turnover Ratio 

3.2.3.12 Average collection period (ACP) 

 It represents duration a company must wait after making sales, before it actually receives cash from 
its customers  

 Average collection period = 
Average receivables

Average sales per day
OR  

Average receivables × 365
Sales

 

 This ratio is used to assess credit policy of firm.  

 It enables to effectively manage their credit.  

 If ratio is too high it means company is facing difficulties in collecting debts.  
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 If the ratio is too low means the company is having restrictive credit policy  

 ACP = (189 x 365) / 904  =  76 days  

 

Fig 3.2.13: Average Collection Period 

3.2.3.13 Fixed assets turnover ratio (FATR) 

 It helps to measure effective utilization of fixed assets by company.  

 It is used to compare fixed assets utilization of two firms.  

 High ratio usually indicates better asset utilization.  

 Sometimes this ratio may be too high if assets are old or the ratio maybe too low if capital assets 
are procured recently.  

 FATR = Net Sales ( or COGS) / Fixed Assets = 904 / 229 = 3.95  

 

Fig 3.2.14: Fixed Assets Turnover Ratio 

3.2.3.14 Profitability Ratios  

These ratios indicate company’s profitability in relation to other companies, internal comparison with its 
previous year’s performance. They also indicate management effectiveness  

3.2.3.15 Gross Profit ratio  

 This ratio represents cost of production.  

 It helps in understanding proportion of raw materials used and direct expenses incurred in overall 
production process.  

 This ration reflects income being generated which can be apportioned by promoters  

 This ratio also reflects efficiency of firm’s operations as well as how products are priced  

 GPMR = Gross profit/ Net sales  
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Gross Profit = Net sales - COGS = 904 - 714 = 190 

GPMR = Gross Profit / Net sales  = 190 / 904 = 0.21 = 21% 

 Implies 79% (100-21%) of sales contribute towards direct expenses and raw material.  

 

Fig 3.2.15: Gross Profit Margin Ratio 

3.2.3.16 Net Profit Ratio  

 It takes into account not only cost of production but also administrative expenses like staff salary, 
selling & distribution overheads.  

 It represents surplus of gross profit after meeting expenses.  

 Net profit is usually appropriated to meet tax liability, dividend payments and to retain part in 
business.  

 NPMR = Net profit (Profit after tax)/ Net sales = 52 / 904 = 5.7 %  

 This implies that every `  100/- of sales, `  5.7 /-  earned as profit  

 

Fig 3.2.16: Net Profit Margin Ratio 

3.2.3.17 Return on Investment  

 This ratio indicates efficiency with which company used its capital (Equity as well as debt)  

 This ratio takes into consideration overall returns of the company assuming company has not taken 
any debt.  

 It gives overall returns including adjustments of earnings for financial leveraging.  

 It enables one to check whether return made on investment is better than other alternatives 
available.  

 RoI = EBIT x 100 / Capital Employed  

 EBIT = 143  

 Capital Employed = 566 ( ( 120 + 50 + 215 + 181 ) – ( 0 – 0) )  

 (Equity + Preference + Reserve & Surplus + Debt) – (Fictitious assets + Non-operating assets)  
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 ROI = 143 / 566 x 100 = 25.26 %  

 The company has earned a profit of `  25.26 paisa on every `  100 reinvested as shown in Fig 
3.2.17 

 

Fig 3.2.17: Return on Investment 

3.2.3.18 Valuation Ratios  

Earnings per share (EPS)  

 It represents total earnings of a company available for distribution among equity shareholders. 
Evaluates performance of company shares over a period of time  

 EPS = Net profit available for equity shareholders / No of  Equity shares  

 EPS alone should not be basis of decision making with respect to purchase of any company share  

 Faulty reasons of High EPS  

 Less No of Equity shares  

 Investment in risky ventures  

Price Earnings (PE) Multiple  

 It is the simplest method of comparing different stocks at a point of time to make investment 
decisions  

 As a layman, this is the price being paid for buying one rupee of earning of a company  

ex: If PE of Infosys share is Rs 9/- it means we are paying to the market a price of 9 for every Rs 1/- 
earning of the company 

 PE Ratio = Market Price per share/ EPS  

Price Earnings Growth (PEG) Multiple 

 An extension of PE which also takes into account growth rate of the company � PEG Multiple = PE / 
Growth 
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 Company A Company B 

Market Price 200 200 

EPS 10 20 

Growth rate  5% 2% 

PE Ratio 20 ( 200/10 ) 10 ( 100 / 20 ) 

PEG Multiple 4 ( 20 / 5 ) 5 ( 10 / 2 ) 

 Company A overvalued. 

 Company B overpriced wrt growth potential 

With this we complete Ratio analysis. We shall now learn how to carry out Du Pont Analysis. 

3.3 Du Pont Analysis  
Du Pont Analysis helps to break down the Return on Equity (RoE).  

3.3.1 What is ROE?  

Return on Equity is a financial ratio that shows you how well the management has created value for 
shareholders. ROE is made up of two numbers, net income and shareholders’ equity.  

ROE = Net Income/Shareholders Equity  

A high ROE generally means that the rate of return on shareholders’ equity is going up and that the 
company is doing a good job of growing profits without adding new equity into the business.  

A high and consistent ROE can signal that the company has a competitive advantage over its competitors.  

3.3.2 Introducing the DuPont Analysis  

Du Pont Analysis dissects the ROE to tell you how the company is achieving its ROE. These are the three 
questions that the DuPont analysis can help you answer:  

 Is the company increasing margins?  

 Is the inventory turnover increasing?  

 Is leverage being used?  

3.3.3 Three Step DuPont Analysis Model  

ROE = (Net Profit Margin x (Asset Turnover) x (Equity Multiplier) 

 Net profit margin shows operating efficiency  

 Asset turnover shows asset utilization efficiency  

 Equity multiplier shows financial leverage; where  
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Net Profit Margin = Net Income/Sales 

Asset Turnover = Sales/Total Assets 

Equity Multiplier = Total Assets/Shareholders Equity 

When we multiply these three factors, Sales and Total Assets cancel each other out resulting in ROE as 
shown in Fig 4.3.1. 

ROE = (Net Income/Sales) x (Sales/Total Assets) x (Total Assets/Shareholders Equity) 

 

 Fig 3.3.1: Return on Equity 

3.4 Leasing  
Leasing is a common method for financing property, facilities, and equipment. Leases are contracts 
between an asset’s owner (called the lessor) and the user (the lessee). A lease gives the lessee the right to 
use the asset in exchange for periodic payments to the lessor. For defining operating leases of equipment, 
the lessor is often a manufacturer that leases its own products to the lessee (sales-type leases). 
Sometimes the lessor is an independent leasing company that buys from the manufacturer and leases it to 
the lessee (direct leases). In this case, the lessor may borrow funds from creditors in order to buy the 
equipment from the manufacturer (leveraged leases). At other times, the owner of an asset sells it to 
another firm and immediately leases it back (sale and lease-back leases). This allows the original owner to 
raise cash for immediate needs and still retain the use of the asset while the lease is paid off.  

Lease terms vary. Operating leases are generally for shorter durations than the useful life of the asset 
leased and, for this reason, they are not fully amortized; the lessor does not recover the asset’s full cost.  

The lessor reacquires possession of the asset at the expiration of the operating lease and can lease it 
again for further use. Financial leases, on the other hand, are fully amortized. A lessee can cancel an 
operating lease before its expiration date. However, a lessee cannot cancel a financial lease and must 
make all payments or face bankruptcy. Leases also differ in requirements for the lessee to insure and 
maintain the leased asset and the right of the lessee to renew on the expiration of the lease.  
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Leasing a car for a day or week during a vacation trip is an example of a short-term lease. Leasing trucks, 
factory machinery, computers, or airplanes for a number of years are examples of long-term financial 
leases that are involved in capital budgeting. Such leases are the most common method of financing 
equipment.  

For the lessee, the choices are to buy or to lease. For the lessor, the problem is to identify the highest 
rental rate that would be acceptable to a lessee.  

The following case study is for a long-term financial lease of operating equipment from the standpoint of the 
lessee. It shows how to identify whether it is better for a company to lease or buy operating equipment. 
Note the treatment of depreciation, the firm’s cost of capital or discount rate, the lessor’s rental rate, and 
taxes. As the owner of the asset leased, the lessor gets a tax shield for the asset’s depreciation. The lessee 
can claim the lease payments as an operating expense. The benefits generated by the equipment and such 
expenses as maintenance, repair, and insurance are assumed to be the same regardless of whether the 
equipment is leased or purchased.  

Example 1: Suppose we want to buy a server and its cost is ` 1, 75,000/- and lease payments are 
`  45,000/- with annual rate 8% 

 

Fig 3.4.1: Leasing Example 
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Fig 3.4.2: Leasing Example – Formula mode 

Example 2: 

A company is considering to acquire an additional machinery It has 2 options: 

Option 1:    To purchase machinery for Rs 2200000 

Option 2: To lease the machinery for 3 years for `  725000 as annual lease. The agreement also requires 
an additional payment Rs 600000 at the end of 3rd year 

Annual Operating Costs (excluding depreciation /lease rent of machinery) are estimated at `  900000 with 
an additional cost `  100000 for training cost at the beginning of the year. These costs are to be borne by 
lessee. The Company will borrow at 16% interest to finance the acquisition. The Machinery under review 
will be worth Rs 10 lacs at the end of 3 years. Repayments are to be made as follows: 

 

Year end Principal Interest 

1 5,00,000 3,52,000 

2 8,50,000 2,72,000 

3 8,50,000 1,36,000 

The Company uses SLM to depreciate the assets & pays tax @ 50%. 

Which alternative is better? 

For solving this example we shall create two tables. One table will be used to evaluate NPV under the 
leasing option and second table will be used to evaluate NPV under the Purchase option. 

To recreate these tables use the formula as displayed in Table with Show formula mode enabled as shown 
in Fig 3.4.3. 
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Fig 3.4.3: Leasing Example 2: Evaluating Leasing Option 

 

Fig 3.4.4: Leasing Example 2: Evaluating Leasing Option (Formula-Mode) 

 

Fig 3.4.5: Leasing Example 2: Evaluating Purchase Option 
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Fig 3.4.6: Leasing Example 2: Evaluating Purchase Option (Formula-Mode) 

Under the leasing option we have made sure that tax has been considered and subtracted from the cash 
outflows. Then we apply the PV factor of 8% (16% x 50% tax rate) to the net cashflow. 

Under the purchase option we have subtracted tax component from the interest to ensure that we account 
for the tax benefit on the same. Also we subtract depreciation of 2,00,000/- 

(Cost – Salvage value)/Life  = [( 22,00,000 – 10,00,000 ) / 3] * 50% tax rate 

From above figures it is evident that NPV under the purchase option is lower than NPV under lease, thus 
purchasing the machinery is a better choice. 

3.5 Financial Shenanigans  
Financial shenanigans are actions or omissions (tricks) intended to hide or distort the real financial 
performance or financial condition of an entity. They range from minor deceptions to more serious 
misapplications of accounting principles.  

Let us see one of the most famous (for all the wrong reasons) case of financial fraud and how it could have 
been detected by a simple analysis of Ratios and Charts  

3.5.1 Enron case  

The table shows Enron sales figures for five years in a row. We shall first calculate the GP and NP ratio 
and then create a chart based on the same to compare their growth trend as shown given figures 4.5.1.  
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Fig 3.5.1: Enron Annual Comparative 

 

Fig 3.5.2 Enron Annual Comparative – Show formula mode 

3.5.2 Chart preparation Steps: 

(Note: Certain formatting options shown below are more or less same for all the charts) 

1. Select Range A2:F2 

 

Fig 3.5.3: Select range 

2. Go to Insert Tab > Charts Section > Line Chart > 2D Line Chart > First option 
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Fig 3.5.4: Chart selection 

3. We get a chart which looks like the following image, click on this chart to enable Contextual Chart 
Tools. This will show three tabs: Design, Layout and Format tab  

 

Fig 3.5.5: Chart image 

4. Goto Design Tab > Select Data button 

 

Fig 4.5.6: Select Data Button 
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5. We shall get the following window, click on Edit Button of Horizontal Axis labels 

 

Fig 3.5.7: Click on Edit Button 

 

Fig 3.5.8: Select Data Source 

6. We get “Axis Label Range” Selection Window. Select Range B1:F1. Click OK. X – Axis will now have 
years instead of numbers 1 to 5.  

7. Left click on Chart Title and Type “Enron Growth”. The type value appears in the formula bar. After 
typing, press Enter to save the chart title.  

8. Goto Layout tab > Data labels > Above  
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Fig 3.5.9: Go to Layout Tab 

9. Goto Layout tab > Gridlines > Primary horizontal gridlines > None 

 

Fig 3.5.10: Select None 

10. Goto Layout tab > Legend > Show Legend at bottom. This will shift the chart index and place it below 
the chart. 
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Fig 3.5.11: Select Legend 

11. Left click on the plotted sales line such that the data points get selected. 

 

Fig 3.5.12: Data Point 

3.5.3 Data points 

12. Goto Layout Tab > Current Selection Section > Format Selection Button 



Main source : ICAI

 downloaded from : taxupindia.com

 ADVANCED MS-EXCEL 

64  ADVANCED INFORMATION TECHNOLOGY 

 

Fig 3.5.13: Format Selection 

13. We get a Format Data Series window. Select Marker Options. Under Marker Type, Select Built-in 
option. Then Close the window.  

 

Fig 3.5.14: Select Built-in 

14. On the design tab we have various chart styles. We can select any one from the given options or 
create a custom style.  

 

Fig 3.5.15: Select Design tab 

15. As a result of the above settings we get the following chart. The following chart clearly shows the 
sudden increase in the revenues. The sudden increase shown in the chart itself is a sufficient sign to 
alert any person who is analyzing the revenues of the company.  
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Fig 3.5.16: Enron Growth Chart 

Chart preparation Steps: 

1. Select Range A4:F4, then keeping the Ctrl key pressed, select Range A6:F6 Thus we have selected 
two non-continuous ranges.  

 

Fig 3.5.17: Select two non-continuous ranges 

2. Goto Insert Tab > Charts Section > Line Chart > 2D Line Chart > First option 
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Fig 3.5.18: Select 2D Line Chart 

3. As explained in the previous chart  

(a) Enable Data labels.  

(b) Change Legend position  

(c) Add Data Markers.  

4. As a result of the above formatting we shall get the following chart.  

 

Fig 3.5.19: Profit Ratio trend 

From both the charts it is very evident with some basic charts, trend analysis and due diligence it was very 
much possible to understand that there was something really wrong with the company’s financial data. It 
wouldn’t be very difficult for a learned investor and a good auditor to recognize the anomalies in data. 
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3.6 Equity Research 

3.6.1 What is Equity Research  

Equity research is a study of equities or stocks for the purpose of investments. Equities or common stock 
comprises a big chunk in any company’s capital and shareholders need to know whether to stay invested in 
the company or sale the shares and come out. As an individual, it is time consuming to do equity research 
– that is to study the company, its financial statements, products, management and take a decision about 
investment. Thus there are people working in research companies whose job is to do equity research and 
recommend companies for investment.  

3.6.2 Valuation Methods  

Valuation models use time value of money principles or simpler market principles to value assets, stock and 
shares or the perceived value of future benefits. Valuation by different methods does not necessarily 
produce the same answers and the market employs a wide variety of methods. The purpose of this chapter 
is to set out some of the basic mathematics for valuation.  

Companies can be valued from several different angles: for example a liquidation value can be very 
different from a going concern. Alternatively, a stream of dividends is very different from cash flow although 
a long-term investor may view a company purely for its income potential. Similarly it depends on whether 
you are buying or selling. Since a flow of future benefits represents a forecast, the financial model has to 
show all the inputs to enable risk analysis of the key variables. The valuation is very likely a range rather 
than a single point which should be compared by method and with other companies within a peer group.  

Methods fall into these main categories:  

 Asset and adjusted asset valuations;  

 Dividend models;  

 Market methods;  

 Free cash valuation.  

3.6.3 Market methods  

Stock market and earnings methods using share prices, earnings per share and price / earnings per share 
(P/E) are traditional ways of forming benchmarks or comparisons. The mathematics are very simple and 
spreadsheets are not really required, although the benchmark is often needed for comparison and price 
ranges. Whilst the pricing reflects market sentiment about particular stocks which can rise on takeover 
speculation or fall during a crash, it does represent a fair price between a willing buyer and seller. The 
basic calculation is:  

Market value = no of shares * share price  
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The model needs:  

 Earnings after tax and interest (NPAT)  

 Number of shares  

 Calculate earnings per share (EPS)  

 Price earnings per share (P/E) ratio  

 Current market price of share / EPS  

The valuation can be derived from either: 

 P/E * earnings per share = share price  

 Share price * no of shares = market value  

The net income and number of shares is on the Data sheet and from this the earnings per share can be 
calculated as approximately 0.07. The current share price is 5.0 so the price / earnings per share ratio is 
71.43. 

The valuation is therefore P/E * Net earnings: 71.43 * 3.50 = 250. 

The data table in Figure 14.3 shows the sensitivity to the P/E ratio. This is a high figure and there are 
perhaps some problems relating to the variables used. The formula is: 

Value of equity = sustainable earnings * approx P/E ratio + value of non-operating assets 

3.6.4 Dividend Growth model  

Suppose Big D, Inc. just paid a dividend of ` 30. It is expected to increase its dividend by 2% per year. If 
the market requires a return of 15% on assets of this risk, how much should the stock be selling for?  

 D (1� g)  D 

P  � 

0  

� 

1 

   

0 

R - g 

 

R - g   

P0 = D0(1+g)/(R-g) 

P0 = 30 * (1+.02) / (.15 - .02) = Rs 235. 2 
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Fig 3.6.1: Dividend Growth Model Example 

Suppose ABC Ltd. is expected to pay a ` 120 dividend in one year. If the dividend is expected to grow at 
5% per year and the required return is 20%, what is the price? 

P0 = D1/(R-g) 

P0 = 120 / (.2 - .05) = `  800/- 

 

Fig 3.6.2: Dividend Growth Model Example 

3.6.5 Stock Price Sensitivity Analysis – growth percentage  

We shall perform a sensitivity analysis to see how the change in growth percentage affects Market price of 
shares.  

In this example we have Expected dividend as `  2; Required Rate as 20%  

Using the formula learnt above we shall create a table by entering formula in Cell B6  

After entering the formula double click on the fill handle in Cell B6 so the entire column will be filled with 
stock price for the respective growth percentage in the table.  
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Fig 3.6.3: Growth Percentage 

Chart preparation Steps: 

1. Select Range A5:B25.  

2. Goto Insert Tab > Charts Section > Scatter Chart > Select the chart as show below.  

 

Fig 3.6.4: Select Scatter Chart 

3. Format the chart as explained in previous example. 
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Fig 3.6.5: Stock price sensitivity to dividend growth 

This chart clearly displays how the price increase with growth in dividend. 

3.6.6 Stock Price Sensitivity Analysis – expected return  

We shall perform a sensitivity analysis to see how the change in expected return affects Market price of 
shares.  

In this example we have Expected dividend as `  2; growth rate is 5%  

Using the formula learnt above we shall create a table by entering formula in Cell B6  

After entering the formula double click on the fill handle in Cell B6 so the entire column will be filled with 
stock price for the respective growth percentage in the table.  

 

Fig 3.6.6: Current Stock Price 
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Chart preparation Steps: 

1. Select Range A5:B25.  

2. Goto Insert Tab > Charts Section > Scatter Chart > Select the chart as show below.  

 

Fig 3.6.7: Scatter Chart 

3. Select the numbers on X axis and double click on them. This will open a Format Axis window.  

 

Fig 3.6.8: Select Numbers on X-axis 

4. On the Format Axis window, change the following setting to 0.05 (5%) since our required rate starts 
at 5.5% we don’t want value 0 on X axis. After making this change close the window  
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Fig 3.6.9: Format Axis 

5. Change the title of the chart to your preference.  

6. Depending on the formatting options used you shall get a chart similar to the following image.  

 

Fig 3.6.10: Stock price sensitivity to expected return rate 

This chart clearly depicts how the price falls with every increase in the Expected rate of return. 
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3.7  Summary  
Excel is an invaluable tool for data analysis. In this chapter, we learnt how to apply simple formula and 
functions that allow us to analyze financial data. We learnt to create and format charts. Charts are one of 
the most important visual analysis tools available in excel. We learnt how to use Du-pont analysis in excel 
by proper data structuring and simple functions. We also learnt decision making like whether it was feasible 
to Lease a machinery or should it be purchased. In addition, we also learnt how to use charts to analyze 
trends and recognize the possibility of a fraud.  
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MATHEMATICAL AND STATISTICAL 
TOOLS FOR FINANCIAL ANALYSIS 

 

 
 

4.1 Introduction  
This chapter focuses on the statistical features of Excel application. The primary goal of this chapter is not to 
impart knowledge of statistics as a subject, thus basic knowledge of statistics is presumed.  

A “Statistic” can be a numerical fact, like Google has a 5% return last month or a test average in a class was 79 
points.  

Statistics as a discipline = It is an art and science of collecting, presenting and interpreting data.  

It’s an Art because the presentation of your analysis matters a lot.  

It’s a science because we must use the scientific methods of experiment and probability.  

Data means chunks of some values. It can be any value first name, last name, month names etc. Information is 
data represented in a useful way.  

Interpretation of data means that we make useful information from data, using statistics or any tool, so that we 
can take decisions. Since future is always uncertain we try to use statistics on the past data in an attempt to 
predict the future and take decisions important decisions.  

4.2 Enable Data Analysis Toolpak  
 
Go to File menu – Options – Add-ins Section as shown in Fig 4.2.1 

 

LEARNING OBJECTIVES 

 To learn statistical features of excel  

 To learn Testing of hypothesis  

 To learn confidence interval  

 To learn level of confidence and level of significance  

 To learn ANOVA  

 To learn Regression Analysis  

CHAPTER 

4 
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Fig. 4.2.1: Excel Options 

Enable Analysis ToolPack and click OK. A button called Data Analysis shall be added to Data tab – Analysis 
section as shown in Fig 4.2.2 

 
 

Fig. 4.2.2: Add-Ins 
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4.3 Basic Statistical Functions  
 
Arithmetic Mean: A typical value that represents all the data points. To get this value we just add up all the 
numbers and divide by the count.  

Let us take an example of marks of 40 students. We shall calculate the mean value of those marks using 
AVERAGE function as shown in Fig 4.3.1. 

 

Fig. 4.3.1: Arithmetic Mean 

Median: When a data set has high fluctuations or extremes in its values we cannot take the arithmetic mean as 
a representative of the entire population. This is because the extreme values in the data set will drag the 
arithmetic mean too high or too low. Thus in such a scenario we use median which is the middle value in a 
given data set. 

Let us take an example of salaries. We have a data of salaries of 20 individuals, we shall calculate their median 
as well as mean as shown in Fig 4.3.2 

 

Fig. 4.3.2: Arithmetic Median 
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Mode: Mode is the value with the highest recurrence in a given dataset as shown in Fig 4.3.3 

Let us again take example of test scores and find Mode using MODE.SNGL function 

 

Fig. 4.3.3: Mode 

4.4 Testing of Hypothesis  
Hypothesis is a statement about a population parameter subject to verification. Example:  

Suppose a report says that monthly salary of CAs in industry is ` 60,000/-  

Now we may or may not agree with the above report. We may even try testing the authenticity of the claim by 
carrying out such an analysis in our region. This test that we conduct would be known as hypothesis testing.  

4.4.1 Hypothesis, Tests and Errors  

Hypothesis testing is a statistical procedure that uses sample evidence and probability theory to determine 
whether a statement about the value of a population parameter:  

 Should be rejected  
 Should NOT be rejected  

After the testing we shall make a concluding statement about the population parameter based on sample 
evidence. 

Continuing the above example of CAs in industry, we actually try testing the report in our region and according 
to our test the average monthly salary turns out to be ` 63,500/-. We cannot immediately conclude that the 
original report was wrong or that our report is correct because our report is based on a sample that is different 
than the sample tested by the original report. Thus we need to first find out the difference between our result 
and the original result. 

The difference is ` 3,500 (` 63,500 – ` 60,000). This difference is known as Standard Error. We have to 
decide if this standard error is “statistically significant” or “statistically insignificant”. Thus what we have to 
follow a scientific procedure to reach a conclusion as to whether the result of our test is significant enough to 
override the original test. 

 



Main source : ICAI

 downloaded from : taxupindia.com

 MATHEMATICAL AND STATISTICAL TOOLS FOR  FINANCIAL ANALYSIS   

 ADVANCED INFORMATION TECHNOLOGY 79 

 

A hypothesis is a guess about the way the world works. It’s a tentative explanation of some process, whether 
that process is natural or artificial. Before studying and measuring the individuals in a sample, a researcher 
formulates hypotheses that predict what the data should look like. Generally, one hypothesis predicts that the 
data won’t show anything new or interesting. Dubbed the null hypothesis (abbreviated H0), this hypothesis 
holds that if the data deviate from the norm in any way, that deviation is due strictly to chance. Another 
hypothesis, the alternative hypothesis (abbreviated H1), explains things differently. According to the alternative 
hypothesis, the data shows something important. 

After gathering the data, it’s up to the researcher to make a decision. The way the logic works, the decision 
centers around the null hypothesis. The researcher must decide to either reject the null hypothesis or not to 
reject the null hypothesis. Hypothesis testing is the process of formulating hypotheses, gathering data, and 
deciding whether to reject or not reject the null hypothesis. 

Regardless of the reject-don’t-reject decision, an error is possible. One type of error occurs when you believe 
that the data show something important and you reject H0, and in reality the data are due just to chance. This is 
called a Type I error. 

The other type of error occurs when you don’t reject H0 and the data are really due to something out of the 
ordinary. For one reason or another, you happened to miss it. This is called a Type II error as show in Fig 4.4.1 

 

Fig. 4.4.1: Type II error 

4.4.2 Case Study 

Now that we have a basic understanding of hypothesis testing we shall take up the example of CAs in industry 
as shown in Fig 4.4.2 

 

Fig. 4.4.2: Basic understanding of Hypothesis testing 

Before we reach to any conclusions we have to check whether difference of 3,500 is statistically significant. 
Thus we perform a hypothesis test and decide our Null and Alternate Hypothesis statement. We select a value 
of α that shall be acceptable to us. 
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Fig. 4.4.3: Hypothesis testing step-1 and step-2 

Now we shall calculate X bar, Standard Error and Z value. 

We have the sample salaries in range A4:A39 

 

Fig. 4.4.4: Hypothesis testing Step-3 

We shall calculate the p-value and the critical value of the one talied test. This will help us to decide whether we 
have to reject or NOT reject to Null hypothesis. 

 

Fig. 4.4.5: Hypothesis testing Step-4 

Finally, we come to the conclusion that 

 

Fig. 4.4.6: Hypothesis testing Step-5 
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4.5 Confidence Interval  
The Confidence Interval of a Mean is an interval in which the true population mean probably lies based upon a 
much smaller random sample taken from that population. A 95% Confidence Interval of a Mean is the interval 
that has a 95% chance of containing the true population mean.  

The width of a Confidence Interval is affected by the sample size. The larger the sample size, the more 
accurate and tighter is the estimate of the true population mean. The larger the sample size, the smaller will be 
the Confidence Interval. Samples taken must be random and also be representative of the population.  

4.5.1 Level of Confidence and Significance  

Level of Significance: α ("alpha"), equals the maximum allowed percent of error. If the maximum allowed error 
is 5%, then α = 0.05.  

Level of Confidence: It is the desired degree of certainty. A 95% Confidence Level is the most common. A 
95% Confidence Level would correspond to a 95% Confidence Interval of the Mean. This would state that the 
actual population mean has a 95% probability of lying within the calculated interval. A 95% Confidence Level 
corresponds to a 5% Level of Significance, α = 0.05. The Confidence Level therefore equals 1 – α  

Standard Error: It is an estimate of population Standard Deviation from data taken from a sample. If the 
population Standard Deviation (σ), is known, then the Sample Standard Error, Sxavg, can be calculated. If only 
the Sample Standard Deviation (s) , is known, then Sample Standard Error, Sxavg, can be estimated by 
substituting Sample Standard Deviation ( s ), for Population Standard Deviation ( σ ) , as follows:  

Sample Standard Error = Sxavg = σ / SQRT(n) = s / SQRT(n) 

σ = Population Standard deviation s = Sample standard deviation 

n = sample size 

4.5.2 Region of Certainty vs Region of Uncertainty  

Region of Certainty is the area under the Normal curve that corresponds to the required Level of Confidence. If 
a 95% percent Level of Confidence is required, then the Region of Certainty will contain 95% of the area under 
the Normal curve. The outer boundaries of the Region of Certainty will be the outer boundaries of the 
Confidence Interval.  

Region of Uncertainty is the area under the Normal curve that is outside of the Region of Certainty. Half of the 
Region of Uncertainty will exist in the right outer tail of the Normal curve and the other half in the left outer tail.  

4.5.3 Case Study 

Calculate a Confidence Interval from a Random Sample of Test Scores 

Given the following set of 32 random test scores taken from a much larger population, calculate with 95% 
certainty an interval in which the population mean test score must fall. In other words, calculate the 95% 
Confidence Interval for the population test score mean. The random sample of 32 tests scores is shown next. 
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Fig. 4.5.1: Random sample 

We shall use the following functions to get confidence interval boundaries: 

COUNT, AVERAGE, STDEV.S, SQRT, NORM.S.INV, CONFIDENCE 

 

Fig. 4.5.2: Calculation 

4.6 Analysis of Variance (ANOVA) 

4.6.1 Introduction  

ANOVA, Analysis of Variance, is a test to determine if three or more different methods or treatments have the 
same effect on a population. For example, ANOVA testing might be used to determine if three different teaching 
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methods produce the same test scores with a group of students. The measured output must be some type of 
group average such as average test score per group or average sales per group. ANOVA testing might also be 
used to determine if different combinations of product pricing and promotion have different effects in different 
markets.  

4.6.2 ANOVA Tests the Null Hypothesis  

The basic test of ANOVA is the Null Hypothesis that the different methods had no effect on the outcome that is 
being measured. Using the teaching method example, the Null Hypothesis in this case would be that the 
different teaching methods had no effect on the average test scores of student groups to which different 
treatments (teaching methods) were applied.  

4.6.3 Single Factor ANOVA  

Single Factor ANOVA tests the effect of just one factor, in this case, the teaching method, on the measured 
outputs. The measured outputs are the mean test scores for the groups that had the different teaching methods 
applied to them. The Null Hypothesis for this one factor states that varying that factor has no effect on the 
outcome.  

We have units of products sold by three different groups of salesman throughout ten days. The observations of 
the groups are as follows as shown Fig 4.6.1 

 

Fig. 4.6.1: One way ANOVA 
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 Go to Data tab and click on Data Analysis as shown in Fig 4.6.2 

 

Fig. 4.6.2: Data Analysis 

 From the window that appears next click on Anova: Single factor  

 

Fig. 4.6.3: Anova single factor 

 Select Input Range: =$C$3:$E$13  
 Grouped By: “Columns”  
 Enable “Labels in first row”  
 Set Alpha at 0.05  
 Select Output Range: =$G$1; Click OK.  

 

Fig. 4.6.4: Anova: Single Factor 
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Fig. 4.6.5: Output 

H0 = µa = µb = µc 

Ha = At least one inequality. 

Since p – value is greater than α we do not reject H0 

Also, f value is far less than the f critical hence we are far away from the Rejection Region on f distribution 
diagram. 

4.7 Prediction using Regression  
Multiple Regression is a statistical tool used to create predictive models. The Regression Equation - the end 
result of the Regression – predicts the value of an output variable (the dependent variable) based upon the 
values of one or more input variables (the independent variables). If there are more than one independent 
variable, the Regression is classified as Multiple Regression. To begin the Regression procedure, you need 
completed sets of independent variables and their resulting outputs, the dependent variables.  

To begin the Regression procedure, you need completed sets of independent variables and their resulting 

Count of nos. 
in group 

Sum of 
observations Average of 

observations 

Variance of 
observations 

Average of 
observations 

MS = SS/df

F = MS between 
groups / MS within 
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outputs, the dependent variables. Below is an example of the data needed to calculate a Regression equation 
as shown in Fig 4.7.1.  

 

Fig. 4.7.1: Calculate Regression equation 

4.7.1 Regression Equation  

Regression Analysis will be run on the above data. The output of the Regression Analysis below is called the 
Regression Equation:  

y = B0 + (B1 * x1) + (B2 * x2) + (B3 * x3) + (B4 * x4) 

B0, B1, B2, B3 and B4 are Coefficients of the Regression Equation. This Regression Equation allows you to 
predict a new output (the dependent variable y) based upon a new set of inputs (the independent variables x1, 
x2, x3, and x4).  

4.7.2 Case Study 

Below are the monthly rates of return of 4 stocks: (Google, Yahoo, MS, and Apple) and the Tech Index. Create 
a Regression Equation that will predict the Tech Index return for a given month if a different set of rates of 
return for each company's stock are input as shown in Fig 4.7.2. 

 

Fig. 4.7.2: Case study 

The next step in the Regression process is to run a correlation analysis on all variables simultaneously. We 
only want to input variables in the regression equation that are good predictors of the independent variable. We 
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will examine the correlation between the dependent variable (the output that we are trying to predict) and each 
of the possible inputs (the independent variables). Correlation between two variables can take a value from 
anywhere between -1 and +1. The closer the correlation is to 0, the less correlated the two variables are and 
the less explaining power the independent variable has for the dependent variable. We want to remove any 
possible inputs from the regression equation if they have a low correlation with the output. 

 Go to Data tab and click on Data Analysis  

 

Fig. 4.7.3: Go to Data Tab 

 From the window that appears next click on Correlation as shown in Fig 4.7.4 

 

Fig. 4.7.4: Data Analysis 

 Select Input Range: =$B$13:$F$19  
 Grouped By: “Columns”  
 Enable “Labels in first row”  
 Select Output Range: =$A$22; Click OK.  

 

Fig. 4.7.5: Correlation 
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We shall get the following output. As marked in the output, Apple and Yahoo have low correlations with the 
Tech Index and therefore are not good predictors of the Tech Index. They should be removed. 

Also, if two of the independent variables above are highly correlated with each other, only one of them should 
be used in the Multiple Regression below. This is not the case here because none of the variables above have 
a high correlation with another variable. 

Using highly correlated variables as inputs to a Multiple Regression causes an error called Multicollinearity and 
should be avoided as shown in Fig 4.7.6 

 

Fig. 4.7.6: Multiple Regression 

 After removing the two columns of Yahoo and Apple. We have the new data as follows.  

 

Fig. 4.7.7: New data 

 Now we shall execute regression analysis. In the data analysis window select regression as shown in Fig 
4.7.8 

 

Fig. 4.7.8 Select Regression 
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 On the window that appears next configure the following  

 Input Y Range: $B$31:$B$37  

 Input X Range: $C$31:$D$37  

 Enable Labels.  

 Set Confidence Level at 95%  

 Set output range as $A$40  

 Enable Residuals  

 Click Ok  

 

Fig. 4.7.9: Output Regression 

As a part of our regression analysis we get the following output. 

 Regression statistics and ANOVA  
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Fig. 4.7.10: Regression and ANOVA 

 Standard Errors and P-values  

 

Fig. 4.7.11(A): Standard Errors and P-values 

 

Fig. 4.7.11(B): Output 

 Residual Output  

 

Fig. 4.7.12: Residual Output 
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Let’s take a look at the meaning of the output derived. 

 First and foremost we check the overall accuracy of the regression which is determined by R-square and 
adjusted R-square.  

R-square is 90% which means that 90% of the variance of the output variable can be explained by the variance 
of input variable. Adjusted R-square is more conservative and more accurate.  

 Secondly, we check the probability that the regression output was not obtained by chance (co-incidence)  

This can be determined by significance of F for the regression which in our case is 2.8%. Thus there is 2.8% 
chance that our regression output is mere co-incidence.  

 Third, we check the reliability of coefficients and y intercepts. This will be determined by the p-values. 
Smaller p-values means these values are not a result of co-incidence/chance.  

 Lastly, residuals are difference between actual tech index and predictive value of dependent variable. 
Thus the equation we get is: Tech Index = 0.251 + 0.393 * Google + 0.063 * MS  

4.7.3 Using Regression equation to predict an output  

Predict the Tech Index if Google = 7 and MS  = 4.  

Tech Index = (0.251) + (0.393)*(Google) + (0.063)*(MS)  

Tech Index predicted = (0.251) + (0.393)*(7) + (0.063)*(4)  = 3.25  

4.7.4 The Confidence Interval of the Output Variable 

The Confidence Interval was set at 95%. This is the default setting. 

It could have been set to any desired confidence level. 

The 95% Confidence Interval is interval in which the output variable, Tech Index, should fall with 95% certainty. 

The 95% Confidence Interval = Tech Index predicted +/-  Z Score95% * (Standard Error) 

Z score Calculation 

Level of Confidence = 95% = 1 – α;  Level of Significance = α = 0.05 

Z Score 95% = Z Scoreα=0.05 = NORMSINV (0.975) = 1.96 

The cell containing the Overall Standard Error for the Regression Equation = 1.33 

The 95% Confidence Interval = 3.25 +/-  (1.96) * (1.33) = 0.64 to 5.86 

This means that there is a 95% chance the actual Tech Index return will fall within 0.64 and 5.86 for inputs 
Google = 7 and MS = 4. 
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4.8 Summary  
In this chapter we have glanced through some of the statistical features of excel. We have learn how to 
calculate and interpret ANOVA. We have learnt how to identify our Null and Alternate hypothesis.  

We have also learnt how to calculate basic statistical values like mean, median and mode. We have seen how 
to get a regression equation using regression analysis tools. Based on the derived equation we have learnt to 
predict an output. We have also learnt how to calculate the confidence interval of the output variable. Thus in 
this chapter we have touched upon various aspects of statistics as a subject and a few of its use cases in 
Excel.  
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5.1 Introduction 
Excel is a powerful tool available in the hands of users. Application of excel functions are unlimited. It depends 
on the imagination of the user only, how a function can be used in a particular situation. In this section we are 
going to discuss about some of the functions relating to accounting and finance.  

When excel was not there, still people used to analyze financial data using traditional tools with lot of limitation. 
After the availability of excel in the hands of the user, analysis of huge amount of data is possible at an 
absolutely great speed.  

In this section, we are going to discuss financial functions relating to depreciation calculation, marginal costing, 
cash budgeting, discounting, tax calculations, EMI calculations, capital budgeting, risk analysis and investment, 
financial planning, etc.  

In today’s era of technology, it is directly / indirectly compulsory for an accounting professional to learn these 
financial functions in excel to ensure his/her existence in this competitive world. Knowledge of these 
technological tools gives us an added advantage of handling huge amount of data at a great speed. 

So, let us start understanding one by one some of the useful functions in excel relating to accounting and 
finance.  

5.2 Depreciation Accounting 
 Depreciation stands for reduction in value of fixed assets. Value of fixed assets is generally reduced over the 

period of time due to any of the following reasons.  

(a) Wear & Tear  

(b) Change in taste of people 

(c) Change in technology.  

 

CHAPTER 

5 
LEARNING OBJECTIVES 

 To know about the various tools available in excel regarding costing and finance.  

 To know how to use these tools in practical situations.
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Depreciation is considered as non cash expenditure and occupies a prominent place in Profit & Loss Account. If 
value of fixed asset is high, then depreciation may also be quite substantial figure.  

In excel, there are five different functions for calculation of depreciation. These are as under.  

Sr. 
No. 

Function Use 

1 SLN For calculation of depreciation as per Straight Line Method. 

2 SYD For calculation of depreciation as per Sum of Years’ Digit Method 

3 DB For calculation of depreciation as per Declining BalanceMethod.  

4 DDB For calculation of depreciation as per Double Declining Balance Method 

5 VDB For calculation of depreciation as per Variable Declining Balance Method 

Table 5.2.1: Five different functions for calculation of depreciation 

1. SLN Function:  

SLN function is used for calculation of depreciation figure as per Straight Line Method. In this method, the 
amount of depreciation remains constant over the period of time and it does not change every year. Following 
three inputs are required for calculation.  

(a) Cost – Cost incurred for acquiring fixed asset.  

(b) Salvage Value – The value which can be realized at the end of life of fixed asset by selling it.  

(c) Life – Total life of fixed assets in years as shown in Fig 5.2.1.  

 

Fig.5.2.1: SLN function 

2. SYD Function:  

SYD stands for Sum of Years’ Digits. Sum of the years' digits method of depreciation is one of the accelerated 
depreciation techniques which are based on the assumption that assets are generally more productive when 
they are new and their productivity decreases as they become old as shown in Fig 5.2.2. 
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Formula for calculation of depreciation under SYD is as under  

Depreciation   =  Depreciable Base x 
Remaining Useful Life
Sum of Years’ Digits

  

Depreciable Base  =  Cost less Salvage Value 

Remaining Useful Life = Useful life remaining in the beginning of each year for which depreciation is to be 
calculated. 

Sum of Years’ Digits  =  Total of digits of years.  

E.g. if total life of asset is 10 years, the sum of years digit shall be 10+9+8+7+6+5+4+3+2+1 = 55.  

 

Fig.5.2.2: SYD function 

3. DB Function: 

DB stands for declining balance. This method uses a fixed rate to calculate depreciation. Rate is calculated 
using the formula as under.  

Rate  =  1 – ((Salvage Value / Cost) ^ (1 / Life)) 

Depreciation  =  (Cost – Previous Depreciation) x rate  

Amount of depreciation will keep on decreasing every year. The total amount of depreciation amount for all the 
years shall be equal to the cost less salvage value as shown in Fig 5.2.3.  
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Fig.5.2.3: DB function 

4. DDB Function:  

When calculating the depreciation of an asset, it is common to use an accelerated depreciation calculation, in 
which the calculated value of an asset is reduced by a larger amount during the first period of its lifetime, and 
smaller amounts during subsequent periods. 

One of the most popular accelerated depreciation methods is the Double Declining-Balance Method, in which 
the straight-line depreciation rate is doubled. 

The Excel DDB function uses the following equation to calculate the depreciation 

 

Fig.5.2.4: DDB function 

Following variables shall be used in the calculation of depreciation using DDB function.  

Cost – Initial cost of the asset 
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Salvage – Value of asset at the end of the life of asset 

Life – The total number of periods over which the asset is being depreciated. It is sometimes called as the 
useful life of the asset.  

Period – The period for which you want to calculate depreciation. Period must use the same units as life. E.g. 
Depreciation for 2nd Year, 3rd Year, etc.  

Factor – The rate at which balance declines. If omitted, it is assumed as 2.  

5. VDB Function: 

VDB stands for variable declining balance. The VDB function uses the DDB (Double Declining Balance) method 
by default. The VDB function performs the same calculations as the DDB function. However, it switches to 
Straight Line calculation to make sure you reach the salvage value. It only switches to Straight Line calculation 
when Depreciation Value as per Straight Line Method is higher than Depreciation Value as per DDB method. 

There are two additional arguments in VDB function.  

Start_period – It is starting period for which you want to calculate depreciation.  

End_period – It is the ending period for which you want to calculate depreciation.  

VDB function is much more versatile than the DDB function. It can calculate the depreciation value of multiple 
periods as shown in Fig 5.2.5. 

 

Fig 5.2.5: VDB function 

Example : Let us try to find out the depreciation calculation using all the five methods discussed above.  

Cost  : 1,00,000 

Salvage :   10,000 

Life  :      10 
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Period SLN SYD DB DDB VDB 
1 9,000.00 16,363.64 20,600.00 20,000.00 20,000.00 
2 9,000.00 14,727.27 16,356.40 16,000.00 16,000.00 
3 9,000.00 13,090.91 12,986.98 12,800.00 12,800.00 
4 9,000.00 11,454.55 10,311.66 10,240.00 10,240.00 
5 9,000.00 9,818.18 8,187.46 8,192.00 8,192.00 
6 9,000.00 8,181.82 6,500.84 6,553.60 6,553.60 
7 9,000.00 6,545.45 5,161.67 5,242.88 5,242.88 
8 9,000.00 4,909.09 4,098.37 4,194.30 4,194.30 
9 9,000.00 3,272.73 3,254.10 3,355.44 3,388.61 

10 9,000.00 1,636.36 2,583.76 2,684.35 3,388.61 
Total  90,000.00 90,000.00 90,041.25 89,262.58 90,000.00 

5.3 Marginal Costing  
In economics and finance, marginal cost stands for change in the total cost that arises when the quantity 
produced has an increment by unit. That is, it is the cost of producing one more unit of a good.It is computed in 
situations where the breakeven point has been reached: the fixed costs have already been absorbed by the 
already produced items and only the direct (variable) costs have to be accounted for. 

Marginal costs are variable costs consisting of labor and material costs, plus an estimated portion of fixed costs 
(such as administration overheads and selling expenses). In companies where average costs are fairly 
constant, marginal cost is usually equal to average cost. However, in industries that require heavy capital 
investment (automobile plants, airlines, mines) and have high average costs, it is comparatively very low. The 
concept of marginal cost is critically important in resource allocation because, for optimum results, management 
must concentrate its resources where the excess of marginal revenue over the marginal cost is highest. It is 
also called choice cost, differential cost, or incremental cost. 

Marginal costing is the system of calculating marginal costs for the purpose of financial and business decisions. 
Various concepts and tools are used for calculating marginal costs for the purpose of business decision 
making.  

Marginal costing mainly uses terms as under. Understanding of these terms is necessary before we proceed to 
discuss marginal costing in Excel. 

5.3.1 Marginal Costing Equations 

Following equations are used in Marginal Costing.  

(a) Profit  =  Sales – Total Cost 

(b) Total Cost = Fixed Cost + Variable Cost 

(c) Contribution = Sales – Variable Cost  
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The whole idea of marginal costing revolves around a simple equation as under.  

Fixed Cost + Profit = Sales – Variable Cost 

(a) Fixed Costs: As the name suggest, these cost remain fixed irrespective of level of production. Fixed cost 
need to be incurred even if there is no production. Examples of fixed cost can be Salary of administrative staff, 
office rent, audit fees, etc.  

 Fixed Cost = Sales – Variable Cost – Profit 

 Fixed Cost = (Sales x PV Ratio) – Profit 

(b) Variable Costs: As the name suggest, these cost vary according the volume of production. Total 
variable cost changes after every unit of production. But variable cost per unit remain the same. All direct costs 
are variable costs. E.g. raw material cost, commission to salesman, etc. are variable cost.  

 Variable Cost = Sales – Fixed Cost – Profit  

 Variable Cost = Sales x Variable Cost Ratio 

 (Variable Cost Ratio = 1 – PV Ratio) 

(c) Sales: This is the amount generated from selling of products. Total sales can be obtained by multiplying 
selling price per unit with number of products sold.  

(d) Contribution: It is the difference between sales and variable cost. As the sales and variable cost can be 
calculated for each unit, it also possible to calculate contribution per unit using the simple formula as under.  

 Contribution per unit  = Selling Price per Unit - Variable Cost per Unit  

Or 

 Contribution per unit  = 
Total Sales Value – Total Variable Cost

No. of units sold
  

(e) PV Ratio: Profit Volume Ratio expresses mathematical relationship between two variables, i.e. Profit and 
Volume of sales. It can be calculated by using any formula as stated below.  

 PV Ratio = (Contribution / Sales) x 100 

 PV Ratio = [(Sales – Variable Cost) / Sales] x 100 

 PV Ratio = 1 – Variable Cost Ratio 

 PV Ratio = (Change in Profit / Change in Sales) x 100 

(f) BEP: Break Even Point is the point of no profit or no loss. It may be expressed in terms of sales value or 
sales unit. It can be calculated as under.  

 BEP (Value) = 
Fixed Cost
PV Ratio

 

 BEP (Units) = 
Fixed Cost

Contribution per Unit
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(g) Margin of Safety: It is the value of sales above the BEP point. It denotes how much safe we are about 
not incurring losses. If BEP sales is ` 100 and total sales is ` 140, then margin of safety is calculated as 40, 
i.e. 140 -100 using the formula as under.  

 Margin of Safety = Total Sales – BEP Sales  

5.3.2 BEP Calculation  

Excel can be conveniently used for preparation of chart showing Break Even Point. BEP level can also be 
calculated without using excel. But it is very easy to change the variables like selling price, variable cost and 
fixed cost to see the change in BEP level.  

Problem 1: 

Prepare a chart showing BEP when Selling Price is of a ` 600, Variable Cost is ` 250 and Fixed Cost is 
` 4200 as shown in Fig 5.3.1. 

 

Fig 5.3.1: BEP Calculation 
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Pricing Decisions & Discounts: 

Excel can also be used for taking decision on product pricing. When large size data is to be handled excel can 
be really useful in such cases.  

Problem 2: 

SRT Enterprises is into business of selling cricket bats. They have to take a decision about price of the product. 
Before the price is decided, marketing department is being consulted about the sales in quantity that can be 
achieved in the first year. SRT Enterprises wishes to achieve BEP in the first year itself. Consider following 
data.  

 Variable Cost = ` 250,   

 Fixed Cost = 10.00 Lacs. 

 Sales Price Range = ` 300 to ` 1,000  

A chart can be prepared as under to help in decision making as shown in Fig 5.3.2. 

 

Fig 5.3.2: BEP Calculation 

As it is clear from the above table, if selling price is set at ` 1,000, BEP shall be achieved by selling 1,333 units 
while it will take 20,000 units to achieve BEP is product is priced at ` 300.  
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5.3.3 Calculation of Marginal Revenue 

If we wish to calculate marginal revenue that would be generated at different sales levels with different selling 
prices, following formula can be used.  

Change in Sales
Change in Quantities

 

This problem can be solved very easily in excel as given the picture below.  

 

Fig 5.3.3: Calculation of Marginal Revenue 

Excel can be used in variety of ways for marginal costing and for taking business decisions using marginal 
costing. Above examples are just illustrative and not exhaustive.  

5.4 Cash Budgeting  
Budget stands for planning for future. Cash budget is prepared for planning for future as far as movement of 
cash is concerned. Movement of cash includes inflow and outflow of cash. Normally bank transactions are also 
considered in cash budget.  

Cash budget is useful in maintaining the smooth flow of cash in business as well as to ensure liquidity during 
the budget period. Many financial and business decisions are taken on the basis of cash budget, e.g. how much 
credit to be given to customer, how much funding to be taken from outside sources, etc.  

The inputs to the cash budget come from several other budgets. The results of the cash budget are used in the 
financing budget, which itemizes investments, debt, and both interest income and interest expense. The cash 
budget is comprised of two main areas, which are Sources of Cash and Uses of Cash. The Sources of Cash 
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section contains the beginning cash balance, as well as cash receipts from cash sales, accounts receivable 
collections, and the sale of assets. The Uses of Cash section contains all planned cash expenditures, which 
comes from the Direct Materials Budget, Direct Labor Budget, Manufacturing Overhead Budget, and Selling and 
Administrative Expense budget. It may also contain line items for fixed asset purchases and dividends to 
shareholders. 

If there are any unusually large cash balances indicated in the cash budget, these balances are dealt with in the 
financing budget, where suitable investments are indicated for them. Similarly, if there are any negative 
balances in the cash budget, the financing budget indicates the timing and amount of any debt or equity needed 
to offset these balances. 

Cash may be prepared for any period ranging from a daily to yearly.  

A sample cash budget in excel can be prepared as shown in Fig 5.4.1.  

 

Fig 5.4.1: Sample Cash Budget  

Requirements for preparation of cash budget in Excel: 

 Knowledge of accounting 

 Knowledge of formatting an excel sheet 

 Knowledge of cell linking 

 Knowledge of basic formulae 
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Figure under each head of inflow and outflow may be brought from a separate sheet, e.g. Cash Sales may be 
brought from Sales Budget Sheet, Loan Repayment figures may be brought from separate loan repayment 
schedule. These figures should be linked with the cells in other sheet so as to update the data on real time 
basis, automatically.  

5.4.1 Budget & Actual  

Purpose of any budget is not fulfilled till the time budget figures are compared with actuals and a suitable 
corrective action is taken, if required. A budget with actual figures along with variance can be prepared as 
shown in Fig 5.4.2.  

 

Fig 5.4.2: A Budget with actual figures  

5.4.2 Budget Template 

Excel provides a readymade template for preparation of personal monthly budget, which may be used as it or 
along with modifications as required. Follow the steps as given under.  

(a) Open a new or any existing excel file. 



Main source : ICAI

 downloaded from : taxupindia.com

APPLICATION OF MS-EXCEL   

 ADVANCED INFORMATION TECHNOLOGY 105 

 

(b) Right click on any sheet tab. 

(c) Click on “Insert”. 

(d) Click on “Spreadsheet Solutions” tab. 

(e) Double click on Personal Monthly Budget to open it.  

 

Fig 5.4.3: Budget Template 

(f) Following format of budget shall get opened on your screen.  
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Fig 5.4.4: Format of Budget  

5.5 Discounting 
Discounting is the process of determining the present value of a payment or a stream of payments that is to be 
received in the future. Given the time value of money, a rupee is worth more today than it would be worth 
tomorrow given its capacity to earn interest. Discounting is the method used to figure out how much these 
future payments are worth today. 

Discounting is one of the core principals of finance and is the primary factor used in pricing a stream of cash 
flows, such as those found in a traditional bond or annuity. For example, the succession of coupon payments 
found in a regular bond is discounted by a certain interest rate and summed together with the discounted par 
value to determine the bond's current value. 

5.5.1 Discounting Factor 

A discount factor can be thought of as a conversion factor for time value of money calculations. Time value of 
money calculations are based on the principle that funds placed in a secure investment earn interest over time.  

In the past, it was common to refer to a discount factor table to look up the number needed to perform a time 
value of money conversion. With the use of calculators and spreadsheets, the table lookup technique is 
practically obsolete. 
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5.5.2 Using Excel for calculating Discounting Factor 

Discounting factor can be calculated by using a simple formula as under  

Discounting Factor = 1 / (1+r) ^ n 

Where r = rate of interest and n = the year number for which discounting factor is to be calculated.  

Let us consider a case where we wish to calculate the discounting factor for 10 years at interest rate of 11%. 
This can be done very easily in excel as shown in Fig 5.5.1. 

 

Fig 5.5.1: Calculating Discounting Factor 

These discounting factors can be multiplied with cash flow values to get the present value of future cash flows.  

Basically, discounting factors are used to calculate present value of future cash flows. One can get this even 
without calculated discounting factors. Many excel functions like PV, FV, IRR can be used to calculate the 
discounted value of cash flow without using the above mentioned formula. These functions are discussed later 
in other topics.  

5.6 Tax Computations Using Excel 
Excel can be conveniently used for preparation of tax computations. Let us prepare a computation sheet using 
some of the excel features.  

1. File Creation  

Create a new excel file and save it at desired location.  

2. Sheet Formatting  

Format the sheet as per requirement. Type the headings are required. Prepare the computation of income as 
per the required format without using any special excel function or feature. All types of controls and validation 
can be placed later on. A sample computation sheet is given for your reference as shown in Fig 5.6.1. 
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Assessee : Shashank Prakash Deshpande Assessment Year : 2014-15
PAN : AFIPD0679G Previous Year : 2013-14
Date of Birth : 17-03-1978 Status : Individual 

Income From Profession : 
Profit As Per Profit & Loss Account 7,55,542        
Less : Interest on Savings Account 3,994            
Less : Other Interest Income 7,496            
Less : Interest on Fixed Deposits 24,213           
Less : Share of Profit in Partnership Firm 68,055           
Total 6,51,784        6,51,784      

Income From House Property : 
Annual Value (Self Occupied) -                
Less :Deduction for Interest on Housing Loan (50% of 1,24,475) 62,238           (62,238)       

Income From Other Sources : 
Interest on Savings Bank Account 3,994            
Interest on Fixed Deposits 24,213           
Interest other 7,496            35,703         
Gross Total Income 6,25,250      

Less : Deductions Under Chapter VI-A
Principal Repayment on Housing Loan (50% of 140348) 70,174           
Kotak Life Insurance 4,437            
ELSS Mutual Fund 60,000           
Total Investment u/s 80C 1,34,611        
Total Deductions 1,34,611        1,00,000      

Total Income 5,25,250      
Less : Short Term Capital Gain -              
Taxable Income 5,25,250    
Total income rounded off under section 288A 5,25,250      
Tax on Above Income 35,050         
Short Term Capital Gain Tax -              
Total Tax 35,050         
Add: Eduction Cess @ 3% 1,052          
Total Tax Payable 36,102         
Add : Interest -              
Total Tax + Interest Payable 36,102         
Less : Tax Deducted at Source 54,117         
Refund Due (18,016)      

Computation of Income 

Shashank Prakash Deshpande
(Assessee)

 

Fig 5.6.1: Tax Computation using Excel 
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3. Sheet & Cell Protection  

Once the basic format is ready, we can move towards locking the sheet / cells for editing. This will prevent the 
user from changing the sheet formatting, titles and thus disturbing the computation sheet. This can be done as 
shown in Fig 5.6.2 and Fig 5.6.3.  

(a) By default all the cells in any excel sheet are locked. We must unlock the cells which we wish to keep 
open for users for data input. Select such cells and…. 

 Right Click > Format Cells > Protection > Uncheck the “Locked” check box.  

 

Fig 5.6.2: Unlock cell  

 Once this is done, the selected cells shall not be locked and other remaining cells shall be locked. 

(b) Go to Review Tab> Protect Sheet. Type the password. Password is optional.  

 

Fig 5.6.3: Password to Protect Sheet 

This will ensure that the sheet is protected from all unwanted and unauthorized changes by users. The users 
shall be allowed to type or edit the text in selected fields only.  

1. Setting Input Validations 

(a) Date – Only date shall be entered in the filed for date of birth. This can be done by selecting the 
validation criteria as Date. 
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(b) PAN – PAN must have 10 characters only. Further, the first five characters shall be alphabets, next four 
characters shall be numbers and the last, i.e. 10th character shall be an alphabet only. For setting this type of 
validation, PAN has to be written in 10 different cells with 10 different validations.  

(c) Value – Fields meant for typing figures, e.g. income shall allow only figures and not text. This can be 
done by selecting the validation criteria as “Whole number”.  

(d) Status – Status can be selected from the list of drop down option as Individual, Firm, Company, Society, 
etc. This can be done by using the validation criteria as “List”. This  

To set validation rules, go to Data > Validation. Any validation rule can be selected and set as per requirement 
as shown in Fig 5.6.4.  

 

Fig 5.6.4: Data Validation 

2. Tax Calculations 

Method of tax calculations shall change according to status of assess, date of birth, etc. Let us consider a 
practical case as under.  

Income   :  ` 11,62,500 

Status   : Individual (Age Below 60 Years) 

Calculate the tax payable for AY 14-15 

This can be easily done in excel using IF function as shown in Fig 5.6.5.  
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Fig 5.6.5: Tax Calculation 

Explanation to formula used.  

1. For 10% slab – Check if the income is greater than ` 5.00 lacs, if yes, the tax shall be ` 30,000. If no, 
then check if the income is greater than ` 2.00 lacs, if yes then tax shall be 10% of excess of income over ` 
2.00 lacs). If income is even less than ` 2.00 lacs, the tax shall be zero.  

2. For 20% slab – Check if income is greater than ` 10.00 lacs, if yes, then the tax shall be ` 1.00 lacs. If 
no, then check whether income is greater than ` 5.00 lacs, if yes, then tax shall be 20% of excess of income 
above ` 5.00 lacs. If income is not greater than ` 5.00 lacs, then tax shall be zero.  

3. For 30% slab – Check if income is greater than ` 10.00 lacs, if No, tax shall be zero. If yes, tax shall be 
30% of income above ` 10.00 lacs.  

5.7 EMI Calculations Using Excel 
EMI stands for equated monthly installment. This is very often needed in case of taking any type of finance 
decision. May it be lender or borrower, both the parties are always interested in knowing the amount of monthly 
installment that shall be payable. Installments are equated over the period of time for the sake of simplicity. 
There are certain points which need to be understood about EMI.  

 Every installment amount shall include principal amount as well as interest amount.  

 Interest amount shall be highest in the first EMI and lowest in the last EMI. Interest portion shall reduce 
gradually in every next EMI. 

 Principal amount shall be lowest in the first EMI and highest in the last EMI. Principal portion shall 
increase gradually in every next EMI.  
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The biggest challenge in the above calculation is to how to change the proportion of principal and interest in 
every next EMI. This can be easily done using excel.  

Case Study: 

Mr. A want to avail a loan of ` 1.00 lacs. Repayment period is three years and rate of interest is 12% p.a. 
Please let him know what shall be the EMI.  

Solution: 

Equated Monthly Installment can be very easily calculated using PMT function as shown in Fig 5.7.1.  

(a) Type the data in excel as given under.  

 

Fig 5.7.1: Using PMT function 

 

(b) Select the cell where you want the result and click on the function button as shown in Fig 5.7.2 

 

Fig 5.7.2: Select the cell 

Following screen shall appear after clicking on “fx” button as shown in Fig 5.7.3. 
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Fig 5.7.3: Screen of Financial function 

Various types of functions are available in excel. Here the relevant function is “PMT” which stands for payment. 
This function is a part of Financial Functions in excel. Select the category as “Financial” and select “PMT” 
function.  

After selecting “PMT” function, following screen shall appear as shown in Fig 5.7.4.  

 

Fig 5.7.4: Selecting PMT function 

 Rate – It is the rate of interest, to be divided by 12 for getting monthly rate of interest. 

 Nper – It is total number of periods, i.e. 60 months in this case.  

 PV – It is present value of cash flows, i.e. loan amount as on today.  
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All the above values can be typed or liked with cells in excel sheet for real time updation. As soon as all the 
values are entered / linked correctly, formula result is displayed at the bottom as ` 2,224.44. It is displayed as a 
negative figure just because excel considers all outflows are considered as negative figure. After clicking on OK 
button, the result shall be generated in the desired cell as shown in Fig 5.7.5.  

 

Fig 5.7.5: Result of PMT function 

PPMT Function 

This function is used to calculate the principal portion in every installment. This function requires one additional 
input, i.e. the installment number. The principal amount shall increase after every installment. Hence, principal 
amount shall be different in every EMI. 

Continuing with the above example, the following figure shows calculation of principal and interest component 
in each EMI. Installment number is denoted by “Per” in excel. 

For the calculation of interest component in each EMI, excel has IPMT function. Both the functions are used in 
the following figure.  
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Fig 5.7.6: PPMT function 

Loan Amortization Sheet 

Excel provides a readymade solution for the EMI calculation. This can be simply done by following steps as 
shown in Fig 5.6.7.  

(a) Open any excel file  

(b) Right click on sheet tab.  

(c) Select “Insert” option. 

(d) Go to “Spreadsheet Solutions” tab  

(e) Select “Loan Amortization” and click OK button.  
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Fig 5.7.7: Loan Amortization Sheet template 

(f) Enter all the details like Loan Amount, Annual interest rate, Loan period in years, Number of payment per 
year, Start date of loan, etc. All the EMI calculations shall be displayed as shown in Fig 5.7.8.  

 

Fig 5.7.8: Loan Amortization Sheet template 
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5.8 Sampling 
Sampling is the process of selecting units (e.g., people, organizations) from a population of interest so that by 
studying the sample we may fairly generalize our results back to the population from which they were chosen. 
Two words often used in sampling are sample and population. Sample means the units or items selected for 
study or consideration and population means the total set of data used for selection of samples.  

Sampling is a process used in statistical analysis in which a predetermined number of observations will be 
taken from a larger population. The methodology used to sample from a larger population will depend on the 
type of analysis being performed, but will include simple random sampling, systematic sampling and 
observational sampling. 

The basic expectation from sampling is that the sample should be a representation of the general population. 

When taking a sample from a larger population, it is important to consider how the sample will be drawn. To get 
a representative sample, the sample must be drawn randomly and encompass the entire population. For 
example, a lottery system can be used to determine the average age of students in a college by sampling 20% 
of the students, considering an equal number of students from each type of course. 

5.8.1 Sampling Randam Methods  

Following are some of the sampling methods.  

1. Simple Random Sampling: In this case each individual is chosen entirely by chance and each member of 
the population has an equal chance, or probability, of being selected. One way of obtaining a random sample is 
to give each individual in a population a number, and then use a table of random numbers to decide which 
individuals to include. 

2. Systematic Sampling: Individuals are selected at regular intervals from a list of the whole population. The 
intervals are chosen to ensure an adequate sample size. For example, every 10th member of the population is 
included. This is often convenient and easy to use, although it may also lead to bias. 

3. Stratified Sampling: In this method, the population is first divided into sub-groups (or strata) who all share 
a similar characteristic. It is used when we might reasonably expect the measurement of interest to vary 
between the different sub-groups. Gender or smoking habits would be examples of strata. The study sample is 
then obtained by taking samples from each stratum. 

In a stratified sample, the probability of an individual being included varies according to known characteristics, 
such as gender, and the aim is to ensure that all sub-groups of the population that might be of relevance to the 
study are adequately represented. 

The fact that the sample was stratified should be taken into account at the analysis stage. 

4. Clustered Sampling: In a clustered sample, sub-groups of the population are used as the sampling unit, 
rather than individuals. The population is divided into sub-groups, known as clusters, and a selection of these 
are randomly selected to be included in the study. All members of the cluster are then included in the study. 
Clustering should be taken into account in the analysis. 
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The General Household survey, which is undertaken annually in England, is a good example of a cluster 
sample. All members of the selected households/ clusters are included in the survey. 

5. Quota Sampling: This method of sampling is often used by market researchers. Interviewers are given a 
quota of subjects of a specified type to attempt to recruit. For example, an interviewer might be told to go out 
and select 20 adult men and 20 adult women, 10 teenage girls and 10 teenage boys so that they could 
interview them about their television viewing. There are several flaws with this method, but most importantly it is 
not truly random. 

6. Convenience Sampling: Convenience sampling is perhaps the easiest method of sampling, because 
participants are selected in the most convenient way, and are often allowed to chose or volunteer to take part. 
Good results can be obtained, but the data set may be seriously biased, because those who volunteer to take 
part may be different from those who choose not to. 

7. Snowball Sampling: This method is commonly used in social sciences when investigating hard to reach 
groups. Existing subjects are asked to nominate further subjects known to them, so the sample increases in 
size like a rolling snowball. For example, when carrying out a survey of risk behavior amongst intravenous drug 
users, participants may be asked to nominate other users to be interviewed. 

5.8.2 Simple Random Sampling in Excel 

Consider a small case of analysis of customer feedback about a product. Let us assume that we have a 
population of 1000 customer feedback forms. We need to analyze the feedback pattern of 5% customer, .i.e. 50 
customers. 

This can be done easily by following steps as under shown in Fig 5.8.1.  

(a) Write Column heading in Cell A1 as Customer IDs and write customer codes / IDs in Cell A2, A3,A4, and 
so on.  

(b) Go the cell B1 and write the column heading as Random Numbers.  

(c) Go to cell B2 and type “Rand()” and press ENTER. This is a function for generating random numbers in 
any particular cell. After pressing ENTER, a random number shall be generated in cell B2.  

(d) Copy Cell B2 and paste it in the Cells B3, B4, B5, etc. Now in-front of every customer ID, there is a 
random number.  

(e) Sort both columns according to random numbers  
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Fig 5.8.1: Simple Random Sampling 

(f) Select the first 50 customers. Now these 50 customers are the randomly selected customers and 
represent the complete data.  

5.8.3 Using Sampling Feature 

Excel has got a built in feature for sampling of data. This can be used as under.  

(a) Type the data regarding roll number of students in Cell A2, A3, A4, and so on.  

(b) To get a sample of five students, go to Data > Data Analysis 

 

Fig 5.8.2: Sampling Feature 

(c) Select “Sampling” from the list and click OK. 
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Fig 5.8.3: Select Sampling 

(d) Following screen shall appear.  

 

Fig 5.8.4: Sampling 

There are three options for user to set.  

 Input Range – Specify the population range here.  

 Sampling Method – Select the method from two options. If periodic is selected, period, i.e. interval needs 
to be specified. If random is selected, number of samples required from the population has to be 
specified.  

 Output options – Specify the location where you want the sampled data. It may the specific location in the 
same sheet, or some other sheet or in a new file also.  

(e) Click OK to get the result. Following type of screen shall be generated. In this case we have considered a 
population of twenty students and we are obtaining samples of five students.  
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Fig 5.8.5: Obtained Sampling 

5.9  Summary 
Summary reports are useful for quick reading and easy understanding, particularly for top management. When 
excel is used for preparation of reports in similar formats, it can be used for consolidation of reports into a 
master report or a summary report. Additional operations like average, count, sum can be done while preparing 
summary reports.  

To summarize and report results from data on separate worksheets, you can consolidate the data from each 
separate worksheet into one worksheet (or master worksheet). The worksheets you consolidate can be in the 
same workbook as the master worksheet or in other workbooks. When you consolidate data in one worksheet, 
you can more easily update and aggregate it on a regular or ad hoc basis. 

For example, if you have a worksheet of expense figures for each of your regional offices, you might use data 
consolidation to roll up these figures into a corporate expense worksheet. This master worksheet might contain 
sales totals and averages, current inventory levels, and highest selling products for the entire enterprise. 

Example: 

Let us consider a case where the data about debtors for two months is stored in two different sheets. We wish 
to consolidate the data in third sheet.  

Solution: 

Let us assume that names of debtors are stored in Cell A2, A3, A4, and so on and monthly purchases by them 
are recorded in Cells B2, B3, B4, and so on. Data for the month of April is stored in Sheet1 and data for May is 
stored in Sheet2. Let us consolidate the data in Sheet3.  

(a) Create a new sheet and rename it as Summary.  

(b) Go to Data > Consolidate (Under Data Tools Group) 

(c) Following type of screen shall appear as shown in Fig 5.9.1.  
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Fig 5.9.1: Consolidate Data 

(d) Select the required function from the drop down menu. Here we have selected Sum.  

(e) Select the table array (A2:B11) from Sheet1 in Reference and click on Add button. 

(f) Now, select the reference (A2:B11) from Sheet2 in Reference and click on Add button.  

(g) As we have stored the names of customer in A column, check the check box “Left column” 

(h) Click on OK button. The result shall be generated on “Summary” sheet.  

(i) If the check “Create links to source data” is clicked, summary report shall be linked with source data on 
real time basis. Updations in Sheet1 or Sheet2 shall be updated in Summary sheet also.  

  

Fig 5.9.2: Create links to source data 

Data can be summaries by using the Consolidate command (Data tab, Data Tools group). Other way of data 
consolidation is using formulae like COUNTIF, SUMIF, etc. or a PivotTable report also. 
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5.10 Capital Budgeting 
It is a process in which a business determines whether projects such as building a new plant or investing in a 
long-term venture are worth pursuing. Oftentimes, a prospective project's lifetime cash inflows and outflows are 
assessed in order to determine whether the returns generated meet a sufficient target benchmark. 

Ideally, businesses should pursue all projects and opportunities that enhance shareholder value. However, 
because the amount of capital available at any given time for new projects is limited, management needs to use 
capital budgeting techniques to determine which projects will yield the most return over an applicable period of 
time.  

Popular methods of capital budgeting include net present value (NPV), internal rate of return (IRR), discounted 
cash flow (DCF) and payback period. Obviously excel can be of great use in Capital Budgeting. Let us 
understand each of these concepts and its calculation in excel.  

5.10.1 Net Present Value 

Net present value is the value of all future cash inflows less future cash outflows as on today. This is a major 
point in capital budgeting decisions. Net present value can be calculated in excel using two ways.  

(a) By calculating discounting factors – Consider the following example where project future cash flows are 
given for five years. In the year zero, i.e. beginning of year one, ` 1000 is shown as outflow, which is initial 
investment. Positive figures in year 2,3,4,5 shows net cash inflows. To calculate the discounted cash flow, 
discounting factor is calculated in row six. Row seven shows present value of cash flows. Cell F8 shows the net 
present value of all the future cash flows, i.e. ` 402.  

 

Fig 5.10.1: Net Present value 

(b) By using NPV function – A readymade function is available in excel for calculation of Net Present Value. 
The function NPV uses the syntax as under. Using NPV function, NPV can be directly calculated without 
calculating discounting factors. The following figure shows NPV calculation of cash flows for all the five years in 
Cell L9. Formula bar below shows the syntax of NPV function.  
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Fig 5.10.2: NPV function 

5.10.2 Internal Rate of Return 

The discount rate often used in capital budgeting that makes the net present value of all cash flows from a 
particular project equal to zero. Generally speaking, the higher a project's internal rate of return, the more 
desirable it is to undertake the project. As such, IRR can be used to rank several prospective projects a firm is 
considering. Assuming all other factors are equal among the various projects, the project with the highest IRR 
would probably be considered the best and undertaken first. 

To calculate IRR using excel –  

(a) Click on function button and select IRR function as shown in Fig 5.10.3. 

 

Fig 5.10.3: IRR function 

(b) Following screen shall be displayed after selecting IRR function as shown in Fig 5.10.4.  
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Fig 5.10.4: Screen display after selecting IRR function 

 Values – Input the cash flow values here or give a range.  

 Guess – Type any number that you guess is close to IRR.  

 Here IRR is calculated as 23.29% as shown in Fig 5.10.5 

 

Fig 5.10.5: Result of IRR function 

(c) We can cross check this IRR by changing the Discount Rate in Cell D3 to 23.29%, automatically the Net 
Present Value becomes zero.  

5.11 Risk Analysis & Investment  
Risk analysis is the process of defining and analyzing the dangers to individuals, businesses and government 
agencies posed by potential natural and human-caused adverse events. 

In quantitative risk analysis, an attempt is made to numerically determine the probabilities of various adverse 
events and the likely extent of the losses if a particular event takes place. 

Qualitative risk analysis, which is used more often, does not involve numerical probabilities or predictions of 
loss. Instead, the qualitative method involves defining the various threats, determining the extent of 
vulnerabilities and devising countermeasures should an attack occur. 

In case of investments, risk analysis is the study of the underlying uncertainty of a given course of investment 
action. Risk analysis refers to the uncertainty of forecasted future cash flows streams, variance of 
portfolio/stock returns, statistical analysis to determine the probability of a project's success or failure, and 
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possible future economic states. Risk analysts often work in tandem with forecasting professionals to minimize 
future negative unforeseen effects. 

Almost all sorts of businesses require a minimum sort of risk analysis. For example, commercial banks need to 
properly hedge foreign exchange exposure of oversees loans while large department stores must factor in the 
possibility of reduced revenues due to a global recession. Risk analysis allows professionals to identify and 
mitigate risks, but not avoid them completely. Proper risk analysis often includes mathematical and statistical 
software programs. 

5.11.1 Risk Analysis & Excel 

Excel being spreadsheet software can be very effectively used for analysis of any type of data and risk analysis 
cannot be an exception. There can variety of ways of using excel for risk analysis.  

5.11.2 Risk Analysis Using Charts 

Charts are generally used to present information in a simple and better way. Charts can also be used to 
analyse the risk in a better way. Following figure shows how project, probability and its consequence can be 
explain in a simple and user friendly way using a chart as shown in Fig 5.11.1.  

 

Fig 5.11.1: Risk Analysis using Charts 

5.11.3 Probability 

Probability is a measure of the likeliness that an event will occur. 

Probability is used to quantify an attitude of mind towards some proposition of whose truth we are not certain. 
The proposition of interest is usually of the form "Will a specific event occur?" The attitude of mind is of the form 
"How certain are we that the event will occur?" The certainty we adopt can be described in terms of a numerical 
measure and this number, between 0 and 1 (where 0 indicates impossibility and 1 indicates certainty), we call 
probability. Thus,higher the probability of an event, the more certain we are that the event will occur. A simple 
example would be the toss of a fair coin. Since the 2 outcomes are deemed equi-probable, the probability of 
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"heads" equals the probability of "tails" and each probability is 1/2 or equivalently a 50% chance of either 
"heads" or "tails". 

Example 1: 

Let us consider a case where we want to calculate probability of achieving sales target between 70 to 80 units. 

Follow the steps as under.  

1. Create two column headings in excel files as under  

 Cell A1 – “Sales Units” 

 Cell B1 – “Probability”  

2. Write the Sales Units in cells A2 to A7 as 50,60,70,80,90,100 

3. Write the probability of each number in front of it, i.e. in Cells B2 to B7 as 0.05, 0.1, 0.4, 0.3, 0.1 and 
0.05.  

4. Get the cursor on Cell C2, i.e. the cell where we want to get the result.  

5. Click on Function key and select PROB function 

6. Set as the variables as shown in the figure below. 

 

Fig 5.11.2: Calculate probability 

7. Result will be generated in Cell C2 as “0.7”. It means that there are 70% chances of achieving sales 
target anything between 70 to 80 units.  

Note: 

(a) X-range – The range of sales units  

(b) Prob-range – The range of outcomes associates sales units.  
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(c) Lower Limit – Here we wish to set it as 70, anything out of the sales units can be selected here.  

(d) Upper Limit – This field is optional. If ignored, it is considered as same as that of lower limit.  

Example 2: 

Using the same data, calculate the probability of achieving sales level of anything ranging from 50 to 100.  

Solution: 

1. Just click on Function Key once again and change the values of Lower & Upper Limit as 50 and 100 
respectively.  

2. Result generated is “1” or 100% if expressed in terms of percentage. It means, there are 100% chances 
of selling units between 50 to 100. In any case sales will not go below 50 units.  

This type of information is useful in taking various decisions, e.g. How much to spend on marketing, how many 
salesman to be appointed, what should be the price of the product, etc.  

In the similar way, probability of any particular outcome may be obtained just by changing lower and upper 
values.  

5.11.4 Sensitivity Analysis 

It is a technique used to determine how different values of an independent variable will impact a particular 
dependent variable under a given set of assumptions. This technique is used within specific boundaries that will 
depend on one or more input variables, such as the effect that changes in interest rates will have on a bond's 
price. 

Sensitivity analysis is a way to predict the outcome of a decision if a situation turns out to be different compared 
to the key predictions.  

Sensitivity analysis is very useful when attempting to determine the impact the actual outcome of a particular 
variable will have if it differs from what was previously assumed. By creating a given set of scenarios, the 
analyst can determine how changes in one variable will impact the target variable.  

Example 1: 

Consider a simple case of loan and EMI calculation. In case of EMI calculations, there are two variables, loan 
amount and interest rate. Sensitivity analysis can be used to check the impact on the EMI if both the variables, 
i.e. loan amount and interest rates are changed.  

Input the data in excel sheet as under in Fig 5.11.3.  
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Fig 5.11.3: Sensitivity Analysis 

EMI in the above sheet is calculated using PMT function.  

Now, let us try to check the impact on EMI if interest rate varies from 7.5% to 9%. Also let us check the impact 
on EMI if loan amount changes from ` 15.00 Lacs to ` 50.00 Lacs. For this purpose, input the data as shown 
under.  

Interest rates are written in Cells A8:A23 and Loan Amounts are written in Cells C7:I7. 

 

Fig 5.11.4: Sensitivity Analysis Using Two variable data 

Select the complete table from Cell A7 to Cell I23.  
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Go to Data > What-If Analysis > Data Table 

 

Fig 5.11.5: What-If Analysis 

Select the row input cell as the cell where loan amount is stored and select the column input cell as the cell 
where interest rate is stored and press enter.  

 

Following type of report shall be generated as shown in Fig 5.11.6.  

 

Fig 5.11.6: Generated report 
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It can be observed from the above table that in case of ` 30.00 lacs loan and rate of interest of 8% p.a., EMI 
comes to be ` 28,670, which matches with our original calculations. The complete data considering two 
variables is ready within few minutes.  

5.11.5 Scenario Analysis 

Scenario is a particular situation dependent on some events. Scenario analysis includes analysis of a situation 
considering happening or not happening of certain events. In financial world, particularly regarding investments, 
it is the process of estimating the expected value of a portfolio after a given period of time, assuming specific 
changes in the values of the portfolio's securities or key factors that would affect security values, such as 
changes in the interest rate. 

Scenario analysis commonly focuses on estimating what a portfolio's value would decrease to if an unfavorable 
event, or the "worst-case scenario", were realized. Scenario analysis involves computing different reinvestment 
rates for expected returns that are reinvested during the investment horizon. 

Example: 

Consider a case of a furniture shop. You have 100 chairs in your shop. Chairs are sold to different customer at 
different prices, e.g. ` 4,000 to ` 6,000.  

If we are selling 60% of chairs at highest price of ` 6,000 each and 40% chairs at lowest price of ` 4,000 each, 
following shall be the scenario.  

 

Fig 5.11.7: Scenario Analysis 

ANow consider what if you are selling 70% of chairs at highest price, or 80% of chairs at highest price or 90% 
or all the chairs at highest price. What will be the profit figure in each case ? This can be easily done by using 
scenario analysis.  

 To create scenarios go to Data > What-If Analysis > Scenario Manager  

 Click on Add button  

o Type some relevant name for scenario 

o Link the changing cell, i.e. the cell where % (C3 in this case) is written and click on OK button.  
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Fig 5.11.8: Edit Scenario 

After clicking OK button, scenario value has to set in this screen. Type 0.6 as value. 

 

Fig 5.11.9: Scenario Value 

Go on creating all the scenarios one by one for 70%, 80% 90% and 100%.  

To see the changes in report, change the scenario and click on show button in Scenario Manager screen.  

Note: Cell having % and number of chairs sold must be linked.  

5.11.6 Certainty Equivalent Model 

Certainty Equivalent can be considered as a guaranteed return that someone would accept, rather than taking a 
chance on a higher, but uncertain, return. If you've ever thought about leaving your job to start your own 
profession, and potentially make more money, but decided to stay and continue drawing a salary instead, then 
the amount of your salary is your certainty equivalent. You might need to come up with a business idea with a 
higher potential payoff to be convinced to leave the security of your existing job. 

Investments must pay a risk premium to compensate investors for the possibility that they may not get their 
money back. If an investor has a choice between a Government bond paying 3% interest and a corporate bond 
paying 8% interest, and he chooses the government bond, the payoff is the certainty equivalent. The company 
would need to offer this particular investor a potential return of more than 8% on its bonds, to convince him to 
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buy. Thus, a company seeking investors can use the certainty equivalent as a basis for determining how much 
more it needs to pay, to convince investors to consider the riskier option. The certainty equivalent will vary, 
because each investor has a unique risk tolerance. 

5.11.7 Decision Tree Analysis 

It is a system where a schematic tree-shaped diagram is used to determine a course of action or show a 
statistical probability. Each branch of the decision tree represents a possible decision or occurrence. The tree 
structure shows how one choice leads to the next, and the use of branches indicates that each option is 
mutually exclusive. 

A decision tree can be used to clarify and find an answer to a complex problem. The structure allows users to 
take a problem with multiple possible solutions and display it in a simple, easy-to-understand format that shows 
the relationship between different events or decisions. The furthest branches on the tree represent possible end 
results. 

A decision tree is a kind of flowchart -- a graphical representation of the process for making a decision or a 
series of decisions. Businesses use them to determine company policy, sometimes simply for choosing what 
policy is, other times as a published tool for their employees. Individuals can use decision trees to help them 
make difficult decisions by reducing them to a series of simpler, or less emotionally laden, choices. Regardless 
of the context or type of decision, the structure of a decision tree remains the same. Or you can say A decision 
tree is a decision support tool that uses a tree-like graph or model of decisions and their possible 
consequences, including chance event outcomes, resource costs, and utility. It is one way to display an 
algorithm. 

Example:  

How to create a decision tree in excel? 

Follow the steps as given here.  

1. Open a new excel file and go to the "Insert" tab and click the "SmartArt" button. A window titled "Choose 
a SmartArt Graphic" will appear. Click the "Hierarchy" category and choose "Horizontal Labeled 
Hierarchy" design. Click "OK." 

2. Type the name of the decision next to the first bullet point in the window that says "Type your text here." 
Type something like "Investment," if you are making an investment decision. 

3. Type the names of each option in the indented bullet points under the decision bullet. For example, you 
are investing in a lump sum amount either with Government or in a private company. Evaluate each 
option and determine whether a result is achieved, if there is uncertainty, or if another decision needs to 
be made 

4. Insert boxes wherever there is another decision to be made and circles for uncertainties. If there is a 
result, nothing needs to be done. Boxes can be added by pressing "Enter" and "Tab" after the bullet point 
where you would like to add a box. To change the shape to a circle, for example, right click on the shape, 
and select "Change Shape." Select a circle. 
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5. Enter probabilities in the closest cell where circles and lines join. The probabilities represent the 
percentage you expect to occur. Enter estimated values such as dollar values in the closest cell where 
boxes and lines are joined. These represent the estimated value of the decision if it is taken. 

A sample decision tree can be prepared as shown in Fig 5.11.10.  

 

Fig 5.11.10: Sample decision tree 

While considering an investment option, safety of money, returns and liquidity may be the criteria for evaluating 
each investment option.  

5.11.8 Monte Carlo Simulation 

A problem solving technique used to approximate the probability of certain outcomes by running multiple trial 
runs, called simulations, using random variables. Monte Carlo simulation is named after the city in Monaco, 
where the primary attractions are casinos that have games of chance. Gambling games, like roulette, dice, and 
slot machines, exhibit random behavior. 

Monte Carlo simulation is a computerized mathematical technique that allows people to account for risk in 
quantitative analysis and decision making. The technique is used by professionals in such widely disparate 
fields as finance, project management, energy, manufacturing, engineering, research and development, 
insurance, oil & gas, transportation, and the environment. 

Monte Carlo simulation furnishes the decision-maker with a range of possible outcomes and the probabilities 
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they will occur for any choice of action.. It shows the extreme possibilities—the outcomes of going for broke and 
for the most conservative decision—along with all possible consequences for middle-of-the-road decisions. 

The technique was first used by scientists working on the atom bomb; it was named for Monte Carlo, the 
Monaco resort town renowned for its casinos. Since its introduction in World War II, Monte Carlo simulation has 
been used to model a variety of physical and conceptual systems. 

5.12 Finance Planning 
Planning is considered to be the primary requirement for moving towards any goal. Financial planning is the 
process of meeting the financial goals through the proper management of finances. Proper management of 
finances includes deciding the source and application of funds along with it timing. It is common for anybody to 
face financial setbacks at some point. One way to avoid or reduce the impact of such setbacks in the future is 
through careful financial planning. Financial goals can include buying a home, saving for your child’s education 
or planning for retirement. The financial planning process involves the following steps:   

There are two basic rules in any type of financial planning.  

(a) Earlier the better – Money received today is always better than money received tomorrow. 

(b) Bigger the better – More money received is always better than less money received. 

5.12.1 Five Ds of Finance Planning: 

1. Deciding the Objective : This is the first step in financial planning. One has to be clear about the 
objective of finance planning. This is basic step which decides and impacts all the future steps.  

2. Data Collection : Once the objective is decided and clear, the next step is to collect the required data for 
analysis. Data can be obtained in any form, but mostly it will be in figures. Excel can be used for storing the 
data of any size very easily.  

3. Data Analysis : This is a very important step in the overall process. This step requires huge amount of 
efforts and expertise. Excel can be very effectively used for analysis of data of any size and that too with great 
amount of ease. Data is evaluated as per the direction of financial objective.  

4. Drawing Inference :This step invovles human intervention. Many a times this step is ignored. Every 
individual may have his/her own set of rules for drawing inferences. Two different individuals may draw two 
different inferences using the same set of data.  

5. Decision Making : Once the inferenace is drawn, decision has to be taken about financial planning. 
Decision making involves taking action on the basis of four earlier steps.  
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Fig 5.12.1: Five Ds of Finance Planning 

5.12.2 Using Excel for Financial Planning  

Various excel functions and features can be used in the process of financial planning. Some of the functions 
are listed below.  

Sr. No. Function Use 

1 PMT Payment – Used for calculating monthly installment/investment amount.  

2 PPMT Principal Payment – Used for calculating principal amount in EMI 

3 IPMT Interest Payment – Used for calculating interest amount in EMI 

4 FV Future Value – Used for calculating future value of present investment  

5 RATE Rate – Used for calculating rate of interest  

6 NPER Number of Periods – Used for calculating number of periods (months/years) 
required for a particular maturity amount at a given rate of interest.  

7 IRR Internal Rate of Return – Used for  

8 PV Present Value – Used for calculating present value of future cash flows.  

Table 5.12.1 Excel function for Financial Planning 

 

Deciding the 
Objective  

Data 
Collection  

Data 
Analysis 

Drawing 
Inference  

Decision 
Making 
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5.13 Personal Financial Planning 
Personal financial planning in case of most of the individuals shall include planning for retirement, decision 
about home loans, budgeting for major expenses like marriage of children, education expenses, etc.  

Let us directly try to handle these commonly asked questions by individuals.  

Example 1: 

Mr. Swapnil Ghate is willing to invest ` 5,000 per month for the purpose of buying office space. He wants to 
know how much amount he would get at the end of 10 years considering a rate of interest of 8% p.a. 

Solution: 

This question can be answered very easily by using “FV” function.  

Following shown in Fig 5.13.1 how this function can be used.  

 

Fig 5.13.1: FV Function 

Please Note: 

(a) Period is given in months and rate of interest is given per anum. Here, while linking the rate interest, it 
should be divided by 12 to arrive at the monthly rate of interest.  

(b) All outflows shall be considered as a negative figure as per excel norms. Hence monthly investment of ` 
5,000 is written as negative figure.  

Here the answer is appearing as ` 9,14,730.  

Example 2: 

Mr. Ashish Deshpande is planning to have ` 10.00 Lacs after five years for the purpose of education of his 
daughter. He wants to know how much he needs to invest every month considering a rate of interest of 8% p.a. 
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Solution 

This question can be answered using two combination of two functions PMT and FV. 

Look at the figure shown below. We have used PMT function and set the future value as ` 10.00 Lacs. The 
result shown is ` 13,610 as shown in Fig 5.13.2.  

 

Fig 5.13.2: PMT Function with Future Value 

Example 3: 

Mr. Amit Shriwas want to have ` 5.00 lacs at the end of five years by investing ` 5,000 per month. He wants to 
know the rate of interest at which he should invest.  

Solution: 

This question can be answered using RATE function and future value.  

 

Fig 5.13.3: Rate Function with Future Value 
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As shown in the figure above, Mr. Amit Shriwas needs to invest ` 5,000 per month for 60 months @ 1.62% 
p.m., i.e. @ 19.38% p.a. 

Example 4: 

Ms. MayuraRahane is interest in investing ` 10,000 per month @ 10% p.a. She wants ` 5.00 Lacs for the 
purchase of a plot. She is interested in knowing the period for which she should invest to get ` 5.00 Lacs.  

Solution: 

This question can be answered using NPER function with future value as shown in Fig 5.1.3.4.  

 

Fig 5.13.4: NPER Function 

The answer is 41.97 Months.  

5.14 Corporate Financial Planning 
Basic rules of personal financial planning and corporate financial planning are same. The difference is in the 
quantum of money involved. As it is very high as compared to the money involved in personal financial 
planning, the amount of risk involved becomes very high. The amount of risk involved is also affected by the 
various other factors like changes in business conditions, technology, Government policies, international 
issues, etc.  

Corporate planning can be defined as the process of setting the procedures in the organization for achieving 
the predefined goals. A corporate plan should incorporate the values and priorities of a company, with a 
comprehensive map of how to achieve those goals. The growth of a business depends on many factors like 
good leadership, a product or service in high demand etc but the most important is careful financial planning. 
The process of planning includes –  

1. Research/ study of the existing situation. 
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2. Analysis about present resources and liabilities for an entity. 

3. Goal Setting 

4. Prioritisation of goals 

5. Incorporate budget details into a feasible plan for the future. 

6. Utilisation of existing resources for achievement of the goals. 

7. Comparison of planned activities VS actual results at regular period of time. 

Technological advancements play a vital role in financial planning at the corporate level. These advancements 
include usage of various software, comparison of periodical information, discussions among top management, 
passing of crystal clear goals before each and every individual, etc. Obviously excel can play an important role 
for corporate financial planning. Various formats can be prepared using functions / feature in excel. Following 
are some activities which are being carried out in the process of corporate financial planning.  

1. Analysis of Financial Statements 

2. Forecasting of Annual Revenues 

3. Turning Points in Financial Trends 

4. Forecasting Financial Statements 

5. Forecasting seasonal revenues 

6. Cash Budgeting 

7. Calculation of NPV, IRR etc 

8. Calculation of Cost of Capital 

9. Calculations of Break Even Points, Profit and Leverage etc 

10. Calculation Depreciation and taxes 

11. Capital Budgeting and so on 

From above we get an overall idea what the corporate financial planning is and how it is being done.Many of 
the above stated features are explained earlier. Let us discuss some of the issues regarding financial planning 
and excel.  

Example 1: Iterative Calculations  

Indradhanu Consulting Pvt. Ltd. is planning to avail a term loan of ` 10.00 crores for a term of 10 years at 10% 
rate of interest p.a. For the purpose of preparation of financial plan for 10 years, they wish to calculate interest 
on average balance. Prepare a chart showing interest calculation and repayment.  

Solution: 

A simple chart can be prepared as shown in Fig 5.14.1(A).  
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Fig 5.14.1(A): Iterative Calculations 

In the above chart, we have calculated principal closing balance. This is not loan closing balance as interest 
payable is yet to be calculated. Please note that interest shall be calculated on average balance of loan and 
average balance shall be calculated as opening balance + closing balance divided by two.  

The basic problem here is that we need to calculate interest for getting closing balance figure and at the same 
time closing balance figure is needed to calculate average balance, which is in turn used for calculation of 
interest. Hence, closing balance is needed for interest calculation and interest figure is needed for closing 
balance calculation. This question problem is just like “What Comes First ? Egg or Hen ? “ 

This problem can be solved by using Iterative Calculations in excel. Iterative calculation is a feature where 
calculation is performed in a loop automatically for required number of times. The result is displayed when the 
change in calculation is negligible.  

Please note: 

 In year 1, before considering the interest figure, average balance is (1000 + 900) /2 = 950 

 Interest shall be calculated on this average balance @ 10%, i.e. 95.  

 This 95 shall be added to the outstanding, closing balance shall increase to 995. 

 Again the average balance shall be calculated considering the closing balance of 995. 

 Now, the average balance shall be 997.50 and interest on this figure shall be 99.75.  

 This process shall be repeated till the time the change between the two calculations is negligible. 

 Calculating the interest to calculate average balance and vice versa is called as iterations.  

 This can be done manually, as it is done in the sheet below. But it would take lot time. 

 

  Fig 5.14.1(B): Iterative Calculations  
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In the above figure, all the calculations are for year 1 only. So ultimately we have settled on the interest figure 
of 100.00 

Above type of iterative calculations can be very easily done using excel using following simple steps.  

 Prepare a chart as shown above. 

 Calculate the average balance. 

 Calculate interest on average balance. 

 Link this interest figure with Cell B4.  

 As soon as you press ENTER to accept interest calculation, a Circular Reference Warning message is 
displayed. Excel assumes that something has gone wrong.  

 Here, we need to tell excel that this is the way we wish to calculate interest and nothing has gone wrong. 
This can be done by making a small change as under. 

 Click on File and go to Options.  

 Go to Formulas.  

 

Fig 5.14.2: Excel Option 

 Check the check box for “Enable iterative calculation”. Maximum iterations and maximum change figures 
can be specified here. Now onwards, excel shall not display any Circular Reference Warning Error 
Message.  



Main source : ICAI

 downloaded from : taxupindia.com

APPLICATION OF MS-EXCEL   

 ADVANCED INFORMATION TECHNOLOGY 143 

 

 The completed chart shall look as shown in Fig 5.14.3.  

 

Fig 5.14.3: Complete Chart 

In the above case, we have assumed that interest is paid separately.  

Every single feature in excel can be used in variety of ways. Its use is limited by the imagination of the user 
only. The list of features and functions is just an illustrative list and not an exhaustive list.  
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INTRODUCTION TO MS EXCEL AS 
AN AUDIT TOOL 

 

1.1 Introduction 

Microsoft Excel is one of the most widely used softwares in the world. Lakhs of people around the globe use 
Microsoft Excel. People use excel for a variety of purposes. Primarily, it is used for all sorts of data processing 
and calculations. Excel is indispensable and has become life blood of modern commerce. 

1.2 Auditors and MS Excel 
The discipline of Auditing is not an exception to the phenomenon as described above. As auditors, we live and 
breathe Microsoft Excel. A lot of dedicated softwares are nowadays available for Auditing. Nevertheless, MS 
Excel is still the favorite of many and most. Hence, the more we try to learn excel, the sharper will be our audit 
reports.  

1.3 Need for MS Excel  

Originally released in 1985, Microsoft Excel is today the most popular spreadsheet program in the world. No 
business can imagine working without excel. It has become most essential in many departments like:  

1. Accounting and Finance 

Excel is indispensable in accounting and finance because of its ability to automate calculations.  Complex 
formulas can be built in excel which can perform tedious calculations. Tricky items like accrual of compound 
interest, depreciation, retirement benefits, net income after adjusting the gross for expenses etc. can be 
calculated quite effortlessly in excel.  

2. Marketing 

MS Excel is required by marketing persons for doing their marketing efforts. Product pricing is done by making 
calculations through excel. Customers data may be maintained in excel. Charts and other visual tools in excel 
are used by marketing managers to deliver their ideas more effectively.   
 

CHAPTER 

1 
LEARNING OBJECTIVES 
 Learn how auditors and MS Excel go together. 
 Be aware about the need for MS Excel felt by an organisation 
 Learn how data for audit should be obtained 
 Know about the key capabilities of MS Excel 
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3. Purchase 
This department generates prime cost which is generally a significant portion of the total cost. Therefore, 
purchase department personnel try to exercise strong control over costs. For this, they make meticulous 
calculations using excel.   

4. Production 

Excel is required by the production department to keep track of their production activities. It needs to calculate 
how much to produce based on production budgets. These budgets may be prepared using excel.  

5. Human Resources  

HR Managers need to keep track of employee related data. They need to calculate employee salaries, 
incentives, retirement benefits, leave calculations etc. There may be dedicated softwares for this. However, 
they can also be calculated using excel. In fact, excel makes customized calculations possible. 

6. Administration 

The whole organization revolves around this department. All the decisions are made by general managers and 
their implementation is done by the other departments. Admin department is the brain of an organization. 
Needless to say, these managers depend upon quality information for their decision making. This information 
flows to them through a Management Information System (MIS). Today, despite other dedicated softwares, MS 
Excel is still most popular software for MIS. Indeed, MIS as a system cannot function well if excel is not 
provided. 

Thus, we can see that an organization heavily depends upon excel for its effective functioning. Excel is totally 
indispensable for today’s organisations, be it large or small.  

1.4 Obtaining Audit Data 
When an auditor tries to perform his auditing function, he has to inevitably work upon data. Such data 
he needs to obtain from the auditee’s records. Nowadays we have modern database systems which 
hold the auditee’s records. These records can be exported to excel. Sometimes, data may also be 
exported in other formats like text, XML (Extensible Markup Language), CSV (Comma Separated 
Values) etc. These can be brought to excel pretty easily. Another popular format for exporting data is 
PDF (Portable Document Format). It is not easy to convert it into excel. We need to make use of 
converters. There are many converters available in the market. There are also websites which offer 
PDF to excel conversion. They could either be free or paid. Obviously, the paid converters do a better 
job than the free ones. So one needs to analyze his requirement and accordingly decide which 
converter to use. 

1.5 Key Steps for Obtaining Audit Data 
Broadly, we need to follow the steps given below to obtain the Audit Data: 

1. Raise a data Request – We need to raise a request with the auditee to share his data. We need to clearly 
specify our requirements. This step is very important as any ambiguity in this step will lead to wastage of time 
and efforts. This request needs to be made to the proper person having the authority to supply such data. 
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2. Do follow up – If the data is not received within reasonable time, then a follow is needed. We need to 
issue gentle reminders from time to time to make sure that the data reaches in our hand as soon as possible. If 
the data reaches late, then we have lesser time to process it and draw our conclusions. 

3. Receive the data – In due course, auditee will send the data. We should receive it and should 
acknowledge its receipt. If some data is in hard copy which we are expected to return back, make a list of such 
documents and obtain the auditee’s attestation on such list. This is to avoid future disputes with respect to 
possession of document. 

4. Validate the data - Check the received data for its authenticity, integrity and completeness. If the data is 
incomplete, in inappropriate format or doesn’t appear to be authentic then we should immediately raise this 
issue. 

5. Follow up – Again, for the missing links in the data, keep making follow up to receive those in good time. 

1.6 Key Capabilities of MS Excel 
Once the complete data is received, we can perform all sorts of analysis using MS Excel. Following 
are its notable capabilities: 

1. Quick data processing – One of the most amazing things about excel is that it can perform analyses in a 
flash! It is much faster than performing work manually. Certain features like Pivot Tables can help generate 
complex reports literally within few seconds. 

2. Accurate computation – In addition to the quick processing of data, excel also carries out the computation 
accurately. The more we use excel features, the more we are confident about the output. Thus, it makes a lot of 
difference when we replace a manual process with an excel based process. 

3. Wide range of pre-set functions – Excel’s function library is very rich. Therefore, for many calculations, 
there are ready made functions available. We simply need to supply some basic inputs and then we 
automatically get the output.  

4. Scope for automation – By using a language called VBA (Visual Basic for Applications), we can carry out 
programming in excel. A program can be written for a long and complex procedure of working with excel. Thus, 
we can reduce repetitive tasks to a click of a button! 

This leaves no doubt in our minds that MS Excel is one of the most suitable softwares for performing 
audits. Therefore, we must harness its power to our advantage and achieve our auditing objectives. 

1.7 Summary 
MS Excel is one of the most widely used softwares in the world. Especially, for auditors, excel is bread and 
butter. Excel is also needed by the different departments of an organisation. Departments like accounting and 
finance, marketing, purchase, production, human resources, administration etc. heavily use excel for carrying 
out their operations. 

As auditor, we need to obtain data for auditing purpose. This data may come in various formats like XML, CSV, 
PDF etc. We can bring that to excel and work upon it. 
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While obtaining audit data, we need to perform various steps. We need to raise a data request, do follow up, 
receive the data, validate for its correctness and then again follow up for proper data, if applicable. Audit data is 
critical for audit and therefore all these steps need to be carried out diligently. 

Once we receive the data and bring it in excel, we can do wonderful analysis of it. We can harness the key 
capabilities of excel like quick data processing, accurate computation, wide range of functions and capacity of 
automation to bring out the desired results. 

1.8 Multiple Choice Questions (MCQ) for Practice 
1. When was MS Excel launched for the first time?  

(a) In 1980s 

(b) In 1990s 

(c) In 2000s 

(d) After 2010 

2. MS Excel is used by which of the following departments: 

(a) Marketing 

(b) Accounting and Finance 

(c) Human Resources 

(d) All of the above 

3. Which of the following formats cannot be easily converted to excel? 

(a) CSV 

(b) PDF 

(c) Text 

(d) XML 

4. Rohan says to Deepali: 

(1)  There is no need to validate the data given by the auditee as excel data cannot be tampered with. 

(2)  We can do programming in MS Excel  

What can you say about the two statements? 

(a) Both of them are right 

(b) 1st statement is right but the 2nd statement is wrong 

(c) 1st statement is wrong but the 2nd statement is right 

(d) Both of them are wrong 
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5. Which language is used by excel for automation purpose? 

(a) Visual Basic 

(b) Java 

(c) C++ 

(d) Visual Basic for Applications 

Solutions 
1. (a) 

2. (d) 

3. (b) 

4. (c) 

5. (d) 
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USEFUL FUNCTIONS FOR 
AUDITING 

2.1 Introduction 
This chapter explores the various functions in MS Excel which can be profitably used by Chartered Accountants 
from an audit perspective. They help us in making calculations or deriving useful information from a dataset.  

MS Excel has a very rich function library. Various categories of functions are available like Financial, Logical, 
Text, Date & Time, Math & Trig, Lookup & Reference, etc. The function library is available in Formulas Tab.  

 

2.2 Difference between function and formula 
A function should be distinguished from formula. Both terms are used in excel, but they have different 
meanings. A function is a pre-set calculation methodology developed by Microsoft. It may require some inputs 
(known as arguments). When a user specifies those inputs, the function will calculate the intended output for 
that function. 

A formula, on the other hand, may involve multiple functions or may even be free from any functions. A formula 
is the complete structure of calculation laid down for the purpose of deriving the final output. 

CHAPTER 

2 
LEARNING OBJECTIVES 
 Be familiar with the rich variety of excel functions. 
 Be able to apply the functions. 
 Learn the differences and similarities between different functions 
 Study the intricate features of the functions and their arguments 
 Learn how multiple functions can be combined in some illustrative situations 
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Fig. 2.2.1: Function and Formula 

In Fig. 2.2.1, A4 cell has made use of sum function. As sum function is preset by Microsoft, it will automatically 
add the arguments of this function i.e. cells A1 and A2. On the other hand, cell A5 makes use of a formula. 
Here no function is used, but it will again add the cells A1 and A2. 

Important thing to note about functions is that their inputs/arguments are not always compulsory in nature. Most 
users often miss out on commas and brackets in a function. The best way to avoid that error is to closely 
observe the parameters that a function requires. For instance SUMIF function shows (range, criteria, 
[sum_range]) as parameters. Since sum_range is written in square brackets this part of the formula is optional. 
Every time a function is being written by the user, excel highlights a parameter in bold font Fig. 2.2.2. User has 
to ensure that they keep a track on this bold font. After every parameter user has to insert a comma and the 
moment they reach the last parameter brackets have to be closed. This information sounds very easy but most 
users don’t follow it and often end up with errors.  

 

Fig. 2.2.2: Parameter Highlighted 

We will now proceed to learn some important functions in MS Excel. 

2.3 Financial Functions 
Financial functions perform many of the common financial calculations required in project analysis, loan 
amortization schedules, valuation, asset depreciation etc. Let us explore few financial functions. 

2.3.1 NPV Function 

NPV stands for Net Present Value. This function is used to calculate the present values of all future cashflows. 
It is highly useful in project analysis. NPV for a project is calculated (based on its forecasted cashflows) using a 
rate of discounting (usually the cost of capital). If the NPV is positive, the project is accepted else it is rejected. 

The arguments of NPV are rate and values. Rate is the rate of discounting. Values are various cashflows 
occurring in future, starting from period 1. Therefore, if we wish to calculate the net present value of a project, 
we must include the future cashflows inside the function and we should subtract the initial cash outflow from it.  
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Fig. 2.3.1: NPV 

Above illustrates the use of NPV function as shown In Fig 2.3.1. The initial cash outflow is Rs 1,00,000. 
Subsequent cashflows, as expected in future, are laid down further. Insert NPV function and define the rate as 
10%. Then specify the range of values as B3 to B6, covering the future cashflows. Do not include the initial 
cashflow at this stage. Then close the function and thereafter, add the initial cashflow. Since the initial cashflow 
is entered as a negative figure, it reduces the present value of future cashflows and returns the NPV. 

The final structure of the formula is shown in B8 cell and the resultant value is shown in B9 cell. 

2.3.2 IRR Function 

IRR stands for Internal Rate of Return. It is related to the concept of net present value. IRR is the rate of 
discounting at which NPV = 0 i.e. the present value of all cash inflows is equal to the present value of all cash 
outflows. Thus, it is expressed in percentage form. IRR is another useful tool for project analysis. If IRR for a 
project exceeds its cost of capital then the project is accepted else it is rejected. 

The arguments for IRR function are values and guess rate. Unlike NPV function, all the cashflows (including the 
initial cash outflow) should be specified in values. Guess rate is an estimated IRR. This is an optional argument 
so it may or may not be specified by the user. If it is not specified by the user, excel assumes it to be 10%. 

 

Fig. 2.3.2: IRR 
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Above illustrates the use of IRR function as shown in Fig 2.3.2. The initial cash outflow is Rs 1,00,000. 
Subsequent cashflows, as expected in future, are laid down further. Insert IRR function and specify the range of 
values as B2 to B6, covering all the cashflows. You may specify the guess rate at, say, 12%. Then close the 
function and hit enter. The IRR will be computed by excel. 

The final structure of the formula is shown in B8 cell and the resultant value is shown in B9 cell. 

2.3.3 XNPV and XIRR Function 

NPV and IRR functions assume that the cashflows are spaced equally. However, in real life, we may come 
across many situations where the cashflows occur unevenly. In such cases, we may rather use the XNPV and 
XIRR functions in excel. These functions calculate NPV and IRR based on the dates of cashflows. Thus, they 
can enable us to carry out more meaningful project analysis when the cashflows are not periodic. 

XNPV function’s arguments are rate, values and dates. Rate is the rate of discounting, values are the cashflows 
and dates are the dates corresponding to the cashflows. All the arguments are mandatory.  

The arguments of XIRR are values, dates and guess. Values are the cashflows and dates are the dates 
corresponding to the cashflows. Guess is an optional argument which is an estimated IRR. If it is not specified 
by the user, excel assumes it to be 10%. 

 

Fig. 2.3.3: XNPV and XIRR 

Above illustrates the use of XNPV and XIRR functions as shown in Fig 2.3.3. We have a cashflow schedule with 
dates and cashflows. You may note that the cashflows are occurring on dates without any periodicity between 
themselves.  

Insert XNPV function with rate as 10%, values as the range B2 to B6 and dates as the range A2 to A6. Close 
the function, hit enter and the NPV is calculated. Similarly, insert XIRR function. Specify values as the range B2 
to B6 and dates as the range A2 to A6. You may specify the guess rate at, say, 12%. Then close the function 
and hit enter. The IRR will be computed by excel. 

The final structures of the formulas are shown in B8 and E8 cells respectively. The resultant values are shown 
in B9 and E9 cells, respectively. 
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2.3.4 DB Function 

This function is used for calculating depreciation as per Written Down Value method. You may use this function 
while verifying depreciation expense claimed by your auditee. The arguments of this function are cost, salvage, 
life, period and month. Cost is the original cost of an asset and salvage is its salvage value. Life denotes its 
useful life. In period, you must specify the period for which you wish to calculate depreciation. Month is an 
optional argument. You may specify the number of months for which depreciation needs to be calculated in the 
first year. Month becomes relevant when an asset is purchased in the middle of the year (which is almost 
always the case!). If month is omitted, it is taken to be 12.  

Internally, DB function first derives the applicable fixed rate of depreciation, based on the given inputs. For this 
purpose, it uses the following formula: 	 	1 	    

The above rate is then applied to each year, on a written down value basis.  If month is specified, the 
depreciation calculation for the 1st period and last period is done in a special manner.  	 	1 	 	 	 	 	 	 12 	 
 	 	 	 	 	 	 	 	 	 	12 	12 	 

 

Fig. 2.3.4: DB 

As shown in Fig 2.3.4, a fixed asset is assumed to be purchased on 01st September, 2011. Its cost is Rs 10 
Lakhs and salvage value is Rs 1 Lakh. Its useful life is 5 years. These details of the asset are enlisted in 
columns E and F. Depreciation based on these details is calculated for each year in column B. The underlying 
formulas are shown in column C.  

The year ending date for each year is 31st March. Since for the 1st year the asset was in existence for only 7 
months (01st September to 31st March), month has been specified as 7. You may note that even though we are 
making calculations for subsequent periods, nevertheless we need to keep specifying month as 7 in every 
formula. 
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DB is an extremely convenient function for calculating depreciation under WDV method and hence should be 
used frequently. 

2.4 Date & Time Functions 
More often than not, we are required to perform calculations on dates and timings. This may be necessary for 
interest calculations, deriving due dates, computing overtime wages, etc. Let us explore some important 
functions under Date & Time category. 

2.4.1 Eomonth Function 

Eomonth function is a very simple yet highly effective function. It lets you calculate the end of the month date 
corresponding to a given date. It also lets you calculate the end of the month date few months ahead or behind 
the reference date. It is useful for calculating maturity dates. It can also be used to obtain number of days in a 
month. 

The arguments of Eomonth are start date and months. Both are mandatory arguments. Start date is the 
reference date for which we wish to compute the end of month date. Months denotes the number of months 
ahead or behind we wish to obtain end of month date. For same month as reference date, enter months as 
zero. 

 

Fig. 2.4.1: Eomonth 

As shown in Fig 2.4.1, some dates are given in column A. The formula structures are given in column B and 
their output is given in column C. Eomonth function has been used throughout to achieve the month end dates. 

In case of the first date, month end date for the same month has been achieved. Thus, you may note that the 
second argument (months) has been defined as zero. For the 2nd date, month end date after 2 months was 
desired. Hence months has been defined as 2. Finally, for the 3rd date, months has been defined as -3 which 
yields month end date three months before.  

However, you may notice that eomonth returns the output formatted as numbers. The numbers, as we can see 
in column C, are not much useful for us. Hence, we need to format them as dates.  
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Fig. 2.4.2: Format being changed to Short Date 

As illustrated in the Fig 2.4.2, highlight the dates. Then go to Home tab and click on the dropdown button for the 
number format. From there, select Short Date (or any other date format as per your choice). Then the dates will 
get transformed to proper date format. Look at the following image. 

 

Fig. 2.4.3: Format changed to Short Date 

Let us consider another example. Suppose, we wish to ascertain the number of days in different months. The 
month beginning dates are available. In that case, we can derive the month end dates for those dates using 
eomonth, subtract the month beginning dates from them and add 1. This will yield the number of days for those 
months.  
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Fig. 2.4.4: No of days in a month 

The same has been done in the above image. Look at the example laid down in columns E to G. Column F 
shows the formula while column G shows the result. 

Eomonth function works very well for all the dates. It takes into account leap year factor, wherever applicable. 
Hence it is one of the most useful functions while making tricky calculations on dates. 

 2.4.2 Edate Function 

Edate is somewhat similar to Eomonth. The arguments are the same i.e. start date and months. However, the 
output is different. Eomonth returns the month end date, specified number of months before or after the start 
date. However, Edate returns the date with the same day which is specified number of months before and after 
the start date.  

For example, if the start date is 05th October, 2016 and months is 2 then Eomonth function will return 31st 
December, 2016. On the other hand, Edate function will return 05th December, 2016.  

This function can be helpful in deriving a schedule of dates at equal intervals. For example, Edate can be used 
to build a series of EMI due dates, at monthly intervals. 

 

Fig. 2.4.5: Edate 

As demonstrated in above Fig 2.4.5, we can see that Edate function helps us in building the monthly dates with 
the same day very easily. Similar to Eomonth function, Edate also returns the output by default formatted as 
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number. We may change that to Short Date format as discussed earlier. The final output will be as shown in Fig 
2.4.6. 

 

Fig. 2.4.6: Edate with Short Date format 

2.4.3 Networkdays Function 

This function calculates the number of working days between two dates. Networkdays can be used to verify 
employee benefits which are paid by the auditee on the basis of number of actual days worked during a period. 
Networkdays excludes all weekends (Saturdays and Sundays) in between two dates and returns the remaining 
number of days. 

There are three arguments to Networkdays function; start date, end date and holidays. Start date and end date 
are the starting and ending dates of the period under consideration. Both of them are mandatory. Holidays is an 
optional argument. If applicable, you may specify a range of cells containing holidays other than Saturdays and 
Sundays i.e. public holidays falling on weekdays. These dates will also be excluded. 

The start date and end date are included while returning the output of Networkdays. 

 

Fig. 2.4.7: Networkdays 
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In the above Fig 2.4.7, the start date is given in cell B1. End date is given in cell B2. A list of holidays is given in 
Column F. The working days excluding all weekends and holidays as listed is 62. This can be obtained using 
the Networkdays function. The construction of the formula is given in cell B4 and its result is shown in cell B6. 

Note, if you are using Excel 2010 and above there is a function called NETWORKDAYS.INTL it is similar to 
NETWORKDAYS except that it has an extra parameter called “weekend” that allows you to decide whether 
Saturday and Sunday both should be treated as weekends or any other day/combination of days as available in 
a drop down list. 

2.4.4 Workday Function 

Workday function is somewhat similar to Networkdays function. Networkdays returns the number of working 
days between two dates. On the other hand, Workday returns the working day before or after specified number 
of workdays with respect to a start date. The output of Workday will be a date. Workday, like Networkdays, 
excludes all weekends (Saturdays and Sundays). 

Workday has three arguments viz. start date, days and holidays. Start date is the base date. Days is the 
number of working days we wish to specify. If we want to go backwards and derive a date in the past, we must 
specify days as negative. Both these arguments are mandatory. Holidays is an optional argument. If applicable, 
we may specify a range of cells containing holidays other than Saturdays and Sundays i.e. public holidays 
falling on weekdays. These dates will also be excluded. 

 

Fig. 2.4.7: Workday 

In the above image, the start date is given in cell B1. Days is given in cell B2. A list of holidays is given in 
Column F. Now the Working day after 62 days from 01st January, 2017 can be obtained using the Workday 
function. The construction of the formula is given in cell B4 and its result is shown in cell B6. 

As in the case of Eomonth and Edate function, Workday function also returns the output formatted as a number. 
It can be converted to short date format after which the final output appears as shown in Fig 2.4.8. 
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Fig. 2.4.8: Workday with Short Date format 

Note, if you are using Excel 2010 and above there is a function called WORKDAY.INTL it is similar to 
WORKDAY except that it has an extra parameter called “weekend” that allows you to decide whether Saturday 
and Sunday both should be treated as weekends or any other day/combination of days as available in a drop 
down list. 

2.5 Math & Trig Functions 
Math & Trig category of functions includes a rich variety of functions but most of them are not relevant for 
auditors. They are rather useful for professionals from technical disciplines like engineering. Nevertheless, 
there are some functions which still provide lot of value while performing audits. Following is a brief discussion 
on the same: 

2.5.1 MOD Function 

Ordinarily, if we divide a number by some divisor and if the dividend is not completely divisible by the divisor, 
the quotient is expressed in decimal form. However, sometimes we are interested in obtaining the remainder 
separately. In such a case, we can make use of Mod function. 

Mod is a very simple function having only two arguments, number and divisor. Both are mandatory. 

 

Fig. 2.5.1: MOD 
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Say, we wish to obtain the days remaining after casting out completed weeks, in between two dates. This can 
be achieved quite easily, using Mod function. An example has been given in the above image. In B1 and B2 
cells, two dates have been entered. We may divide the difference between these two dates by 7. The integral 
portion of the quotient will be completed weeks. However, we are interested in the remainder. To obtain the 
remainder, use Mod function. Specify number as the difference between B2 and B1 cells and the divisor as 7. 

The construction of the formula is given in B6 cell and the resultant value is given in B8 cell. 

2.5.2 Quotient Function 

If Mod function is one side of a coin, Quotient function is its other side. Mod function returns the remainder of a 
division while Quotient function returns the integer portion of the division, ignoring the remainder.  

Quotient is also a simple function having two arguments viz. numerator and denominator. Both are mandatory. 

 

Fig. 2.5.2: MOD 

Let us extend the previous example. Suppose we wish to obtain the completed weeks, in between the two 
dates. This can be achieved quite easily, using Quotient function. In B1 and B2 cells, the two dates have been 
entered. We may divide the difference between these two dates by 7. To obtain the integral portion of the 
quotient, use Quotient function. Specify the numerator as the difference between B2 and B1 cells and the 
denominator as 7. 

The construction of the formula is given in B6 cell and the resultant value is given in B8 cell. 

2.6 Text Functions 
Text functions may be used for building up text values or for comparing text values. These could be sometimes 
very handy while performing audit operations. A couple of text functions are discussed below: 

2.6.1 Concatenate Function 

To concatenate means to link together or join. This function joins two or more text strings together. It is a very 
simple function. Its arguments are texts. We simply need to specify the multiple texts that we wish to combine. 
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Fig. 2.6.1: Concatenate Formula 

Let us say, we have a list of first names, middle names and surnames. We wish to combine all three and create 
full names. For this purpose, we can use concatenate. The formula structure is given in the above image. Each 
of the field values have been specified as different texts in the arguments. Please note that we must also insert 
space as a separator between two words. Therefore, text2 and text4 have been hard coded in the formula as “ 
“.   

Instead of using concatenate function we can also use the symbol ‘&’ (known as ampersand). In that case, the 
formula will be as shown in Fig 2.6.2: 

 

Fig. 2.6.2: Concatenate using ‘&’ 
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We must put ‘&’ in between two consecutive texts. Needless to mention, we must also include spaces for 
separating words.  

Ultimately, we can extend the formula to all the cells and the final result will be: 

 

Fig. 2.6.3: Final output 

2.6.2 Exact Function 

We may come across several situations where we would like to compare two values and check whether they 
are alike. If they are numeric values we can calculate the difference between the two. If the difference is zero 
then the numbers are alike. However, when those two values are text strings, then we cannot perform any 
mathematical operations on them. In such cases, we can make use of exact function. 

Exact compares two text strings and returns true or false. True means the texts are alike and false means they 
are not. Let us compare the values generated in the previous example using concatenate function and ‘&’ 
symbol. 
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Fig. 2.6.4: Exact 

Please note that Exact function is case-sensitive. Therefore, if the texts are otherwise same but cases are 
different, then Exact will return false. If you wish to perform a non case-sensitive comparison, consider the trick 
demonstrated in the Fig 2.6.5 

 

Fig. 2.6.5: Alternative where cases don’t match 

If we wish to compare D2 and E2 cells, simply type =D2=E2 in, say, F2 cell. If the two cells are alike, this 
formula will return true. This will happen even if the cases don’t match. 
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2.7 Lookup & Reference Functions 
Lookup and reference functions are very commonly used by auditors. In terms of frequency of usage, this 
category may easily score over the rest of the categories. Let’s learn some of the useful functions from this 
category: 

2.7.1 Vlookup Function 

This is the most frequently used function from Lookup & Reference category. Vlookup searches for a value in 
first column of a data/table_array and if it’s found, it returns a corresponding value from the same row but 
another column. It can be better understood with the help of an example: 

 

Fig. 2.7.1: Vlookup Example 

Say, we wish to plot beside every value of column J a corresponding value from column F. We can of course 
make use of find feature i.e. Ctrl + F and one by one find each value of column J in column A, copy 
corresponding value from column F and then paste it back in front of column J. However, that will be time 
consuming, some omissions or errors may creep in and definitely it will be a boring process the moment the 
number of items exceed a reasonable limit. 

A better solution in such a case is to make use of vlookup function. It will do the same thing what we discussed 
above in case of find, but it will do it much faster, thereby making the whole process scalable. 

To insert this function, type ‘=vlookup(’ in cell K3.  

 

Fig. 2.7.2: Arguments of Vlookup 
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There are four arguments for Vlookup function, viz. lookup value, table array, col index number and range 
lookup. Lookup value is the value we need to search. Table array is a rectangular array of data where we need 
to search the lookup value. The search of the lookup value is always performed in the left most column of the 
table array. Col index number is the column number belonging to the same table array, from which a 
corresponding value needs to be retrieved. All these three arguments are mandatory. Final argument is range 
lookup, which is an optional argument. It asks for true or false, true meaning approximate matching of lookup 
value and false meaning exact matching of lookup values.  

If range lookup is not specified, the default value is true. However, in almost all the cases of Vlookup we are 
actually required to go for an exact match of lookup values. Hence it is advisable to specify the range lookup as 
applicable. 

In our case, lookup value will be J3 cell i.e. ACC, table array will be the columns A to F (as we want ACC to be 
searched in Column A), Col index number will be 6 (since we wish to retrieve the closing price from column F 
which is the 6th column) and range lookup will be false (as we wish to match the lookup values exactly). 

At this juncture, your formula should look like as shown in Fig 2.7.3. 

 

Fig. 2.7.3: Construction of Vlookup formula 

Then close the bracket and press enter. You will get a value like below: 

 

Fig. 2.7.4: Result of Vlookup formula 

Drag the formula in cell K3 till the end of the column. And voilà, your job is done! 



Main source : ICAI

 downloaded from : taxupindia.com

USEFUL FUNCTIONS FOR AUDITING  

 ADVANCED INFORMATION TECHNOLOGY 169 

 

 

Fig. 2.7.5: Vlookup formula extended to all cells 

Points to be noted about vlookup: 

1. It is called vlookup because it performs a vertical lookup in the leftmost column of the table array. V stands 
for vertical. 

2. Lookup value is the value which is to be searched in table array. 

3. The search is always performed in the leftmost column of the table array. Therefore, we must start defining 
our table from that column where we expect the lookup value to reside. 

4. The column index number should be the relative position of the result column vis a vis the leftmost column. 
For example, if our table starts at E column and the result column is G, we will put the column index 
number as 3 (It will be incorrect if you think that G is the 7th column in the sheet and hence put it as 7). 

When do we use the range_lookup as true??? 

If you have been using vlookup for some time now, you might’ve wondered about this. Almost invariably, we 
end up specifying the range_lookup as false (or if you prefer, you may even put it as 0. In excel, true is denoted 
by 1 and false is denoted by 0). So the million-dollar question is, why at all did excel create this last 
parameter??? 

Let’s take another example to understand where we can (and must) specify the range lookup as true. 
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Fig. 2.7.6: Vlookup – 2nd Example 

We have a situation wherein we have a dump of salesmen who have made varying amounts of sales. They are 
eligible for varying rates of commissions, based upon a table which is marked in yellow. We need to plot the 
commission rate in front of each salesman.  

This is another eligible case for vlookup. If we plot the formula in cell C4, the lookup value will be B4, table 
array can be column F to column H and column index number will be 3. However, if we specify the range lookup 
as false, we will not get a single rate plotted. Instead, we will get the ugly looking #N/A errors! 

 

Fig. 2.7.7: Construction of Vlookup formula – using range lookup as false 

 



Main source : ICAI

 downloaded from : taxupindia.com

USEFUL FUNCTIONS FOR AUDITING  

 ADVANCED INFORMATION TECHNOLOGY 171 

 

So instead of range lookup being false, let’s specify it as true. Thereafter, drag the formula till the end and you 
will see that now we can see all the applicable commission rates, neatly plotted along the sales! 

 

Fig. 2.7.8: Construction of Vlookup formula – using range lookup as true – desired results are obtained 

Let’s understand how this works. As discussed earlier, if we specify range lookup as true, excel is going to 
perform an approximate match. The first lookup value is 41639. We are trying to perform a lookup column F (as 
it’s the leftmost column of our table array). Since this column essentially provides ranges like 0 to 5000, 5000 to 
15000, 15000 to 25000 etc.; it is unlikely that we will ever get the result by specifying an exact match. Thus we 
get the #N/A errors. 

However, when we specify an approximate match, excel tries to check whether any value in the leftmost column 
exceeds the lookup value. For instance, in the 1st example, 45000 exceeds 41639. So then it comes one row 
back and matches 41639 with 35000 (approximately) and accordingly, plots the result value as 6%. For this, 
inherently excel requires that the table should be sorted in ascending order on the basis of the leftmost column 
(Thankfully, in our case it was already sorted!). 

You may argue that 41639 is closer to 45000 than 35000 so why doesn’t excel approximately match 41639 with 
45000 instead of 35000? Well. the way it has been designed actually helps us. Let’s not forget that we are 
using approximate match for performing a lookup for ranges of values. So if your salesman is making sales of 
44900, you should logically pay him commission @ 6% i.e. the rate applicable to the range 35000-45000. The 
fact that it is just an inch away from 45000 won’t make you round it off to 45000 and hence award him a 
commission of 7%. 

To summarize, if you want to decide whether to use TRUE/FALSE in range_lookup just ask yourself this 
question, “Is my lookup_value being searched in a slab/range of numbers (like 1 to 100 ,101 to 200)?” if yes, 
then write true else write false. It is safe to assume that since only numbers can be searched in slabs, you will 
never write TRUE when your lookup value is a text. 
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2.7.2 HLOOKUP Function 

This function is very similar to Vlookup. You may visualize Hlookup as a horizontal Vlookup. In fact, the ‘H’ in 
Hlookup stands for horizontal.  

Hlookup is suitable when the fields of the table array are placed row wise. The arguments are Hlookup are 
almost the same as Vlookup. They are look up value, table array, row index number and range lookup. Since 
the fields are placed horizontally, instead of column index number we have row index number. The rest of the 
arguments are just the same. 

 

Fig. 2.7.9: Construction of Hlookup formula 

In the above figure, Closing prices are to be obtained for different securities. The security codes are given in 
Column A. The data is available in the range E1:AI8. You may note that the different fields (SC Code, SC Type, 
Open, High etc) are placed along the rows. Therefore, Hlookup function has been applied. 

The lookup value is A2 and table array is the range E1:AI8. ‘$’ symbols are used to fix the range. Since the 
desired field, Close, is in the eighth row of the table array, the row index number has been specified as 8. 
Finally, the range lookup is false. 

On pressing enter, the output is as shown in Fig 2.7.10. 
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Fig. 2.7.10: Result of Hlookup formula 

This formula may be dragged for all the cells and the final output for all the values is: 

 

Fig. 2.7.11: Hlookup formula extended to all the cells 

2.7.3 Index Function 

Index function returns the value or reference at the intersection of a specified row and column, from an array. It 
has two sets of arguments. First set has three arguments, viz. array, row number and column number.  Second 
set has four arguments, viz. reference, row number, column number and area number. If three arguments are 
specified then 1st set is used. If 4 arguments are specified then the 2nd set is used. Array / reference and row 
number are mandatory arguments while column number and area number are optional. 
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Let us have a look at a simple example: 

 

Fig. 2.7.12: Index – 1st three arguments 

Suppose we wish to obtain the value at the intersection of the 3rd row and 5th column of the above table. We 
can use index function for this. We will use the 1st set of arguments. Specify array as the range A1:G14, row 
number as 3 and column number as 5. We get the answer as 3465. 

The construction of the formula is given in Cell B17 and the result is given in cell B21. 

Now let us consider a situation where we wish to locate values dynamically from different arrays. That’s where 
we can use the second set of arguments of Index function.  
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Fig. 2.7.13: Index – All four arguments 

Suppose we have 3 sets of values, enlisted in columns A, B and C. We wish to obtain values dynamically from 
these lists. We can achieve that using index function. Specify the three ranges in the 1st argument i.e. 
reference, enclosed in round brackets and separated by comma. Say, we wish to obtain 5th value from each list. 
So specify row number as 5. Since there is only one column in each of the ranges, specify column number as 1 
or it may even be omitted. Finally, specify area number as a reference to required array. 

As the area number changes, we get values from different ranges. The formula construction is shown in cell G2 
and the results are shown in cells F2:F4. 

The row number, column number and area number arguments need not be constant values. They themselves 
may be references to other cells or other functions. Thus, we may design intelligent formulas using index 
function. 

Finally, think of INDEX as  

INDEX( data, row, column) or  

INDEX((multiple dataset), row, column, sr num of data set) 

Where row and column will always act as co-ordinates to get data from intersection. 

2.7.4 Match 

This function is somewhat similar to Vlookup. Like Vlookup, match searches for a lookup value inside an array. 
However, instead of returning a corresponding value, it returns the position or ranking of the lookup value inside 
the array. 

Match has three arguments viz. lookup value, lookup array and match type. Lookup value and lookup array are 
mandatory while match type is optional. 
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Fig. 2.7.14: Match 

In the above Fig 2.7.14, suppose we wish to search for the value 524208 in the range A1:A16 and ascertain its 
position in that range. For this, we can use match function. Specify lookup value as 524208 (i.e. A20 cell) and 
lookup array as A1:A16. Match type allows either of the three values; less than, greater than or exact match. 
We will select exact match.  

Since 524208 is the eighth cell in the range A1:A16, the output for this formula is 8. The result is shown in the 
cell B20 and the formula is shown in the cell C20. 

Match is often used inside other functions to construct powerful formulas. Let us see one example in the next 
section. 

Please note the second parameter of Match is lookup_array and not table_array, meaning you can select only 
one row or one column to be searched, if you select a table you will mostly end up with N/A error even if the 
data exists in the table. 

2.7.5 Index and Match Combo Function 

Vlookup function doesn’t support right to left lookup i.e. it doesn’t allow the lookup column in the table array to 
be on the right side of the column from which we wish to fetch values. The way Vlookup is designed, the lookup 
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column has to be the left most column of the table array. This sometimes creates a lot of difficulty as we are 
required to perform right to left lookup. 

In these situations, we may combine index function and match function to create a synthetic Vlookup. The best 
part about this combination is that it overcomes the constraint of left to right lookup only. 

 

Fig. 2.7.14: Index Match – Arguments of Index function 

In the above image, we need to search the lookup from column I in column F and obtain the corresponding 
prices from column D. However, column F is on the right side of column D. Hence, we cannot use vlookup here. 
Therefore, Index Match combination becomes relevant. 

To obtain the closing prices for the shares listed in column I, insert index function in cell J2. The array for index 
will be the result vector i.e. column D values. In place of row number argument, insert Match function. Now 
Match has its own arguments. Specify lookup value as I2 cell, lookup array as column F values and match type 
as exact match. Then close the Match function. 

On closing Match function, we return back to Index function. Specify the column number of Index as 1 or it may 
even be omitted. 

 

Fig. 2.7.15: Index Match – Arguments of Match function 

Now when we close the Index function and press enter, we get the desired output. We may copy paste the 
formula and extend it to other cells. 
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Fig. 2.7.16: Index Match – Results 

Index Match combination has the following advantages: 

1. It avoids data redundancy which happens if we decide to use Vlookup by copy-pasting the target column to 
the right side of the lookup column. 

2. It performs right to left lookup 

3. It can also be used as hlookup. Thus a single combination may replace two functions. 

4. The processing requirement is lower as compared to Vlookup. 

2.7.6 Indirect Function 

This function returns the reference specified by a text. Sometimes, we may build certain references using 
concatenate or some other functions. These references are stored as text strings by excel. If we wish to use 
these references as ‘references’ in our formulas, we must use Indirect function. 

Indirect function has two arguments, viz. reference text and A1. Reference text will be the reference generated 
by other functions or formulas (which has been stored as text). A1 is an optional argument. It lets you specify 
whether the said reference is in A1 format or R1C1 format. Normally, our references are in A1 format and that 
is the default value for this argument. Thus, we may omit specifying this argument in almost all the cases. 

Consider the following problem as shown in Fig 2.7.17 
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Fig. 2.7.17: Problem 

We have a list of clients against which we wish to plot their respective PANs. There are dedicated worksheets 
for different clients and their PANs are available in those sheets. The structure of each worksheet is uniform as 
given below in Fig 2.7.17. 

 

Fig. 2.7.17: Worksheet structure 

We may observe that PAN is available in I16 cell. This is true for all the worksheets. The challenge is how we 
can have dynamic references to all the worksheets so that we can pull the PANs from I16 cells of different 
worksheets, using a single formula? 



Main source : ICAI

 downloaded from : taxupindia.com

 MS-EXCEL AS AUDIT TOOL  

180  ADVANCED INFORMATION TECHNOLOGY 

First, we must build a formula to derive the cell reference. If I refer to the I16 cell of a sheet, say, T M G, it 
produces the following reference.  

 

Fig. 2.7.18: Reference to a cell in a different sheet 

We cannot copy paste this formula everywhere as it will keep showing the same PAN for all (coming from T M 
G sheet). Here sheet reference should be a variable. For this, we can make use of concatenate function. We 
will use ‘&’ symbols. 

 

Fig. 2.7.18: Reference generated by concatenate 

As per the syntax, we must have a single inverted comma before the sheet name and ‘!I16 after the sheet 
name. The same has been achieved using concatenate, as shown above.  

However, this reference is still in text format. We need to obtain the values which are residing on these 
references. For this purpose, we must use indirect function. 
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Fig. 2.7.18: Indirect 

The reference generated using concatenate has been enclosed in Indirect function. This finally pulls off the 
PANs from different worksheets. 

Think of INDIRECT function as call forwarding. You “call” a cell reference, that cell_reference gives you 
reference to another cell, your “call” thus gets forwarded to that new cell reference.  

2.8 Logical Functions 
These functions help in decision making using various logics. While performing audits, at times we need to 
make calculations based on various conditions. These functions help us doing that. 

2.8.1 IF Function 

If function is the leading logical function. This is fundamental to most of the audit processes as somewhere or 
the other, we are bound to come across condition based working.  

If function has three arguments viz. logical test, value if true and value if false. If the logical test is satisfied then 
the value if true is executed else the value if false is executed. 

Let us assume a hypothetical situation wherein we are auditing bonuses paid to employees. For this, we wish to 
compute the bonuses by ourselves and then compare with the auditee’s figures. Bonus @10% is payable to an 
employee is if he generates minimum sales of Rs 2 Lakhs. 
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Fig. 2.8.1: If function 

The situation has been presented in the above image. If function is inserted in C2 cell. The logical test is 
defined as sales value of an employee (B2 cell) being greater than or equal to the minimum sales ($G$3 cell). If 
this holds true, then the sales value is to be multiplied by the bonus rate ($G$1 cell).  

‘$’ symbols are used to fix the cells. 

This formula yields Rs 37,400 for the 1st employee as his sales are exceeding Rs 2 Lakhs and thus, 10% of Rs 
3,74,000 equals Rs 37,400. 

The formula may then be extended to other cells too. 

 

Fig. 2.8.2: If function – final output 

2.8.2 And & Or Function 

These two functions are highly similar. Hence, we can consider them together. Sometimes, there are multiple 
conditions, based on which calculations are to be made. Such calculations are required to be made when all 
conditions are satisfied or any one condition is satisfied. In such cases we can make use of these functions. 
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Use And function when all the conditions are to be satisfied. On the other hand, use Or function when any one 
condition is to be satisfied. 

Let us consider another situation, where again bonuses are to be paid. But this time, there are multiple 
conditions to be satisfied. 

1. The employee needs to be a full time employee 

2. He should have a job rating of more than 3 

When both the above conditions are to be satisfied, then And function should be used. This function should be 
used as a part of the logical test argument of If function. 

 

Fig. 2.8.3: And function 

In the above Fig 2.8.3, we can see that And function has been inserted inside If function. The logical test of If 
function is the combination of two logicals specified in And function; namely D2 = “Full Time” and E2 > 3. If and 
only if both these logicals are satisfied, then the value if true of the If function will be executed. 

 

Fig. 2.8.4: If function containing And function 

Above Fig 2.8.4 as shows the complete formula. If the logical test (built with the help of And function) is 
satisfied then salary will be multiplied by bonus percentage (F2 * $M$4) else it will be zero. This formula is 
extended to the subsequent cells as well. 
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Now let us consider the same situation with the same conditions. How to calculate bonus if we it is to be paid 
on the satisfaction of any one condition? For this, we should use Or function. Like And function, Or function 
should also be used as a part of the logical test argument of If function. 

 

Fig. 2.8.5: Or function 

This looks almost the same like And function. But the effect will be different. Even if any one condition is 
satisfied, the evaluation of Or function will be true and hence value if true of the If function will be executed.  

 

Fig. 2.8.6: If function containing Or function 

Above image shows the complete formula. If any one condition is satisfied then salary will be multiplied by 
bonus percentage (F2 * $M$5) else it will be zero. This formula is extended to the subsequent cells as well. 

We can see that many more persons are getting paid bonuses as Or function tends to generate true more 
number of times as compared to And function. 

2.8.3 NOT Function 

Not function is a negation function. It negates the logical evaluation and produces the opposite result. In simple 
words, Not function will convert true into false and false into true.  

It is a very simple function with a single argument, logical. Whatever logical is supplied, Not function generates 
the opposite of the evaluation of that logical. 
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Fig. 2.8.7: Not function 

In the above Fig 2.8.7, the logical is A1 < 10. Since A1 contains 7, this logical gets evaluated to True. However, 
this logical is enclosed inside Not function. Therefore, the evaluation of the complete formula is False. 

The structure of the formula is shown in B3 cell and the result is shown in B5 cell. 

2.8.4 IFERROR Function 

Iferror is a brilliant function introduced in Excel 2007! This function may be viewed as a special case of If 
function. It has two arguments, value and value if error. If the 1st value generates an error of any kind (eg. #N/A, 
#REF!, #VALUE!, #DIV/0! etc.), then the value if error will be executed. If it doesn’t generate any error, then the 
1st value itself will be executed. 

 

Fig. 2.8.8: Vlookup returning errors at some place 
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Above Fig 2.8.8 shows a workbook with 3 worksheets. There are shares listed on NSE and BSE. We wish to 
perform a valuation of these shares by plotting the corresponding prices from exchanges in front of the shares. 
For this, vlookup on NSE has been inserted. For most of the shares, this formula works. But there are a couple 
of shares which are listed only on BSE, not on NSE. They bear #N/A errors in front of them.  

To do valuation for these shares, we need to apply a vlookup on BSE worksheet as well. Thus, some shares 
may require a lookup on one sheet while some shares may require a lookup on another. To solve this issue, we 
can use iferror function. 

 

Fig. 2.8.9: Iferror function 

As we can see in the above image, Iferror function has been used. Value is the 1st Vlookup on NSE while Value 
if error is the 2nd Vlookup on BSE. Whenever the Vlookup on NSE generates #N/A error, Vlookup on BSE gets 
applied. Thus, this single formula fetches prices for all the shares. 

2.9 Statistical Functions 
MS Excel provides an extensive range of functions to generate various statistics. Here we will have a look at 
some functions from this category which could be helpful from auditing point of view. 

2.9.1 COUNTA Function 

Counting of values is a fundamental activity while performing audit. We use Count function for counting 
purpose. However, we must bear in mind that Count function only counts numbers. If we wish to count text 
values, errors, cells with spaces etc; then Count function cannot be used. In such situations, we must use 
Counta function.  
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Counta counts all non-blank cells in a range of cells. As long as the cell is filled (either with number, text, error 
or with space), it will be counted. 

 

Fig. 2.9.1: Counta function 

In the above example, Counta function counts the number of non-blank cells in the range A2:A155. The result is 
154. The construction of the formula is given in cell C1 and the result is given in the cell C2.  

2.9.2 COUNTBLANK Function 

Countblank function is the reverse of Counta function. It counts all the blank cells in a range of cells. This could 
be used in detecting cells which have inadvertently remained blank or where data entry is incomplete. 

It is a very simple function with only one argument, range.  
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Fig. 2.9.2: Countblank function 

Consider the above example. Suppose we wish to ascertain the number of blank cells in the range E1 to E15. 
We can use Countblank function for this. The answer is 4. The construction of the formula is given in cell H1 
and the result is given in the cell H2.  

2.9.3 LARGE & SMALL Function 

This function returns the kth largest number from a list of numbers. Sometimes we are required to fetch 3rd 
largest or 5th largest value. For that, this function is very useful.  

Similarly, we have Small function. This will return the kth smallest number from a list of numbers. 

The arguments for both the functions are same. There are two arguments, array and k. Array is the list of 
numbers. K is kth largest or smallest number that we desire. 
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Fig. 2.9.3: Large and Small functions 

In the above Fig 2.9.3, there is a list of numbers in Column A. Suppose, we wish to ascertain the 4th largest and 
3rd smallest value. That can be achieved using Large and Small functions. The formula constructions are shown 
in E2 and E5 cells while the results are shown in D2 and D5 cells. 

Thus, these are some leading functions of each category. There are many more functions which may prove 
themselves to be useful, depending on the situation. Therefore, you must keep learning new functions from the 
functions library.  

2.10 Summary 
MS Excel has a rich library of functions, divided into various categories like Financial, Logical, Text, Date & 
Time etc. It helps if we learn the major functions from this library. 

To begin with, we should be able to distinguish between a function and a formula. Function is a preset 
calculation methodology developed by Microsoft. Formula is a structure of calculation developed by a user, 
which may or may not involve functions. 
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Following is a brief on leading functions from each Category: 

Financial Functions 

1. NPV – It calculates the Net Present Value for a series of cashflows. You must remember that the initial 
cashflow should not be included inside the formula. It should be subtracted separately outside the function. 

2. IRR – It calculates the Internal Rate of Return for a series of cashflows. Even the initial cash outflow should 
be included inside the formula.  

3. XNPV and XIRR – Similar to above, but these functions are used when the cashflows are not equally 
spaced. In that case, we use the dates corresponding to each cashflow. 

4. DB - It is used for calculating depreciation as per WDV method.  

Date & Time Functions 

1. Eomonth – It is used to calculate the month end date corresponding to a reference date, which could be 
few months ahead or before. 

2. Edate – This function returns the same day, few months ahead or before a reference date. 

3. Networkdays – It calculates the number of working days in between two dates, excluding weekends and 
holidays on weekday, if specified 

4. Workday – This function is similar to Networkdays. It returns the working day before or after specified 
number of workdays with respect to a start date, excluding weekends and holidays on weekday, if specified 

Math & Trig Functions 

1. Mod – It returns the remainder after dividing a number by a divisor 

2. Quotient – It is opposite of Mod. It returns the integral part of the answer when a number is divided by a 
divisor 

Text Functions 

1. Concatenate – It combines two or more text strings. Either concatenate function may be used or ‘&’ symbol 
can be used for this purpose. 

2. Exact – It is used for comparing two text strings and ascertaining whether they are alike. Exact is case 
sensitive. 

Lookup & Reference Functions 

1. Vlookup – It is the most commonly used lookup function. It searches for a value in the left most column of a 
table array and once found, then returns a corresponding value. Range lookup for Vlookup may be 
specified as true when a lookup is to be performed in a range of values (eg. 0-100, 100-200 etc). 

2. Hlookup – It is almost the same as Vlookup. Only difference it performs a horizontal lookup (i.e. row wise 
lookup). 

3. Index – It returns the value or reference at the intersection of a specified row and column, from an array. 
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4. Match – It is somewhat similar to Vlookup. It returns the position or ranking of the lookup value inside the 
array. 

5. Indirect - This function returns the reference specified by a text. 

Logical Functions 

1. If – It contains a logical test. If the test is satisfied then one action is taken else another action is taken. 

2. And & Or – They complement the If function. The can combine multiple logicals to form a consolidated 
logical test of the If function. Use And function if all logicals are required to be satisfied. Use Or function if 
any one logical is required to be satisfied. 

3. Not - It negates the logical evaluation of a statement. It converts true into false and false into true. 

4. Iferror – You need to specify two values, an original value and a value if error. If the original value returns 
an error, the value if error is executed else the original value itself is executed. 

Statistical Functions 

1. Counta – It counts all non-blank cells 

2. Countblank – It is opposite of Counta. It counts all blank cells. 

3. Large and Small – They return the largest and the smallest kth number in a list of numbers.  

2.11 Multiple Choice Questions (MCQ) for Practice 
1. The suitable function to find Net Present Value when cash flows are not equally spaced is: 

(a) NPV 

(b) XNPV 

(c) YNPV 

(d) ZNPV 

2. At IRR, the NPV is: 

(a) 0 

(b) Positive 

(c) Negative 

(d) Indeterminate 

3. DB function calculates depreciation as per: 

(a) SLM Method 

(b) WDV Method 

(c) Either SLM or WDV, as per user’s specification 

(d) Both SLM as well as WDV 
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4. Rajiv wants to find out the last day of the month corresponding to 03rd November, 2016. Which excel 
function should he use? 

(a) Edate 

(b) Emonth 

(c) Eodate 

(d) Eomonth 

5. Radha wants to find out the number of working days between 05/11/2015 and 06/07/2016. Which function 
she should use? 

(a) Workday 

(b) Edate 

(c) Networkdays 

(d) Eomonth 

6. Mod function returns the following: 

(a) Dividend 

(b) Divisor 

(c) Quotient 

(d) Remainder 

7. Sunil wants to join multiple text strings. He faintly remembers that some special symbol can be used for 
this purpose but he is not sure which symbol. He has approached you to seek guidance. Which symbol will 
you advise? 

(a) & 

(b) $ 

(c) @ 

(d) ! 

8. Exact function 

(a) Is always case sensitive 

(b) Is never case sensitive 

(c) Can be sometimes case sensitive, depending upon user specification 

(d) Can be sometimes case sensitive, depending upon nature of data 

9. Vlookup works in the direction: 

(a) Top to bottom 
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(b) Bottom to top 

(c) Left to right 

(d) Right to left 

10. H in Hlookup stands for: 

(a) Heavy 

(b) Horizontal 

(c) Hierarchical 

(d) Historical 

11. Which functions may be combined to mimic Vlookup? 

(a) Index Match 

(b) Indirect Match 

(c) Index Indirect 

(d) Index Not 

12. Which of the following functions return relative position of a value in an array? 

(a) Index 

(b) Match 

(c) Indirect 

(d) Iferror 

13. Which of the following functions returns the reference specified by a text? 

(a) Index 

(b) Match 

(c) Indirect 

(d) Iferror 

14. Which of the following functions has two sets of arguments/ways of writing function? 

(a) Index 

(b) Match 

(c) Indirect 

(d) Iferror 

15. If you wish to combine multiple conditions such that all of them should get satisfied, use: 

(a) And function 

(b) Or function 
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(c) Both the functions 

(d) Either of the two functions 

16. If you wish to combine multiple conditions such that any one of them should get satisfied, use: 

(a) And function 

(b) Or function 

(c) Both the functions 

(d) Either of the two functions 

17. Counta function counts: 

(a) Numbers 

(b) Texts 

(c) Errors 

(d) All of the above 

Solutions 

1. (b) 

2. (a) 

3. (b) 

4. (d) 

5. (c) 

6. (d) 

7. (a) 

8. (a) 

9. (c) 

10. (b) 

11. (a) 

12. (b) 

13. (c) 

14. (a) 

15. (a) 

16. (b) 

17. (d) 
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FORMULA AUDITING 

3.1 Introduction 
An organization compiles financial accounts throughout the year. After the accounts are finalized from the 
auditee’s end, they are sent for audit. Typically, this happens in the month of April or May, in India. The 
objective is to express an opinion whether the accounts reflect a true and fair view of the state of affairs of the 
business.  

Similarly, once a formula based template is developed in excel, we may wonder whether we have constructed 
the various structures properly. To satisfy ourselves, we may perform what may be termed as ‘Formula Audit’. 
This helps us in framing an opinion about robustness and integrity of the formulas.  

Formula Audit may also be performed for an already built and working structure. This may be done either to 
have a better understanding of the structures or to ascertain whether any formulas warrant updates or 
maintenance. 

As a part of our financial audits, we develop various formula based structures in excel. If we perform Formula 
Audit, then we will have more confidence in our working. If there are any anomalies in the formula construction, 
we can become aware of such anomalies in advance, before raising audit observations or at least before 
releasing the audit report. If the logic behind some formulas has undergone a change, then we can update such 
formulas. Thus, Formula Audit is of immense importance to Chartered Accountants. An excel error once cost  
24 million USD  to a firm called TransAlta, thus highlighting the need for formula auditing. 

3.2 Formula Auditing Group 
In Excel, we have a dedicated toolset available for the purpose of Formula Audit. It is available in Formulas 
Tab. 

CHAPTER 

3 
LEARNING OBJECTIVES 
 Be aware about the concept of Formula Auditing. 
 Learn the various features available in the Formula Auditing Group 
 Study the relevant options of Go To Special Window for Formula Auditing 
 Learn some handy tips for better Formula Auditing 
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Fig. 3.2.1: Formula Auditing Group 

In Fig. 3.2.1, the formula auditing group has been highlighted using oval shape. It contains various features like 
Trace precedents / dependents, Error Checking, Evaluate Formula etc. Let us now proceed to learn these 
features in details. 

3.3 Studying interrelationships between cells 

When we try to audit formulas, sometimes we would like to dig the precedents or the dependents for few cells. 
This helps us in understanding the interrelationship between the cells better. For this purpose, we can use 
Trace Precedents and Trace Dependents features from the Formula Auditing Group. 

3.3.1 Trace Precedents 

A formula generally involves other cell references. Sometimes, we may like to mark them clearly on the 
worksheet. For this, we can use Trace Precedents feature available in the Formula Auditing Group. 

 

Fig. 3.3.1: Situation requiring Trace Precedents 

Consider the above diagram as shown in Fig 3.3.1. The cell pointer is resting on cell M19. One may notice the 
long formula which has already been developed in M19 (look at the formula bar). To understand this formula, 
we may like to mark the precedent cells. 

On pressing F2, the precedent cells do get marked, but then we cannot see the result of the cell as shown in 
Fig 3.3.2. 
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Fig. 3.3.2: On pressing F2 

So, to eat the cake and have it too, we may use the Trace Precedents feature.  

 

Fig. 3.3.3: Trace Precedents 
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In the above diagram as shown in Fig 3.3.3, the Trace Precedents feature is highlighted by oval shape. Make 
sure that your cell pointer is resting on the cell M19 (i.e. the cell for which we wish to study formulas) and then 
click on Trace Precedents. 

 

Fig. 3.3.4: Arrows marking the precedent cells 

As we can observe in the above diagram, the precedent cells for the cell M19 are marked using arrows. 
Concurrently, we can read the formula as appearing in the formula bar and also read the result of the formula 
as appearing in cell M19. Thus, all the necessary inputs for the purpose of studying the formula are visible in 
front of our eyes. 

Now, it is also possible that some of the precedent cells themselves are formulas referring to some other cells. 
Thus, there could be many more cells which may indirectly affect our target cell. Sometimes, we may wish to 
mark all such direct or indirect precedents.   

In that case, keep clicking the Trace Precedents button till you don’t hear a beep sound, indicating that further 
precedents don’t exist. 
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Fig. 3.3.5: All precedent cells marked 

In the above diagram as shown in Fig 3.3.5, we can see all the precedent cells marked, either the direct or 
indirect precedents.  

After examining the precedents, if you wish to clear the arrow, use the Remove Arrows feature. 

 

Fig. 3.3.6: Remove Arrows 

We can see the Remove Arrows feature highlighted with the help of oval shape. On clicking it, the arrows will 
go away and we will return back to the view as it was before utilizing Trace Precedents feature. 
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Fig. 3.3.7: On clicking Remove Arrows 

3.3.2 Trace Dependents 

Sometimes, we wish to know dependents on a cell i.e. the cells which may get affected when we modify the 
value of a cell. This is especially essential when we think of deleting a cell. If a cell is deleted without bothering 
about tracing its dependents, the dependents cells will lose their input cell and hence will carry #REF! Error. 

 

Fig. 3.3.8: Trace Dependents 

In the above Fig 3.3.8, the Trace Dependents feature is highlighted by oval shape. Make sure that your cell 
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pointer is resting on the target cell (i.e. the cell for which we wish to trace dependents) and then click on Trace 
Dependents. It may be noted that the target cell itself may or may not contain any formulas. 

 

Fig. 3.3.9: On clicking Trace Dependents 

Above Fig as shown in Fig 3.3.9, the dependent cells marked by arrows, on clicking the Trace Dependents. 
Similar to Trace Precedents, we can have multi-level tracing of dependents. 
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Fig. 3.3.9: On clicking Trace Dependents 

You can see that all the levels of dependents, direct as well as indirect, are marked when Trace Dependents 
button is clicked repeatedly. This keeps happening till no more dependents are traceable, which is indicated by 
a beep sound. 

Similar to Trace Precedents, later we can clear the arrows using Remove Arrows feature which has already 
been discussed above. 

3.4 Go To Special for Formula Auditing 
Sometimes, Trace Precedents and Dependents generate lot of arrows. This becomes extremely confusing and 
we may wonder whether there is an alternate way of marking the precedents and dependents. Fortunately, we 
do have an alternate way of doing this. It is achieved using Go To Special feature.  

Go To Special is located in the Home Tab  Editing Group  Find & Select, as shown in Fig 3.4.1.  

 

Fig. 3.4.1: Go To Special 

On Clicking Go To Special, it opens a window with lots of options, like shown in Fig 3.4.2. 
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Fig. 3.4.2: Go To Special Window 

3.4.1 Trace Precedents – using Go To Special 

Keep the cell pointer on the target cell and then open the Go To Special Window. Select the option of 
Precedents. We also get to choose whether we want to highlight Direct only or All levels. In this example, we 
will select all levels. 

 



Main source : ICAI

 downloaded from : taxupindia.com

 MS-EXCEL AS AUDIT TOOL  

204  ADVANCED INFORMATION TECHNOLOGY 

Fig. 3.4.3: Precedents – All levels 

On clicking OK, all the Precedents are highlighted, as shown in Fig 3.4.4. 

 

Fig. 3.4.4: Precedents – All levels are highlighted.  

This is only a temporary selection and it will disappear once the active cell is moved. If you wish to retain the 
highlighting permanently, you may assign a fill color at this stage. 

 

Fig. 3.4.5: Precedents – All levels are highlighted using a fill color. 

You can see, once a fill color is given, it stays permanently on the cells and doesn’t disappear even if the cell 
pointer is moved elsewhere. 

3.4.2 Trace Dependents – using Go To Special 

Similarly we can highlight the dependents using Go To Special. Keep the cell pointer on the target cell and then 
open the Go To Special Window. Select the option of Dependents. You may select Direct only or All levels, as 
desired. 
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Fig. 3.4.6: Dependents – All levels 

On clicking OK button, the dependents at all levels will highlighted: 

 

Fig. 3.4.7: Dependents – All levels highlighted 

Of course, like Precedents we can obtain permanent marking by applying a fill color. 
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Note: None of the tools in excel can highlight precedents or dependents from other worksheets or workbooks.  
This remains as a limitation in excel. 

3.4.3 Highlighting all cells containing formulas – using Go To Special 

In addition to highlighting precedents and dependents, Go To Special can also highlight all cells containing 
formulas.  

 

Fig. 3.4.8: Selecting all formulas 

Activate the Go To Special Window. Then select Formulas, as shown above. We also get the option of 
highlighting formulas which yield any or all out of numbers, text, logicals and errors. Presently, we will let all of 
them be selected. On pressing OK, we get the following result: 
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Fig. 3.4.9: All formulas highlighted 

 

3.5 Showing all Formulas 
As the cells containing formulas get highlighted in front of us, we may become curious about the formulas 
contained in these cells. We may like to examine each of them. This may reveal us the nature of each formula 
and can also help us in identifying inconsistencies or other errors, if any. 

The basic method of checking the formulas is to visit each and every cell and press F2. However, this could be 
highly time consuming and in any case, we cannot have an apples-to-apples comparison. 

A better technique would be to use the Show Formulas feature in the Formula Auditing Group as shown in Fig 
3.5.1. 
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Fig. 3.5.1: Show Formulas 

On clicking the Show Formulas button, all the formulas in the entire worksheet open up as shown in Fig 3.5.2. 

 

Fig. 3.5.2: Show Formulas - applied 

One can study all the formulas at once. As we rest the cell pointer on a cell, it highlights the immediate 
precedents automatically, thus making it easier to study a formula. If one observes the formulas closely, he may 
even spot errors or inconsistencies in the formulas. 

To return back to the normal view, click on Show Formulas button once more. 
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Shortcut for show formulas options is Ctrl ~  .This may come handy. 

3.6 Error Checking 
Using Show Formulas, we can trace errors. However, for this we rely on the keen observation of the user. It is 
quite possible that we fail to spot some errors. Therefore, Microsoft has developed a dedicated tool for tracking 
down the errors. This tool is called as ‘Error Checking’ as shown in Fig 3.6.1. 

 

Fig. 3.6.1: Error Checking 

On clicking Error Checking, MS Excel runs through the formulas in the worksheet and identifies the common 
errors that may creep in while constructing formula based templates. 
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Fig. 3.6.2: Error Checking 

For example, on pressing Error Checking, excel may flash an error like the one shown in the above diagram. 
The error is present in D57 cell and one may note a green colored triangular comment mark on the top left hand 
corner of cell D57 (highlighted using circular shape).  

Excel shows the formula as contained in the formula and also describes the nature of the error briefly. It 
suggests an action to rectify the error. It also offers other options like help on error, ignore error etc. Thus, this 
tool provides lot of value in checking errors. 

 

Fig. 3.6.3: Other errors in the worksheet 

After the first error is checked, this tool runs through all the errors in the worksheet, one by one. This allows the 
user to take suitable action on each error.  
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Fig. 3.6.4: Error check is complete 

After all errors are identified and acted upon, excel flashes that the error check is complete for the sheet.  

 

Note: Error Checking only identifies certain common errors. Needless to say, it will not identify errors in the 
logic behind formula construction. 

3.7 Evaluate Formula 
We are often required to use excel files containing formula structures developed by other colleagues. We may 
go through the formulas build by them but we may not understand them at once. Alternately, we ourselves may 
have developed a formula structure in the past but now we may not be sure about the logic. In such cases, we 
may like to observe the step-by-step execution of the formula and deduce the logic behind the formula. 

Keeping this requirement in mind, Microsoft has developed the feature of Evaluate Formula.  

 

Fig. 3.7.1: Evaluate Formula 
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This tool lets a user execute the formula in a piece meal manner, thus letting him pause and understand the 
role played by each component  of the formula and how those parts integrate to generate the desired result. 

 

Fig. 3.7.2: Example 

Let us consider the formula contained in cell A4 in the above diagram. The formula is displayed in the formula 
bar. It starts with an If function and somewhere inside that a concatenate of few components has been 
achieved, using ‘&’ symbol.  

Say, you haven’t understood the formula by reading it from left to right and you are not sure how it returns the 
value ‘532284 TCFCFIN’. Especially, when many other cells in column A are identical to the corresponding cells 
in columns B and C. Thus, you may desire evaluating the formula step-by-step. For this, click on the ‘Evaluate 
Formula’ feature in the Formula Auditing Group. It will flash a window as shown in Fig 3.7.3 

 

Fig. 3.7.3: Evaluate Formula Window 
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The window shows the entire formula expression as contained in the cell. This expression will be evaluated in a 
piecemeal manner. You may notice that B4 in the expression is underlined, which indicates that B4 will be 
evaluated as soon as the ‘Evaluate’ button is clicked. We also have a Step in button (highlighted using oval 
shape). This button lets us understand the value contained in the cell reference about to be evaluated. Click on 
Step In. 

 

Fig. 3.7.4: Step In 

On clicking Step In, we can see that another section opens up below the expression, which displays the value 
contained in cell B4 (i.e. 532284). The cell pointer also moves to B4 cell. After this, to return back to the 
expression, click Step Out. 

 

Fig. 3.7.5: On Stepping Out 
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B4 cell in the expression is now replaced by its value, 532284. The cell pointer also returns back to A4 cell. The 
next part about to be executed is C4, which is underlined. Click Evaluate. 

 

Fig. 3.7.6: Next part to be evaluated 

C4 is now replaced by TCFCFIN. Now the next part to be evaluated is 532284 <> “TCFCFIN”. Click Evaluate. 

 

Fig. 3.7.7: Evaluation of statement 
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The part which was evaluated just now was a statement. Since it was a true statement, it has been replaced by 
TRUE.  Now the next part is again B4 cell. Click Evaluate. 

 

Fig. 3.7.8: B4 evaluated 

We can see that B4 is replaced by its value. Now the next part to be evaluated is the concatenate between this 
value and space. Click Evaluate. 

 

Fig. 3.7.9: Concatenate 
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We can clearly see the space after 532284. Now C4 will be evaluated again. Click Evaluate. 

 

Fig. 3.7.10: C4 evaluated 

C4 is replaced by TCFCFIN. Now the whole underlined matter is about to be evaluated. Click Evaluate. 

 

Fig. 3.7.11: 2nd Concatenate 

We can see that the 2nd and final concatenate works out to be 532284 TCFCFIN. Now, the formula appears to 
be much simpler. It stands out as an IF function; where the logical test has been evaluated as TRUE, 532284 
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TCFCFIN in place of the value if true and B4 cell in place of the value if false. Since the evaluation of the logical 
test is true, excel doesn’t waste time in evaluating B4. You may notice that the whole IF formula is underlined 
and will be evaluated at once now. 

 

Fig. 3.7.11: Final Evaluation 

Thus, excel discards B4 and presents the value if true i.e. 532284 TCFCFIN as the final result. Now, it’s 
possible that despite this step-by-step evaluation, you may not have understood the formula completely. In that 
case, excel lets you have the opportunity of doing the whole evaluation once more. For this, you need to click 
the Restart button. You can have as many rounds of evaluation as you wish, till you are not completely 
satisfied! 

3.8 Evaluate Formula using F9 key 
The Evaluate Formula feature we learnt in the previous section carries out a slow motion evaluation of the 
entire formula. On the other hand, if we want a quick evaluation of only one of the parts of the formula, we can 
make use of F9 key. 
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Fig. 3.8.1: Same Example 

Let’s consider the same example again. The complete formula appears in the formula bar. Suppose, you have 
understood the broad logic of the formula but you are not quite sure about the evaluation of the concatenate 
part (highlighted in rectangular shape above).  

In such a case, press F2 and highlight the said part, as shown below: 

 

Fig. 3.8.2: Highlight relevant part 

Then press F9. This will evaluate only the highlighted portion. 

 

Fig. 3.8.3: Partial evaluation 
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To evaluate the complete formula, don’t highlight any portion. Simply go inside the cell (by pressing F2) and 
then press F9.  

 

Fig. 3.8.4: Complete evaluation 

Caution: After evaluation using F9, exit the cell by pressing Esc key. If you press enter, the evaluated portion 
stays inside the cell and to that extent, you lose your formula! 

3.9 Formula Auditing Tips 
There are some commonly found errors which may inadvertently creep in. You should carefully watch out for 
them. These errors may not be detected by the Error Checking feature.  Let us have a look at them: 

3.9.1 Numeric Headings Included in AutoSum Totals 

 

Fig. 3.9.1: Numeric Product Codes 

Look at the above diagram. It shows zone wise sales of some products, represented by their codes. You may 
note that the product codes are numeric. 

Totals for all the zones together are desired in row 6. If you highlight the cells as shown above and use 
Autosum (highlighted using rectangular shape), we will get totals as shown in Fig 3.9.2. 
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Fig. 3.9.2: Wrong Totals 

These totals are wrong, as the Autosum has included the first row values as well, which are in fact the headers. 
This is clearly evident from the formula bar. 

 

Fig. 3.9.3: Right Totals 

To obtain the right totals, we need to rectify the formulas and make sure that the first row is excluded from the 
range of cells getting added. 

3.9.2 Ignoring Order of Operations 

This is a fundamental principle behind evaluating mathematical expressions, whether or not excel is used. 
Nonetheless, quite often, one fails to recognize it. Look at the following example in Fig 3.9.4. 

 

Fig. 3.9.4: Wrong Average Stock 
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Your assistant has calculated average stock, based on opening stock and closing stock. When you examine the 
figures, you may immediately note that the average stock is more than both the opening as well as closing 
stock. Average or Arithmetic mean can never exceed the highest value in the sample. Thus, you are perplexed 
how come your assistant has calculated such a figure. 

 

Fig. 3.9.5: Root Cause 

If you look at the underlying formula you may immediately spot the error. Your assistant has assumed that excel 
calculates from left to right and has accordingly constructed his formula. However, this is wrong.  

 

Fig. 3.9.6: Correct formula 

You may rectify the situation by putting B1 + B2 inside a pair of brackets. Alternately, you may also consider 
using average function. This should fix the issue. Thus, the right average value is 5, 50,000. 

 

Fig. 3.9.7: Correct formula 

In general, one must remember the following order of calculation which is followed by excel (or almost every 
other software, for that matter): 

Brackets  Exponents Division  Multiplication Addition Subtraction 

It is easy to remember this sequence using the acronym BEDMAS. 
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3.9.3 Beware of Reset Error Indicators 

Sometimes some common errors may occur while developing some formulas in excel. Such errors are indicated 
by green colored triangle at the top left hand corner of the cell.  

 

Fig. 3.9.8: Error indicated by green triangle 

However, if one prefers, he may decide to ignore this error as shown in Fig 3.9.9. 

 

Fig. 3.9.9: Ignore Error 

This will remove the green triangle as shown in Fig 3.9.10. 
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Fig. 3.9.10: Green triangle removed 

However, this is a potentially dangerous situation as the cell no more appears to be bearing any errors. 
Therefore, you may actually like to get the green triangle back. In that case, we can use the Reset Ignored 
Errors feature. For this, click on File  Options as shown in Fig 3.9.11. 

 

Fig. 3.9.11: File  Options 

This will open the excel options. Select Formulas. On the right hand side, you will notice Reset Ignored Errors. 
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Fig. 3.9.12: Reset Ignored Errors 

Now click on this button. This will bring back the green triangle. 

 

Fig. 3.9.13: Error Indicator is back 
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Note: It is difficult to trace the errors by using the green triangle indicator. A better idea is to use the Error 
Checking feature. This is, of course, assuming that errors are reset in the first place. 

3.10 SUMMARY 
After creating a formula based template, we may like to test our formulas for integrity and robustness. In that 
case, we can use the Formula Auditing Group, present in the Formulas Tab of excel. This tab carries various 
features like the following 

1. Trace Precedents / Dependents – Use this feature to trace the precedent cells (cells used as inputs for the 
active cell) or dependent cells (other cells which use the active cell as input). Precedents and dependents 
can be traced at direct or multiple levels. These are marked in the worksheet using arrows. 

2. Remove arrows – This is used to clear the arrows generated while using Trace Precedents / Dependents. 

3. Show Formulas – This opens up the worksheet and shows all the formulas in the sheet. 

4. Error Checking – Use this feature to trace common errors crept in while constructing formulas and rectify 
them. Of course, this will not highlight errors in formulas thanks to incorrect logic. 

5. Evaluate Formula–This lets us evaluate a formula slowly and steadily so that we can observe how it 
progresses and reaches to the result. This is extremely handy tool for understanding long and complex 
formulas, especially developed by others. 

In addition to the Formula Auditing Group, we have some more tools at our disposal for formula auditing 
purpose like: 

1. Trace Precedents / Dependents using Go To Special – We can use Go To Special to highlight precedents 
and dependents. This tool selects such cells. Thereafter, we can permanently mark these cells by changing 
their formatting features. 

2. Highlighting all formulas using Go To Special – Again, this tool can let us select all the formulas present in 
the worksheet. If required, we can also specify whether we would like to focus on formulas yielding only 
numbers, texts, logicals etc 

3. Evaluating a formula using F9 – By using F9 key, we can get a partial or complete evaluation of the 
formula, inside the formula bar. This is supposed to give us a quick idea of the evaluation. However, while 
exiting the cell, one must remember to press Esc key. If enter key is used, the evaluation stays in the 
formula. 

Finally, some tips may be kept in mind while dealing with formula based structures: 

1. Be careful when you have numeric column headings. While using Autosum feature, they may get added in 
your totals. 

2. One must remember the order in which mathematical operations are carried out. The acronym BEDMAS 
may help us to remember the order Brackets  Exponents Division  Multiplication Addition 
Subtraction 

3. Someone may remove error indicators put by excel, in the form of green triangle. Those can be restored by 
visiting File  Options Formulas Reset Ignored Errors.  
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3.11 Multiple Choice Questions (MCQ) for Practice 
1. The Formula Auditing Group is present in the ______________  tab: 

(a) Insert 

(b) View 

(c) Review 

(d) Formulas 

2. Trace Precedents will trace the cells which: 

(a) Use active cell as input 

(b) Are inputs for the active cell 

(c) Are independent of the active cell 

(d) None of the above 

3. Trace Dependents will trace the cells which: 

(a) Use active cell as input 

(b) Are inputs for the active cell 

(c) Are independent of the active cell 

(d) None of the above 

4. Which shape is used by Trace Precedents and Dependents to mark cells? 

(a) Arrow 

(b) Triangle 

(c) Circles 

(d) Diamonds 

5. Virat has come across a formula which he finds extremely confusing. He would like to work out each part of 
the formula step-by-step till he arrives at the final result. Which feature can he use? 

(a) Formula Audit 

(b) Trace Dependent 

(c) Evaluate Formula 

(d) F9 key 

6. Sania has a formula in front of her. She wants to quickly evaluate one small portion of the formula. She 
doesn’t intend to understand the complete flow of the formula. Which tool can she use? 

(a) Formula Audit 

(b) Trace Dependent 

(c) Evaluate Formula 
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(d) F9 key 

7. Which of the following operators will be executed first? 

(a) Addition 

(b) Multiplication 

(c) Exponents 

(d) Division 

8. Which of the following operators will be executed last? 

(a) Addition 

(b) Multiplication 

(c) Exponents 

(d) Division 

9. Errors are highlighted by excel using: 

(a) Green triangles 

(b) Red triangles 

(c) Green squares 

(d) Red squares 

10. To reset ignored errors, we must visit: 

(a) Error Checking 

(b) File  Options  Formulas 

(c) Both a and b are needed 

(d) Either a or b, as per your choice 

11. We cannot effectively trace the precedents / dependents from other worksheets or workbooks.   

(a) This statement is always true 

(b) This statement is false. This feature is available by default in all versions of excel. 

(c) Depends on the version of excel 

(d) By default no, but is possible if we make suitable changes in excel options. 

12. Which of the following tools can trace precedents / dependents? 

(a) Formula Auditing Group 

(b) Go To Special 

(c) Both of them 

(d) None of them 

13. To look at all the formulas in a worksheet at once, which feature can be used? 
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(a) Display Formulas 

(b) Show Formulas 

(c) Express Formulas 

(d) Open Formulas 

14. Which of the following errors will not be traced by Error Checking? 

(a) Inconsistent manner of defining formulas 

(b) Errors like #N/A, #REF! etc 

(c) Numbers stored as text 

(d) Error in the logic of defining the formula 

15. Go To Special is located in the ______________ tab: 

(a) Formulas 

(b) Home 

(c) File 

(d) Insert 

Solutions 
1. (d) 

2. (b) 

3. (a) 

4. (a) 

5. (c) 

6. (d) 

7. (c) 

8. (a) 

9. (a) 

10. (b) 

11. (a) 

12. (c) 

13. (b) 

14. (d) 

15. (b) 
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DATA ANALYSIS USING MS EXCEL 

 

4.1 Introduction 
The core function of MS Excel as a software is data analysis. Excel helps us in deriving information out of raw 
data.  

As auditors, we come across lot of financial data in excel. We need to study this data extensively without which 
we cannot give assurance about the auditee’s financial accounts. We need to derive some important statistics, 
categorise date, perform aging analysis, remove duplicates, detect gaps, consolidate data etc. For doing these 
activities, we can use excel very productively. 

Let us now see how we can do this effectively using excel. 

4.2 Duplicates 
Quite often, we come across list of values which we feel may contain duplicate values. We would like to mark 
such duplicate values and may also like to remove them. 

  

CHAPTER 

4 
 
LEARNING OBJECTIVES 
 Be aware about the need for Data Analysis. 

 Learn the various tools available for Data Analysis 

 Study Pivot Tables in Depth 

 Go through some practical case studies 
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4.2.1 Mark Duplicates 

 
Fig. 4.2.1: Data 

Consider the data as shown in Fig 4.2.1. We feel some records have got duplicated. We would like to highlight 
such records. There can be a variety of ways of doing this. We will presently make use of conditional 
formatting.  

Highlight the range of cells where you feel duplicate values may be present. In our case, we will highlight 
Column A as shown in Fig 4.2.2.  
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Fig. 4.2.2: Column A highlighted 
Then apply conditional formatting. It is located in the Home tab  Styles group as shown in Fig 4.2.3. 

 

Fig. 4.2.3: Conditional Formatting 
Click on conditional formatting and then click on highlight cell rules. There select Duplicate values as shown in 
Fig 4.2.4.  
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Fig. 4.2.4: Conditional Formatting  Duplicate Values 

A small window comes up. Here we get to select whether we would like to mark the duplicate values or we 
would like to mark unique values. Presently we will select duplicate values as shown in Fig 4.2.5.  

 

Fig. 4.2.5: Duplicate or Unique 

Then we can select the manner of formatting cells. We may either select one of the standard ways of formatting 
given by MS Excel or we may customize it. Right now, we will select ‘Light Red Fill with Dark Red Text’ as 
shown in Fig 4.2.6. 

 

Fig. 4.2.6: Light Red Fill with Dark Red Text 
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Now we can see that all the records with duplicate values are marked in red colour. Alternately, we could’ve 
also marked only the unique values as shown in Fig 4.2.7. 

 

Fig. 4.2.7: Duplicate values highlighted 

4.2.2 Remove Duplicates 
The above process will only mark the duplicates. If we wish to remove the duplicate values, then we need to 
make use of another feature called ‘Remove Duplicates’. This is a dedicated feature introduced in Excel 2007 
only to remove the duplicate values.  

Go to Data tab  Data Tools group and click on Remove Duplicates as shown in Fig 4.2.8.  
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Fig. 4.2.8: Remove duplicates 
A small window comes up. First of all, check whether the checkbox of ‘My data has headers’ is rightly or 
wrongly, ticked or unticked.   

 

Fig. 4.2.8: My data has headers – not ticked 

In our case, we can see that it has been wrongly unticked. So let us tick it now.  

Then we can select the column(s) which may contain duplicate values. Click on ‘Unselect All’ button and then 
select the Full name column a shown in Fig 4.2.9.   
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Fig. 4.2.9: Full Name ticked 

Thereafter, click on OK button. We will get a report about the duplicate values removed as shown in Fig 4.210. 

 

Fig. 4.2.10: Duplicate values removed 
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Now we can work on the unique values only. 

4.3 Sort 
The data that we receive for audit purpose may not be arranged in the order that we desire. In such cases, we 
would like to arrange the records in the data in the order that may be suitable to us. 

  

Fig. 4.3.1: Data 
Consider the data in the above diagram. We can see records arranged in a random order. We may like to 
arrange them in a different order, say, first on the basis of ‘Name’, then on 'Date of Payment / Credit' and then 
on 'Amount paid/ Credited'. For this purpose, we can use the sort feature. Sort is located in the Data tab  
Sort & Filter group as shown Fig 4.3.2.  

 

Fig. 4.3.2: Duplicate values removed 
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Click on the sort button. The sort window opens up. Similar to Remove Duplicates feature, check whether the 
checkbox of ‘My data has headers’ is rightly or wrongly, ticked or unticked. Here it is already rightly ticked. 

 

Fig. 4.3.3: Sort Window 
Click on the dropdown of ‘Sort by’ and select ‘Name’. We are desirous of a multi-level sort. Thus, click on ‘Add 
Level’ Button to add further levels as shown in Fig 4.34.  

 

Fig. 4.3.4: Sort Levels added 
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Specify the other two fields i.e. 'Date of Payment / Credit' and 'Amount paid/ Credited'. The final window will be 
as shown in Fig 4.3.5. 

 

Fig. 4.3.5: Sort – All Levels specified 
Now click on OK button to sort the data. After sort, the data appears as shown in Fig 4.3.6. 
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Fig. 4.3.6: Data is sorted 

4.4 Filters 
Often, we would like to short-list records out of a big dataset, on the basis of some or the other criteria. This lets 
us focus on one portion of the dataset at a time. For this purpose, the most suitable tool will be filters. 

Filters are available in Data Tab  Sort & Filter Group as shown in Fig 4.4.1 

 

Fig. 4.4.1: Filter 
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Filters may be classified into three categories; text filters, numeric filters and date filters. Let us study them one 
after the other: 

4.4.1 Text Filters 

Consider the following data. 

 

Fig. 4.4.2: Data 

We would like to apply filters and short list it based on various criteria. For that, go to Data Tab  Sort & Filter 
Group and click on Filters. Dropdown buttons will appear on top of the header as shown in Fig 4.4.3.  

 

Fig. 4.4.3: Filter Dropdown 
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Click on the drop down button. It will let you tick and untick values. Untick (Select All) and tick say, IDFC 
ARBITRAGE PLUS FUND as shown in Fig 4.4.4. 

 

Fig. 4.4.4: IDFC ARBITRAGE PLUS FUND ticked 

Press OK. Now Only IDFC ARBITRAGE PLUS FUND values are visible.  
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Fig. 4.4.5: Only IDFC ARBITRAGE PLUS FUND values 

This ticking and unticking options are available in case of numeric and date filters also. We can see that the row 
numbers are blue in colour. This is a very obvious indicator that the list is a filtered list.  

To see all the records once more, go to Data Tab  Sort & Filter Group and click on Clear button a shown in 
Fig 4.4.6.  

 

Fig. 4.4.6: Clear Button 

In Excel 2010, a new search window has been incorporated in filters which enhances filtering experience a lot!  
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Fig. 4.4.7: Search Window 

We can type matter in this window and get the data filtered. For example, suppose we are interested in all 
schemes containing ‘Equity’. In that case, type ‘Equity’ in the search window as shown in Fig 4.4.8.  

 

Fig. 4.4.8: Equ in Search Window 
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Even before completing the spelling, all the schemes containing ‘Equity’ appear. Press OK.  

 

Fig. 4.4.9: All Equity Schemes 
Quite often, we mark important values by using colour. Later, we may desire obtaining a list of all such values 
together. For this purpose, again filters can be used. Click on the filter drop down button, filter by colour and 
select yellow colour as shown in Fig 4.410. 
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Fig. 4.4.10: Filter by Colour 

On clicking yellow colour, we get all the yellow marked records as shown in Fig 4.4.11. 

 

Fig. 4.4.11: Yellow coloured records 
We have lot of text filters options too.  
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Fig. 4.4.12: Other text filter options 

There are options like begins with, ends with, contains, does not contain etc. We can use these options 
judiciously. We can also combine any two of these using custom filter and achieve the required filtering. You 
are advised to practice these options.  

4.4.2 Numeric Filters 
Numeric filters get applied in case of fields containing numbers. In numeric filters, we have the options of ticking 
– unticking values and filter by colour, similar to text filters. However, we rather make heavy use of the number 
filter options. Let’s have a look at them. 

 
Fig. 4.4.13: Number Filters 
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We can perform filtering using greater than, less, between etc. option. Top 10 option allows let us filter for the 
top 10 values. However, top 10 need not be ‘top 10’ always. Instead of top, we can select bottom. Instead of 10 
we can specify other numbers. Instead of number of items we can specify percentages. Thus, we have lot of 
flexibility in top 10. 

We can also use above average and below average. Finally, we can combine any two criteria by using custom 
filter as shown in Fig 4.4.13. 

4.4.3 Date Filters 
Date filters get applied in case of fields containing dates. In date filters, we have the options of filter by colour 
and ticking – unticking values, similar to text filters. But there is one difference. 

 

Fig. 4.4.14: Hierarchy in Dates 
There is a tree structure for the dates. As dates follow a hierarchy of Year  Month  Day, we can do ticking 
– unticking at different levels. If a year is unticked, then all the dates in that year will be unticked.  This is 
extremely convenient. Nevertheless, we rather make heavy use of the date filter options. Let’s have a look at 
them. 
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Fig. 4.4.15: Date Filters 
We can do filtering for before, after or between two dates. This is similar to greater than, less than, between 
etc. in numeric filters. We can filter for today, tomorrow, yesterday; this week, next week, last week; etc. We 
can also obtain year to date records. One of the most fascinating filters is ‘All Dates in the Period’. Here we can 
obtain records for different months or quarters, irrespective of years.  

Finally, we can again combine multiple criteria by using custom filters. 

Excel filters have a wide variety. You are advised to study them carefully. 

4.5 Consolidation of Data 
Sometimes we come across data which is distributed across multiple worksheets. In such cases, we would like 
to bring the data in all such worksheets together. One may immediately think of using copy paste. 
Unfortunately, the headers don’t always match. Therefore, we need a little more intelligent tool which will 
consolidate data based on the headers. 
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Fig. 4.5.1: Different worksheets with varying headings 
In the above diagram, we can see 4 worksheets representing 4 zones of the country. In each sheet, the row 
headers (Products) and column headers (Quarters) are varying. We would like to consolidate the data in these 
4 worksheets into a single worksheet.  

For this we can use a feature called Consolidate. It is available in Data Tab  Data Tools Group as shown in 
Fig 4.5.2 

 

Fig. 4.5.2: Consolidate 
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To consolidate your data, go to the destination sheet and keep the cell pointer on the cell where you would like 
to place your output. Then click on Consolidate button. It will flash a window.  

 

Fig. 4.5.2: Consolidate Window 

It will ask for references. Here, one by one, we need to specify the ranges which we wish to consolidate. Visit 
each worksheet, highlight the range and click on Add button as shown in Fig 4.5.3.  

 
Fig. 4.5.3: Adding References 
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Like this, visit all the sheets one by one, highlight the ranges and keep adding them. Tick use labels in top row 
and left column. Also tick Create links to source data. Finally, the Consolidate window appears as shown in Fig 
4.5.4. 

 

Fig. 4.5.4: All references added 

At the end, press OK. The data will be consolidated and will appear as shown in 4.5.5 

 

Fig. 4.5.5: All data consolidated 
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These are the subtotals across all worksheet. If we wish to view the individual values, we can clik on the level 
2, as it appears on the top left hand corner as shown in Fig 4.5.6. 

 

Fig. 4.5.6: Data at Level 2 

Unfortunately, Consolidate doesn’t present the source sheet names in front of the values. Instead, it plots the 
workbook’s name itself. 

4.6 Pivot Tables 
It is one of the most powerful features of excel for data analysis. As you advance in excel proficiency, sooner or 
later you are bound to use Pivot Tables for efficient data analysis. Even though it’s highly effective, quite 
ironically, it is also one of the most user friendly features of excel. It’s a vast and fascinating topic. Let’s explore 
it a bit now. 
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4.6.1 Preparing Your Data for Analyzing 
For using Pivot Tables, we need to have a dataset in rectangular format (also known as flat format) i.e. the data 
should be composed of fields placed in columns and records placed in rows. Thus, it should assume a 
rectangular shape. Also, every column should have a heading. If there are no headings, excel cannot create a 
Pivot Table. 

 

Fig. 4.6.1: Data 
In the above diagram, we can see that fields like Scheme_name, Asset_type, Units, rate, nett_val etc are 
placed in columns. The records are given in rows. Every column has a heading. Thus, this data is in flat format 
and hence can be analyzed using Pivot Tables. 

4.6.2 Creating Pivot Table 
Pivot Table is available in the Insert Tab  Tables Group as shown in Fig 4.6.2. 
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Fig. 4.6.2: Pivot Table 

Click on Pivot Table button. It opens an interactive wizard.  

 

Fig. 4.6.3: Create Pivot Table Window 
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First of all, we need to specify the data that we wish to analyze. Either we can specify a table or a range of 
cells. By default, excel considers the region around the active cell. Alternately, we can also use an external 
data source. 

Then we need to specify where to place the PivotTable report. We can either place it in a new worksheet or an 
existing worksheet. Pivot Table, as we will discover later, is highly dynamic in nature and quickly changes its 
dimensions. Thus, generally it’s advisable to place it in a new worksheet. That is also the default option. 

Make changes if necessary and then click on OK button. 

 

Fig. 4.6.4: Blank Pivot Table 
This inserts a new worksheet and shows the Pivot Table layout (which is presently blank). There is a field list 
on the right hand side of the worksheet and enlists different fields. It also has four sections; Report Filter, 
Column Labels, Row Labels and Values. 

4.6.3 Adding Fields to Pivot Table 
As written in the instruction in the above diagram, we need to choose fields from the Pivot Table field list and 
drop them in one of the four sections so that we can build a report. 

The fields are to be dropped in the proper section based on the following logic: 

1. Report Filter – Drop fields in report filters if you wish to filter the Pivot Table 

2. Column Labels – Drop fields over here so that the values of the fields become column labels 

3. Row Labels - Drop fields over here so that the values of the fields become column labels 

4. Values - Drop fields over here so that computations like sum, count, min, max etc. can be done on the 
values of such fields. 
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Thus, row labels and column labels will be the outline or the framework of the report while values will be the 
main body. Accordingly, we may decide which column should be dropped where. 

Presently, let us put scheme_name in Row Labels and net_val in Column Labels.  

 

Fig. 4.6.5: Scheme wise Totals 
We can see that a list of scheme has been created by excel in column A and the sum of net value for each of 
those schemes has been generated in column B. The best part of this is that the entire job of enlisting the 
unique values of schemes and generating corresponding totals is handled by excel itself. 

4.6.4 Changing Field Statistics 
It is not necessary that we need to always have sum of a field. We can also obtain other statistics like count, 
min, max etc. For this, click on the field in the Values section and select the last option Value Field Settings. 



Main source : ICAI

 downloaded from : taxupindia.com

DATA ANALYSIS USING MS EXCEL  

 ADVANCED INFORMATION TECHNOLOGY 257 

 

Fig. 4.6.6: Value Field Settings 

Then a window appears which lets us select the appropriate statistic. Say, we select Max over there so that can 
have maximum value for each scheme. 
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Fig. 4.6.7: Max 
Now click on OK. This will update the values to maximum value for each scheme. 
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Fig. 4.6.8: Scheme wise Max 
We can also express the values in a variety of ways. Activate the window of Value Field Settings once more.  

Select Sum once more.  

 

Fig. 4.6.9: Back to Sum 
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Then click on Show Values As tab. There default value is No Calculation. But you may select any of the multiple 
values available. Select % of Grand Total. 

 

Fig. 4.6.10: % of Grand Total 

Press OK. We can see that the absolute figures of sum have got converted into percentages.  
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Fig. 4.6.11: Scheme wise Percentages 

These all are percentages of the grand total value. Now come back to absolute figures by again selecting No 
calculation.  

 

Fig. 4.6.12: Back to absolute values 
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4.6.5 Showing Two or More Fields in the Data Area 
Till now we have used only one field each in Row Labels and Values sections. We can involve multiple fields, if 
we wish to. Say, we would like to see the values scheme wise but broken separately for purchase and sales. 
We would also like to see the number of trades i.e. count of scheme names. 

For this drag and drop pur_sal field into Row Labels and scheme_name field in values segment. The resultant 
output will be as shown in Fig 4.6.13 

 

Fig. 4.6.13: Multiple fields 
One great part about Pivot Tables is that we can fine tune the layout as per our choice. For example, if we feel 
that a better presentation can be achieved by showing Pur and Sal along the columns, we simply need to drag 
and move pur_sal from Row Labels to Column Labels as shown in Fig 4.6.14. 

 
Fig. 4.6.14: Pur and Sal in Columns 
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We may also consider presenting Pur and Sal as main columns and Sum and Count as sub columns. In that 
case, click on pur_sal in Column Labels and then click on Move up. 

 

Fig. 4.6.15: Move Up 
The resultant output is as shown in Fig 4.6.16: 

 

Fig. 4.6.16: Pur Sal Moved Up 
This feature of swiftly changing the layout of a table is known as ‘pivoting’. We can do pivoting very easily using 
Pivot Tables. Therefore, they are known as ‘Pivot’ Tables. 

4.6.6 Eliminating Blank Cells from the Data Section 
In the above diagram we can see that there are many blank cells (For e.g., cell B14). In place of blanks, we 
may like to show 0. This can be achieved by changing Pivot Table options.  

At the top, there is the pink coloured PivotTable Tools Tab. It in turn contains Options Tab. Go to Options Tab 
 Pivot Table Group  Options  Options   
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Fig. 4.6.17: Pivot Table Options 
On clicking Options, we see the Pivot Table Options window. In its Layout & Format Tab  Format section, 
there is a check box saying For empty cells Show. There enter 0.  

 

Fig. 4.6.18: Zero for blanks 

Click OK. We can see that all the blank cells are now replaced by 0.  

 

Fig. 4.6.19: Blank cells now replaced by 0 
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4.6.7 Using Filters of Row / Column Labels 
Suppose we wish to see selected row / column label values. In that case, we can use the filters given over 
there. For example, let us say we are interested only in purchase details. We can select Pur from the dropdown 
filter button given on Column Labels.  

 

Fig. 4.6.20: Column Label Filters 
On pressing OK, we can see that Sal details have vanished.  

 

Fig. 4.6.21: Filtered List 
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We may do a similar thing in case of Row Labels. Say, we want to see details only for IDFC All Seasons Bond 
Fund, IDFC Dynamic Bond Fund and IDFC Cash Fund. We can select these values from the filter dropdown on 
Row Labels. 

 

Fig. 4.6.22: Filter on Row Labels 

Press OK and now we can see only selected data.  

 

Fig. 4.6.23: Filtered List 

To see 100% of the data click on Select All in both the filters. 

4.6.8 Top 5 Values 
We may also be interested in knowing the top values in the data. For this, we can use the Top 10 feature in the 
filters. Click on the filter dropdown of Row Labels, select Value filters and then select Top 10.  
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Fig. 4.6.24: Top 10 

The Top 10 window opens up. Even though it says ‘Top 10’, it need not be the top ten values. We can select 
top 7, top 5 or even top 3 values. Presently, we will specify top 5.  

 

Fig. 4.6.25: Top 5 items 

Press OK and you can see the top 5 values of net_val field. 
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Fig. 4.6.26: Top 5 items - result 
Note: We have lot of flexibility in Top 10. We can change top to bottom, 10 to any number and Item to 
percentage. 

4.6.9 Report Filters 
This kind of filtering is OK when we wish to filter one or more values present in the Pivot Table. But sometimes 
we come across a situation where we are required to apply filter on the entire table based on a field which is 
actually not a part of the Pivot Table. In such a case, we can make use of Report Filters. 

Say, in the above data, we wish to apply filters on the basis of asset_type field which in fact is not a part of the 
Pivot Table. Drag asset_type and put it in Report Filter section. 

 

Fig. 4.6.27: Report filter 

We can see that the phrase asset_type is entered in cell A1 and (All) is entered in the cell B1. It also has a 
dropdown button.  
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We can click on this dropdown and select values. Suppose, we wish to apply filter on the table based on the 
asset type as Equity. So we can select the value Equ as shown in Fig 4.6.28. 

 

Fig. 4.6.28: EQU 
Press OK and we can see that the table now shows only those values which correspond to equity as the asset 
type. Cell B1 shows ‘EQU’. 

 

Fig. 4.6.29: EQU result 
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We can multi-select too. Suppose, we are interested in Equity, non-convertible debentures, futures, repo and 
government securities. Click on drop down and tick ‘select multiple items. The values will now have checkboxes 
before them. Tick all the values mentioned above. 

 

Fig. 4.6.30: Select Multiple Items 
Press OK. We can see Multiple Items written in the cell B1. The resultant output will be as shown in Fig 4.6.31. 

 

Fig. 4.6.31: Multiple Items - result 

To see 100% of the data click on (All) in the dropdown. To remove the Report Filter, click on asset_type in 
Report filter section and click on Remove Field.  
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Fig. 4.6.32: Remove Field 

4.6.10 Drilling Down To See Detail 
We may become curious about one or the other figure generated by Pivot Table. We may like to obtain the 
underlying records for that value. This can be done very easily in Pivot Table. 

 

Fig. 4.6.33: Curious about a figure 
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In the above diagram, suppose we find the number 565358788.89 as generated by Pivot Table (marked with 
cell pointer) interesting.  We wish to go through the underlying records which make up this value. In that case, 
simply double click on this number.  

 

Fig. 4.6.34: Underlying records opened in a new sheet 
The underlying records open up in a new worksheet as shown above.  

4.6.11 Pivot Tables and Recalculation 
One unfortunate thing about Pivot Tables is that it doesn’t automatically update itself when the underlying 
undergoes a change. This is because excel copies the underlying data in its memory, in order to save time in 
updating the Pivot Table. Therefore, for any change in the data, we must remember to ‘Refresh’ Pivot Table. 

Consider the Pivot Table as shown in the earlier diagrams. One of the Row Labels is IDFC Cash Fund. 
Suppose, we realize at a later point that the scheme has undergone a name change, hence the revised name 
for the scheme is now IDFC Cash & Cash Equivalent Fund. This we may update in our data.   

 

Fig. 4.6.35: Changes in records 
As shown in the above diagram, we may use Find and Replace feature to replace all occurrences of ‘IDFC 
CASH FUND’ with ‘IDFC CASH AND CASH EQUIVALENT FUND’. Thus, the values in data get updated. 
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Fig. 4.6.36: Replacements done 
However, the Pivot Table will not get updated automatically. For that, Go to Pivot Table Tools  Options Tab 
 Data Group  Refresh 

 

Fig. 4.6.37: Pivot Table still showing old values 
On clicking Refresh, we can see that the scheme name has now got updated. 
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Fig. 4.6.38: Pivot Table Refreshed 

4.6.12 Limitations of Pivot Tables 
While Pivot Tables are a fascinating tool of data analysis, they suffer from few limitations: 

1. We cannot insert rows or columns in between a Pivot Table report. 

2. Pivot Tables don’t auto-update themselves. We need to refresh them. 

3. The data needs to be in rectangular i.e. flat format 

4. If the number of records are very large, Pivot Tables may respond slowly  

We’ve looked at few tools of data analysis. Now let’s look at some practical case studies where we can apply 
the tools of data analysis. 

4.7 Gap Detection 
We know that key documents like invoice numbers should be serially numbered. However, sometimes there 
may be some invoices which could be ‘missing’. In other words, gaps may exist in between two numbers. We 
can detect gaps by bringing together some tools in excel. 
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Fig. 4.7.1: Data 

Consider the above data. At a cursory glance, we may get an impression that all the invoice numbers are 
serially numbered. However, this may or may not be completely true. We may like to test whether any gaps 
exist. 

Ideally, we could’ve simply extracted difference between two consecutive invoice numbers. This would work 
where we have purely numeric invoice numbers. But over here, we have alphanumeric invoice numbers. Thus, 
we cannot calculate the difference directly. We need to separate the numeric part first. 

If we observe closely, we can see that all the invoice numbers are exactly six characters long and that only the 
first two characters are alphabets, rest four are numbers.  Thus, we can use right function and extract the 
numeric part. 

 

Fig. 4.7.2: Right Function 
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Drag the formula till the bottom. Then we will get a series of numbers. 

 

Fig. 4.7.3: Numeric Part 
The numbers may carry prefix 0s, but that is alright. Now derive the difference between the two consecutive 
numeric parts. It they are serially ordered, the difference should be one. 



Main source : ICAI

 downloaded from : taxupindia.com

DATA ANALYSIS USING MS EXCEL  

 ADVANCED INFORMATION TECHNOLOGY 277 

 

Fig. 4.7.4: Difference 
The best way to check whether the numbers are 1 or no is through filters. Apply filters and check for the 
different values. 
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Fig. 4.7.5: All Differences 

On applying filters, we can see that there are many numbers other than 1. Thus, sometimes one invoice is 
missing and sometimes more. Therefore, we can conclude that there are gaps in this data. There are also 
instances of repetition of invoice numbers which is suggested by 0. 

If we want a list of the missing invoice numbers, we can make use of Vlookup function. For this, note the 
smallest and biggest invoice numbers. Accordingly generate a list of all the invoice numbers in this range in 
another worksheet (You may use fill handle for this!). 

 

Fig. 4.7.6: List of all Invoices 
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Above is the list of all invoice numbers, between IN0001 to IN4920. Now apply Vlookup function on the original 
data.  

 

Fig. 4.7.7: Vlookup 
If there are gaps, the Vlookup will return #N/A error. Apply filters and check for #N/A as shown in Fig 4.7.8. 

 

Fig. 4.7.8: Filter on #N/A 
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Clearly there are #N/A errors. Press OK button and retrieve all such values. 

 

Fig. 4.7.9: Missing Invoices 

Now this is the list of all missing invoice numbers. 

4.8 Benford’s Law 
This is one the most famous tools used in modern day Forensic Audits. Benford’s Law is also known as the law 
of first digit. This is because it is based on the first digits of numbers. It was propounded by Frank Benford in 
1938. 

4.8.1 Concept 
Conventional probability says that the probability of a particular digit being the 1st digit of a number is 1/9 i.e. 
0.1111. It remains the same for any other digit (except 0 which cannot be the 1st digit). Thus all the digits are 
equi-probable for being the 1st digit of a number. 

However, Frank Benford observed that in real life the numbers behave in a different way. The probability of 1st 
digit being 1 is the highest among all digits. After that, 2 is most probable, after that 3 is most probable and so 
on. The probability of 9 is the least among all digits. He did extensive research on various unrelated datasets; 
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including lengths of rivers, molecular weights, physical constants, death rates and even the list of all numbers in 
a copy of Reader’s Digest! Thereafter, he laid down the following table of probabilities: 

First Digit Probability
1 0.30103
2 0.17609
3 0.12494
4 0.09691
5 0.07918
6 0.06695
7 0.05799
8 0.05115
9 0.04576  

These probabilities are given by the formula: 𝑃 (𝑛) = log10(1 + 1
𝑛

 ) 

Where n is the leading digit or the first digit of a number. 

4.8.2 Benford’s Law and Forensic Audits 
Benford’s Law was used for the first time in Forensic Audits by Dr Mark Nigrini in 1993, when he unearthed a 
fraud involving bogus payments. Those payments didn’t adhere to the pattern suggested by Benford’s Law and 
hence aroused the suspicion of Dr Nigrini. Eventually, they were found out to be fraudulent payments. 

Today, this Law is used by every sleuth dealing with numbers, to test whether the numbers appear to be 
genuine or they appear to be cooked up. Please note that if the numbers deviate from the pattern suggested by 
the Law, it is not a conclusive evidence of a fraud. It could still be a genuine list. Thus, it is merely an indicator 
of a possible fraud or what is termed as a ‘Red Flag’! 

4.8.3 Applying Benford’s Law using Excel 
We can apply Benford’s Law on a data in excel. Consider the following data as shown in Fig 4.8.1. 
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Fig. 4.8.1: Data 

Above details are purchase details of an organization, from various vendors. We would like to check whether 
this data conforms to Benford’s Law. For this purpose, we need to extract the first digit of every number. We 
can use left function for this as shown in Fig 4.8.2. 

 

Fig. 4.8.2: Left Function 
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Then we can use Pivot Tables and extract a count of the 1st digit. 

 

Fig. 4.8.3: Pivot Table on 1st Digit Count 
For comparison purpose, we can convert these absolute numbers into percentages, using Value Field Settings 
 Show Numbers As  % of Grand Total (Discussed above in Pivot Tables section) 

 

Fig. 4.8.4: Pivot Table on 1st Digit % 
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Thus, we get the above percentages. Now we can plot the Benford’s Law percentages. For this purpose, we 
can use the formula stated above i.e. 𝑃 (𝑛) = log10(1 + 1

𝑛
 ). To achieve this, we can use Log10 function in 

excel. Thereafter, format the cells as percentage with two decimals. 

 

Fig. 4.8.5: BenFord’s Law % 

The percentages on the original data are almost similar to Benford’s percentages. Thus, we may conclude that 
apparently the numbers in this data are genuine numbers.  

Note: The conclusion is highly subjective in nature. Someone else may feel the difference in digit 5 and 
corresponding difference in digit 9 as significant and may try to investigate them in further details. 

4.9 Aging Analysis 
Aging analysis involves breaking down inventories, receivables etc. into categories based upon number of days 
since the current asset has come into existence. As these current assets become old they warrant asset 
provisioning or even a write off. Thus, aging analysis is very important from auditing perspective.  

The biggest challenge in aging analysis lies in categorizing current asset values. Let us see how that can be 
achieved with the help of excel.  
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Fig. 4.9.1: Data 

Consider the above diagram. It lays down outstanding receivables. The date of sale is also mentioned. Based 
on the date of sale and today’s date, we can derive the age of the receivable and hence categorise it. 

For this, we will dedicate a cell to write today’s date. If preferred, we can even use the function Today().  

 

Fig. 4.9.2: Today 
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Then find out age of each receivable. For this, compute the difference between today’s date and the date of 
sale for each receivable.  

 

Fig. 4.9.3: Age of Receivables 
You may note the ‘$’ symbols used while referring to the cell B1. This ensures that cell B1 is fixed while the 
formula is copied till the bottom. 

Thereafter, create categories of ages and accordingly put headings. Following categories are considered here: 

 

 Fig. 4.9.4: Categories 
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Now comes the most challenging part. How to categorise the receivables? For this, we will make use of 
different formulas involving if function. Let’s consider the formula for ‘Not Due’ category. Put the following 
formula: 

 

Fig. 4.9.5: If Function 
It’s a simple formula which considers whether the age is less than 45 days or no. Now we will put the formula 
for the category ’45-59’ which is as shown in Fig 4.9.6. 
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Fig. 4.9.6: If Function with And 

Here a slightly complex formula is used. The age is checked whether it is greater than or equal to 45 days as 
well as less than 60 days or no.  

Similarly, we can put the other formulas for other categories and derive totals. Our categorization is over! 

 

Fig. 4.9.7: All Formulas 
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Now that the categorization is over, we can perform the analysis. Huge numbers as well as amount of 
receivables are due for more than 90 days. Therefore, the auditee must take strict action and recover those 
receivables. 

4.10 Statistical Analysis 
We may carry out some statistical analysis to understand our data better. For this, there is an add-in available 
in excel, known as Analysis Toolpak. This add-in makes statistical analysis quick and smooth, thus saving 
valuable time and efforts. 

This add-in lurks in the background. We must activate it first, without which we cannot use it. Click on File  
Options. In the Options window, click on Add-ins as shown in Fig 4.10.1. 

 

Fig. 4.10.1: Add-Ins 
Click on Go button beside Excel Add-ins. Add-ins window appears as shown in Fig 4.10.2 
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Fig. 4.10.2: Analysis ToolPak 
Tick Analysis ToolPak and press OK. Then visit Data Tab. You will see a new group added to the tab called 
Analysis as shown in Fig 4.10.3. 

 

  Fig. 4.10.3: Analysis Group 
We can do statistical analysis using this group. 

4.10.1 Sampling 
As a part of audit, many times we are required to work on a sample. Say, we have got a list of bank account 
numbers and we wish to draw a sample out of it for audit. Instead of drawing out sample manually (thus losing 
randomness), we can let excel draw the sample for us. This will remove bias, if any. 

 

Fig. 4.10.4: Data 
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Above is a list of 1000 bank account numbers. We would like to draw a sample of 200 accounts. For this, we 
can use the Data Analysis feature. Click on Data Tab  Analysis Group  Data Analysis. 

 

Fig. 4.10.5: Sampling 
The Data Analysis window opens up. Select Sampling and press OK as shown in Fig 4.10.6. 

 

Fig. 4.10.6: Sampling Window 
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Sampling window opens as shown in Fig 4.10.7. It is a simple interactive window which captures basic details 
and gives you the output. Specify input range as A1 to A1001, Tick labels and No of samples (sample size) as 
200.  

 

Fig. 4.10.7: Inputs of Sampling 
Press OK. The random sample will be generated and will be placed in a new worksheet. 

 

Fig. 4.10.8: Sample 
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4.10.2 Stratification 
‘Strata’ means groups or categories. It is the plural of the Latin word ‘stratum’. Stratification involves breaking 
heterogeneous data into homogenous groups called as strata. This is a pre-requisite for sampling where the 
data is not homogenous. Instead of taking out sample directly from the entire population, we can first divide the 
data into homogenous strata and then draw out sample elements from each ‘strata’. 

The procedure for stratification is very similar to the aging analysis that we carried out earlier. Consider the 
following data as shown in Fig 4.10.9. 

 

Fig. 4.10.9: Data 

Say, we would like to categorise this data into Very Small, Small, Moderate, Large and Very Large. For this 
purpose the category limits may be as follows: 

1. Very Small – 0 to 20,000 

2. Small – 20,001 to 40,000 

3. Moderate – 40,001 to 60,000 

4. Large – 60,001 to 80,000 

5. Very Large – 80,001 to 1,00,000 
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What may naturally spring to our minds is to use IF function (similar to the way we used in case of aging 
analysis). We can definitely achieve stratification using IF function. It will involve use of multiple IFs nested one 
inside the other for each category. In fact, one IF less than the total number of categories. Since we are 
considering 5 categories, we will need 4 IFs.  

 

Fig. 4.10.10: First IF function 

Above diagram as shown in Fig 4.10.10, the construction of the 1st IF. Its logical test checks whether the 
number is less than or equal to 20,000. If yes, it will be categorised as ‘Very Small’. Now in place of the value if 
false of the IF function, we will have to put the 2nd IF.  

 

Fig. 4.10.11: Second IF Function 

In the 2nd IF, in place of the logical test argument, use AND function. This will enable us to categorise all values 
greater than 20,000 but less than or equal to 40,000. If yes, it will be categorised as ‘Small’. In place of the 
value if false argument, we will have to put the 3rd IF. Likewise, we can continue and can construct the entire 
formula. 
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Fig. 4.10.12: Complete Formula 
We can see that the formula has turned out to be extremely long and tedious. It is bound to become further 
complex if more categories are to added. Therefore, we may wonder whether there exists a better solution. 
Fortunately, there exists a simpler way! 

In the earlier chapter on Functions, we had learnt about Vlookup function. More specifically, we had discussed 
the situations where we can define the range lookup argument of Vlookup as true. (If your memory eludes you, 
quickly visit those pages and refresh your memory).  

We will now use the Vlookup function and will achieve the same output, albeit in a much cleaner way. Firstly, let 
us make a table outlining all the categories in our minds. 

 
Fig. 4.10.13: Category Table 
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Now let’s apply Vlookup. Consider the following formula: 

 

Fig. 4.10.14: Vlookup Formula 

It is a simple formula involving a single Vlookup with no other complex combination of functions. We have fixed 
the table array by using dollar symbols. Also note that the last argument is defined as TRUE (approximate 
match). This is imperative; otherwise we will get #N/A errors.  

The final output is as shown in Fig 4.10.15 

 

Fig. 4.10.15: Final Output using Vlookup 
The best part about using Vlookup function rather than nested IF is the scale independence. Whether it’s 5 
categories or 500 categories, Vlookup can be used with equal ease. The formula remains the same. We can 
also add new categories or edit existing categories at a later point very easily. All we need to do is to update 
the table. Thus, this is a much better approach. 
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Post stratification, now this data can be used for the purpose of sampling using Analysis Toolpak or any other 
tool. Sample elements should be derived from each distinct strata to make the sample truly representative of 
the population. 

4.10.3 Descriptive Statistics 
Suppose we have some data and we wish to calculate a number of basic statistics like mean, median, mode 
etc. Either we can make use of individual functions one by one and derive them or we can make use of Data 
Analysis and generate all of them at once. We will use the latter approach now.  

 

Fig. 4.10.16: Data 
Consider the above diagram. We wish to calculate a number of statistics with respect to Amount column. Click 
on Data Analysis.  
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Fig. 4.10.17: Descriptive Statistics 
Select Descriptive Statistics and press OK. The Descriptive Statistics Window opens up as shown in Fig 
4.10.18 
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Fig. 4.10.18: Descriptive Statistics Window 
Specify Input Range as cells D1 to D505. Tick Labels in First Row. Tick Summary statistics, Confidence Level 
for Mean, Kth Largest and specify 3 and Kth Smallest and specify 5.  
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Fig. 4.10.19: Descriptive Statistics Inputs 

Press OK. The statistics are generated in another sheet as shown in Fig 4.10.20. 

 
Fig. 4.10.20: Result 
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Similarly, we have many more statistical tools available in Data Analysis like Correlation, Regression, Moving 
Average, Random Number Generation etc. One may use them as per requirement. 

4.11 Summary 
Auditor has to deal with data. Thus, data analysis is very important for him. We discussed some tools for Data 
Analysis. They are as follows: 

1. Duplicates using Conditional Formatting – You can highlight duplicate values using Conditional Formatting. 
However, this will not remove the duplicates. 

2. Remove Duplicates – Use this tool to remove the duplicates in the data. 

3. Sort – We can arrange the records in ascending or descending manner, using sort feature. We can also 
achieve multi-level sort. 

4. Filters – Filters help in short-listing data, based on some criteria. The rest of the records are temporarily 
hidden. Filters can be Text, Numeric or Date. Various features are available, based on the category. 

5. Consolidate Data – If data exists in multiple worksheets or workbooks, it can be merged together using 
Consolidate feature. The headings may or may not be in the same order. If required, we can also maintain 
links with the sources. 

6. Pivot Tables – This is one of the most powerful tools for effective data analysis. We can generate a report 
in a cross tab manner, by using Pivot Tables. Various statistics like Sum, Count etc. can be generated 
effortlessly. Multiple fields can be involved, thus making it highly useful. We can filter the labels and values 
or we can use report filters to filter the entire table. We can also drill down summarized values to check the 
underlying records. However, one must remember that Pivot Table doesn’t refresh itself automatically. On 
the whole, it’s a highly capable tool. 

Thereafter, we studied some case studies like: 

1. Gap Detection – Invoice numbers may contain some gaps. As an auditor, we need to identify gaps, if any. 
For this, we can use right function and obtain the numeric part. Then find out difference between the 
consecutive numeric parts. If it is not 1, then we must check. We can also make a complete list of invoices 
and use Vlookup function to plot the same from original data. If there are #N/A errors, they indicate the 
missing invoices. 

2. Benford’s Law – It was propounded by Frank Benford. It says that the probability of first digit being 1 is the 
most and that it being 9 is the least. These probabilities can be calculated using the formula: 

𝑃 (𝑛) = log10 �1 +
1
𝑛

 � 

It was used in the department of Forensic Audits by Dr. Mark Nigrini. We can use excel to test whether a 
dataset conforms to Benford’s Law. For this, extract the first digit of numbers using left function. Then 
summarize the count of all the first digits. This can be done using Pivot Tables. Convert those absolute 
counts into percentages. Then compare these percentages with Benford’s Law Percentages. 

3. Aging Analysis – We can categorise Current Assets like Inventories, Receivables etc. into ages. These 
ages help us in understanding which current assets we have been holding for long period of time and 
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perhaps warrant a provision or write off. For this, we first derive age of each receivable by subtracting the 
date of receivable from today’s date. Then we use if function to categorise it. 

4. Statistical Analysis – As an auditor we are sometimes required to use statistics. For this, we can make use 
of an add-in called Analysis ToolPak. It needs to be activated first which can be done by visiting File  
Options  Add-ins  Excel Add-ins. This loads a new group in Data Tab called Analysis with Data 
Analysis feature. Using this, we can perform a variety of analyses. Most relevant for an auditor are 
sampling and descriptive statistics. Other variations are also available. 

5. Stratification – This involves breaking the given data into number of strata or categories. This is very similar 
to Aging Analysis. Stratification is necessary to divide heterogeneous data into homogenous strata. One 
may use if function for categorization purpose. This involves using multiple IF functions. Number of IFs 
required is one less than the number of categories. We need to nest these IFs one inside the other. 

The formula using IF functions can be extremely long and tedious. It could be difficult to understand or edit 
later. A simpler approach is to make a table of the different categories  and use Vlookup function. The 
range lookup should be TRUE. This achieves the same output and does away with all the demerits of IF 
functions. After stratification, we can take out samples from each strata.  

4.12 Multiple Choice Questions (MCQ) for Practice 
1. To mark duplicates we can use ______________  

(a) Remove Duplicates 

(b) Conditional Formatting 

(c) Text To Columns 

(d) Analysis ToolPak 

2. To eliminate repeated values in a dataset such that it is left with unique values only, we can use: 

(a) Remove Duplicates 

(b) Conditional Formatting 

(c) Text To Columns 

(d) Analysis ToolPak 

3. Rajesh says following to Meena: 

1) Sort feature cannot perform multi-level sort 

2) Top 10 in filters can only be used for top 10 values. One cannot change it to top 7. 

What can you say about his statements? 

(a) Both 1 and 2 are right 

(b) 1 is right but 2 is wrong 

(c) 2 is right but 1 is wrong 

(d) Both 1 and 2 are wrong 
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4. On applying filters, row numbers turn: 

(a) Red 

(b) Blue 

(c) Pink 

(d) Green 

5. Records for different months or quarters, irrespective of years, can be obtained using _________ in date 
filters. 

(a) Year to Date 

(b) All Dates in the Period 

(c) Custom Filter 

(d) None of these 

6. Which of the following is not a pre-requisite of Pivot Tables? 

(a) Data should be in rectangular format 

(b) Data should contain headers 

(c) Every cell in the data region should be filled 

(d) Fields should be placed in columns and records in rows 

7. We can change Sum of values to Count using _________ in Pivot Tables: 

(a) Value Field Settings 

(b) Show Values As 

(c) Refresh 

(d) Pivot Table Options 

8. Which of the following can be used to filter the entire Pivot Table? 

(a) Report Filter 

(b) Label Filter 

(c) Value Filter 

(d) None of these 

9. Which of the following can be used to replace blank cells with zero? 

(a) Value Field Settings 

(b) Show Values As 

(c) Refresh 

(d) Pivot Table Options 

10. Which of the following can be used to update Pivot Table? 
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(a) Value Field Settings 

(b) Show Values As 

(c) Refresh 

(d) Pivot Table Options 

11. Which of the following is NOT a limitation of Pivot Tables?   

(a) We cannot insert rows or columns in between a Pivot Table report 

(b) Pivot Tables don’t auto-update themselves. We need to refresh them 

(c) The data cannot be in rectangular i.e. flat format   

(d) If the number of records are very large, Pivot Tables may respond slowly 

12. If there are no gaps between invoice numbers, the difference between two consecutive functions should 
be? 

(a) 1 

(b) 0 

(c) 2 

(d) Any value, depends 

13. Benford’s Law is based on? 

(a) 1st digit 

(b) Last digit 

(c) Middle digit 

(d) All digits 

14. Which function can be used to calculate probabilities as per Benford’s Law? 

(a) Log10 

(b) Sumif 

(c) Fact 

(d) Mod 

15. The conclusion drawn by using Benford’s Law is: 

(a) Subjective 

(b) Conclusive 

(c) Temporary 

(d) Illusory 

16. Which of the following functions is totally irrelevant for performing aging analysis? 

(a) If 
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(b) And 

(c) Left 

(d) Today 

17. Which add-in performs statistical calculations? 

(a) Analysis Tool Pak 

(b) Solver 

(c) ASAP Utilities 

(d) Fuzzy Lookup 

18. Stratification of data is done because: 

(a) The data is humongous 

(b) The data is heterogeneous 

(c) The data is homogenous 

(d) The data is horrendous 

19. Which of these are demerits of using IF function for stratification? 

(a) The formula may become very long and tedious 

(b) It may be difficult to edit the formula later 

(c) It may be difficult to understand the formula later 

(d) All of the above 

20. While using Vlookup function for stratification purpose, the range lookup argument should be: 

(a) True 

(b) False 

(c) Either a or b, as per the situation 

(d) Both a and b 

Solutions 
1. (b) 

2. (a) 

3. (d) 

4. (b) 

5. (b) 

6. (c) 

7. (a) 
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8. (a) 

9. (d) 

10. (c) 

11. (c) 

12. (a) 

13. (a) 

14. (a) 

15. (a) 

16. (c) 

17. (a) 

18. (b) 

19. (d) 

20. (a) 
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ERP OVERVIEW  
 
 

 

 

 

1.1 What is ERP Concept? 
An enterprise is a group of people with a common goal, having certain resources at its disposal to achieve this 
goal. In an enterprise way, the entire organization is considered as one system and all the departments are its 
sub-systems. Information regarding all aspects of the organization is stored centrally and is available to all 
departments. Resources include money, manpower, materials, machines, technologies etc. 

 

Fig. 1.1.1 An enterprise wherein there are stand alone Systems with no communication 

As shown in Fig. 1.1.1, each department will maintain separate databases and design applications as per their 
functionalities. As shown in Fig. 1.1.2, ERP combines all the business requirements of the company together 
into a single, integrated software program that runs off a single database so that the various departments can 
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more easily share information and communicate with each other. This transparency and information access 
ensures that the departments no longer work in isolation pursuing their own independent goals. 

Each sub-system knows what others are doing, why they are doing it and what should be done to move the 
company towards the common goal. The ERP systems help to make this task easier by integrating the 
information systems, enabling smooth and seamless flow of information across departmental barriers, 
automating business processes and functions, and thus helping the organization to work and move forward as a 
single entity. 

 

Fig. 1.1.2 Enterprise where all Departmens communicate to each other in an ERP System  

1.2 Business Functions and Business Processes 
Organizations have different functional areas of operation – marketing and sales, production and materials 
management, accounting and finance, human resources etc. Each functional area comprises a variety of 
business functions and business activities.  

A business process is a collection of activities that make one or more kinds of input and creates an output that is 
of value to the customer. A business process cuts across more than one business function to get a task done. For 
example – One of the business functions of the customer service department is to accept the damaged item and 
to replace or repair it depending upon the severity of the damage, whereas actual repair or replacement of the car 
is a business process that involves several functional areas and functions within those areas. 

Sharing data effectively and efficiently between and within functional areas leads to more efficient business 
processes. Information systems can be designed so that accurate and timely data are shared between 
functional areas. These systems are called Integrated Information Systems. 

1.3  Business Modeling 
The approach to ERP is to first develop a business model comprising the business processes or activities that 
are the essence of the business. A business model is not a mathematical model, but a representation of the 
business as one large system showing the interconnections and interdependencies of the various sub-systems 
and business processes. 
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In business modeling, the business is modeled as an integrated system, and the processes managing in 
facilities and materials are the resources. Information, though not described as a resource, is vital in managing 
all the resources and can, therefore be added as a resource while showing the concept of a business. Thus the 
business model is a representation of the actual business, the various business functions of the organization, 
how they are related, their interdependencies, and so on. The business model is represented in the graphical 
form using flowcharts and flow diagrams. The data model of the system is created from the business model. 

1.3.1 Integrated Data Model 
ERP systems provide an access to the integrated data, to all the employees from the different departments. 
With the implementation of ERP systems, all the data has to-be-from the integrated database and not from the 
isolated databases, thus reducing the data redundancy and providing updated and upto the minute information 
about the entire organization to all the employees. 

Thus while designing the data model for the ERP system the most important thing is the information integration 
and the process/procedure automation. The data model should reflect the entire organization and should 
successfully depict an integrated data structure of the entire organization. 

Fig. 1.3.1 depicts the data model and its relationship with the Real World. 
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1.4. ERP and Related Technologies 
1. Business Intelligence  
2. Online Analytical Processing (OLAP) 
3. Product Life Cycle Management (PLM) 
4. Supply Chain Management (SCM) 
5. Customer Relationship Management (CRM) 

1.4.1 Business Intelligence 
Business Intelligence (BI) is a tool that refers to skills, processes, technologies, applications and practices used 
to facilitate better, accurate and quicker decision making. Business intelligence systems are data-driven 
Decision Support Systems. In modern businesses, the use of standards, automation and specialized software. 
Including analytical tools, allows large volumes of data to be extracted, transformed, loaded and warehoused to 
greatly increase the speed at which information becomes available for decision-making.  

To maximize the value of the information stored in ERP systems, it is necessary to extend the ERP 
architectures to include more advanced reporting, analytical and decision support capabilities. This is best 
accomplished through the application of data warehousing, data mining, OLAP and other analysis, reporting 
and business intelligence tools and techniques. 

1.4.2 Data Warehousing 
If operational data is kept in the database of the ERP system, it can create lot of problems. As time passes, the 
amount of data will increase and this will affect the performance of the ERP system. As the volume of the data 
in the database increases, the performance of the database and the related application degrades. Thus, 
archiving the operational data once its use is over is a better option. 

Data warehousing technology is the process of creating and utilizing the company’s historical data i.e. 
separating the operational data from non-operational data. The primary concept of data warehousing is that the 
data stored for business analysis can most effectively be accessed by separating it from the data in the 
operational systems. 
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Data Warehouses can be defined as subject-oriented, integrated, time-variant, non-volatile collections of data 
used to support analytical decision making. The data in the Warehouse comes from the operational 
environment and external sources. 

Subject Orientation 

Data Warehouses are designed around the major subject areas of the enterprise; the operational environment 
is designed around applications and functions. Data Warehouses do not contain information that will not be 
used for informational or analytical processing; operational databases contain detailed data that is needed to 
satisfy processing requirements but which has no relevance to management or analysis. 

Integration and Transformation 

The data within the Data Warehouse is integrated which means that there is consistency among naming 
conventions, measurements of variables, encoding structures, physical attributes, and other salient data 
characteristics. As the data is moved to the warehouse, it is transformed into a consistent representation as 
required. 
Time Variance 

Data in Data Warehouse is accurate as of some moment in time, providing an historical perspective. This differs 
from the operational environment in which data is intended to be accurate as of the moment of access.  

Non-Volatility 

Data in the warehouse is static, not dynamic. The only operation that occur in Data Warehouse applications are 
the initial loading of data, access of data, and refresh of data. For these reasons, the physical design of a Data 
Warehouse optimizes the access of data, rather than focusing on the requirements of data update and delete 
processing. 

In the Data Warehouse model, operational databases are not accessed directly to perform information 
processing. Rather, they act as the source of data for the Data Warehouse, which is the information repository 
and point of access for information processing. An Operational Data Store (“ODS") is a database designed to 
integrate data from multiple sources to make analysis and reporting easier. Because the data originates from 
multiple sources, the integration often involves cleaning, resolving redundancy and checking against business 
rules for integrity. There are sound reasons for separating operational and informational databases, as 
described below. 

 The users of informational and operational data are different. Users of informational data are generally 
managers and analysts; users of operational data tend to be clerical, operational and administrative staff. 
Fig. 1.4.1 illustrates the fact that different sets of users access the data, using different sets of 
applications and for different purposes. 

 Operational data differs from informational data in context and currency. Informational data contains an 
historical perspective that is not generally used by operational systems. 

 The technology used for operational processing frequently differs from the technology required to support 
informational needs. 

 The processing characteristics for the operational environment and the informational environment are 
fundamentally different. 
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1.4.2.1 Data Warehousing Activities 

Data Warehousing requires both business and technical expertise and involves the following activities:  

 Accurately identifying the business information that must be stored in the warehouse  

 Identifying and prioritizing subject areas to be included in the Data Warehouse. 

 Managing the scope of each subject area which will be implemented into the Warehouse on an iterative 
basis. 

 Developing a scalable architecture to serve as the warehouse’s technical and application foundation, and 
identifying and selecting the hardware /software/ middleware components to implement it. 

 Extracting, cleansing, aggregating, transforming and validating the data to ensure accuracy and 
consistency. 

 Defining the correct level of summarization to support business decision making. 

 Establishing a refresh program that is consistent with business needs, timing and cycles. 

 Providing user-friendly, powerful tools at the desktop to access the data in the Warehouse. 

 Educating the business community about the realm of possibilities that are available to them through 
Data Warehousing.  

 Establishing a data warehouse help desk and training users to effectively utilize the desktop tools. 

 Establishing processes for maintaining, enhancing and ensuring the ongoing success and applicability of 
the warehouse. 

1.4.2.2 Data Warehousing Functions 

Fig. 1.4.2 illustrates the flow of data from originating sources to the user, and includes management and 
implementation aspects. It starts with access mechanisms for retrieving data from heterogeneous operational 
data sources. That data is replicated via a transformation model and stored in the data warehouse.   

The definition of data elements in the data warehouse and in the data sources, and the transformation rules 
that relate them, are referred to as 'metadata'. Metadata is “data about data” and is the means by which the 
end-user finds and understands the data in the warehouse.  

The data transformation and movement processes are executed whenever an update to the warehouse data is 
desired.  

Different parts of the warehouse may require updates at different times, some at regular intervals such as 
weekly or monthly, and some on specified dates. There should be a capability to manage and automate the 
processes required to perform these functions.  

Particularly in a multi-vendor environment, adopting architecture with open interfaces would facilitate the 
integration of the products that implement these functions.  

Quality consulting services can be an important factor in assuring a successful and cost effective 
implementation. 
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Fig. 1.4.2 Data Warehousing Functions 

Benefits 

 A data warehouse provides a common data model for all data of interest regardless of the data's source. 
This makes it easier to report and analyze information than it would be if multiple data models were used 
to retrieve information such as sales invoices, order receipts, general ledger charges, etc.  

 Prior to loading data into the data warehouse, inconsistencies are identified and resolved. This greatly 
simplifies reporting and analysis.  

 Information in the data warehouse is under the control of data warehouse users so that, even if the 
source system data is purged over time, the information in the warehouse can be stored safely for 
extended periods of time.  

 Because they are separate from operational systems, data warehouses provide retrieval of data without 
slowing down operational systems.  

 Data warehouses can work in conjunction with and, hence, enhance the value of operational business 
applications, notably customer relationship management (CRM) systems.  

 Data warehouses facilitate DSS applications such as trend reports (e.g., the items with the most sales in 
a particular area within the last two years), exception reports, and reports that show actual performance 
versus goals.  

Disadvantages 

 Data warehouses are not the optimal environment for unstructured data.  

 Because data must be extracted, transformed and loaded into the warehouse, there is an element of 
latency in data warehouse data.  



Main source : ICAI

 downloaded from : taxupindia.com

 ENTERPRISE RESOURCE PLANNING  

316  ADVANCED INFORMATION TECHNOLOGY 

 Over their life, data warehouses can have high costs. Maintenance costs are high.  

 Data warehouses can get outdated relatively quickly. There is a cost of delivering suboptimal information 
to the organization.  

Application Areas 

Some of the applications data warehousing can be used for are: 

 Credit card churn analysis  

 Insurance fraud analysis  

 Call record analysis  

 Logistics management.  

1.4.3  Data Mining 

Data Mining is the process of identifying valid, novel, potentially useful and ultimately comprehensible 
knowledge from databases that is used to make crucial business decisions. Data mining is the process of 
extracting patterns from data. As more data are gathered, data mining is becoming an increasingly important 
tool to transform these data into information. It is commonly used in a wide range of profiling practices, such as 
marketing, surveillance, fraud detection and scientific discovery. 

Data mining in relation to Enterprise Resource Planning is the statistical and logical analysis of large sets of 
transaction data, looking for patterns that can aid decision making. 

The main reason for the necessity of automated computer systems for intelligent data analysis is the enormous 
volume of existing and newly appearing data, accumulated each day by various businesses, scientific and 
governmental organizations around the world that requires processing.  

Further, automated data mining systems has a much lower cost than hiring an army of highly trained and 
professional statisticians. While data mining does not eliminate human participation in solving the task 
completely, it significantly simplifies the job and allows an analyst who is not a professional in statistics and 
programming to manage the process of extracting knowledge from data. 

1.4.4  Online Analytical Processing (OLAP) 

Online Analytical Processing, or OLAP, is an approach to quickly answer multi-dimensional analytical queries. 
OLAP is part of the broader category of business intelligence, which also encompasses relational reporting and 
data mining. The typical applications of OLAP are in business reporting for sales, marketing, management 
reporting, Business Process Management (BPM), budgeting and forecasting, financial reporting and similar 
areas.  

Databases configured for OLAP use a multidimensional data model, allowing for complex analytical and ad-hoc 
queries with a rapid execution time. OLAP systems use concept of OLAP cube called a multidimensional 
cube or a hypercube consisting of numeric facts called measures which are categorized by dimensions. The 
cube metadata is typically created from a set of tables (Facts and Dimensional) in a relational database. 
Measures are derived from the records in the fact table and dimensions are derived from the dimension tables. 
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The output of an OLAP query is typically displayed in a matrix (or pivot) format. The dimensions form the rows 
and columns of the matrix; the measures form the values. 

1.4.4.1 Characteristics of OLAP 

1. Fast: Means that the system is targeted to deliver most responses to users within no time. 

2. Analysis: Means that the system can cope with any business logic and statistical analysis that is 
relevant for the application and the user, and keep it easy enough for the target user. 

3. Shared: Means that the system implements all the security requirements for confidentiality and if multiple 
write access is needed, concurrent update locking at an appropriate level. 

4. Multi-Dimensional: Means that the system must provide a multi-dimensional conceptual view of the 
data, including full support for hierarchies and multiple hierarchies. 

5. Information: Is all of the data and derived information needed, wherever it is and however much is 
relevant for the application. 

OLAP technology is most commonly applied for sales and marketing analysis, financial reporting and 
consolidation, budgeting and planning, product profitability and pricing analysis, activity based costing, 
manpower planning and quality analysis. 

1.4.5 Product Life cycle Management (PLM) 

The conditions under which a product is sold will change over time. The product life cycle refers to the 
succession of stages a product goes through. Product Life cycle Management is the succession of strategies 
used by management as a product goes through its life cycle. 

In other words, PLM is the process of managing the entire lifecycle of a product from its conception, through 
design and manufacture, to service and disposal. PLM integrates people, data, processes and business 
systems and provides a product information backbone for companies and their extended enterprise. 

PLM helps organizations in the following areas: 

 Reduce time-to-market through faster design and validation. 

 Optimally deploy CAD and prototyping resources to complete critical projects. 

 Reduce product development and manufacturing costs. 

 Reduce levels of obsolete component inventory at multiple locations. 

 Get product design changes into productivity quickly. 

1.4.6 Supply Chain Management 

A supply chain is a network of facilities and distribution options that performs the functions of procurement of 
materials, transformations of these materials into intermediate and finished products and the distribution of 
these finished products to customers. Supply chain management (SCM) is the management of a network of 
interconnected businesses involved in the ultimate provision of product and service packages required by end 
customers. It is defined as the process of planning, implementing and controlling the operations of the Supply 
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chain as efficiently as possible. SCM includes movement and storage of raw materials, work-in-process 
inventory, and finished goods from point-of-origin to point-of-consumption. In essence, SCM integrates supply 
and demand management within and across companies. 

SCM can be grouped into strategic, tactical and operational levels of activities. 

1.4.6.1 Strategic 

 Strategic network optimization, including the number, location, and size of warehousing, distribution 
centers, and facilities.  

 Strategic partnerships with suppliers, distributors, and customers, creating communication channels for 
critical information and operational improvements such as cross docking, direct shipping, and third-party 
logistics.  

 Product life cycle management, so that new and existing products can be optimally integrated into the 
supply chain and capacity management activities.  

 Information technology infrastructure to support supply chain operations.  

 Where-to-make and what-to-make-or-buy decisions.  

 Aligning overall organizational strategy with supply strategy.  

1.4.6.2 Tactical 

 Sourcing contracts and other purchasing decisions.  

 Production decisions, including contracting, scheduling, and planning process definition.  

 Inventory decisions, including quantity, location, and quality of inventory.  

 Transportation strategy, including frequency, routes, and contracting.  

 Benchmarking of all operations against competitors and implementation of best practices throughout the 
enterprise.  

 Milestone payments.  

 Focus on customer demand.  

1.4.6.3 Operational 

 Daily production and distribution planning, including all nodes in the supply chain.  

 Production scheduling for each manufacturing facility in the supply chain (minute by minute).  

 Demand planning and forecasting, coordinating the demand forecast of all customers and sharing the 
forecast with all suppliers.  

 Sourcing planning, including current inventory and forecast demand, in collaboration with all suppliers.  

 Inbound operations, including transportation from suppliers and receiving inventory.  

 Production operations, including the consumption of materials and flow of finished goods.  
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 Outbound operations, including all fulfillment activities, warehousing and transportation to customers.  

 Order promising, accounting for all constraints in the supply chain, including all suppliers, manufacturing 
facilities, distribution centers, and other customers.  

SCM addresses our clients' challenges through seven service areas as shown in Fig 1.4.3 

 Supply Chain Strategy  

 Supply Chain Planning  

 Logistics  

 Procurement  

 Product Lifecycle Management  

 Supply Chain Enterprise Applications  

 Asset management  

 

Fig. 1.4.3 Data Warehousing Functions 

1.4.7 Customer Relationship Management (CRM) 

Customer Relationship Management is a corporate level strategy, focusing on creating and maintaining 
relationships with customers. It covers methods and technologies used by companies to manage their 
relationships with clients. 

There are several different approaches to CRM, with different software packages focusing on different aspects: 

1. Operational CRM 

Operational CRM provides support to "front office" business processes, e.g. to sales, marketing and service 
staff. Interactions with customers are generally stored in customers' contact histories, and staff can retrieve 
customer information as required. 

The contact history provides staff members with immediate access to important information on the customer 
(products owned, prior support calls etc.), eliminating the need to individually obtain this information directly 
from the customer. Reaching to the customer at right time at right place is preferable. 
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Operational CRM processes customer data for a variety of purposes: 

 Managing campaigns  

 Enterprise Marketing Automation  

 Sales Force Automation  

 Sales Management System  

2. Analytical CRM 

Analytical CRM analyzes customer data for a variety of purposes: 

 Designing and executing targeted marketing campaigns  

 Designing and executing campaigns, e.g. customer acquisition, cross-selling, up-selling, add on-selling  

 Analyzing customer behavior in order to make decisions relating to products and services (e.g. pricing, 
product development)  

 Management information system (e.g. financial forecasting and customer profitability analysis)  

Analytical CRM generally makes heavy use of data mining and other techniques to produce useful results for 
decision-making. It is at the analytical stage that the importance of fully integrated CRM software becomes 
most apparent - the more information available to analytical software, the better its predictions and 
recommendations will be. 

3. Sales Intelligence CRM 

Sales Intelligence CRM is similar to Analytical CRM, but is intended as a more direct sales tool. Features 
include alerts sent to sales staff regarding: 

 Cross-selling/Up-selling/Switch-selling opportunities  

 Customer drift  

 Sales performance  

 Customer trends  

 Customer margins  

 Customer alignment  

4. Campaign Management 

Campaign management combines elements of Operational and Analytical CRM. Campaign management 
functions include: 

 Targeting groups formed from the client base according to selected criteria  

 Sending campaign-related material (e.g. on special offers) to selected recipients using various channels 
(e.g. e-mail, telephone, SMS, post)  

 Tracking, storing, and analyzing campaign statistics, including tracking responses and analyzing trends  
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5. Collaborative CRM 

Collaborative CRM covers aspects of a company's dealings with customers that are handled by various 
departments within a company, such as sales, technical support and marketing. Staff members from different 
departments can share information collected when interacting with customers. For example, feedback received 
by customer support agents can provide other staff members with information on the services and features 
requested by customers. Collaborative CRM's ultimate goal is to use information collected by all departments to 
improve the quality of services provided by the company. Producers can use CRM information to develop 
products or find new market. CRM facilitates communication between customers, suppliers and partner. 

6. Consumer Relationship CRM 

Consumer Relationship System (CRS) covers aspects of a company's dealing with customers handled by the 
Consumer Affairs and Customer Relations contact centers within a company. Representatives handle in-bound 
contact from anonymous consumers and customers. Early warnings can be issued regarding product issues 
(e.g. item recalls) and current consumer sentiment can be tracked (voice of the customer). 

7. Simple CRM 

It is a relatively new spinoff of the traditional CRM model first appearing in 2006. At their core, CRM tools are 
designed to manage customer relationships. As described above there are countless supplemental features 
and capabilities. Simple CRM systems breakdown the traditional CRM system to focus on the core values, i.e 
managing contacts and activities with customers and prospects. These systems are designed to create the 
most value for the immediate end user rather than the organization as a whole. They often focus on satisfying 
the needs of a particular marketplace niche, organizational unit, or type of user rather than an entire 
organization. 

8. Social CRM 

Beginning in 2007, the rapid growth in social media and social networking forced CRM product companies to 
integrate "social" features into their traditional CRM systems. Some of the first features added were social 
network monitoring feeds (e.g. Twitter timeline). Other emerging features include messaging, sentiment 
analysis, and other analytics. CRM experts agree that online social communities and conversations have 
significant consequences for companies, and must be monitored for real-time marketplace feedback and trends. 

1.5 Enterprise Resource Planning using Web 2.0   
Enterprise systems of today cater to technologies and business practices that liberate the workforce from the 
constraints of legacy communication and productivity tools like email. They are perceived as critical tools 
expected to provide business managers with access to the right information at the right time through a web of 
inter-connected applications, services and devices.  

In the global dynamic and vibrant market space, the need arise for an effective collaboration for virtual 
integration and interaction between partners, customers, suppliers, stakeholders, professionals and employees. 
Enterprises look forward to strategic investment in new innovative, novel business models engraved on new 
robust technologies that make accessible the collective intelligence of many, translating to a huge competitive 
advantage in the form of increased innovation, productivity and agility. 
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An Enterprise Resource Planning (ERP) system for an enterprise aims to provide optimized solutions to 
enterprises in leveraging their business process management activities at reduced cost and maximum 
operational efficiency. The ERP systems are on the outlook for quick return on investment (ROI) through new 
efficient and strategic business enabling technologies. The big focus is on partnering in the marketplace over 
the network (customer communities, cloud sourcing, and crowd sourcing), looking for major new opportunities 
for low cost growth, and to do more with less. 

Web 2.0 techniques as coined by Andrew McAfee with the acronym SLATES as: 

 Search: the ease of finding information through keyword search which makes the platform valuable. 

 Links: guides to important pieces of information. The best pages are the most frequently linked to. 

 Authoring: the ability to create constantly updating content over a platform that is shifted from being the 
creation of a few to being the constantly updated, interlinked work.  

 Wikis- the content is iterative in the sense that the people undo and redo each other's work.  

 Blogs- the content is cumulative in that posts and comments of individuals are accumulated over time. 

 Tags: categorization of content by creating tags that are simple, one-word descriptions to facilitate 
searching and avoid rigid, pre-made categories. 

 Extensions: automation of some of the work and pattern matching by using algorithms for 
recommendations. 

 Signals: the use of RSS (Really Simple Syndication) technology to notify users with any changes of the 
content by sending e-mails to them. 
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Fig. 1.5.1 Business Technology 

Adapted from: blogs.zdnet.com/Hinchcliffe/images/ew2_outlook_2009.png. 

The Web 2.0 technology framework integration into an Enterprise Resource Planning system enables using 
services built around Service Oriented Architecture (SOA) and Web Oriented Architecture (WOA). The technical 
Impacts of upgrading legacy application to Web are; web as a platform, harnessing collective intelligence, data 
as the core, end of the software release cycle, light weight programming models, and software as a 
service(SaaS) along with rich user experience(RIA). The two decisive features of the framework are "Network 
as platform" and "Architecture of participation". 

(a)  Network as platform: is used for computing, allowing users to run software-applications entirely through 
a browser, own the data and exercise control over that data. The enterprise of today is not to meet the 
demands of twelve markets of millions but to a million markets of twelve. 

(b)  Architecture of participation: that encourages users to add value to the application as they use it. The 
concept of Web-as-participation-platform captures these characteristics;  rich user experience, user 
participation, dynamic content, metadata, web standards and scalability with openness, freedom and collective 
intelligence. The companies have recognized that user interaction, in and of itself, represents value to their 
services. The service's users are a network and can leverage that network to significantly strengthen the 
service. 

The benefits and value additions on its ERP systems using web 2.0 characteristics are: 
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 Low cost investment.  

 Increased customer satisfaction.  

 Rich and user-friendly interface.  

 Reduced re-investment cost.  

 Solutions and services using new advanced technologies.  

 Faster turn-around time by using latest and fastest technologies.  

 Faster and timely data updates and data refreshes.  

 Easy access for customers and users from any remote place through web.  

(i)  Revenue and growth- New revenue streams can be built and present revenue streams enhanced 
through community and social networking. In particular, the cost containment of the last few years has given 
way to business-side interest in innovation-based growth and revenue. The rapid growth and innovation in the 
Web space is seen as something that companies need to emulate. 

 (ii)  Web-based economies of scale- Companies realize that they can dramatically cut the cost of capital 
equipment and people by using a Web-based delivery model to communities of their customers. Business to 
Consumer (B2C) companies is planning to support tens of millions of customers with just hundreds of 
employees. 

(iii)  Flexible employment models- The use of contract and agency staff for delivery allows flexibility and 
agility. Agency and contract staff can be thought of as another, specialized community and can be supported 
with Web 2.0 techniques, similar to customers. 

Community creation as evangelism and support- Customers are a business's best sales, marketing, support 
and development organization. The creation of communities effectively outsources these cost centres, at zero 
cost. Indeed, with the inclusion of targeted advertising to the community, many of the present cost centres may 
become profit centres. 

(iv)  Community leader advantage- Community dynamics are such that the first successful community is by 
far the most powerful and the organization that owns this community is the one which controls the space. If an 
organization's competitors are first in the community space they will have very significant competitive 
advantage. 

These are five areas in which Web 2.0 techniques can be used in working with customer communities to 
provide Business to Community. 



Main source : ICAI

 downloaded from : taxupindia.com

ERP OVERVIEW  

 ADVANCED INFORMATION TECHNOLOGY 325 

 

To summarize the technology features of an enterprise system on time 

Today's Enterprise(Web 2.0) Yesterday's Enterprise 

Flat Organization 
Ease of Organization Flow 
Agility 
Flexibility 
User-driven technology 
Bottom up 
Distributed 
Teams are global 
Fuzzy boundaries, open borders 
Transparency 
Information systems are emergent 
Folksonomies 
Simple 
Open 
On Demand 
Short time-to-market cycles  

Hierarchy 
Friction 
Bureaucracy 
Inflexibility 
IT-driven technology / Lack of user control 
Top down 
Centralized 
Teams are in one building / one time zone 
Tailored and boundaries 
Need to know Information systems are structured 
and dictated Taxonomies 
Overly complex 
Closed/ proprietary standards 
Scheduled Long time-to-market cycles 

Source: msdn.microsoft.com/en-us/library/bb735306.aspx 

Despite a more-challenging economic environment, more small and midsize businesses (SMBs) are obtaining 
the benefits of efficiency and the information advantage that ERP suites can deliver. A survey by Dataquest 
insight on ERP suite trends and characteristics recommends the following: 

 Differentiate go-to-market strategies by addressing more-focused line-of-business and vertical-market 
requirements of SMBs. Focus on the vertical markets with the highest concentration of users. Investigate 
complementary areas and invest in partnerships and/or development funds to seed further revenue 
opportunities. 

 Address subtle distinctions in ERP systems across small, lower- mid- and upper-midmarket businesses 
in go-to-market strategies to maximize revenue opportunity. 

 Incorporate SaaS, Web 2.0 and service-oriented architecture (SOA) enablement into product plans, 
which have grown in their influence and awareness within the SMB market.  

 SMB ERP suite should take note of business model migration from product-centric to service-centric 
initiatives and evaluate new delivery models that can achieve quicker and more-tailored deployments.  

 Proactively engage users being targeted across the SMB spectrum via user groups and feedback 
mechanisms (focus groups, advisory committees, and so forth) to do a better job segmenting and 
targeting distinctive submarkets and their requirements, as well as understanding the nuances in 
servicing SMBs.  

 Emphasize clear direct communication with users with respect to updated product road maps and persist 
partners to update on an annual basis.  
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1.6  Open Source ERP Products 
Companies availing ERP services always face the hassle of paying a large sum of money for license fees, 
implementation, modification and deployment. However ERP open source helps to remove this drawback. The 
companies can download the software programs at free of cost and use them.  

Some of the features of Open Source ERP are as follows: 

1.  Cutting down the costs. 

2.  Reducing dependence on the vendors. 

1.6.1 Limitations of Open Source ERP 

1.  Increased complexities 

2.  Legal complexities 

3.  Unsuitable for conventional applications 

Selected List of Open ERP Software's are: 

Title Functionalities Technical / Platform Website 
Openbravo 
ERP Software 

Openbravo ERP encompasses a 
broad range of functionalities such as 
finance, supply chain & 
manufacturing. 

Openbravo ERP is a Web 
based ERP for SME built on 
proven MVC & MDD framework. 
Built on Java and Javascript, 
SQL and PL/SQL and  XML. 

http://www.ope
nbravo.com/ 

SQL-Ledger 
ERP Software 

Accounting/ERP system for 
manufacturers, retail and service 
businesses.  SQL-Ledger® ERP is a 
double entry accounting/ERP 
system. Accounting data is stored in 
a SQL database server. The entire 
system is linked through a chart of 
accounts. Each item in inventory is 
linked to income, expense, and 
inventory and tax accounts. 

SQL-Ledger is platform 
independent and runs on any  
Mac or Windows computer 

http://www.sql-
ledger.org 

PostBooks 
ERP Software 

Accounting, CRM package for small 
to midsized businesses. 
1. Accounting (general ledger, 
accounts receivable and payable, 
bank reconciliation, financial 
reporting) 
2. Sales (quotes, order entry, sales 
reporting, shipping) 
3. CRM (universal address book, 
incident management, opportunity 
management, to-do lists, project 

Built with the open source 
PostgreSQL database, and the 
open source Qt framework for 
C++. 
ERP client runs on Linux, Mac, 
and Windows (built with open 
source Qt framework). 
 

http://www.xtupl
e.com/postbook
s 
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management) 
4. Purchasing (purchase orders, 
receiving, vendor reporting) 
5. Product Definition (items, infinite-
level bills of material) 
6. Inventory (multiple locations, other 
advanced warehouse features) 
7. Light Manufacturing (work orders, 
strong support for make-to-order) 
8. OpenRPT open source report 
writer 

OpenERP 
Software 

OpenERP is a modular system and 
has modules for Accounting and 
Finance, CRM, Human Resources, 
Inventory (Stock) Manufacturing, 
Purchase and procurement Sales 
and Marketing. The latest version of 
Ubuntu (8.04) has version 4.2 called 
TinyERP. 

OpenERP has a server and 
client install for Windows, Mac 
and Linux variations. The main 
Linux distributions have 
OpenERP in their repositories 
ready for an easy install. 
Platform: Windows, Linux, 
FreeBSD, OpenSolaris 
Database: PostgreSQL 

http://www.ope
nsourceaccount
ingsoftware.co
m 

FireERP 
Software 

Powerful and free ERP, CRM, 
eBusiness and SCM /SRM solution 
for business enterprises. 

JFire is entirely free/open-
source software, uses the latest 
technologies (J2EE 1.4, JDO 
2.0, Eclipse RCP 3.3) and is 
designed to be highly 
customizable.  Current 
Versions: Tough Trader (0.9.4-
beta) 

https://www.jfire
.org 

ERP5ERP 
Software 

ERP5 Finance is a complete 
accounting and finance solution 
designed with and certified by 
chartered accountants. ERP5 is 
suitable for small to large 
multinational organizations in the 
private or public sector. 

It is mainly developed in the 
Python programming language 
and the source code is freely 
available under the GNU 
General Public License. 

http://www.erp5
.com/solution/er
p5-solution-erp 

Project-open 
ERP Software 

PO integrates areas such as CRM, 
sales, project planning, project 
tracking, collaboration, timesheet, 
invoicing and payments. 

Web-based project 
management & project portfolio 
management system for service 
and consulting companies with 
2-200 employees 

http://www.proj
ect-open.org/ 

Table 1.6.1 List of Open ERP Software’s 
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“Enterprise Computing is on the road to operational efficiency on thin budgets.” 

ERP is the process of integrating all the business functions and processes in an organization to achieve 
numerous benefits. It is especially important for companies which are "intimately connected" to their vendors 
and customers, and use electronic data interchange (EDI) to process sales transactions electronically. 
Therefore, the implementation of ERP is exceptionally beneficial to businesses such as manufacturing plants 
that mass-produce products with little changes.  

2.1  Implementation Life Cycle 
The flowchart in the figure below depicts several activities that must be performed before implementing an ERP 
system.  

Step 1: Managers must conduct a feasibility study of the current situation to assess the organization's needs by 
analyzing the availability of hardware, software, databases, and in-house computer expertise, and make the 
decision to implement ERP where integration is essential. They must also set goals for improvement and 
establish objectives for the implementation, and calculate the break-even points and benefits to be received 
from this expensive IT investment.  

Step 2: The second major activity involves educating and recruiting end users to be involved throughout the 
implementation process. 

Step 3:  Managers form a project team or steering committee that consists of experts from all functional areas 
to lead the project. 

Step 4:  After a decision is made to implement ERP, a team of system consultants will be hired to evaluate the 
appropriateness of implementing an ERP system, and to help select the best enterprise software provider and 
the best approach to implementing ERP. In most situations, the consultant team also recommends the modules 
that are best suited to the company's operations (manufacturing, financials, human resources, logistics, 
forecasting, etc.), system configurations, and Business-to-Business applications such as supply-chain 
management, customer relationship management, e-procurement, and e-marketplace.  

CHAPTER 

2 
LEARNING OBJECTIVES 
 Implementation Life Cycle 
 Issues on ERP Implementation 
 ERP Implementation -Traps  
 ERP Security Audit  
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Step 5: Adequate employee and manager training must be provided to all business, stakeholders, including 
managers, end users, customers, and vendors, before the system is implemented. Such training is usually 
customized and can be provided by either internal or outside trainers. 

Step 6: The system installation process will address issues such as software configuration, hardware 
acquisition, and software testing.  

Step 7: Data and information in the databases must be converted to the format used in the new ERP system 
and servers and networks need to be upgraded. A post implementation review is recommended to ensure that 
all business objectives established during the planning phase are achieved. Needed modifications are tackled 
during this phase too. 

 

Fig 2.1.1 Activity flowchart before ERP implementation. 
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2.2 Issues on ERP Implementation 
Implementing an ERP causes massive change that needs to be carefully managed to reap the benefits of an 
ERP solution. Critical issues that must be carefully considered to ensure successful implementation include 
fundamental issues, organizational change process, people, and implementation cost and time and employee 
morale. The pertinent issues are: 

1. Fundamental Issues 

Implementation of an ERP system can be long, costly, and labor-intensive and can affect an organization's 
bottom line if done incorrectly. To ensure the success of any ERP implementation project, a project team 
consisting of an ERP consultant, internal auditing, and IT staff familiar with the company's business operations 
should be established and their role must be defined.  

(a)  Role of Manager: Managers must consider the fundamental issues of system integration by analyzing 
the organization's vision and corporate objectives. 

 Does management fully understand its current business processes, and can it make implementation 
decisions in a timely manner?  

 Is management ready to undertake drastic business process reengineering efforts to yield dramatic 
outcomes?  

 Is management ready to make any changes in the structure, operations, and cultural environment to 
accommodate the options configured in the ERP system?  

 Is the organization financially and economically prepared to invest heavily in an ERP implementation?  

(b)  Role of an Auditor: Auditors play a proactive role in helping the organization laying the foundation for an 
initiative's success with their knowledge of internal control practices, compliance requirements, and business 
processes. In particular, internal auditors can:  

 Document abbreviations and their function.  

 Identify documents used in the organization's daily operations.   

 Compile a list of the organization's master data sets.   

 List the internal controls that are applied and adopted during each business process stage.   

 Create a list of currently used and recently generated management information reports.  

(c)  Top Management Commitment: Management needs to exploit future communication and computing 
technology issues in order to integrate the ERP system with e-business applications in their organization to 
decide on the key related implementation and business issues. Due to enormous impact on the competitive 
advantage of the company, top management must consider the strategic implications of implementing an ERP 
solution keeping in mind the size of the company and the modules installed. Management must ask several 
questions before embarking on project.  

 Does the ERP system strengthen the company's competitive position? How might it erode the company's 
competitive position?  
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 How does ERP affect the organizational structure and the culture? What is the scope of the ERP 
implementation -- only a few functional units or the entire organization?  

 Are there any alternatives that meet the company's needs better than an ERP system?  

 If it is a multinational corporation, the management should be concerned about whether it would be better 
to roll the system out globally or restrict it to certain regional units?  

2.  Organizational Change Process 

ERP implementation requires organizations to reengineer their key business processes reengineering of the 
existing processes, integration of the ERP with other business information systems, selection of right 
employees, and training of employees on the new system. 

(a) Reengineering of the existing Process: Implementing an ERP system involves reengineering the 
existing business processes to the best business process standard which at the end must conform to the ERP 
model. ERP systems are built on best practices that are followed in the industry, though the cost and benefits of 
aligning with an ERP model and customizing could be very high. The more the customization, the greater the 
implementation costs.  

(b) Integration of ERP with other BIS: The benefits of an ERP application are limited unless it is 
seamlessly integrated with other information systems. Some of the major concerned areas would be:  

 Integration of ERP Modules  

 Integration of E-Business Applications  

 Integration with Legacy Systems  

(c) Selection of Right Employees: Companies intending to implement an ERP system must be willing to 
dedicate some of their best employees to the project for a successful implementation. Internal resources on the 
project should exhibit the ability to understand the overall needs of the company and should play an important 
role in guiding the project efforts in the right direction. Companies should consider comprehensive guidelines 
while selecting internal resources for the project. Lack of proper understanding of the project needs and the 
inability to provide leadership and guidance to the project by the company's internal resources is a major 
reason for the failure of ERP projects.  

(d) Training Employees: Training and updating employees on ERP is a major challenge as it is extremely 
complex and demanding. It is difficult for trainers or consultants to pass on the knowledge of ERP package to 
the employees in a short period of time. This knowledge transfer gets hard if the employees lack computer 
literacy or have computer phobia. In addition to being taught ERP technology, employees have to be taught 
their new responsibilities.  

3. Implementation Cost and Time            
(a)  Implementation Cost: Even though the price of prewritten software is cheap compared with in-house 
development, the total cost of implementation could be three to five times the purchase price of the software. 
The implementation costs would increase as the degree of customization increases. After training the selected 
employees, strategies such as bonus programs, company perks, salary increases, continual training and 
education, and appeals to company loyalty work to retain them. Other intangible strategies such as flexible 
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work hours, telecommuting options, and opportunities to work with leading-edge technologies are also being 
used. 

(b) Implementation Time: ERP systems come in modular fashion and do not have to be implemented 
entirely at once. ERP packages are very general and need to be configured to a specific type of business and 
may follow a phase-in approach with one module implemented at a time. Some of the most commonly installed 
modules are Sales and Distribution (SD), Materials Management (MM), Production and Planning, (PP), and 
Finance and Controlling (FICO) modules. The length of implementation is affected by the number of modules 
being implemented, the scope of the implementation, the extent of customization, and the number of interfaces 
with other applications. The more the number of units, the longer the implementation time. Further as the scope 
of implementation grows from a single business unit to multiple units spread out globally, the duration of 
implementation increases.  

4. Employee Morale 

Employees working on an ERP implementation project put in long hours (as much as 20 hours per day) 
including seven-day weeks and even holidays. Even though the experience is valuable for their career growth, 
the stress of implementation coupled with regular job duties could decrease their morale rapidly. Leadership 
from upper management and support and caring acts of project leaders would certainly boost the morale of the 
team members. Other strategies, such as taking the employees on field trips, could help reduce the stress and 
improve the morale. 

ERP solutions are revolutionizing the way companies produce goods and services. They are a dream come true 
in integrating different parts of a company and ensuring smooth flow of information across the enterprise 
quickly. ERP systems bring lot of benefits to organizations by tightly integrating various departments of the 
organization.  

ERP systems are very large and complex and require a careful planning and execution of their implementation. 
They are not mere software systems; they affect how a business conducts itself. The top contributor for a 
successful ERP implementation is strong commitment from upper management, as an implementation involves 
significant alterations to existing business practices as well as an outlay of huge capital investments. The other 
important factors are the issues related to reengineering the business processes and integrating the other 
business applications to the ERP backbone. Upper management plays a key role in managing the change an 
ERP brings into an organization. Organizational commitment is paramount due to possible lengthy 
implementation and huge costs involved. Integrating different software packages poses a serious challenge, 
and the integration patchwork is expensive and difficult to maintain. 

Selecting and managing consultants pose a continuous challenge due to the shortage of skilled consultants in 
the market. Organizations could reduce the total cost of implementation if they reduce customization by 
adapting to the ERP's built in best practices as much as possible. Selecting the right employees to participate in 
the implementation process and motivating them is critical for the implementation's success. Finally, it is 
important to train the employees to use the system to ensure the proper working of the system. 

An ERP implementation is a huge commitment from the organization, causing several lakhs of rupees and can 
take up to several years to complete. However, when it is integrated successfully, the benefits can be 
enormous. A well-designed and properly integrated ERP system allows the most updated information to be 
shared among various business functions, thereby resulting in tremendous cost savings and increased 
efficiency.  



Main source : ICAI

 downloaded from : taxupindia.com

ERP IMPLEMENTATION  

 ADVANCED INFORMATION TECHNOLOGY 333 

 

2.3  ERP Implementation - Traps   
Even the most experienced organizations in information technology domain have had futile experiences in the 
implementation of the Enterprise Resource Planning (ERP) systems. This article highlights some of the issues 
which are presumed consequential to failures, they are by no means the most important, but they are missed in 
many implementations.  

(a)  Change Management and Training. This was mentioned as the major problem with implementations. 
Changing work practices to fit the system is a major difficulty. Also mentioned were training across modules 
and starting training sooner.  

(b)  To Business Process Re-engineering (BPR) or not to BPR. It is difficult to draw the line between 
changing Business Processes to suit the system or retaining Business Processes and paying the cost, in 
rupees and time, to change the system. As time and cost squeeze the implementation, the usual path is to not 
modify the system, but to change the way people work. This feeds back into Change Management and 
Training.  

(c)  Poor Planning. Planning covers several areas such as having a strong business case, to the availability 
of users to make decisions on configuration, to the investing in a plan that captures all the issues associated 
with implementing it.  

(d)  Underestimating IT skills. As most people are upgrading from old technology, the skills of the staff 
need to be upgraded as well. The upgrade is also going to place significant demands on a team who are geared 
to maintain an old but stable environment. Usually this effort is underestimated.  

(e)  Poor Project Management. Very few organizations have the experience in house to run such a complex 
project as implementing a large-scale integrated solution. It usually requires outside contractors to come in and 
manage such a major exercise. It can be a fine line between abdicating responsibility and sharing responsibility. 
Many consulting firms do a disservice to their clients by not sharing the responsibility.  

(f)  Technology Trials. The effort to build interfaces, change reports, customize the software and convert 
the data is normally underestimated. To collect new data, and clean the data being converted, will also require 
an effort that is beyond what is normally expected.  

(g)  Low Executive Buy-in. Implementation projects need senior executive involvement to ensure the right 
participation mix of business and IT, and to resolve conflicts.  

(h)  Underestimating Resources. Most common budget blow outs are change management and user 
training, integration testing, process rework, report customization and consulting fees.  

(i)  Insufficient Software Evaluation. This involves the surprises that come out after the software is 
purchased. Organizations' usually do not do enough to understand what, and how the product works before 
they sign on the bottom line. The Bleeding Edge ERP is so massive and integrated that reporting and linking to 
other systems (either your own or your customers and suppliers) can be much more difficult than you expect. 
Companies looking at ERP need to examine how they accept online feeds from a customer, or a customers' 
customer, and examine the technological enablers as well as the implications of these technologies inside of 
the Business.  
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These lead to a list of likely problems with an ERP system. 

 The cost is likely to be underestimated  

 The time and effort to implement is likely to be underestimated  

 The resourcing from both the Business and IT is likely to be higher than anticipated  

 The level of outside expertise required will be higher than anticipated  

 The changes required to Business Processes will be higher than expected.  

 Scope control will be more difficult than expected  

 There will never be enough training - particularly across different modules  

Most important of all, and the single biggest failure point for ERP implementations, is the need for change 
management. The need for change management is not likely to be recognized until it is too late. The changes 
required to corporate culture are likely to be grossly underestimated. It is going to be hard enough to cope with 
the technical issues without having to address major people issues as well. 

2.4  ERP Security Audit  
Enterprise Resource Planning (ERP) is an enterprise-wide information system designed to coordinate all the 
resources, information, and activities needed to complete business processes such as order fulfillment or 
billing. Many firms rely on ERP systems to implement business processes and integrate financial data across 
their value chains. This reliance increases the importance of ERP system security in protection of a firm's 
information assets. In recent years, the audit of ERP security has gained importance and begun receiving an 
increasing percentage of firms' audit budgets. However, the audit of ERP security remains a complex, lengthy 
and costly task due to a confluence of factors. 

ERP systems are inherently complex systems spanning many functional areas and processes along a firm's 
value chain. They are designed to provide flexible solutions to business problems. The sheer number of 
possibilities available for configuring an ERP system implies many potential security configurations. However, 
ERP systems pay little attention to potential conflicts and problems in those security configurations. Deployment 
and implementation of ERP systems also pay little attention to security implications, as the main purpose is to 
solve business problems within time and budget. In post implementation stages, auditors have access to 
rudimentary ERP tools and capabilities for auditing security configurations. There are also shortages of staff 
members trained in the ERP security. 

Unfortunately, the increased enthusiasm on this subject has been met with complex and costly challenges. 
Many companies and audit firms are not yet prepared to tackle the need for a rigorous ERP security audit. 
Major challenges in auditing ERP Security are given as follows: 

(a)  Complexity of ERP systems: Complexity of ERP systems leads to security vulnerabilities. ERP systems 
must be able to process a wide array of business transactions and implement a complex security mechanism 
that provides granular-level access to users. For example, in SAP R/3, hundreds of authorization objects are 
used to allow access to various actions in the system. A small or medium-sized organization may have 100 
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transactions that are commonly used, and each transaction typically requires at least two authorization objects. 
If the company has 200 end users who fill a total of 20 different roles and responsibilities, there are 
approximately 800,000 (100*2*20*200) ways to configure security in the ERP-and this scenario excludes other 
complexity factors, such as multiple transactions sharing the same authorization objects, an authorization 
object having up to 10 fields that can be assigned to various values, and the possibility of using position-based 
security. The point of this illustration is that the inherent complexity of an ERP system increases the complexity 
of security configurations and leads to potential security vulnerabilities. Flaws, errors and Segregation-Of-Duty 
(SOD) conflicts become more likely.  

Consider a scenario in which a security administrator has to grant read-only access to transaction X, which 
requires him/her to assign 10 authorization objects to the role. At a later point in time, management decides to 
grant write access to transaction Y, which implies assigning five more authorization objects. One of the objects 
is common to both transactions and determines the write capability. Although these two changes are seemingly 
independent, due to the shared authorization object granting write privileges, the unintended consequence is a 
potential SOD conflict.  

An ERP system does not automatically check for these kinds of security vulnerabilities. Unless the security 
administrator is well trained and employs rigorous positive and negative testing, he/she is likely to miss the 
unintended consequence of allowing write access to both transactions X and Y. As the number of potential 
configurations and authorization objects increases, it becomes increasingly difficult and costly to analyze the 
security implications of ERP configurations, such as the unintentional creation of SOD conflicts.  

(b)  Lack of ERP Tools: ERP tools for security audit are inadequate. Most of the security tools available in 
ERP packages are not designed to facilitate efficient and effective audit of ERP security. The main emphasis of 
ERP tools is on security configuration and maintenance. Recently, there has been an increase in the number of 
third-party product offerings assisting with ERP security and SOD reviews. However, many users complain that 
those tools often generate false positives and create more work for auditors.  

(c)  Customization of ERP Systems: The customization of ERP systems to firms inhibits the development of 
standardized security solutions. Every ERP implementation contains some level of customization specific to the 
firm undertaking the implementation. However, customization makes it difficult to develop a standard approach 
or methodology for conducting ERP security audits.  

(d)  Manpower: There is a shortage of manpower trained in ERP security. Most ERP training programs are 
designed for implementation efforts. They offer very little on ERP security and audit. Thus, there is a shortage 
of auditors who are trained in ERP security.  

(e)  Inadequate attention towards security: Implementers pay inadequate attention to ERP security during 
deployment. Many companies do not pay adequate attention to security implications of ERP configurations 
during the deployment and implementation of ERP systems. Implementation teams are usually tasked with 
finishing the implementation projects on time and within budget. They do not pay adequate attention to security 
implications since it increases implementation time and budget. Due to limited emphasis on security 
implications, ERP security becomes too lax, making post implementation problem identification and remediation 
very costly. 

(f)  Conventional Approach: Most ERP security audits today are performed using a manual approach. 
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There is little automation beyond the use of native tools that come standard with ERP packages. Unfortunately, 
the bottleneck of the manual approach is the limitation of the native security reporting tools found in most ERP 
products. These native tools are not designed to facilitate a large-scale audit effort, but rather to help security 
administrators perform occasional validation of the accuracy of security configuration. They allow reporting on 
only a single transaction per query, which may be adequate for a security administrator who works full time and 
handles each transaction request individually; however, it is not as practical for an IT auditor who is expected to 
perform the audit in a limited period of time and must test a large number of transactions. Although some IT 
auditors are able to utilize technology to perform this process more efficiently than others, as long as the 
process is based on the same philosophy of manual extraction followed by analysis, it continues to be an 
incredibly tedious and time-consuming task. The manual method is also prone to human errors.  

In today's business life, ERP is recognized as an effective tool which supports most of the business systems 
that maintain the data needed for a variety of business functions such as Manufacturing, Supply Chain 
Management, Financials, Projects, Human Resources and Customer Relationship Management in a single 
database. On the other hand, auditing of ERP security is also a demanding area which requires proper 
attention. Though many steps have already been taken by various researchers worldwide, but for smooth and 
efficient functioning of business tasks in a better manner, there is still a need of many more initiatives to be 
taken in this direction. 

2.5  Introduction to Tally.ERP 9 
Tally.ERP 9 is the world's one of the fastest and most powerful concurrent multi-lingual business accounting 
and inventory management software. Tally.ERP 9, designed exclusively to meet the needs of small and medium 
businesses, is a fully integrated, affordable and comparatively reliable software. Tally.ERP 9 is easy to buy, 
quick to install, and easy to learn and use. Tally.ERP 9 is designed to automate and integrate all your business 
operations, such as sales, finance, purchasing, inventory, and manufacturing. With Tally.ERP 9, accurate, up-to 
date business information is literally at your fingertips anywhere. The powerful new features and blazing speed 
and power of Tally.ERP 9 combine with enhanced MIS, Multi-lingual, Data Synchronization and Remote 
capabilities help you simplify all your business processes easily and cost-effectively. 

Features of Tally.ERP 9 

The Tally.ERP 9 encompasses the following salient features: 

 Simplicity: Tally.ERP 9 is simple, easy to setup and use. It also allows easy keyboard operations. It 
requires basic knowledge of accounts and English to use it. 

 Speed: Tally.ERP 9 provides the capability to generate instant and accurate reports, which assists the 
management to take timely and correct decisions for the overall productivity and growth of the company.  

 Power: Tally.ERP 9 allows the user to maintain multiple companies and with unlimited levels of 
classification & grouping capabilities. It also allows drill down facility from report level to transaction level. 

 Flexibility: Tally.ERP 9 provides flexibility to generate instant reports for any given period (month/year) 
or at any point of time besides providing the facility to toggle between accounting & inventory reports of 
the same company or between companies. 
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 Scalability: Tally.ERP 9 suits to any style of business needs and eliminates the necessity for a business 
to change its style of operation, in order to adapt to the application.  

 Concurrent multi-lingual capability: Tally.ERP 9 offers you the exclusive capability of maintaining your 
accounts in many Indian languages and few international languages, viewing them in another language 
and printing them in yet another Indian language.  

 Real time processing: Immediate posting & updation of books of accounts as soon as the transactions 
are entered, thereby facilitating instant statements & reports. It also facilitates real-time multi-user 
environment.  

 Accounting without codes: Tally.ERP 9 allows accounting with the regular names (the way you spell 
them or use in normal parlance) without any account codes.  

2.6  Technological Features in Tally.ERP 9 
It is a given that businesses grow either from being small / simple to larger / complex. Needing to cope up with 
scaling up business operations both internally and externally and bringing in much needed flexibility is a key 
requirement for any business. The enabling technology that makes this possible is detailed as below sections: 

2.6.1  Quick and Easy installation  

Tally.ERP 9 has a simple, menu-driven installation procedure. The user can install the program files on any 
drive if the hard disk has partitions. The user can also specify the name and directory location of the program 
files. Tally.ERP 9 uses minimum hard disk space in the local drive. Its installation on the local disk takes just a 
few seconds. 

2.6.2  Codeless User Interface  

As a business user, your vendors or customers are not codes but are entities that have a distinct name and 
identity. So why add Customer ID/code to them to create uniqueness. Let us take an example of customers who 
have the same name for their business for instance Ganesh Enterprises. Now while referring to them will you 
say account no 3456 Ganesh enterprises or account no 3457. What you would actually do is distinguish them 
by their area of operation, e.g. Ganesh Enterprises New Bazaar Street and Ganesh enterprises Gandhi Nagar. 
This not only overcomes the issue of speed and human error. Rapid incremental search without the introduction 
of new data elements is facilitated as well. For instance while typing Ganesh enterprises all business that 
begins with Ganesh is displayed and you can narrow on the choice very quickly. 

2.6.3  Multiple aliases across languages  

In business you may refer to the same item differently based on the context be it stocks, ledger accounts, 
locations, employees, categories, groups and so on. Tally's multi-referential system allows multiple names to 
refer to the same entity.  

2.6.4  Extendible Units of Measure  

A stock unit can be purchased, stocked, manufactured or sold in different units of measure. These measures 
are just simple units or are a derivative of specific units. Translation of units across each definition is easy and 
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intuitive. There are instances where the stocking unit and the transaction unit are different; this is possible by 
defining the multiplication factor at the time of at the transaction i.e. time of sale or Physical Stock take. 

2.6.5  Unlimited Grouping and Classification  

In business recasting accounting data is common place especially when reports are to be generated from a 
particular view of the business be it a geographical location, a product line, a department a function. This 
aspect needs to be configured at the time of setting up the COA or the relevant entities and brings in 
unnecessary rigidity. This rigidity is inherited even in the transactions and imposes restriction on reports that 
are generated. With Tally the flexibility to sub classify, re-classify entities removes this rigidity that is imposed at 
the transaction level also at the report really necessary and this aspect of being able to classify, reclassify 
items, groups & categories, godowns, ledger groups, cost categories, centers, budgets etc.   

2.6.6  Unlimited multi-user support  

A multi-user version of Tally.ERP 9 can be installed on a network, having any number of computers with 
different operating systems such as Win 95, 98, NT, 2000, XP, Vista, Windows 7, Windows 8, etc.. 

2.6.7  Graphical analysis of data  

Tally.ERP 9 provides graphical analysis of data which helps the user to perform deeper analysis. The user can 
generate graphical analysis reports such as Sales Register, Purchase Register, Ledgers, Funds Flow, Cash 
Flow, Stock Item Registers and so on. This helps the management to quickly judge performance and be better 
prepared for difficult times.  

2.6.8  Flexible and Extendible reporting  

This is essentially ensuring that reports are not limited to specified financial years or periods thus allowing, 
generating total expenses for a particular period extending beyond multiple financial periods. This actually 
translates into eliminating concepts of day end processing, month end processing or posting to control accounts 
etc and keeping the accounting data free from such artificial bifurcations. Given this flexibility users are able to 
generate reports across 2 to 3 financial years an example to illustrate this business need is tracking civil 
construction project expenses across financial years. You can also track inventory levels, expenses for each 
project. 

2.6.9  Data Reliability and Automatic recovery  

Tally provides a high level of reliability of data with several technologies built into it. The data does 
not get corrupted even if there is a sudden machine shutdown or network breakdown or power cut. 
This is ensured using the concept of transaction atomicity which is supported by the object oriented 
storage. Tally uses data integrity checks intensively to detect any change to your data by external 
means. Any corruption happening in this way will be instantly detected as the program operates the 
data with a timely warning to you. Besides providing a warning, Tally provides you a unique 
capability to recover from most corruptions by allowing you to simply rewrite the data. The corrupted 
data is then discarded and you can continue with normal operations, at the most re-entering the 
corrupted transactions or masters only.  



Main source : ICAI

 downloaded from : taxupindia.com

ERP IMPLEMENTATION  

 ADVANCED INFORMATION TECHNOLOGY 339 

 

2.6.10  Internal backup/ restore  

Tally.ERP 9 has an in-built, user-friendly ‘backup and restore’ option. It helps the user to take a backup of one 
or more companies or all companies, in a single directory, in the local hard disk, or in any external media. 

2.6.11 Import/ Export of data  

Any transaction can be exported and imported to other software after suitably altering the current structures to 
accept the Tally.ERP 9 data structure. Data can also be imported to Tally.ERP 9 by writing a Tally Definition 
Language program. The data which is to be exported from Tally.ERP 9 can be in XML, HTML or ASCII format.  

2.6.12  Split Company Data  

Tally.ERP 9 allows users to maintain a company for any number of financial years. Once the books of accounts 
have been completed for the earlier financial years, the user can split the company data into multiple 
companies as per financial periods required. Tally.ERP 9 also has a feature to split company data. The user 
can specify the date from which the company has to be split and Tally.ERP 9 will split the company to form two 
companies as per periods specified. Once the data has been split, the closing balance of the first period (first 
company) becomes the opening balance for the next period (second company).  

2.6.13  HTTP-XML based data interchange  

Tally uses a recursive object oriented data structure which can naturally and easily be expressed as XML. Tally 
can export your data in XML format and can also import data coming in XML format. This is a fundamental 
capability of the program and can be easily used to extract data for third party applications or to pump in data 
from third party applications as long as it is compliant with the schema of a voucher or master. The process can 
be automated since Tally can run as an HTTP (Hyper text transfer protocol) server and can process requests 
for import or export in HTTP-XML to this server from other applications. Even third party web applications 
written in ASP, PHP, and Java etc. can talk to your Tally running as an HTTP server and provide real-time 
information or remote data input. The third party application can send a request to Tally to get any report in 
XML or even in HTML formats. Even new reports can be added by defining them in TDL (Tally Definition 
Language). In the same way, a master or a voucher can be created in XML and sent to Tally server as an 
HTTP-XML request and will be processed and stored by Tally.  

2.6.14  References  

The concept of a document being correlated to transactions other than its document number is a concept that 
allows for one to one, many to one, many to many adjustment of payments/receipt against invoices/loans/other 
transactions. Work may not flow in sequence, for instance  

Purchase Order > Advance > Invoice > Receipt of Goods > Goods Return > Payment 

What actually happens is material is received, purchase orders are regularized, prices are re-negotiated, goods 
are received in multiple batches, multiple POs are processed into a single receipt note or multiple debit notes 
are raised for price adjustments etc. or payments are staggered based on delivery, All of this cannot be referred 
against a single document number and hence the need to separate reference nos. against document numbers 
bring about flexibility in the document flow and references at the same time.  
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2.6.15  Tally Fit Technology  

Where names of accounts, party ledger accounts run beyond a certain length you are required to find 
abbreviations and sometimes these abbreviations that are not intuitive and becomes code based. With Tally fit 
technology the characters are reduced in breadth and user is allowed to input additional characters which 
would make the account name, entity complete and readable.  

2.6.16  Multi-directory for company management  

The user can create multiple directories / folders to store data. The data stored in these directories can be 
accessed directly in Tally.ERP 9, by specifying the path. 

2.6.17  User-defined security levels  

Tally.ERP 9 offers high levels of security. Users can define multiple levels of security according to their 
requirements. Every authorised user in the company can have an individual password, with rights to use 
specific features only. The user with the administrator level password will have full access and can set controls 
for other users.  

2.6.18  Tally Audit Feature  

The Tally.ERP 9 audit feature provides the user with administrator rights and the capability to check the entries 
made by the authorised users and alter these entries, if necessary. Once the entries are audited, Tally.ERP 9 
displays the altered entries, if any, along with the name of the user, who has altered the entry, and the date and 
time of the alteration. 

2.6.19  Tally Vault  

Tally.ERP 9 offers a data encryption option called Tally Vault. Without the valid Tally- Vault password, the data 
cannot be accessed. Tally.ERP 9 follows the DES (Data Encryption Standard) encryption method to safeguard 
the data.  

2.6.20 ODBC data access  

Tally provides an ODBC (Open database connectivity) driver natively which allows other applications like MS-
Excel (which can use an ODBC data source) to directly pick up data from Tally running as an ODBC server. 
This data is again real-time data and can be refreshed by such applications any time as long as Tally is 
running. You can pick and choose the available information and design your own reports in tools like Excel. The 
type of data available on ODBC from Tally can be extended using TDL (Tally definition Language). 

2.6.21 Data Synchronization  

Synchronization is the process of exchanging Tally.ERP 9 data between two or more locations. This process 
enables a branch office to send its data to the head office, over the Internet or a private network. Tally.ERP 9 
has the ideal solution for those who have their data in Tally 7.2 and now want to use Tally.ERP 9.  
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2.6.22 Data Migration Capability  

Tally.ERP 9 provides a migration tool which helps the user to migrate the data easily to the latest version and 
continue with day-to-day transactions. Data of all the previous versions, e.g. Tally 4.5, 5.4, 6.3, 7.2, 8.1, 9 can 
be migrated to Tally.ERP 9. Data of old version can be migrated to new version, but data of new version cannot 
be migrated to old version.  

2.6.23 Multilingual capability  

Tally.ERP 9 is the world's first accounting and inventory software with multilingual capability. Currently, 
Tally.ERP 9’s multilingual capability extends to 12 languages which include nine Indian languages (Hindi, 
Gujarati, Punjabi, Tamil, Telugu, Marathi, Kannada, Malayalam and Bengali), Bahasa Melayu and Bahasa 
Indonesia. Tally.ERP 9 enables you to enter data in one language and have it transliterated into different 
languages. You can generate invoices, purchase orders or delivery notes in the language of your choice after 
entering data for the same in any of the nine specified languages. Also, the phonetic keyboard allows you to 
spell the term phonetically based on how it sounds and Tally.ERP 9 displays the data in the language selected 
after transliteration.  

2.6.24 Direct web browser access  

While working on Tally.ERP 9, the user can directly log on to the Tally website, provided he/ she have access 
to the Internet. The website lists details of all the facilities offered by Tally.ERP 9. The user can also download 
the latest release of Tally.ERP 9 as and whenever it is available. The Tally website also offers Tally Chat, by 
which a user can communicate with a Tally representative and get required information.  

2.6.25 Web Publishing and Email Facility 

Companies which want to publish reports and price lists on their website can do so directly from Tally.ERP 9. It 
also facilitates the mailing of any Tally.ERP 9 report or document.   

2.6.26 Tally.NET  

Tally.NET is an enabling framework which establishes a connection through which the remote user can access 
the Client's data without copying / transferring the data. In other words, the remote user can access the 
company data, provided the Company is open and connected on Tally.NET.  
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Fig. 2.6.1 Tally.NET 

(a) Tally.NET Features 

Tally.NET is a default feature available in the product and provides the following host of capabilities.  

 Connect companies from Tally.ERP 9  

 Create and maintain Remote Users 

 Synchronization of data (via Tally.NET)  

 Remote access of data by authorised Remote User(s) 

 Use online help and support from Tally or the browser  

 Use Control Centre for centralised Account Management 

 Remote availability of Auditors' Edition of Tally License 

2.6.27 Remote Access  

Tally.ERP 9 provides remote capabilities to access the data from anywhere and anytime. The account 
administrator can create user id’s, authorise and authenticate them to access data remotely. 

The Remote users created under the security level Tally.NET Auditor or Tally.NET User can login, audit and 
access data from a remote location using another instance of Tally.ERP 9 running in Licensed or Educational 
mode. The data is transferred between the remote location and the server using a secured mechanism called 
encryption. 
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Fig. 2.6.2 Remote Access 

2.6.28  Control Centre  

Tally.ERP 9 provides a powerful feature named Control Centre to its users, which works as an interface 
between the user and Tally.ERP 9 installed at different sites, it enables the user to centrally configure and 
administer Site / User belonging to an account. The Control Centre encompasses the following features 

 Manage Licenses  

 Central Configuration  

 Manage Users  

 Manage Company Profile  

 Manage Accounts (using My Tally.NET Accounts)  

 Change Passwords 

 Jobs and Recruitments  

 Activity History  
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Advantages of Control Centre  

The Advantages of Control Centre are represented in the following diagram 

 

Fig. 2.6.3 Control Centre 

The Advantages of Control Centre are:  

1.  Create users with predefined Security levels  

2.  Centrally configure and manage your Tally.ERP 9  

3.  Surrender, Confirm or Reject activation of a Site  

4.  Maintain Account related information 

2.6.29 Auditor’s Edition  

A developing economy, widening tax net and increasing compliance requirements make an auditor's role 
critical. A Chartered Accountant as an entrepreneur is exposed to various operational risk factors viz., time, 
increasing travel & people costs, limited availability of skilled manpower, intense audit periods. This alleviate 
these circumstances, Tally.ERP 9 offers Auditors’ Edition, which provides Audit & Compliance capabilities for 
Chartered Accountants. The Auditors’ Edition provides the Chartered Accountants with Tax Audit and Statutory 
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Compliance tools which equips him / her to retrieve the required information on the basis on which he form an 
opinion.  

Tally.ERP 9 - Auditors' Edition is designed to help CAs to transform their practice and streamline their client’s 
businesses. The Auditors' Edition also helps to increase audit efficiency, reduce time and effort, and increase 
opportunity for providing additional bill-able services. 

Advantages of Auditors' Edition of Tally.ERP 9  

 Secure remote access to client data  

 At-a-glance dashboard showing voucher / ledger correctness and verification status  

 Easy identification of errors by way of exceptions 

 Special audit and compliance menus  

 Generate annexure for Tax Audit under Sec 44AB Using Auditors’ Edition of Tally.ERP 9, a Chartered 
Accountant can provide services to their clients in the following scenarios.  

o Audit at CA’s office by accessing local data 

o Audit at Client’s place by accessing local data 

o Audit Remotely by accessing Client’s data from anywhere  
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3.1  Tally.NET and Remote Capabilities 
3.1.1 Overview of Tally.NET 

Tally.NET is an enabling framework which establishes a connection through which the remote user can 
access the client's data without copying / transferring the data. In other words, the remote user can access 
the company data, provided the Company is open and connected on Tally.NET. 

Using Tally.NET features, the user can create remote users (IDs), authorize & authenticate them for 
accessing the connected (available) companies. The remote users can be mapped to a particular user and 
assigned security controls based upon their security levels (viz., Tax Auditor / Administrator, Standard User 
etc.). The remote user can further create sub-ids under him to assign tasks based on their security levels. 

The user making the company available and a person accessing the data behave as clients to Tally.NET, 
thereby rendering a secure exchange system. 

Tally.NET Features 

Tally.NET is a default feature available in the product and provides the following host of capabilities. 

 Connect companies from Tally.ERP 9 

 Create and maintain Remote Users 

 Synchronization of data (via Tally.NET) 

 Remote access of data by authorised Remote User(s) 

 Use online help and support from Tally or the browser 

 Use Control Centre for centralised Account Management 

 Remote availability of Auditors' Edition of Tally License 

As discussed above, Tally.NET is enabled in Tally.ERP 9 but however, certain configurations are required to 
be setup for enabling Company data to get connected. Follow the steps given below: 

1. Configuring Tally.NET features 

2.  Creating and Authorizing Remote Users 

CHAPTER 

3 
LEARNING OBJECTIVES 
 Management and Controls in Tally.ERP 9 
 Security Management in Tally.ERP 9 
 Data Management in Tally.ERP 9 
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3.1.2 Configure Tally.NET Features 

To configure Tally.NET follow the steps shown: 

Go to Gateway of Tally > F11: Features > F4: Tally.NET Features 

 The Tally.NET Features screen appears. 

 In the Registration Details section 

o In the Connect Name field provide a specific name with which the company is displayed on 
Tally.NET servers. 

o Provide the name of the contact person in the field Contact Person Name. 

o Provide the Mobile/Telephone numbers of contact person in the field Contact Number 

 The name of the contact person and the contact number are published along- with Company Name, 
Account ID and Serial Number in the List of Companies screen. 

 In the Connect for Remote Access section, 

o Allow to Connect Company is set to Yes, in case you want the company to be connected for 
remote access. 

o Contact on Load is set to Yes, when you want the company to be connected automatically for 
remote access on loading. 

o Press Enter to accept. 

The completed Tally.NET Features screen is displayed as shown in Fig 3.1.1: 

 

Fig. 3.1.1 Tally.NET Features 

 Accept to save the Configurations 
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You must set Security Controls to “Yes” while creating/altering a company, in order to enable 
Tally.NET in Tally.ERP 9. 

3.1.3 Connect Company on Tally.NET 

To connect the company on Tally.NET, 

Go to Gateway of Tally > press F4: Connect. 

 

Fig. 3.1.2 Connected to Tally.NET 

A message “Company connected successfully” is displayed in the Calculator panel. 

In the same way to disconnect a Company from Tally.NET, 

Go to Gateway of Tally, 

 Press F4: Disconnect 
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Fig. 3.1.3 Disconnected from Tally.NET 

A message “Company disconnected successfully” is displayed in the calculator panel. 

3.1.4  Create Remote Users 

Tally.ERP 9 allows you to connect from a remote location and access your data. The Remote users are broadly 
classified into two security levels, namely: 

 Tally.NET User: can access data from a remote location. 

 Tally.NET Auditor: can audit data from a remote location, subject to using Auditor’s Edition of Tally.ERP 9. 

To create the remote users: Go to Gateway of Tally 

 Click “K: Control Centre” button or press Ctrl + K. 

 The Login as Remote Tally.NET User screen is displayed. 

 Enter the required Account ID in the Your E-Mail ID field and Password in Your Tally.NET Password 
field. The password is sent by e-mail separately to the email address provided while activating Tally.ERP 9. 

 

Fig. 3.1.4 Login as Tally.NET User 
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 Press Enter 

 The Control Centre screen appears as shown: 

 

Fig. 3.1.5 Control Centre 

 Select My Tally.NET Accounts, the My Tally.NET Accounts 

Screen appears 

 Select the required Account ID and press Enter. 

 The Control Centre for the selected Account ID screen appears 

 Select User Management and press Enter. 

 The User Management screen appears: 

 

Fig. 3.1.6 User Management - List of Users 

To create Remote Users, execute the following steps: 

 Select Standard User from the list of Security Level. 



Main source : ICAI

 downloaded from : taxupindia.com

ERP CONTROL AND AUDIT  

 ADVANCED INFORMATION TECHNOLOGY 351 

 

 Type any valid email ID in the Tally.NET ID field and press Enter. Please note that a Tally.Net ID has to 
be a valid email ID only. It cannot be a simple user name like “pankaj”, “swapnil”, “gauri”, etc.  

 Set Yes to Tally.NET User in case you want this user to access data remotely 

 Based on your requirement, select the required status from the list of Status. 

 Similarly you can create the required Tally.NET User. 

 

Fig. 3.1.7 User Management 

 Accept to save the new Tally.NET User that has been created 

The company’s system administrator should authorize Tally.NET User ID and connect to Tally.NET  

  and allow remote access. 

    A brief write-up about each feature of the Control  Centre is discussed under the section Features of  

    the Control Centre 

3.1.5  Authorise Remote Users 

Once the Company is registered and connected, the system administrator can authorise users created under 
Tally.NET User security level to access by logging in from a remote location. To authorise the remote users to 
login follow the steps shown: 

Authorise Remote User 

Go to Gateway of Tally > Press Alt + F3 

 The Company Info. menu appears 

 Select Security Control > Users and Password 

The List of Users for Companies screen is displayed as shown. 
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Fig. 3.1.8 List of Users for Company 

 Select Tally.NET User from the list of Security List. 

 Enter the same email ID which was typed in remote user creation in control centre e.g. 
“tallynetnormal1@tallysolutions.com” in Name of User field. Once the security level is selected 
as Tally.Net User, the user name field will accept a user name as an email ID only. It will not 
accept a plain user name like pankaj, swapnil, gauri, as stated above. Set Allow Remote Access 
to Yes, in order to allow Tally.NET User created earlier to access data from a remote location 

 Set Allow Local TDLs to Yes or No as per requirement. If set to No, local TDL available in the 
remote users machine will not be loaded. 

 Type mobile number of the respective user in Mobile Number field. This mobile number shall be used 
for sending and receiving sms to and from Tally. Mobile number is optional. 

 Select End of List. 

 

Fig. 3.1.9 Creation of Users 
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 Accept to Authorise the Tally.NET User. 

3.1.6 Remote Access 

Tally.ERP 9 provides remote capabilities to access the data from anywhere. The account administrator can 
create user IDs, authorise and authenticate them to access data remotely. 

The Remote users created under the security level Tally.NET Auditor or Tally.NET User can login, audit and 
access data from a remote location using another instance of Tally.ERP 9 running in Licensed or Educational 
mode. 

The data transferred between the remote location and the server is transferred using a secured mechanism 
called encryption. 

3.1.6.1 Login as Remote User 

 Start Tally.ERP 9 at the remote location 

 In the Company Info screen 

 Select Login as Remote User Or. 

 Select Login as Remote Tally.NET User in the Startup screen. 

 

Fig. 3.1.10 Login as Remote Tally.NET User 

 Press Enter. 

 The Login As Remote Tally.NET User screen is displayed. 
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 Enter your user ID, i.e. email address registered with Tally.Net and set in Tally Company, in Your Email 
ID field. 

 Enter the password emailed in Your Tally.NET Password 

 Press Enter. 

 The Select Remote Company screen is displayed, showing the list of remote companies accessible 
by the remote user. 

 

Fig. 3.1.11 Lists of Remote Companies 

 Select the required company and press Alt+O or click O: Open or press Enter. 

 The Gateway of Tally for the selected company appears displaying the Remote User Details 
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Fig. 3.1.12 Remote Company 

To view or print the reports select the required options available. 

3.2  Management and Controls 

3.2.1 Concept of Control Centre 

Tally.ERP 9 provides a powerful feature named Control Centre to its users, which works as an interface 
between the user and Tally.ERP 9 installed at different sites. It enables the user to centrally configure and 
administer Site / User belonging to an account. 

3.2.1.1 Features of Control Centre 

The Control Centre encompasses the following features 

 Manage Licenses 

 Central Configuration 

 Manage Users 

 Manage Company Profile 

 Manage Accounts (using My Tally.NET Accounts) 

 Change Passwords 

 Jobs and Recruitments 

 Activity History 

3.2.1.2 Advantages of Control Centre 

With the help of Control Centre, you will be able to 
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 Create users with predefined Security levels 

 Centrally Configure & manage your Tally.ERP 9 

 Surrender, Confirm or Reject activation of a Site 

 Maintain Account related information 

 Manage Licenses and Activity History 

 Manage Jobs and Recruitments 

3.2.2 Create users with predefined Security levels 

Using the Control Centre feature, the Account Administrator can create users and map them to a predefined 
security level and authorise them to access a Site / Location linked to that Account. Further the system 
administrator can also create Remote users and allow / disallow them to remotely access the data. 

The predefined security levels in Tally.ERP 9 are: 

 Owner 

 Data Entry 

 Tally.NET User 

 Tally.NET Auditor 

3.2.3 Centrally configure and manage your Tally.ERP 9 

The Control Centre provides the flexibility to make changes to product configurations in the Tally.ini 
(Configuration file) and apply them to immediate effect without restarting the application. 

The following master configurations set can be made from the Control Centre 

 Add / Modify the Tally.ini parameters 

 Assign TDL’s to a site or all the sites under an account 

 Permit or Deny changes to the local configurations 

The master configurations set created is applied initially to the account centrally which is inherited by the 
site(s) on updation of license, based on the site level permissions by the Account Administrator. 

3.2.4 Surrender, Confirm or Reject activation of a Site 

The Account Administrator is authorised to surrender, confirm a site license or Reject the request received on 
activation from another site. 

3.2.5 Maintain Account related information 

Control Centre allows maintain information about the organisation. Based on the requirements, the Account 
Administrator can merge multiple accounts into one or split an account into multiple accounts for easy and 
better management. 
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Before we start using Control Centre in Tally.ERP 9, it is recommended to understand the process of 
installation of Tally.ERP 9 as explained. 

3.2.6 Installing & Activating Tally.ERP 9 

Tally.ERP 9 software installation is a simple and one time activity. You can install program files on any drive 
(if the hard disk has partitions) or specify a directory for installation. You can also specify the location of the 
data directory. 

3.2.6.1 Installing Tally.ERP 9 

To install Tally.ERP 9: 

 Insert the Tally.ERP 9 Installation CD in the computer's CD drive 

 Select My Computer on Desktop 

 Select CD drive 

 Run Install.exe > Specify Path (for Program files and data directory) 

 Click Install 

 After Installation a message Installation Successful is displayed. Click OK. 

On successful installation of Tally.ERP 9, a shortcut is placed on the desktop, a folder titled Tally.ERP 9 is 
created in the selected drive and all the files required to run Tally.ERP 9 are stored in this default folder. 

In the same way, you can install Tally.ERP 9 Multi-User. In Multi-User installation, select the required 
programs (Tally.ERP 9 / License Server) to install at Server and client locations and specify other required 
details. 

3.2.6.2 Activating Tally.ERP 9 License 

On successful installation of Tally.ERP 9, the Licensing Operations Startup screen appears on your 
computer, once you start Tally.ERP 9. 

Step 1: Activate License 

To activate license, follow the steps given below: 

 Select Activate License, the Activate License screen appears as below shown in Fig. 3.2.1 
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Fig. 3.2.1 Startup screen 

The Activate License has two options which allow you to activate the license based on your requirements. 

 First time activation for your organization: allows you to activate a single site license. 

 Activation of an additional Site for your organization: allows you to activate the next or consecutive 
site licenses for your organization. 

 

Fig. 3.2.2 Activate License 

 Select First time activation for your organization 

 The Activate License Form appears, Enter the required License Serial Number in the Serial Number 
field 

 Enter the required Activation Key in the Activation Key field 

 Enter your E-Mail ID in the E-Mail ID of Administrator field 

 Repeat the Email-ID in the Repeat (E-Mail ID of Administrator) field 



Main source : ICAI

 downloaded from : taxupindia.com

ERP CONTROL AND AUDIT  

 ADVANCED INFORMATION TECHNOLOGY 359 

 

 

Fig. 3.2.3 Activation Form 

Unique account identification is created using this E-Mail Id and the license serial number is linked to this 
account. The License Key, Password and Account related information are mailed to the E-Mail Id provided 
in the activation form. 

 Press Enter, Tally.ERP 9 searches for the availability of Internet Connectivity on your computer 

 If Internet Connection is Available, Tally.ERP 9 displays a message Congratulation! Your activation 
Request has been processed 

 The Tally_lck.lic file is created and placed in the default Tally.ERP 9 directory 

You can also Activate License in Offline Mode, if Internet Connection is not available. To activate License in 
Offline Mode, generate the License File Offline and paste the license file onto the system where internet is 
available and Tally.ERP 9 is installed, go to the licensing menu, select send External request, the license 
file will be generated, copy the file and paste it where the license is to activated. 

Step 2: Unlock License File 

 Access your mail and retrieve the unlock key 

 In the Startup screen, select Unlock License 

 Type the Unlock Key in unlock field and press Enter 

 On successfully unlocking the license file, Tally.ERP 9 displays the message 

Congratulations! Your License is successfully activated. 

 Start Tally.ERP 9, the License Serial Number and Account ID are displayed under the Version and 
Licensing sections of the information panel respectively. 

In the same way, you can activate license for Multi-Site, by selecting Activation of an Additional Site for 
your Organisation in the Activate License screen and providing Site Name, Site Administrator Email ID and 
other related details. 
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3.2.6.3 Launch Tally.ERP 9 

Start Tally.ERP 9 by choosing any one of the methods discussed earlier. On starting Tally.ERP 9 the 
Gateway of Tally screen appears displaying the Edition and Users are under Version block, and the Serial 
Number and Account ID under License block of the Information panel. 

 

Fig. 3.2.4 Gateway of Tally 

3.2.7 Logging to Control Centre 

To start Control Centre follows the steps shown: Go to Company Info menu or Gateway of Tally 

1.  Press K: Control Centre or press Ctrl + K 

 

Fig. 3.2.5 Start Control Centre 

2.  The Login As Remote Tally.NET User screen appears as shown in Fig. 3.2.6 

 Enter the User ID in Your E-Mail ID field. 

 Enter the password emailed in Your Tally.NET Password field. 
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Fig. 3.2.6 Start Control Centre 

Based on the authentication received from Tally.NET you can access the Control Centre. 

Depending on the requirement, you can enter the Account/ Site Administrator's Id to 
administer an Account/Site respectively. You can also provide the other User Id to access the 
support centre and access other areas of the control centre based on the permissions 
assigned. 

In case, you have forgotten the Password, provide the Account/Site/User ID in Your E-Mail 
ID and press F5. The new password will be emailed to the respective E-Mail ID. 

3.2.8  Managing Accounts using Control Centre 

After logging in, the Control Centre screen will appear as shown in Fig. 3.2.7: 

 

Fig. 3.2.7 Control Centre 
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The Control Centre screen displays the options available which are briefly described below 

 My Tally.NET Account: Use this option to configure, activate / deactivate sites, create users and assign 
security levels and manage your Account details. The My Tally.NET Account has the following sub-
options: 

o Licensing & Configuration enables you to configure and surrender a site belonging to an account. 
The configuration set can be created for each site by the Account / Site administrator. Further, the 
Account Administrator may allow or restrain the site administrator from making any changes to the 
con- figuration set locally. 

o User Management enables you to administer users belonging to an account by assign security 
levels with predefined permissions to enable remote access, assign users to a site and maintain the 
active users as required. 

o Profile Management enables you to enter the essential information related to the Account/Site ID. 

o Change Account Admin enables you to change the Account Administrator’s ID. To change the 
account ID, the account administrator should provide the existing account ID and the new account 
ID. 

 Change My Profile enables you to manage the Tally.NET User’s profile by providing the required details 
for further communications. 

 Change My Password this option enables you to change password at your convenience. 

3.2.8.1 My Tally.NET Accounts 

 Select My Tally.NET Accounts and press Enter 

 On selecting My Tally.NET Accounts, the My Tally.NET Accounts screen appears as shown in Fig.3.2.8 

 

Fig. 3.2.8 My Tally.NET Accounts 

The My Tally.NET Accounts screen displays the User ID against Tally.NET ID field, the Account ID, 
Security Level, permission to access Tally.NET, Site ID (for Multi Site only), permission to administer the 
Account and the account status. It also displays the Account IDs associated with your Account, based on 
your requirement you may disassociate your Account ID. 
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 Site ID will not appear when you have a Single Site Account. 

 To disassociate from another account, select the required 

o Account ID and press Alt+D. 

 The Account/Site Administrator ID cannot be disassociated from associated accounts. 

The My Tally.NET Accounts screen for Multi-Site will appear as shown in Fig. 3.2.9: 

 

Fig. 3.2.9 My Tally.NET Accounts - Multi Site 

 Select the required Site Account ID and press Enter, the Control Centre of an Account appears as 
shown in Fig. 3.2.10 

 

Fig. 3.2.10 Control Centre of an Account 
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You can use this option to configure, activate / deactivate sites, create users and assign security levels and 
manage your Account details. The options available are briefly explained below: 

 Licensing & Configuration: Allows you to configure and activate / deactivate a site 

 User Management: You can create Remote Users and assign security controls 

 Profile Management: Maintain details related to your account 

 My Activity History: Display the list of accounts where your ID is used 

 Change Account Admin: Allows the Account Administrator to change the Account Administrator's User 
ID. 

3. 2.8.2 Licensing & Configuration 

The Account administrator can configure and surrender a site belonging to an account. The configuration set 
can be created for each site by the Account / Site administrator. Further, the Account administrator can allow 
or restrain the site administrator from making any changes to the configuration set locally. 

The Licensing & Configuration screen displaying the information related to each site / license serial number 
and the date on which the site was created. 

 

Fig. 3.2.11 Licensing & Configuration 

By default, the status is Active, based on your requirement you can surrender the license by selecting 
Surrender from the list of Status. The license status is briefly explained for your benefit: 

 Active: indicates that the site is in operation 

 Surrender: indicates that the site has been surrendered. 
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3. 2.8.3 General Configuration 

To create configuration set for a Site, follow the steps given below 

In the Licensing & Configuration screen 

 Click on F6: Show Config or press F6 

 The General Config and TDL Config fields appear as shown in Fig. 3.2.12 

 

Fig. 3.2.12 Licensing & Configuration 

 In the General Config field, press Alt+C to create configuration 

o The General Configuration Management screen appears 

o Enter the required configuration name in Name of Configuration field. The configuration 
parameters are saved with the configuration name provided in the account. 

o Set “Want to set client/server configuration” to “Yes” to create a fresh set of configuration. 

o In “Tally is acting as” field, select the required behaviour from the list of Client / Server list. 
Tally.ERP 9 will act as Server / Client / Both based on the parameter selected. 

o Set “Enable ODBC server” to “Yes”, when you want to transfer data from any third party application 
to Tally.ERP 9 or Vice Versa. 

o Enter the required port number in Port field. 

o Set “Can be overridden locally” to “Yes”, when you want the above parameters to be changed / 
modified by the site administrator locally. 

o In Disallow Request section, specify the required Server Name/ IP Address/URL in from field to 
deny a request from the Server/IP Address/ URL. 
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o Similarly, specify the required Server Name/ IP Address/URL in To field to deny a request to 
Server/IP Address/URL 

o In Allow Request section, specify the required Server Name/ IP Address/ URL in “From” field to 
allow a request from the Server/IP Address/URL. 

o Similarly, specify the required Server Name/ IP Address/URL in “To” field to allow a request to 
Server/IP Address/URL. 

 

Fig. 3.2.13 Licensing & Configuration 

o Press Enter to save the General Configuration 

o Select the specified configuration package in the General Configuration field. 

3.2.8.4 To View/Alter General Configuration 

In the Licensing & Configuration screen 

 Click F7: Gen Config List or press F7 

 Select the required configuration from the List of General Configs 

 The General Configuration Management screen will appear, you can make the required changes as per 
your requirements. 

The Select Item screen appears 
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Fig. 3.2.14 Licensing & Configuration 

3.2.8.5 User Management 

You can administer users belonging to an account by assigning security levels with predefined permissions in 
order to enable remote access, assign users to a site and maintain the active users as required. 

To administer the users within an account follow the steps shown: In the Control Centre screen 

1. Select User Management and press Enter 

2. By default, the Security Level for the User ID, Permission to access Tally.NET and the Status is 
displayed. 

3. To Create the required user: 

 Select the required Security Level from the list of Security Level 

 Enter the required E-Mail ID in the Tally.NET ID field.  

 Set Tally.NET User field to “Yes” when you want the user to access data from a anywhere using 
Tally.NET. 

 In the Status field, select the required status from list of Status which are explained below 

1.  Active: Set the status to active when you want the user to be in operational mode. 

2.  Deleted: Set the status to “Deleted” when you want the user to be removed permanently. 

3.  In-active: Set the status to “In-Active” when you want the user to be non-operational mode. 
You can change the status to Active later on as and when required. 
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Fig. 3.2.15 User Management 

 Accept to save the user created. 

Default users such as Account Administrator or 

Site Administrator is assigned the security levels of Owner. However, based on the 
requirements, you can change the security level. 

To create a user 

Select the required Security Level from list of Security Level or press Alt+C to create a new security level. 

 Owner: has the capability to manage Sites/Users belonging to an account. The Owner is not permitted 
to change Account / Site Admin ID, Site Status and Account Profile. 

 Standard User: Created with predefined permissions. All users other than the Owner are created under 
this security level. 

 Enter the required E-Mail ID in the Tally.NET ID field. Using the E-Mail ID provided a Tally.NET ID is 
created and the Password emailed. 

 Set Tally.NET User field to “Yes”, if you want the user to access data from a remote location using 
Tally.NET. 

 In the Status field, select the required status from list of Status which are explained below 

o Active: Set the status to “Active” when you want the user to be in operational mode. 

o Deleted: Set the status to “Deleted” when you want the user to be removed permanently. 

o In-active: Set the status to “In-active” when you want the user to be non- operational mode. You 
can change the status to Active as and when required. 

Similarly, you can create other users as required. 
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From the above screen, you can change the Tally.NET ID for any user other than 
Account/Site Administrators. However, you will not able to change the status to Delete or 
In-Active for Account/Site Administrator. 

To change the User ID, type the new user id in the Tally.NET ID field. 

The User Management screen also displays the number of Tally.NET Users created for an account. To view in 
Detailed mode, 

In the User Management screen 

 Click F1: Detailed or press Alt+F1 

 The User Management screen appears displaying the user details as shown in Fig. 3.2.16 

 

Fig. 3.2.16 User Management Multi Site 

To view the Security Level List 

In the User Management screen 

 Click F8:Sec Level List or press F8 

 The Select Items screen appears, select the required security level from the List of Security Levels 

The Security Levels screen appears as shown in Fig. 3.2.17 

 

Fig. 3.2.17 User Management Multi Site 
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 By default, the Standard User is authorised to access the Support Centre only, based on your 
requirement select the access controls from the list of Access Rights as shown in Fig. 3.2.18 

 

Fig. 3.2.18 User Management Multi Site 

 Accept to save the access rights assigned to the security level. 

3.2.8.6 Create Security Levels 

An authorised user can create security levels and assign the Access Rights to the user in order to allow the 
user to perform certain tasks within the account. The security levels created are then assigned to the users 
belonging to the account. 

To create a security level and assign access controls follow the steps shown: 

 Press Alt+C in the Security Level field, the Security Level Management screen appears 

 Type the required security level name in the Name of Security Level 

o In Allow the Following Facilities, select the required access rights from the list of Access Rights 
as shown in Fig. 3.2.19 

 

Fig. 3.2.19 Create Security Levels 
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 Accept to save the security level created. 

To alter an existing security level, place the cursor in Security Level field and press Ctrl+Enter or 
press F8: Sec Level List, select the required security level to make necessary changes. 

The Owner security level is assigned all the access rights and cannot be modified. 

3.2.8.7 Profile Management 

The user can enter the essential information related to the Account/Site ID in Profile management. To enter the 
details regarding the organisation follow the steps shown: 

In the Control Centre screen 

 Select Profile Management and press Enter 

 The Profile Management screen appears 

o By default the E-Mail ID of the Account Administrator appears in the Account ID field. 

o Select the required account type from the list of Account Types 

o Enter the details related to the Account as shown in Fig. 3.2.20 

 

Fig. 3.2.20 Profile Management 

 Accept to save the information. 

Change Account Admin 

To change the Account Administrators ID follow the steps shown: In the Control Centre screen 

 Select Change Account Admin 
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 The Change Account Admin screen appears 

 

Fig. 3.2.21 Change Account Admin 

 Enter the required Account Administrators ID in the Old Account Admin ID field 

 Enter the new Account Administrators ID in the New Account Admin ID field 

 Accept the create a new Account Administrators ID 

 

The new Account Administrators ID can be created only by an existing account administrator. 

3.2.8.8 Change My Profile 

You can manage the Tally.NET User's profile by providing the required details for further communications. To 
change the user profile the user has to follow the steps shown: 

In the Control Centre screen 

 Select My Profile 

 The Change My Profile screen appears displaying the Tally.NET ID 

 In the Salutation field select the required salutation from the list of Salutation. 

 Enter the required name in the Name field. 

 Enter the required Mobile Number in the Mobile field. 

 

Fig. 3.2.22 Change Profile 

 Accept to save the profile Change Password. 

To change the Password follows the steps shown:  

In the Control Centre screen 
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 Select My Password or press Alt+W 

 

Fig. 3.2.23 Change Password 

The Change Password screen appears with the Username. 

 Enter the current password in Old Password field. 

 Enter the new password in New Password field. 

 Repeat the new password in Repeat field for the purpose of confirmation. 

 

Fig. 3.2.24 Change Password 

 Accept to change the password. 

3.3 Security Management in Tally.ERP9 
3.3.1 Security Controls 

Tally.ERP 9 allows you to create multiple levels of security as per requirements and authorize users with 
individual passwords and rights to access specific functionality only. The user with an Administrator level 
password is authorised for full access to all features and set access controls for other users. 

To activate the Administrator level Password: Go to Company Info. > Create 

 Type Company Name, Address and other related details 

 Set the feature Use Security Control to Yes 
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 Specify Administrator Name, password and repeat 

 Save the screen 

If the company is already created: 

 Load Company > Alt+F3 (Cmp Info) > Alter 

 

Fig. 3.3.1 Company Info screen 

 Set the feature Use Security Control to Yes 

 Specify Administrator Name, password and repeat 

 Save the screen 

 

Fig. 3.3.2 Company Alteration screen 

 



Main source : ICAI

 downloaded from : taxupindia.com

ERP CONTROL AND AUDIT  

 ADVANCED INFORMATION TECHNOLOGY 375 

 

Exit Tally.ERP 9, after accepting the modifications implemented in the Security Control fields. Now, attempt 
to open Tally.ERP 9. Tally.ERP 9 opens the Company Login screen where you will be asked to enter the 
User Name and Password. 

The Company Login screen is displayed as shown. 

 

Fig. 3.3.3 Company Login screen 

  The password is case sensitive. Any variation in the case will not allow you to login to 

Tally.ERP 9.User ID is not case sensitive.  

To create multiple levels of passwords: 

 Create the Administrator level password as explained earlier. 

 Press Alt+F3 (Cmp Info) > Security Control > Types of security 

 Specify Name of Security Level 

 Select Owner in the field “Use Basic Facilities of” 

 Specify the value for Days allowed for Back Dated vouchers. (The no. of days the user is allowed to go 
back to enter vouchers from the date of last entry). 

 Specify the value for Cut-off date for Back Dated vouchers (The last date upto which the user can go 
back to enter transactions) E.g. 31.03.2014 if books are finalized till this date. 

 In the Disallow the following Facilities column, specify the Type of access 

o (i.e. Full Access, Alter, Create, Create/Alter, Display, Display/Print etc.) 

 In the field Allow the following Facilities, specify the required details 

 Save the screen. 

Tally.ERP 9 allows you to create any number of levels. 

 Select Users and Passwords under the Security Control 

 Specify Name of the user, password and level 

 Save the screen 



Main source : ICAI

 downloaded from : taxupindia.com

 ENTERPRISE RESOURCE PLANNING  

376  ADVANCED INFORMATION TECHNOLOGY 

3.3.1.1 Create Users and Passwords 

 Use Alt+F3 and view the Company Info menu. 

 Press Enter on Security Control and a sub-menu is displayed as shown in Fig. 3.3.4 

 

Fig. 3.3.4 Security Control 

 The menu allows you to define access under Users and Passwords. 

 User Name: Preethi. 

 Password: preethi. 

 Security Level: Owner. 

Enter the other information as shown. 

The List of Users of Company screen is displayed as shown in Fig. 3.3.5 
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Fig. 3.3.5 List of Users for Company 

 Press Y or Enter to accept. 

3.3.2  Types of Security 

In Security Control menu, click Types of Security. The screen is displayed as shown in Fig. 3.3.6 

 

Fig. 3.3.6 Security Levels for Company 

 Under List of Security Levels, the default value is Data Entry, Tally.NET User and Tally.NET Auditor 

 Press the Down Arrow Key to create a new security level. 

 Enter Preethi in the List of Security Level field. 

 Press Enter to view the Security Levels screen. 

3.3.2.1 Name of Security Level 

By default, the name (Preethi) is displayed, which you have created. 

Press Enter to go the Level Definition screen, where the following fields are displayed. 

Use Basic Facilities of 

By default, this field displays Owner. However, the other option, i.e., Data Entry is also available. The list 
does not display when you are at the field. Press O and begin to type the word for the list to display. 
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 Select Owner from the Security List. 

Days Allowed for Back-Dated Vouchers 

This is the duration for which the users, at this level, are allowed to alter back-dated vouchers. Specifying 
zero will indicate that back-dated vouchers are not allowed. This is effective only if you disallow back-dated 
entries in the Disallow Column. 

 Retain the Default as 0. 

Cut-off date for Back-Dated Vouchers 

Specify the dates before which users of this profile or security level cannot create or alter vouchers. This is 
an additional control over the previous Days Allowed. It is useful in cases where, for example, you have 
completed your Tax Assessment for a period and no changes are desired in the data for that period. 

 Leave blank. 

Allow to Connect Company 

If this option is set to Yes, the user classified under this security level can connect to a Company with a valid 
Tally.NET subscription. 

Use Tally.NET Authentication 

If this option is to be set to Yes, if we wish to create a security level for remote login users. This should be set 
to “No” for local users.  

Use Tally.NET Auditor Authentication 

If this option is set to Yes, the auditor can access the client’s data remotely and perform an audit. However, a 
user not having the auditor’s license will not be able to perform an audit by setting this option to Yes. 

 

The Tally.NET options will be available in the Security Levels screen, only when the Tally.NET 
Features are activated in F11: Tally.NET Features. 

The screen is further divided into two broad columns with two sub-columns. The left of the screen is to disallow 
access to the various options of the system, while the right of the screen denotes the security level for different 
facilities. 

The sub-columns are Types of Access and List of Reports under both Allow and Disallow facilities. Enter 
the Type of Access which you wish to give and the option sought to be controlled. Once the entry is completed, 
select End of List from Type of Access field to complete the allocation. 

Once the settings have been entered, the screen for Level definition is displayed as shown in Fig. 3.3.7 
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Fig. 3.3.7 Security Level Definitions 

Accept the above settings and the screen Security Levels for Company is displayed. Follow the same 
procedure if you want to create another Security level. Else, Accept and return to the Security Control 
Menu. 

Only the Administrator can assign users and their passwords. 



Main source : ICAI

 downloaded from : taxupindia.com

 ENTERPRISE RESOURCE PLANNING  

380  ADVANCED INFORMATION TECHNOLOGY 

3.3.3 Password Policy  

 
Fig. 3.3.8 Password policy for company 

Password policy feature allows a user to set more controls about use of passwords by other users. As it is 
evident from the above figure, many controls can be set for use of passwords. 

3.3.3.1 Tally Vault 

Tally.ERP 9 offers a data encryption option called Tally Vault, with the help of which you can encrypt the 
company data by setting a password. It is extremely important not to forget the Tally Vault password, as 
forgetting the Tally vault password may land up the users in serious trouble.  

3.3.3.2 Activate Tally Vault 

You can activate the Tally Vault facility at the time of creating a new Company or when altering an existing 
one. 

For a new Company: 

Go to Company Info. > Create 

 Enter the Name of the Company and other related details 

 Enter the Tally Vault Password and repeat the same 

 Save the screen 
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For an existing Company: 

Go to Company Info. > Press Alt+F3 (Cmp Info) > Change TallyVault 

 Type New Password and repeat 

 Save the screen 

 

Fig. 3.3.9 Change Tally Vault Password 

3.3.3.3 Tally Audit Feature 

Tally audit feature provides the capability to check the accuracy and correctness of the entries made by 
authorized users. It allows you to alter the entries if required. Once you audit the entries, Tally.ERP 9 displays 
all the altered entries with the user's name that altered the entry, along with the date of alteration. The audit 
trail is also available in the day book where the administrator can view the alterations made. 

3.3.3.4 To activate Tally Audit 

You can activate the Tally Audit feature during the creation of the Company. If your company is already 
created, 

Go to Gateway of Tally > Click Alt+F3 (Cmp Info) > Alter 

 Select company from List of Companies 

 Set the feature Use Security Control to Yes 

 Specify the Administrator Name & Password 

 Repeat the entry of the password 

 Activate the parameter Use Tally Audit Features to Yes 

 Save the entries made in the Company Alteration screen 
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Fig. 3.3.10 Company Alteration screen – Audit Features 

To effect the changes, shut the company Universal Enterprises and open it again. 

To audit Transactions / Masters (Login Tally.ERP 9 as an Administrator) Go to Gateway of Tally > Display > 
Statements of Accounts.   

The menu is displayed as shown in Fig. 3.3.11 

 

Fig. 3.3.11 Tally Audit Path 
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 Select Tally Audit 

 Select Voucher Types, Masters or Users. 

 View the vouchers that are not audited. 

 Select F7 (Accept one) and audit an entry or select Alt+F7 (Accept all) to audit all entries. 

The Tally Audit Listing screen is displayed as shown in Fig. 3.3.12 

 

Fig. 3.3.12 Tally Audit Listing Screen 

To audit entries that has been altered 

If any entry that is audited is altered by another user, then Tally.ERP 9 displays the entry in the Tally Audit 
report. 

 Click F12: (Configure), set the parameter Show Entered / Altered By to Yes. 

You will find a list of all entries that are altered with the names of users who entered/altered it along with the 
date of alteration. 

Follow a disciplined verification of the list so that it is periodically cleared and only vouchers which 
are of concern remain. 

To view the Ledger Audit list, select Masters from the Tally Audit menu. 

A screen showing the ID (Identification number of ledgers), Ledger Names is displayed. 

Make changes to any two Ledger Accounts. These changes are reflected in the list of new or altered Ledger 
Accounts. Notice that their IDs do not change, which is a useful feature for tracking ledgers. Information 
about the user who changed the accounts and the date of change is available. If you are satisfied with the 
changes made in the ledger, click F7: Accept One or Alt+F7: Accept All. This accepts the ledger as valid 
and removes the old one from the list. 
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3.4  Data Management in Tally.ERP 9 

3.4.1 Data Backup & Restore 
Since the data on a computer is vulnerable, it is important to take regular back-ups of data. Tally.ERP 9 has 
a flexible back-up mechanism for taking a backup of the data onto virtually any storage medium. The 
commonly used media are CD, DVD, hard disc, pen drive and so on, installed either locally or on a network. 

Tally.ERP 9 provides you with the capability of taking a backup of one or more companies or all companies 
in a single directory. 

3.4.1.1 Backup Data 

At the Gateway of Tally, use Alt+F3 to get to the option, Backup. 

In the Backup screen, the source of the backup and the destination (where it has to be stored) have to be 
mentioned. To change either the source or the destination paths, use the backspace key and change the 
paths as required. 

For example, to backup the data to a directory - Tally.ERP 9 backup in the D Drive, change the destination 
path to D:\TallyBackup as shown. 

 

Fig. 3.4.1 Company Backup - Specification of Destination Path 

The process of backing up data begins when at least one company is selected. 

 Select the company Universal Enterprises. 

 

Fig. 3.4.2 Company Backup - Selection of Company 
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To stop selecting companies, select the option End of List which appears at the top of the selection list. 

This option is active only when at least one company has been selected for backup. 

 

Fig. 3.4.3 Company Backup screen - Completed screen 

 Press Y or Enter to accept the screen. 

 The backup file is stored with the name TBK900.001 

3.4.1.2 Backup Administration 

An appropriate backup mechanism needs to be devised depending on the volume of data. One of the methods 
would be to maintain a backup directory in the local hard disk or the server (external storage media such as 
the pen drive or external hard disc).  

Sub-directories could be maintained for every day of the week under the main backup directory and regular 
data backups depending on the day of the week could be created in the following manner. 

Monday - D:\TallyBackup\Monday.  

Tuesday - D:\TallyBackup\Tuesday. 

Wednesday-D: \Tally Backup\Wednesday, and so on. 

 Tally.ERP 9 backup facility is NOT limited to the hard disk drive alone. 

3.4.1.3 Restore data 

Go to Gateway of Tally > Alt+F3 > Restore 

 Select Destination (specify path) 
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 Select Source (specify path) 

 Select the Company / Companies for data restore 

 Save the screen. 

 

Fig. 3.4.4 Company Restore Screen 

3.4.2 Splitting Financial Years 

Tally.ERP 9 allows you to maintain a company for any number of financial years. Once the books of accounts 
are completed for previous financial years and if the need arises, you can split the company data into multiple 
companies as per financial periods required. In other words, Tally.ERP 9 offers a feature to split your company 
data. You can specify the date from which the company has to be split and Tally.ERP 9 will split the company 
to form two new companies according to the periods specified. Once the data has been split, the closing 
balance of the first period (first company) becomes opening balance for the next period (second company). 

To split the data: 

 Load the company that has to be split. 

 Select Alt+F3 (Cmp Info) > Split Company Data. 

 Select Company. 

 Specify the date in Split from (this is the starting date of the new period) 

 Save the screen. 

Tally.ERP 9 splits your company data according to the specified periods. 

 

Fig. 3.4.5 Splitting of Company Data Screen 
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Before actually splitting of company data into two parts, one can verify the company data for any possible 
errors. A separate menu “Verify Company Data” is given for this purpose. A company shall be split successfully 
only if there are no errors in the data.  

3.4.3 Import / Export of Data 

Tally.ERP 9 allows you to import data from as well as export data to other software. You can import and export 
in ASCII, Excel and XML formats. XML is now the most widely used format of exporting data in the world. Any 
type of transaction can be exported to another application after suitably altering their current structures to 
accept Tally.ERP 9 data. The reverse is also possible with the help of a TDL program to accept data from other 
software. Data can be imported into Tally.ERP 9 either in XML or DBF formats. 

Export Tally.ERP 9 Reports to MS Excel 

Tally.ERP 9 now comes with the functionality, wherein all reports can be exported to Microsoft Excel 
spreadsheet. This feature enables you to export any report generated by Tally.ERP 9 into Excel. 

Subsequently, you can generate graphical representations of the data for better visual presentation. This 
process of export can be explained with a few simple steps, as shown. 

Go to Gateway of Tally > Balance Sheet 

The following screen is displayed in Fig. 3.4.6 

 

Fig. 3.4.6 Export Option in Tally.ERP 9 

 Click Export. 
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 Select Restricted (ASCII only) 

 Select Excel (Spreadsheet) in Format. 

 Type the name of file for Output File Name as required. 

 Specify other details. 

 

Fig. 3.4.7 Report Generation Screen for Excel 

 Click Yes for Export. 

By default, the exported report in Excel format is saved in the Tally.ERP 9 folder. 

Open this file to view the report. 
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Fig. 3.4.8 Report in Excel Imported from Tally.ERP 9 

3.5 Audit Feature & Functionalities 
Audit in simple language means verification. There may be different objectives for different audits. Process of audit 
may change according to the objective to some extent but the basic theme remains the same for every audit. It is 
basically verification of data to ensure its correctness. As far as accounting systems are concerned, audit generally 
means verification of accounting data. Software is used to create accounting data hence a software can help a user 
audit the data easily. Hence audit feature and functionalities are provided in software to make the audit process easy 
and simple for a user. We can divide the overall audit process in following two aspects.  

(a) Basic  

(b) Advanced 

Let us discuss both the aspects one by one.  

3.5.1 Manual Audit 

 In case of any computer system, data is stored in two ways, as master data and as transaction data. It is expected 
that the accounting transactions are recorded in the system correctly.  

E.g. Accountant has recorded Cash payment voucher number 143 of Rs. 890 paid towards purchase of stationery as 
Rs. 980. This type of mistake is affecting the trial balance as well as balance sheet. Comparison of original proof of 
transactions, i.e. voucher and its accounting entry will reveal the mistake. This mistake is to be corrected by user 
having the authority.  
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Above example shows a simple example of audit. This can be done manually also without taking help from software. 
But there are some inherent problems in the above case. To understand these problems, let us understand a manual 
audit process.  

Gayatri, an articled clerk, is asked to verify the data of cash payments for the month of August 2017 which contains 
around 1,000 transactions. She has to check the original source document, i.e. voucher with the transaction recorded 
in software. At the time of verification of these transactions, she is supposed to check following aspects.  

(a) Date of voucher 

(b) Voucher Number 

(c) Ledger Debited 

(d) Ledger Credited 

(e) Amount 

(f) Narration  

(g) Approval  

These aspects regarding each voucher are to be checked considering two things.  

(a) Physical Voucher and  

(b) Electronic Data Entry 

Physical voucher is a piece of paper and is to be handled manually. As per far as electronic data entry is considered, 
there are two ways of handling it.  

(a) Taking a print out of vouchers or voucher register for checking 

(b) Putting an electronic tic in software.  

Let us understand case 1, i.e. Manual Audit using print out of voucher register.  

Gayatri has got a file containing payment vouchers for the month of April 2017 for checking. Now she can start 
verification of each and every physical voucher with the printout of cash book.  

 

 

 

 In this process of checking, she founds following types of errors.  

 Date entered in the software is not matching with date of physical voucher 

 Amount entered in the software is not matching with amount in physical voucher 

 Expense ledger debited in software is not in accordance with nature of expenditure as explained on physical 
voucher.   

 These mistakes need to be corrected by making correction in the software. With the help of accountant, Gayatri gets 
all the mistakes corrected in the software and she closes the audit of cash payments for the month of April 2017. She 

Physical 
Vouchers 

Printout of Cash 
Book 
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prepares the report and submits it to her boss. She also takes final printout of cash book after corrections and keeps 
it with her.  

Now Gayatri has to start audit for next month, i.e. May 2017. To her surprise, she finds that the opeing balance of 
cash as on 01.05.17 in software is not matching with closing balance of cash in the printout of cash book with her. 
Now, instead of starting audit for the month of May 2017, she need to put her time and efforts in digging out the 
reason for change in closing balance of cash on 30.04.17. Possible reasons are as under. 

(a) Old entries altered 

(b) New entries added after completion of audit 

(c) Opening balance of cash changed.   

Basic problem with manual audit is non availability of change tracking mechanism and the basic advantage with 
electronic audit is availability of complete change tracking mechanism.  

3.5.2 How data is stored in a Software?  

Basically, accounting data is stored in any software in two ways.  

(a) Master Data – Standing data or permanent data not expected to change frequently.  

(b) Transaction Data – Non permanent data, expected to change frequently.  

There may be different types of master data like Accounting Master Data, Inventory Master Data, Payroll Master 
Data, etc. Similarly transaction data may also relate to Accounting, Inventory, Payroll, etc.  

Auditing of data can be complete only after verification of master data as well as transaction data.  

3.5.3 Basic Audit Feature   

The biggest advantage of using a electronic tools for auditing tools is availability of complete change tracking system. 
Let us discuss the auditing features available in Tally.ERP9. 

This feature provides a facility to put an electronic tick on master data as well as transaction data. Hence there is no 
need to take any printout for putting a tic. After putting an electronic tic on the data, if there is any change, this 
change is tracked along with user name making a change and date on which change was made.  

To use basic audit feature in Tally, follow this path. 

Gateway of Tally > Cmp Info (Alt+F3) > Alter > Select the company and go to company alteration screen as shown in 
Fig 3.5.1. 
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Fig 3.5.1 Enable Basic Audit Features 

First we need to set “Yes” to “Use Security Control”. Then only “Use Tally Audit Features” option shall be 
available. Set it to “Yes”. As soon as this is done, a new menu shall appear in the following path as shown in 
Fig.3.5.2 
 
Gateway of Tally > Display > Statement of Accounts > Tally Audit  

 

Fig 3.5.2 Tally Audit 

Inside Tally Audit menu, there are three sub menus as shown in Fig 3.5.3.  
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Fig 3.5.3 Sub menus of Tally Audit Menu 

Voucher Types Menu: This menu shall display voucher type wise unaudited vouchers and vouchers altered 
after audit. Please see as shown in Fig 3.5.4.  

 

Fig 3.5.4 Voucher Type Menu 

Masters Menu: This menu shall display newly created masters (Ledgers Only) and ledgers altered after audit. 
Please see as shown in Fig 3.5.5.  
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Fig 3.5.5 Masters Menu 

Users Menu: This menu shall display user wise newly created transactions and user wise transactions altered 
after audit. Please see as shown in Fig 3.5.6. 
 

 

Fig 3.5.6 Users Menu 
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How to mark an electronic tic on voucher / master ?  

Open Tally Audit Listing screen by Voucher Types or Users Menu, select a voucher and click on “Accept One” 
button on right hand side button bar as shown in Fig 3.5.7. This will put an electronic tic on the voucher.  

 

Fig 3.5.7 Accept One 

“Accept All” button can be clicked to accept all the vouchers at once.  

 3.5.4 Advanced Audit Feature 

In addition to basic audit feature, Tally.ERP9 has advanced auditing features also. The audit feature discussed 
above deals with only quantitative aspect of audit. Advanced audit feature which we are going to discuss now 
deals with quantitative as well as qualitative aspect also.  

To start using advance audit feature, let us go to Audit & Compliance menu on Gateway of Tally as shown in 
Fig 3.5.8.  
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Fig 3.5.8 Audit & Compliance 

Inside Audit & Compliance menu, there are four sub menus as under. The basic difference between basic audit 
feature and advance audit feature in Tally.ERP9 is that in the case of advance audit feature user can write his 
comments for an audited voucher or a master data as shown in the Fig 3.5.9.  

 

Fig 3.5.9 Audited Voucher 



Main source : ICAI

 downloaded from : taxupindia.com

ERP CONTROL AND AUDIT  

 ADVANCED INFORMATION TECHNOLOGY 397 

 

 

Fig 3.5.10  

Let us discuss these menus one by one.  

3.5.4.1 Audit Documentation  

This menu is used for documentation relating audit such as  

(a) Preparation of audit programme,  

(b) Preparation of audit report 

(c) Preparation of annexures to audit report 

(d) Preparation of check list for accounting standards, its applicability, compliance and remarks.  

(e) Preparation of check list for auditing standards, its applicability, compliance and remarks. 

3.5.4.2 Audit & Analysis 

This is the main menu for auditing with variety of features and functions as shown in Fig 3.5.11.  
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Fig 3.5.11 Main menu for auditing with variety of Features and Functions 

(a) Verification of Chart of Accounts – This is a menu useful for identification of ledger masters which 
needs auditor’s attention. These ledgers can be identified with the help of this menu very easily. This 
report is used for identification ledgers as under. 

 Accounts squared off during the year 

 Accounts not used at all 

 Accounts not used in current year 

 Accounts having only balances and no transactions 

 Accounts used only in current year.  

Please see the Fig 3.5.11 below.  
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Fig 3.5.11 Verification of Charts 

(b) Verification of stock items – This is a menu similar to the above menu, i.e. verification of chart of 
accounts. This is used for identification and verification of stock items which need auditor’s attention. 
Following sub menus are available.  

 Not Used 

 Not used in current year 

 Only balances, no transactions 

 Used only in current year 

(c) Verification of Balances – This menu can be used for Ledger Scrutiny. This help to identify ledgers as 
well as vouchers which may of interest to an auditor.  
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Fig 3.5.12 Verification of Balance 

(d) Analytical Procedure – This menu helps in comparing Groups, Ledgers or Cost Centres across the 
Years (Audit Year & Previous Year) to find the exceptional trends, which will help the Auditor to carry out 
further investigations. The Auditor can also do cross comparisons among Groups, Ledgers and Cost 
Centres to find out exceptions. The Analytical Procedures screen displays the parameters that are 
compared across the years with the details of percentage changes and Variance. The details of various 
fields in the above report are given below: 

Comparison: Displays the parameters that are selected for comparison. 

The second section displays the Base parameter (e.g. Sales Accounts Group) with the following details: 

Current Period: Name of the Company and selected Audit Period is displayed along with the Closing 
Balance for the selected parameter (e.g. Sales Accounts Group) is displayed. The percentage change 
from Previous Period to Current Period is also displayed. 

Previous Period: Name of the Company with which the comparison is done, the selected Previous 
Period along with the Closing Balance for the selected parameter (e.g. Sales Accounts Group) is 
displayed. The Base parameter value for Previous Period is treated as 100% by default as displayed. 

The last line displays the Variance details which includes the Amount and percentage Increase or 
Decrease. 
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The third section displays the details of the compared parameter (e.g. Indirect Expenses) with the Base 
parameter (e.g. Sales Group) along with the Percentage change and Variance. 

Particulars: Displays the parameter (e.g. Indirect Expenses) with which the Base parameter is compared. 

(a) Pending Documents : This menu displays pending matters such as pending purchase orders, pending 
sales orders, goods received but bills not received, goods delivered but bills not made, net pending 
receivables, net pending payables. Complete drill down is available here and user can go up to voucher 
level to mark a voucher as audited.  

(b) Statutory Payments: This menu is used for checking status of statutory payments like VAT, Service 
Tax, TDS, TCS, Excise, etc. But this menu will work only if statutory feature is used in Tally.  

(c) Periodic Payments & Receipts: This menu provides the list of recurring ledger vouchers based on the 
ledgers identified by the users. This report also provides the comparison of ledgers vouchers with 
previous years vouchers to analyse the deviations, if any. This report provides details of total amount 
spent or received along with the total number of vouchers during each year. It also provides the details of 
the amount and voucher variance which can be used to carry on the further investigations. 

(d) Repeated Transactions: This menu displays the Count of those vouchers in which the Total Value is 
repeated more than once for any ledger. The user can filter the required information from this report and 
continue with further scrutiny. This report displays the ledger wise repetition details along with the 
repeated amount. The user can drill down from the above report to view the details of the Ledger 
Vouchers where the same amount is repeated more than twice. 

 

Fig 3.5.13 Repeated Transactions 
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(e) Relative Size Factor: This report will compare the Highest Value transactions for each Ledger Vouchers 

to the Second Highest Value and displays the Relative Size Factor which can lead into further 
investigation to correct the above mistakes. The Auditor can drill down from the report to view the details 
of the Ledger Vouchers where the details of the Relative Size Factor computation can be viewed. This 
report also displays the Ledger wise Highest, Average and RSF Value along with the count of vouchers 
as shown above. The Auditor can drill down from the above report to view the details of the Ledger 
Vouchers where the details of the Relative Size Factor computation can be viewed. 

 

Fig 3.5.14 Relative Size Factor 

Example : Consider a case of electricity expenses ledgers. The normal monthly electric bill of the 
company is around Rs. 10,000. If all the vouchers are around Rs. 10,000, relative size factor shall be 
less than one. But accountant has debited Rs. 1,00,000 towards wiring and electricfication expenses. In 
such case, the highest voucher is Rs. 1,00,000 and second highest voucher is Rs. 10,000. Hence relative 
size factor is 10. This raises an alarm for an auditor. After going into details, it is confirmed that 
expenditure of Rs. 1,00,000 towards wiring and electrification is a capital expenditure and should not 
have been debited to Electricity Expenses as a revenue expenditure. These types of mistakes can be 
very easily identified with the help of this feature.  

(f) Other Analysis: This menu contains variety of other submenus for analysis purpose and provides vital 
information for auditing.  
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(a) Inter Bank Transactions – This report provides the details of all transactions carried out between 
the banks during the analysis year. This report also displays the details of Inter Bank transactions 
along with Voucher Type, Voucher Number, Debit & Credit balances, Instrument Date, Bank Date, 
Number of Days delayed, Verification Status and Verification Note. 

(b) Relative Size Factor - This report provides the details of Total Amount Deposited or Withdrawn 
from bank during the Audit year, along with the voucher count. 

(c) Relative Size Factor – This report provides the details of all the Fixed Assets possessed by the 
selected Company at the end of the Analysis Year. 

 

Fig 3.5.15 Details of all the Fixed Assets 

(d) Transactions on holidays – As the name suggests, this report shows all the transactions 
recorded on holiday. If a transaction is recorded on holiday, it is a matter of concern for auditor. To 
use this report, one need to mark the holidays in Tally first as shown in Fig 3.5.16.  
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Fig 3.5.16 Mark the holiday 

(e) Highest and lowest value transactions – This report provides ledger-wise Highest and Lowest 
amount transactions along with the Difference Range and Difference Range Percentage as shown 
in Fig 3.5.17. 

 

Fig 3.5.17 Difference Range and Difference Range Percentage. 
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(f) Pending Advances – This report provides details of ledger-wise pending loans or advances 
funded. 

(g) Stale cheques / instruments – This report provides the details of Bank-wise Total Amount and 
Count of Stale Cheques/Instruments. To filter the transactions in this report, by default 3 months 
has been set as Validity Period for Cheques/Instruments. The Stale Cheques/Instruments report 
displays the instruments for which the  Validity Period has been exceeded, by comparing Bank 
Date with Instrument Date of the transactions 

(h) External Confirmations (Third Party Confirmations) - Audit evidences from external sources, 
generally considered to be more reliable when compared with internally-generated audit 
evidences, may be obtained through External Confirmation. External Confirmation is when the 
auditor obtains audit evidence through direct communication from a third party. This 
communication will be in response to a request made for information on certain items that affect 
the management’s financial statements; it will be used and evaluated as audit evidence. 

 

Fig 3.5.18 Third Party Confirmations 

(i) Account Reconciliation – This feature in Tally.ERP 9 can be used for transaction-by-transaction 
reconciliation of the Company's Books  with Sister Concerns, Branch offices, etc., apart from third 
parties.    

Audit Journals: 

The Audit Journals report provides the facility to view and pass the Finalisation Entries which are required to 
finalise the Books of Accounts. The Finalisation Flag can be used to pass the entries that will affect the 
Profit/(Loss) before Interest, Depreciation and Tax in the Schedule-VI Profit & Loss A/c. Profit & Loss A/c  
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Ledger is not available for selection when this flag is selected in the Audit Journal creation. To record a 
finalization entry, go to Gateway of Tally > Audit & Compliance > Audit Journals > F7: Audit Jrnl (on right hand 
side button bar). Entries recoded in this way shall be displayed separately in this report.  

Financial Statements:  

This menu includes financial statements like Balance Sheet, Profit & Loss Account and Additional Details 
(regarding financial statements).  

Balance Sheet and Profit & Loss Account as per Schedule VI of Companies Act, 1956 is available in this menu 
as shown in Fig 3.5.19.  

 

Fig 3.5.19 Balance sheet 

Grouping of legers can be changed here as per requirement. Ungrouped items are displayed in red colour for 
easy identification.  

Additional details regarding financial statements can be added by pressing Enter on each line as per 
requirement. Please see the “Additional Details” as shown in Fig 3.5.20. 
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Fig 3.5.20 Additional Details 

3.6 Utilities  
Tally.ERP9 has got many powerful utilities which can be used in variety of ways for simplifying accounting and 
auditing work. These utilities include –  

(a) Banking 

(b) MIS Reporting 

(c) Internet Based Capabilities 

(d) Data Security 

(e) Data Exchange 

(f) E-filing 

Let us discuss these aspects one by one.  

3.6.1 Banking  

Banking menu provided on Gateway of Tally has following submenus.  
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Fig 3.6.1 Banking Menu 

(a) Cheque Printing – This option in the Banking menu allows the user to print all the pending, already 
printed or the required cheques continuously from a single screen. It also allows to update the cheque 
details of a transaction, i.e., the instrument no, instrument date, cheque favouring, etc. The bank ledger 
needs to be enabled for cheque printing from ledger creation or alteration mode. Cheque printing screen 
shall be as shown in Fig 3.6.2.  

 

Fig 3.6.2 Cheque Printing 
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(b) Cheque Register – This menu helps users to manage their cheque books for various banks, give 
information about Cheques which do not belong to any cheque range available and also the status of all 
the cheques. This report gives the values of the total number of cheques for each bank (Cheque Book 
wise), that are Available, Unreconciled, Reconciled, Blank and Cancelled.  

The advantages of the Cheque Register: 

 User will know how many cheques are available for use. 

 Used cheques are classified as Unreconciled and Reconciled. 

 Unreconciled cheques can be reconciled from the Cheque Register itself. 

 Cheque Register has an option to Search for Cheque Numbers. 

 Report can be viewed either Bank-wise or Cheque Range wise or drill-down to Cheque numbers. 

 Users are allowed to change the status of cheques (Available) to Cancelled or Blank and make 
cancelled cheques available. 

 Report can be viewed period-wise, hence makes it easier to filter the cheques that are issued on 
particular date or during a particular period. 

A sample Cheque register report is as shown in Fig 3.6.3.  

 

Fig 3.6.3 Cheque Register 
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(c) Bank Reconciliation – Bank reconciliation can be done using Tally.ERP9 very easily and conveniently. 
This menu gives user an option to write the bank clearing date in each bank voucher and to calculation 
balance as per bank on any given date. F5 is the key to start bank reconciliation. Tally will also identify 
unmatched entries in Ledger and add or deduct it as per its nature and prepare a Bank Reconciliation 
Statement also. One small limitation of this feature is that tally cannot identify unmatched entries in Bank 
Statement. Identification of these entries and their treatment in Bank Reconciliation Statement is to be 
done by user, manually.  

(d) Deposit Slip - Deposit Slip option in the Banking menu allows the user to generate the deposit slip for 
payments received through cheque/dd which need to be deposited into the bank. There are two options 
inside this menu as Cheque Deposit Slip and Cash Deposit Slip. 

(e) Payment Advice – This option in the Banking menu allows the user to generate the payment advice to 
be sent to suppliers/other parties along with the cheques/other instruments. A sample payment advice 
screen is as shown in Fig 3.6.4. 

 

Fig 3.6.4 Payment Advice Screen 

A payment advice can be printed like the screen as shown in Fig 3.6.5. 
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Fig 3.6.5 Payment Advice 

(f) Post Dated Summary – This menu provides a summary of post-dated cheques received and issued.  

3.6.2 MIS Reporting  

MIS stands for Management Information System. Tally.ERP9 gives different MIS reports for management and 
control over accounting. These MIS Reports can be classified as under.  

 Accounting Reports: To obtain information on the financial position, operational performance and 
economic activities of the business. 

 Financial Reports: To determine the financial condition of an organisation as required by shareholders, 
creditors and government units. 

 Inventory Reports: To manage the Inventory effectively since the actual status of stock items is obtained. 

 Management Control Reports: To utilise budgets, cost centre reports, scenario reports etc. for controlling 
activities. 

Let us discuss some of the MIS Reports available in Tally.ERP9. 

1. Receivables   

Tally.ERP9 offers bill wise receivable report where one can check party wise as well as bill wise 
receivables. To get this report correctly, all entries relating to debtors must be marked with correct bill 



Main source : ICAI

 downloaded from : taxupindia.com

 ENTERPRISE RESOURCE PLANNING  

412  ADVANCED INFORMATION TECHNOLOGY 

reference. Path for getting this report is Gateway of Tally > Display > Statement of Accounts > 
Outstanding > Receivables > Sundry Debtors. A sample report is as shown in Fig 3.6.6.  

 

Fig 3.6.6 Report 

This report can be modified on real time basis to some extent as per user requirements by pressing F12 
key. Following options are available to modify the report as shown in Fig 3.6.7  

 

Fig 3.6.7 Modify Report 

2. Payables    

 Just like bill wise outstanding receivable report, bill wise outstanding payable report is also available as a 
part of MIS Report. This report shows party wise and bill wise payable outstanding.  Path for getting this 
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report is Gateway of Tally > Display > Statement of Accounts > Outstanding > Payables > Sundry 
Creditors.  

Just like Receivable and Payable, there is an option to view bill wise outstanding for a particular ledger of 
for a particular Ledger Group also.  

3. Cost Centre Reports  

A Cost Centre is any unit of an organisation to which transactions (generally, revenue) can be allocated. 
When only costs or expenses are allocated to these units, they are referred to as Cost Centres. When 
profits are also allocated to these units, they become Profit Centres. You can now obtain a Profit and 
Loss account of each such Profit Centre. 

Cost Centre in Tally.ERP 9 allows an additional dimension to a transaction where a Ledger account 
indicates the nature of the transaction. It does not readily disclose, except in the narration field, which 
part of the organisation was involved in the transaction. 

With the help of Cost Centres, a transaction can be allocated to it, which would then enable accumulation 
of the all transactions for that particular Cost Centre. Tally.ERP 9 gives you the Cost Centre break-up of 
each transaction as well as details of transactions for each Cost Centre 

To view cost centre reports go to Gateway of Tally > Display > Statements of Accounts > Cost Centres. 
Following options are available in Fig 3.6.8.  

 

Fig 3.6.8 Cost Centre Report 

Some examples of Cost Centres are Departments of an organisation - Finance, Manufacturing, Marketing 
or Products of a company or Individuals such as Salesman A, Salesman B. 

4. Ratio Analysis  

 Ratio analysis is a powerful tool for financial analysis. A meaningful analysis of a financial statement is 
made possible by the use of ratios. 

 Ratios are a set of figures compared with another set. The comparison gives an understanding of the 
financial position of a business unit. There are a number of ratios which can be computed from a single 
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set of financial statements. The ratios to be computed depend on the purpose for which these ratios are 
required. A single ratio may sometimes give some information, but to make a comprehensive analysis, a 
set of inter-related ratios are required to be analysed. 

To view the Ratio Analysis go to Gateway of Tally> Ratio Analysis. The Ratio Analysis screen is 
displayed as shown in 3.6.9. 

 

Fig 3.6.9 Ratio Analysis 

Complete drill down is also available in Ratio Analysis Report. User can go to voucher level from any 
option of ratio analysis.  

5. Cash Flow  

Cash flow, as the name suggests, is a report showing movement of cash during a particular period. This 
report considers all inflow and outflow of cash and bank transactions. Hence, all cash and bank vouchers 
are considered while preparing this report by Tally. Inflow is displayed on left hand side, outflow is 
displayed on right hand side and net flow is displayed at the bottom. All transactions of inflow and outflow 
are grouped as per accounting groups for getting meaningful information. This report is a very useful MIS 
report for knowing the overall movement of cash. To open Cash Flow Report, go to Gateway of Tally > 
Display > Cash Flow as shown in Fig 3.6.10. 
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Fig 3.6.10 Cash Flow 

6. Funds Flow 

This is report similar to Cash Flow. Fund stands for working capital, i.e. Current Assets less Current 
Liability. This report shows movement of working capital, i.e. reasons for increase or decrease in the 
figure of current assets as well as current liabilities. This report considers all items of working capital and 
hence also includes transactions where cash or bank is not involved, i.e. Credit Sales, Credit Purchases, 
etc.  
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Fig 3.6.10 Funs Flow 

7. Exception Report –  

As the name suggest, this report shows something that is exceptional, unusual and not a routine matter. 
Exceptions are always a matter of interest for auditors and need to be monitored closely. Following 
different reports are available under Exception Reports menu a shown in Fig 3.6.11.  

 

          Fig 3.6.10 Exception Report 
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3.7 Internet Based Capabilities  
Internet based capabilities are one of the most important aspect of any ERP software. Tally.ERP9 provides 
many internet based capabilities as under.  

1. Remote Login  

This is a primary feature of any erp software. Tally’s remote login allows a user to access data from a remote 
location. Any type of activity can be performed as per the access given using remote login. A user can 
create/update a voucher, create/update a master data, view a report, take a printout using remote login. To 
start using remote login, first security control needs to be started.  

The best part of remote login in Tally is that the remote user may or may not have an official tally license 
installed in his computer. He can work even without a tally license in an Education Mode. Working of remote 
login is shown in Fig 3.7.1.  

 

Fig 3.7.1 Remote Login 

Menu for remote login is shown in Fig 3.7.2.  

 

Fig 3.7.2 Menu for remote login 
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2. Emails  

Internet capabilities of Tally include sending emails directly from Tally. No need to open any email account in 
the browser. To send an email, just open any report, e.g. Balance Sheet and click on the email button on 
horizontal button bar as shown below. Email button is available in almost all the reports of tally.  

 

Fig 3.7.3 Email Button 

On clicking Email button, following screen shall appear as shown in Fig 3.7.3.  
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Fig 3.7.4 Mailing Balance Sheet 

User need to just enter the details as asked, select a file format for the report to be sent and submit. Email is 
sent along with attachment as shown in Fig 3.7.4. 

3. Control Centre  

The Control Centre works as an interface between the User and Tally.ERP 9 installed at different Sites, it 
enables the user to centrally configure and administer Site/ User belonging to an account. The features of 
Control Centre are as follows: 

 Manage Licenses 

 Central Configuration - TDL and General 

 Manage Users 

 Manage Company Profile 

 Manage Accounts (using My Tally.NET Accounts) 

 Change Account Administrator 

 Manage Passwords 

 Activity History 

 Jobs & Recruitment 

Control Centre button in given on the horizontal button bar as shown in Fig 3.7.5  
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Fig 3.7.5 Control Centre 

To go to control centre, internet connection as well as a valid user ID and password is required. Control centre 
screen is displayed as shown in Fig 3.7.6.  

 

Fig 3.7.6 Control Centre Screen 
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4. Support Centre  

Support centre is a centre for getting support from Tally Solutions Pvt. Ltd. The Support Centre screen displays 
the list of queries raised by you in the last seven days. By default the page size is set to 10 rows. You can click 
on the link provided to view the next set of queries or the previous set of queries. 

 

Fig 3.7.6 Support Centre 

3.8 Data Security  
Data Security is the most important aspect of any of the software system. Auditors also must pay attention to 
this aspect during the audit process. It is very easy to create electronic data as compared to manual data. At 
the same time it is much easier to lose the electronic data as compared to manual data. Data security can have 
two important aspects.  

(a) Physical Safety of Data 

(b) Electronic Safety of Data 

Physical safety of data has be ensured by the organization physically only. Ensuring electronic safety of data is 
matter of software feature. For ensuring electronic safety of data, Tally provides following features.  

(a) Security Control – This is the basic level security control in Tally which asks for user ID and password 
at the time login into any tally company. Basic security control can be set to Yes at the time creating a 
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new company or later on also through company alteration screen as shown below. To go to company 
alteration screen, go to Gateway of Tally > Alt+F3 > Alter > Select the Company > Enter as shown in Fig 
3.8.1.  

 

Fig 3.8.1 Security Control 

Using this screen, one can start using basic security control in Tally. Only one user is created using this 
method.  

(b) Access Control – This may be called as advanced security control where we can create different users 
with different access rights. Security levels may be created and assigned to different users as per 
requirement.  

Gateway of Tally > Alt+F3 > Security Control  
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Fig 3.8.2 Access Control 

Security Levels with different access rights can be set using the screen as shown in Fig 3.8.3.  

 

Fig 3.8.3 Access Control 

Allotment of security levels to different users can be done using screen as shown in Fig 3.8.4.  
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Fig 3.8.4 Allotment of Security Level 

Password policy can set as shown in Fig 3.8.5 

 

Fig 3.8.5 Password Policy 
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(c) Tally Vault – 

Data Security has been a matter of concern to the Business Owner as most businesses depend on the 
confidentiality of the information. Tally Vault is a feature in Tally.ERP 9 that will help the business to 
maintain confidentiality of information by encrypting the data.   

Tally Vault uses a Non-Stored password with an advanced algorithm to validate a new user without any 
prior knowledge of the password and the decrypted form of data is not stored on the system. A 
combination of such algorithms ensures that Tally Vault becomes one of the most secure means of data 
storage. 

Tally Vault can be set during creation of company or later on also, using company alteration screen as 
shown in Fig 3.8.6.  

 

Fig 3.8.6 Tally Vault 

(d) Disallow Opening in Educational Mode :  

A small, but a very useful feature to prevent misuse of data. This feature prevents opening of Tally 
Company in educational mode. Active license is required to start particular tally company is this option is 
set to Yes. This prevents misuse of data out of office.  
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Fig 3.8.7 Disallow Opening in Education Mode 

3.9 E-fling Using Tally.ERP 9  
E-filing stands for electronic filing of tax returns. A business unit has to file variety of tax returns on regular 
basis. These include VAT, Service Tax, TDS, TCS, Excise, etc. Accounting data is the base information for 
filing of any tax return. Hence it is always convenient to get it directly from accounting software. Tally.ERP9 
provides a feature to generate returns for electronic filing of tax returns.  

Following are the broad steps which have to be followed for e-filing of tax returns from Tally.ERP9. By and large 
this process remains the same for all the statutory matters.  

1. Enable statutory feature  

2. Create Masters 

3. Record Transactions 

4. Verify Data 

5. Generate Return 

6. Validate Return 

7. Upload Return 
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Out of the seven steps above, five steps are performed using Tally.ERP9 and remaining two steps, i.e. Validate 
Return and Upload Return are to be outside Tally. Method of filing different types of tax returns may be 
different, but accounting data is filled directly by tally in the return file.  

1. Enable Statutory Feature: To start working with e-filing, go to Gateway of Tally > F11 > Statutory & 
Taxation. Following screen shall be displayed as shown in Fig 3.9.1.  

 

Fig 3.9.1 Enable Statutory Feature 

Seven statutory options are given in this screen. User can enable or disable any statutory option as per 
requirement. There are two options for each statutory matter in this screen, first option is to enable or disable 
the statutory option and second option, i.e. “Set Alter Statutory Details” is for setting or altering statutory details, 
i.e. registration information, type of organization, return periodicity, company level masters, etc. Once these 
matters are set and saved, answer to this becomes No once again. If required, user may go inside this menu 
and make changes again, if required. “Set Alter TDS Details” is as shown in Fig 3.9.2.  
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Fig 3.9.2 Set Alter TDS 

2. Create Masters: For any statutory matter, ledgers need to be created before we start recording 
transactions. Income ledger, expense ledger and tax ledger are to be created first. At the time of creation of 
each of the ledger, tax applicability is to be set as displayed in screen as shown in Fig 3.9.3.  

 

Fig 3.9.3 Create Master 
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3. Record Transactions: Once the ledgers are created as per rules of Tally, user can start recording of 
transactions. In all cases, Tally calculates tax figures automatically. If tax is not calculated automatically in a 
voucher, user must stop and check the settings. For generation of e-return from Tally, it is necessary to follow 
the complete process from start to end meticulously. Warnings given by Tally during data entry must not be 
ignored.  

4. Verify Data: From release 5 and onwards, Tally has given a new report for easy handling of statutory 
return filing. This report is available for all the statutory matter. A sample report for TDS is displayed below. 
Using this report it is very easy to find out error in accounting data and rectify it immediately. Path: Gateway of 
Tally > Display > Statutory Reports. Computation report is available for different tax matters here. A sample 
report for service tax computation is displayed here. Uncertain transactions are displayed here which need to 
corrected before generating the return.  

 

Fig 3.9.4 Data Verify 
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Fig 3.9.5 Statutory Reports 

5. Generate Return: There are different ways for generating different statutory returns, e.g. in case of VAT, 
return is generated as an Excel file first. Tally fills accounting and other related data in excel utility provided by 
respective VAT department of State. In case of TDS, Excise, Service Tax, xml file is directly generated from 
Tally.  

6. Validate Return: This activity is carried out outside Tally. Again validation methods are different for 
different statutory matters. Validation tools are made available by different tax authorities, e.g. file validation 
utility is provided by NSDL for TDS return, VAT return is to be validated in excel utility only, for validation of 
Service Tax and Excise returns, some external applications like notepad ++ along with XML schema given by 
aces.gov.in are to be used. After successful validation of a return file, it becomes error free and ready for 
uploading.  

7. Uploading Return: User need to go to respective e-filing portal for filing of different tax returns. E.g. for 
filing of Service Tax and Excise return, www.aces.gov.in portal is to be used. Every assessee need to create 
an account for e-filing on the portal. User ID and password is provided for the first time by the tax authorities, 
this may be changed later on. Uploading of validated and error free xml file is just like attaching a file to email. 

3.10 Goods & Services Tax 
Goods and Services Tax, as the name suggests is a combination of tax on goods as well as services. VAT 
Service Tax and Excise are replaced by Goods and Services Tax, a single tax common for all the states of 
country.  

Goods & Services Tax is a comprehensive, multi-stage, destination-based tax that will be levied on every value 
addition. 
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To understand this, we need to understand the concepts under this definition. Let us start with the term ‘Multi-
stage’. Now, there are multiple steps an item goes through from manufacture or production to the final sale. 
Buying of raw materials is the first stage. The second stage is production or manufacture. Then, there is the 
warehousing of materials. Next, comes the sale of the product to the retailer. And in the final stage, the retailer 
sells you – the end consumer – the product, completing its life cycle. 

Goods and Services Tax will be levied on each of these stages, which makes it a multi-stage tax. How? We will 
see that shortly, but before that, let us talk about ‘Value Addition’. 

Let us assume that a manufacturer wants to make a shirt. For this he must buy yarn. This gets turned into a 
shirt after manufacture. So, the value of the yarn is increased when it gets woven into a shirt. Then, the 
manufacturer sells it to the warehousing agent who attaches labels and tags to each shirt. That is another 
addition of value after which the warehouse sells it to the retailer who packages each shirt separately and 
invests in marketing of the shirt thus increasing its value. 

GST will be levied on these value additions – the monetary worth added at each stage to achieve the final sale 
to the end customer. 

There is one more term we need to talk about in the definition – Destination-Based. Goods and Services Tax 
will be levied on all transactions happening during the entire manufacturing chain. Earlier, when a product was 
manufactured, the centre would levy an Excise Duty on the manufacture, and then the state will add a VAT tax 
when the item is sold to the next stage in the cycle. Then there would be a VAT at the next point of sale. 

Now, Goods and Services Tax will be levied at every point of sale. Assume that the entire manufacture process 
is happening in Rajasthan and the final point of sale is in Karnataka. Since Goods & Services Tax is levied at 
the point of consumption, so the state of Rajasthan will get revenue in the manufacturing and warehousing 
stages, but lose out on the revenue when the product moves out Rajasthan and reaches the end consumer in 
Karnataka. This means that Karnataka will earn that revenue on the final sale, because it is a destination-based 
tax and this revenue will be collected at the final point of sale/destination which is Karnataka. 

Goods & Services Tax Network (GSTN) 

Goods and Services Tax Network (GSTN) is a Section 8 (under new companies Act, not for profit companies 
are governed under section 8), non-Government, private limited company. It was incorporated on March 28, 
2013. The Government of India holds 24.5% equity in GSTN and all States of the Indian Union, including NCT 
of Delhi and Puducherry, and the Empowered Committee of State Finance Ministers (EC), together hold 
another 24.5%. Balance 51% equity is with non-Government financial institutions. The Company has been set 
up primarily to provide IT infrastructure and services to the Central and State Governments, tax payers and 
other stakeholders for implementation of the Goods and Services Tax (GST). The Authorised Capital of the 
company is Rs. 10,00,00,000 (Rupees ten crore only).  

GST Suvidha Provider 

GSP stands for GST Suvidha Provider. A GSP is considered as an enabler for the taxpayer to comply with the 
provisions of the GST law through its web platform.  

Let’s take one example to understand it better: 
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ABC Ltd is a private multinational company which is running operations on SAP ERP / Tally.ERP9. All records 
with respect to Purchases and Sales are maintained in it. At the end of each month, reports are generated from 
ERP and attached with the tax return and uploaded on government’s portal. 

Our government is now aiming for single and automated workflow wherein these ERP companies can build an 
interface with government’s portal and all the GST related compliance can be done directly through their 
software. 

GSP need not be only ERP companies but can be startups or technology companies having expertise in 
building web applications. 

In the first round of allotment of license, thirty-four companies have been provided with GSP license. A 
complete list of these GSPs is as under. 

1. Alankit limited 

2. Bodhtree Consulting limited 

3. Botree Software International Pvt. Ltd. 

4. Central Depository Services (India) Limited 

5. Computer Age management services Private Limited 

6. Cygnet Infotech Private Ltd 

7. Deloitte Touche Tohmatsu India LLP 

8. Ernst & Young LLP 

9. Excellon Software Pvt. Ltd. 

10. GOFRUGAL TECHNOLOGIES PRIVATE LIMITED 

11. Hazel Mercantile Limited 

12. IRIS BUSINESS SERVICES LIMITED 

13. Karvy Data Management Services Limited 

14. Mastek Limited 

15. Masters India Private Limited 

16. MothersonSumi infotech & Designs Ltd. 

17. NSDL e-Governance Infrastructure Limited 

18. RAMCO SYSTEMS LIMITED 

19. Reliance Corporate IT Park Limited 

20. Seshaasai Business Forms Private Limited 

21. Shalibhadra Finance Limited 

22. SISL Infotech Pvt. Ltd. 

23. Skill Lotto Solutions Pvt. Ltd. 
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24. Spice Digital Limited 

25. Sugal & Damani Utility Services Private Limited 

26. Tally Solutions Private Limited 

27. TATA consultancy services Limited 

28. Taxmann Publication Pvt. Ltd. 

29. Tera Software Limited 

30. Trust Systems & Software (I) Pvt. Ltd. 

31. Vayana Private Limited 

32. Velocis Systems Pvt. Ltd. 

33. Vertex Customer Management India Private Limited 

34. WeP Solutions Limited 

Overall working of GST and Role of GST Suvidha Provider is displayed in the following diagram as shown in 
Fig 3.10.1. 

 

Fig 3.10.1 GST Porta 

Role of Technology in GST  

GST compliance is a completely technology based and most of the things are through technology only.  

(a) Registration – This is to be done using GST Portal only. No paperwork is needed.   

(b) HSN Codes – HSN stands for Harmonized System of Nomenclature. Codes are given to each type of 
goods and services for easy identification and are to be used while making outward or inward supplies. 
These codes are to be written in invoices and also in returns.  
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(c) Filing of Return – All returns to be filed in electronic format only. No paper return is accepted.  

(d) Invoice wise details – This is happening for the first time in our country for any tax compliance matter. A 
registered person must submit invoice wise details of all his inward and outward supplies (purchase and 
sales data) along with debit and credit notes also.  

(e) Matching of Input Credit – GST on inward supplies will be matched with GST on outward supplies of our 
supplier and credit shall be allowed after perfect matching only.  

(f) E-payments – Payment of GST to be in electronic format only.  

Everything in GST is through technology, hence role of software becomes very important in GST.   

GST Return Filing Process in Tally:  

GST Return filing process in Tally is more or less similar to VAT returns. Following steps are to be taken. 

(a) Activate GST Feature from F11  

(b) Create Ledgers for Purchase, Sale, Tax, Debtor and Creditor 

(c) Record Transactions 

(d) Verify data using GSTR-1 Report.  

(e) Generate Return in Excel format 

(f) Submit Return on GST Portal 

Following menus are available in Gateway of Tally > Display > Statutory Reports > GST Reports in Tally as 
shown in Fig 3.10.2.  

 

Fig 3.10.2 GST Report 

GSTR-1 report is as shown in Fig 3.10.3.  
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Fig 3.10.3 GSTR-1 Report 

GSTR-1 status reconciliation report can be obtained by clicking “Status Reconciliation” (Alt+U) button on right 
hand side button bar on this screen. It will be displayed as shown in Fig 3.10.4. 

 

Fig 3.10.4 GSTR-1 Status 
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HSN (Harmonized System of Nomenclature) / SAC (Service Accounting Code) wise summary can be obtained 
as shown in Fig 3.10.5. 

 

Fig 3.10.5 HSN/ SAC 

Data for GSTR-2 shall be displayed in following format as shown in Fig 3.10.6.  

 

Fig 3.10.6 Data for GSTR-2 
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Challan Reconciliation Report is displayed as shown in Fig 3.10.7.  

 

Fig 3.10.7 Challan Reconciliation 
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E-FILING 
 

 
 

E-Filing of Returns refers to the process of electronically filing your tax returns through the Internet. 

Salient Features of eFiling 

 Reduces compliance cost for deductors 

 Offers convenience of time & place to tax payers 

 Reduces interface between assessee and tax officials 

 Helps to correlate deduction of taxes against deposit of the deducted tax in the Government A/c 

 Helps to correlate deduction of tax by the deductors with the corresponding credits claimed by the 
deductees 

Tally.ERP 9 provides e-Filing capabilities for the following Statutory compliances:- 

 eVAT Returns 

 eTDS Returns 

 eTCS Returns 

4.1  eVAT Returns 
There are two ways of filing eVAT Returns namely, 

 Return Online: Fill up the details online and submit returns 

 Upload as Excel File: select Alt+E from the required Return/Form/Annexure to export to .xls format and 
then upload the same 

Go to Gateway of Tally > Display > Statutory Reports > VAT Reports > E-VAT Annexures > EVAT 
Purchases 

CHAPTER 

4 
LEARNING OBJECTIVES 
 eVAT Returns in Tally.ERP 9 
 eTDS  in Tally.ERP 9 
 eTCS in Tally.ERP 9 
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Fig. 4.1.1 eVAT Purchases Exporting screen 

The exported file will be saved in the path specified in the output file name. Similarly, you can export other 
annexures required for eFiling. 

4.2 eTDS Returns 
Tally.ERP 9 allows you to export the ETDS Forms in NSDL compliant formats as well as facilitates printing of 
TDS Forms in Physical Form. The ETDS forms available in Tally.ERP 9 are Form 26, Annexure to 26, Form 
27, Annexure to 27, Form 26Q, Annexure to 26Q, Form 27Q, Annexure to 27Q. 

Export ETDS Forms 

To export ETDS Forms, go to Gateway of Tally > Display > Statutory Reports > TDS Reports > E-Return 

 

Fig. 4.2.1   TDS E-Return Menu 

 Select E-TDS and press Enter, the eTDS Forms menu is displayed. 
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Fig. 4.2.2 eTDS Forms Menu 

 Select 26Q and press Enter 

 In the Exporting eTDS Forms Printing configuration screen, enter the required information as shown 
in Fig. 4.2.3 

 

Fig. 4.2.3 eTDS Forms Printing Configuration screen 
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 Press Y or Enter to export eTDS Form 26Q 

The exported file will be saved in the path specified in the output file name. The file can be validated through 
NSDL’s freely downloadable utility called ‘File Validation Utility’. This can be used to verify whether the 
ETDS return filed by the deductors conforms to the prescribed format. For more details, refer NSDL’s website 
(http:// www.tin-nsdl.com/eTDSfvu.asp). 

Similarly, you can export other eTDS forms. 

4.3 eTCS Returns 
Tally.ERP 9 allows you to export the ETCS Forms in NSDL compliant formats. The ETCS forms available in 
Tally.ERP 9 are Form 27E and Form 27EQ. 

Export ETCS Forms 

To export ETCS Forms, go to Gateway of Tally > Display > Statutory Reports > TCS Reports > ETCS 
Forms 

 In the Exporting eTCS Forms Printing configuration screen, enter the required information as shown 
in Fig. 4.3.1 

 

Fig. 4.3.1 Exporting eTCS Forms 

 Press Y or Enter to export eTCS Form 27EQ 
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The exported file will be saved in the path specified in the output file name. The file can be validated through 
NSDL’s freely downloadable utility called ‘File Validation Utility’. This can be used to verify whether the 
ETCS return filed by the deductors conforms to the prescribed format. For more details, refer NSDL’s 
website (http:// www.tin-nsdl.com/eTDSfvu.asp). 

Similarly, you can export other eTCS forms. 


	contents-module-2
	Chapter 1 Working with Xml-done review
	Chapter 2 Advances in Macros
	Chapter 3  Applied Financial Analysis and Forecasting Financial Statements
	Chapter 4 MATHEMATICAL AND STATISTICAL TOOLS FOR FINANCIAL ANALYSIS
	Chapter 5 Application of Excel
	Chapter-1-Introduction to MS-Excel as an Audit Tool-F
	Chapter-2 Useful Functions for Auditing
	Chapter-3 Useful Functions for Auditing
	Chapter-4 Data Analysis Using MS Excel
	ERP Chapter 1 _After Changes_
	ERP Chapter 2 _After Changes_
	ERP Chapter 3 _After Changes_
	ERP Chapter 4 _After Changes_
	Blank Page
	Blank Page



